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This document provides information on the dispatch console configuration and dispatch functions. It is intended for dispatch console

administrators who configure SmartPTT Dispatcher and operators who will use it.

Additional Information

The document assumes that radioserver is properly configured and started. All the required configuration is presented in SmartPTT

Installation and Configuration Guide.

The document does not provide information on dispatch console computer configuration and its operating system administration. All the

necessary information can be obtained from the Microsoft Docs website, a Microsoft documentation storage for end users, developers,

and IT professionals.

About This Document

https://docs.microsoft.com/en-us/
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First Start  

Chapter 1. First Start

1.1 Configuring SmartPTT Dispatcher at First Start

Follow the procedure to configure SmartPTT Dispatcher at its first startup.

Prerequisites: 

• Install SmartPTT. For details, see “Software Installation” in SmartPTT Installation and Configuration Guide.

• Obtain the IP address / domain name of the DBMS host.

• Obtain the DBMS process name.

• To use SQL Server authorization, obtain the corresponding credentials. For details, see “Adding SQL Server Users” in SmartPTT

Installation and Configuration Guide.

• (Optional) Configure and start the desired radioserver.

• (Optional) From the desired radioserver configuration, obtain the following information:

• IP address or domain name of the computer with installed radioserver.

• Radioserver WCF port (default value: 8888).

• Client name and password (if authentication for desktop clients is used on the radioserver).

For information on the radioserver configuration for SmartPTT Dispatcher connection, see “Configuring Desktop Clients

Connection” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. Start SmartPTT Dispatcher (Client.exe).

The Select Language window appears.

2. In the window that appears, select the desired language for the SmartPTT Dispatcher interface and click OK.

The Configuration Wizard appears.

3. In the Configuration Wizard click Next.

The Database window appears.
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4. In the Database window, in the Database server name field, type the DBMS address.

NOTE

For a database server installed with the SmartPTT Dispatcher application, type the address using the following format:

<Computer Name>\SQLExpress (for example, MYCOMP\SQLExpress).

5. Configure authorization:

To use Windows authorization, from the Authorization mode list, select Windows NT

Authorization.

To use DBMS authorization, perform the following actions:

1. From the Authorization mode list, select SQL Server

Authorization.

2. In the Account name field, type the SQL Server account

login.

3. In the Password field, type the SQL Server account

password.

6. Click Establish Connection to connect to SQL Server.

If connection is successful, in the Database area, the Connection to the database server is established message appears.

Otherwise, at the bottom of the window, the message with an error description appears.
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7. In the Database area, click Create database.

The Create Database window appears.

8. In the window that appears, in the Database name field, type the name of the new database, and then click Save.

If creation is successful, in the Database area of the Database window, the Database <database name> was successfully created!

message appears.

9. In the Database window, click Next.

The Radioservers window appears.

10. (Optional) In the window that appears, configure the desired radioserver connection:

a. Click Add.

The Radioserver window appears.
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b. In the Radioserver window, open the General tab.

c. In the Name field, type the desired radioserver name.

d. In the IP Address field, type the IP address of the radioserver or domain name of the computer with installed radioserver.

e. In the Port field, enter the radioserver WCF port number. The default value is 8888.

f. Click Establish Connection to connect to the specified radioserver.

g. (Optional) If server authentication is enabled in SmartPTT Radioserver Configurator, the Operator Table appears in the

window. In the Administrator entry, perform the following actions:

i. In the Client Name column, type the client account name configured in SmartPTT Radioserver Configurator.

ii. In the Password column, type the client account password configured in SmartPTT Radioserver Configurator. For

details, see “Managing Account Parameters” in SmartPTT Installation and Configuration Guide.

h. Click OK to confirm changes and close the window.

11. In the Radioservers window, click Finish.

The Authorization window appears.
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12. Leave the Password field empty and click OK.

The Set Password window appears. When you start the SmartPTT Dispatcher application for the first time, the password for the

Administrator account is absent by default.

13. In the window that appears, in the Password field, set the password for the account with the Administrator status. In the

Confirmation field, type the password again. To view the entered password, click the eye icon (   ).

For security reasons, the password will not be available for viewing in subsequent sessions.

SmartPTT does not support entering a password using the Input Method Editor (IME).

The account with the Administrator status is created in SmartPTT Dispatcher by default.

NOTE

Your password must comply with the minimum complexity requirements. The default requirements are to use 8 or more characters

from at least three categories: uppercase and lowercase letters (A–Z, a–z), numbers (0–9), and special characters (for example, !, $,

#, %). You can hover your mouse cursor over the info icon (  ) to see which requirements your password does not meet. To change

password policy, submit a request to the SmartPTT Technical Support Center.

WARNING

The password cannot be restored, but it can be reset. To reset the password, submit a request to the SmartPTT Technical Support

Center.

14. Click Save and log in.

The SmartPTT Dispatcher window appears.

Postrequisites: 

• Install the purchased license. For details, see Installing License.

• (Optional) Create operator accounts. For details, see Operators.

http://support.smartptt.com/
http://support.smartptt.com/
http://support.smartptt.com/
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Chapter 2. SmartPTT Dispatcher Functionality Configuration

This chapter describes SmartPTT Dispatcher features configuration. It includes sections regarding the following topics:

• SmartPTT Dispatcher general settings configuration. For details, see General Settings.

• License installation. For details, see Licenses.

• SmartPTT Radioserver connection configuration. For details, see Radioservers.

• SmartPTT Dispatcher database configuration. For details, see Database.

• Control devices settings and hotkeys configuration. For details, see Control Devices.

• General sound settings and settings of connected audio input/output devices configuration. For details, see Audio System.

• Supported devices configuration. For details, see Supported Devices.

• Creating operator accounts and configuring their rights. For details, see Operators.

• Adding and configuring radios. For details, see Radios Configuration.

• Positioning settings configuration, including map / building plan creation and configuration. For details, see Positioning Settings

Configuration.

• Job ticket statuses configuration. For details, see Job Ticket Statuses Configuration.

• Telemetry actions configuration. For details, see Telemetry Configuration.

• Event Log configuration. For details, see Event Log Configuration.

• Call records configuration. For details, see Call Records Configuration.

• Telephony configuration. For details, see Telephone Interconnect Settings.

• Data acquisition module activation and Avigilon configuration. For details, see Third-Party Solutions Configuration.

• Dispatcher list configuration to communicate with other operators. For details, see Dispatcher List Configuration.

• Custom rules, positioning rules, and the Lone Worker mode configuration. For details, see Rules and Lone Worker Mode.

2.1 General Settings

The General Settings window provides the Administrator with the ability to set basic parameters of operators' work in SmartPTT

Dispatcher:

• Language.

SmartPTT Dispatcher interface is available in various languages. To apply a new language, you need to restart SmartPTT

Dispatcher.

• Windows authentication.

SmartPTT Dispatcher provides the ability to automatically log in the application using the current Windows account. To use

Windows authentication, you must create a SmartPTT Dispatcher operator account with the same name as a Windows user or the

group to which the user belongs. For details, see Operators.

• Launching the dispatch console on Windows start.

SmartPTT Dispatcher launches automatically at Windows startup using a specific operator's profile.

• Confirmation before closing or changing the operator.

SmartPTT Dispatcher can be configured to ask for confirmation every time you close the program or change the operator.
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• Displaying radio user name.

SmartPTT Dispatcher provides the ability to display the name of the radio user next to the radio name in SmartPTT Dispatcher.

For information on the user authorization service, see “Radio Users” in SmartPTT Installation and Configuration Guide.

• Outgoing call tone.

SmartPTT Dispatcher activates playback of a special tone after clicking the PTT button in the application. The tone indicates that

the channel is free and the dispatcher can start speaking.

• Call Alert.

SmartPTT Dispatcher provides the ability to configure a tone played in the application when the Call Alert command is received

from the radio.

For information on the Call Alert command, see Signaling Features.

2.1.1 Configuring General Settings

Follow the procedure to configure basic SmartPTT Dispatcher parameters.

Prerequisites: 

• To use Windows authentication, create a SmartPTT Dispatcher operator account with the same name as a Windows user or the

group to which the user belongs. For details, see Managing Operator Accounts.

• To configure the dispatch console to launch on Windows start, run SmartPTT Dispatcher as the Administrator.

• To display the name of the radio user, activate the user authorization service and add users in SmartPTT Radioserver

Configurator. For details, see “Radio Users” in SmartPTT Installation and Configuration Guide.
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Procedure: 

1. On the menu bar, click Settings (   ) → Interface → General Settings.

The General Settings window appears.

2. In the window that appears, perform the desired actions:

To change the language of the SmartPTT Dispatcher

interface,

perform the following actions:

1. Click the current Language value.

The Select Language window appears.
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2. In the window that appears, select the desired language from

the list.

3. Click OK.

To use credentials of the current authorized Windows

user at SmartPTT Dispatcher startup,

select the Windows authentication check box.

To launch SmartPTT Dispatcher automatically at

Windows startup,

perform the following actions:

1. Select the Launch the dispatch console on Windows start

check box.

2. (Optional) To launch SmartPTT Dispatcher on Windows start

using a specific operator's profile, perform the following

actions:

a. Clear the Windows authentication check box.

b. From the list to the right of the Launch the dispatch

console on Windows start check box, select the desired

operator account.

To ask for confirmation when closing SmartPTT

Dispatcher or changing an operator,

select the Ask for confirmation before closing or changing

the operator check box.

To display the name of the radio user next to the radio

name in SmartPTT Dispatcher,

select the Show radio user name check box.

To configure a sound notification when clicking the

PTT button in SmartPTT Dispatcher,

perform the following actions:

1. Select the Outgoing call tone check box.

2. Click the Browse (   ) button to the right of the text field.

The Sound File Selection window appears.

3. In the window that appears, specify the desired audio file,

and then click Open.
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To configure the call alert tone played in SmartPTT

Dispatcher,

perform the following actions:

1. In the Tone duration (s) field, type the desired duration (in

seconds) of the call alert tone.

2. (Optional) To the right of the Tone field, click the Browse ( 

 ) button, specify the desired call alert tone audio file in

the Sound File Selection window, and then click Open.

The specified path and file name are displayed in the Tone

field.

NOTE

You can also type or paste the full file path into this field.

3. Move the Volume level slider to the desired level of the call

alert tone volume.

3. Click Finish at the bottom of the window to save changes and close the window.

Postrequisites: 

If you change the interface language, restart SmartPTT Dispatcher to apply the new language.

2.2 Licenses

To use SmartPTT Dispatcher, you must install a license. If SmartPTT Radioserver and the dispatch console are installed on the same

computer, you can install licenses either in SmartPTT Radioserver Configurator or in SmartPTT Dispatcher. If SmartPTT Radioserver and

the dispatch console are installed on different computers, you must install licenses for both applications. If the radioserver and the

dispatch console are installed on different computers, the license installation requirements depend on the client profile settings in the

radioserver. If the client profile allows radioserver to apply its license to the desktop client, it is sufficient to install the license only on

the radioserver. Otherwise, the license must be installed in both applications. For information on applying the radioserver license to

SmartPTT Dispatcher, see “Profiles” in SmartPTT Installation and Configuration Guide.

If SmartPTT Dispatcher without its own license is connected to several radioservers and in its profile it is allowed to copy licenses, it

will use all available licenses. In this case, it will have access to all features within these licenses.

If SmartPTT Dispatcher has its own local license, it will use it regardless of the number of radioservers it is connected to.

Each functionality item in the license is available until its expiration date.

Important

You cannot install software that was released after the update subscription expiration date specified in the Update subscription

expiration date entry of the Licenses window.

Licensing includes the following actions:

• Ordering a license. For details, see “Licensing” in SmartPTT Installation and Configuration Guide.

• License file installation. For details, see Installing License.
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2.2.1 Installing License

Follow the procedure to install a SmartPTT license in SmartPTT Dispatcher.

NOTE

You can configure a radioserver to apply its license to connected SmartPTT Dispatchers. In this case, SmartPTT Dispatcher can use a

license from this radioserver if they are connected. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Prerequisites: 

• Obtain the SmartPTT license file (.spttlx).

• Run SmartPTT Dispatcher as the Administrator.

Procedure: 

1. On the menu bar, click Settings (   ) → Licenses.

The Licenses window appears.

2. In the Licenses window, click Install License.

The file selection window appears.

3. In the window that appears, select the desired license file and click Open.

4. Ensure that the licensed services and their expiration dates are correct. Otherwise, click Restore License, and then click Install

License to select a different license file, or submit a request to the SmartPTT Technical Support Center.

http://support.smartptt.com/
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5. Click Finish.

Postrequisites: 

• Restart SmartPTT Dispatcher to apply the new license.

• If you want to remove the current license, click the Delete button, and then restart the application for the changes to take effect.

2.2.2 Viewing License Items

To view a list of functions that your acquired license allows to use in SmartPTT, on the menu bar, click Settings (   ) → Licenses. The

Configuration window appears.

The License table contains information about the SmartPTT features, the type and number of licenses, and the expiration date for each

feature. The date indicates the last time when you can upgrade SmartPTT for free. Later versions of the SmartPTT software released

after this date will not work with this license.
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2.3 Radioservers

SmartPTT Dispatcher provides the ability to connect to several radioservers simultaneously. Connected radioservers are displayed on

the Radio Fleet panel as parent nodes. You can expand a radioserver node to access objects of the radio systems configured on this

radioserver.

Important

Before adding a radioserver to SmartPTT Dispatcher, desktop clients connection must be configured in SmartPTT Radioserver

Configurator. For details, see “Configuring Desktop Clients Connection” in SmartPTT Installation and Configuration Guide.

If desktop client authentication on SmartPTT Radioserver is enabled, to connect to SmartPTT Radioserver, it is necessary to type

credentials of the client accounts configured in SmartPTT Radioserver Configurator for the desired operators. For details, see

Operators.

SmartPTT Dispatcher also provides the ability to control added radioservers remotely using IPMI. For details, see IPMI Settings.

2.3.1 Managing Radioservers

Follow the procedure to add a new radioserver connection or to edit the existing one.

Prerequisites: 

• Obtain IP address or domain name of a computer with installed radioserver.

• Obtain radioserver WCF port number set in SmartPTT Radioserver Configurator.

• If authentication for desktop clients is used in SmartPTT Radioserver Configurator, obtain the client name and password.

• Add the desired operator accounts. For details, see Managing Operator Accounts.

Procedure: 

1. On the menu bar, click Settings (   ) → Radioservers.

The Radioservers window appears.
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2. In the window that appears, perform one of the following actions:

To add a new connection to a radioserver, click Add (   ).

The Radioserver window appears.

To edit an existing connection to a radioserver, in the Radioservers Table, select the desired radioserver, and

then click Edit (   ).

The Radioserver window appears.

To delete a connection to a radioserver, perform the following actions:

1. In the Radioservers Table, select the desired radioserver.

2. Click Delete (   ).

3. In the Confirmation window, click OK.

The radioserver is deleted from the table.

4. Proceed to the last step.

To find all running radioservers in the network, click Search (   ).

Available radioservers appear in the Radioservers Table.
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To display a radioserver in SmartPTT Dispatcher, for the desired entry of the Radioservers Table, in the Active

column, select the check box.

3. In the Radioserver window, open the General tab.

4. (Optional) In the Name field, type the desired radioserver name.

5. In the IP Address field, type the IP address of the radioserver or domain name of the computer with installed radioserver.

6. In the Port field, enter the radioserver WCF port number.

7. Click Establish Connection to establish connection to the specified radioserver.

8. (Optional) If server authentication is enabled in SmartPTT Radioserver Configurator, the Operator Table appears in the window. In

the Administrator line, perform the following actions:

a. In the Client Name column, type the client account name configured in SmartPTT Radioserver Configurator.

b. In the Password column, type the client account password configured in SmartPTT Radioserver Configurator. For details, see

“Managing Account Parameters” in SmartPTT Installation and Configuration Guide.
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9. (Optional) Repeat the previous step for other operator accounts.

10. Click OK to apply changes and close the window.

11. In the Radioservers window, click Finish.

2.3.2 IPMI Settings

IPMI (Intelligent Platform Management Interface) is a standardized computer system interface that is used for out-of-band management

of computer systems, and monitoring system operation.

SmartPTT system uses IPMI for remote radioserver managing and monitoring. You can use IMPI to reset, turn on or off the radioserver

computer, or view its hardware characteristics.

You can configure IPMI settings for the radioserver on the IPMI tab of the Radioserver window. For details, see Configuring IPMI

Settings.

Remote control of the radioserver computer is available on the Topology panel. For details, see Radioserver Remote Control.

2.3.2.1 Configuring IPMI Settings

Follow the procedure to configure the radioserver IPMI settings.

Prerequisites: 

• Add and configure the desired radioserver. For details, see Managing Radioservers.

• Obtain the IP address and port number of the SmartPTT Radioserver computer used to establish IPMI connection.

• From the IPMI configuration settings on the SmartPTT Radioserver computer, obtain the login and password.
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Procedure: 

1. On the menu bar, click Settings (   ) → Radioservers.

The Radioservers window appears.

2. In the window that appears, double-click the desired radioserver.

The Radioserver window appears.

3. In the Radioserver window, open the IPMI tab.

4. On the IPMI tab, perform the following actions:

a. In the Address and Port fields, type the IP address and port number of the SmartPTT Radioserver host used for establishing

IPMI connection.

b. In the Login and Password fields, type the login and password set in the IPMI configuration settings on the SmartPTT

Radioserver host. To view the entered password, click the eye icon (  ). For security reasons, the password will not be

available for viewing in subsequent sessions.

c. From the Authentication list, select the desired authentication type.

d. From the Privilege list, select the desired privilege for the dispatcher.

e. From the Ciphers list, select the desired cipher.

NOTE

In the Authentication, Privilege, and Ciphers lists, it is recommended to use the default values.

f. (Optional) To activate remote connection to the radioserver, select the Active check box.

5. Click OK to apply changes and close the window.
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2.4 Database

SmartPTT Dispatcher supports Microsoft SQL Server database management systems (DBMS). It is recommended to use Microsoft SQL

Server 2014 Express included in the SmartPTT installation package.

For information on DBMS configuration, see “DBMS Configuration” in SmartPTT Installation and Configuration Guide.

DBMS access and authorization are managed by various services. For details, see “DBMS Utilization” in “Logging” in SmartPTT

Installation and Configuration Guide.

WARNING

Only one dispatch console can be connected to the same database.

The SmartPTT Dispatcher database stores the Event Log, operator accounts, registered subscribers data, and geolocation data. You can

view the summary of information stored in the SmartPTT Dispatcher database in the Statistics window by clicking Service → Statistics

on the menu bar.

The Statistics window provides information on the number of various system events (subscribers' registrations, incoming and outgoing

calls, system alarms, etc.) and displays the database name, current size, and maximum size.

The window also provides information on the size of the folder where SmartPTT Dispatcher stores audio records.

For information on selecting the folder for audio records, see Configuring Audio Recording.

The maximum database size is set during the SQL Server configuration and depends on the SQL Server version and edition. When the

database reaches 90 % of its maximum size, a warning message prompting to perform the automatic database cleanup appears. When

the database reaches its maximum size, another warning message appears. It indicates that new records cannot be added to the

database.

SmartPTT Dispatcher provides the following database-related features:

• Automatic backup of the database. For details, see Database Auto Backup.

• Saving current settings, layout, and database. For details, see Save Dispatcher Settings.

• Importing settings, layout and database from the previously created files. For details, see Restore Dispatcher Settings.
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SmartPTT Dispatcher Database Configuration

SmartPTT Dispatcher database configuration includes the following actions:

• SmartPTT Dispatcher must be connected to DBMS. For details, see Configuring Database Server Connection.

• Database must be selected. For details, see Managing Databases.

• (Optional) Database automatic backup can be configured. For details, see Configuring SmartPTT Dispatcher Database Auto

Backup.

2.4.1 Configuring Database Server Connection

Follow the procedure to configure the SmartPTT Dispatcher connection to the database management system (DBMS).

Prerequisites: 

• Obtain the IP address / domain name of the DBMS host.

• Obtain the DBMS process name.

• To use SQL Server authorization, obtain the corresponding credentials. For details, see “Adding SQL Server Users” in SmartPTT

Installation and Configuration Guide.
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Procedure: 

1. On the menu bar, click Settings (   ) → Database.

The Database window appears.

2. In the window that appears, in the Database server name field, type the DBMS address.

NOTE

For the database server installed with the SmartPTT Dispatcher application, type the address using the following format: <Computer

Name>\SQLExpress (for example, MYCOMP\SQLExpress).

3. Configure authorization:

To use Windows authorization, from the Authorization mode list, select Windows NT

Authorization.

To use DBMS authorization, perform the following actions:

1. From the Authorization Mode list, select SQL Server

Authorization.

2. In the Account name field, type the SQL Server account

login.
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3. In the Password field, type the SQL Server account

password. To view the entered password, click the eye

icon (  ).

4. Click Establish Connection to connect to SQL Server.

If connection is successful, in the Database area, the Connection to the database server is established message appears.

Otherwise, at the bottom of the window, a message with an error description appears.

5. Click Finish to save changes.

Postrequisites: 

Configure the current database. For details, see Managing Databases.

2.4.2 Managing Databases

Follow the procedure to create a new database, select an existing database, or restore a database from a backup.

Prerequisites: 

• Configure the database management system (DBMS) connection. For details, see Configuring Database Server Connection.

• To restore the current database from an automatic backup file, configure the automatic database backup. For details, see

Configuring SmartPTT Dispatcher Database Auto Backup.
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Procedure: 

1. On the menu bar, click Settings (   ) → Database.

The Database window appears.

2. In the window that appears, in the Database area, perform one of the following actions:

To create a new database, perform the following actions:

1. Click Create database.

The Create Database window appears.

2. In the window that appears, in the Database name field, type

the name of the new database, and then click Save.

If creation is successful, in the Database area of the

Database window, the Database <database name> was

successfully created! message appears.
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To use an existing database, from the Current database list, select the desired database.

To restore a local database from a backup file, perform the following actions:

1. Click Restore database.

The Restore Database window appears.

2. In the window that appears, perform one of the following

actions:

• To restore the database from the latest automatic

backup file, select Latest automatic backup file.

• To restore the database from any other backup file,

select Other automatic backup file, click Browse (   ),

and then select the desired database backup file in the

BAK format.

3. Click Save.

4. In the Confirmation window, click OK.

If restoration is successful, in the Database area of the

Database window, the Database <database name> is restored

successfully message appears.

To restore a remote database from a backup file

located on a remote computer,

use DBMS tools.

3. Click Finish to save changes and close the Database window.

Postrequisites: 

Restart SmartPTT Dispatcher to apply the changes.

2.4.3 Database Auto Backup

The Database Auto Backup functionality provides the ability to perform automatic backup of the SmartPTT Dispatcher database. Regular

backups help prevent data loss in case of the SmartPTT Radioserver hardware or software failure. For security purposes, it is

recommended to configure the database automatic backup.

You can back up both local and remote databases. The restoration of the backed up database by means of SmartPTT Dispatcher can be

performed only from a backup file stored on the local computer. If the backup file is located on a remote computer, use DBMS tools to

restore the database.

For information on configuring automatic database backup, see Configuring SmartPTT Dispatcher Database Auto Backup.
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Examples of Auto Backup Settings

If, in the Database Auto Backup Settings window, you select Daily, set 4 in the Interval (days) field, and 9:00 in the Time field, the

database is backed up every fourth day at 9:00.

If you select Weekly, select the Mo and We check boxes, set 3 in the Interval (weeks) field, and 11:00 in the Time field, the database

is backed up every third week on Monday and Wednesday at 11:00.

If you select Monthly, set 5 in the Day of month field, set 2 in the Interval (months) field, and 15:00 in the Time field, the database is

backed up on the fifth day of every second month at 15:00.

2.4.3.1 Configuring Database Auto Backup

Follow the procedure to configure the automatic database backup settings in SmartPTT Dispatcher.

Procedure: 

1. On the menu bar, click Settings (   ) → Information Storage → Database Auto Backup.

The Database Auto Backup Settings window appears.

2. In the window that appears, select the Allow Database Auto Backup check box.

The areas below become available.
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3. To the left of the Backup folder field, click Browse (   ), and then, in the window that appears, select a folder for storing database

backup files.

The path to the selected folder appears in the Backup folder field.

4. In the Backup Settings area, configure the backup period:

To create backups every few days, perform the following actions:

1. Select Daily.

2. In the Interval (days) field, enter the number of days between

backups (1 means daily backups).

To create backups on specific days of the week, perform the following actions:

1. Select Weekly.

2. Select check boxes that are related to the days of the week when

the backup must be created.

3. In the Interval (weeks) field, enter the number of weeks between

backups (1 means weekly backups).

To create backups once in several months, perform the following actions:

1. Select Monthly.

2. In the Day of month field, enter the day of the month when the

backup must be created.

3. In the Interval (month) field, enter the number of months

between backups (1 means monthly backups).

5. In the Time field, enter the time of the day when the database backup creation starts.

6. (Optional) In the Backup Period area, configure start and end dates of the time interval when the backups must be created:

a. In the Start Date field, enter the start date of the backup creation.

b. Configure the end date of the time interval:

To specify the end date, perform the following actions:

1. Select End Date.

2. In the unlocked field, enter the end date.

To unset the end date, select No End Date.

7. Click Finish to save changes and close the window.

Postrequisites: 

Restore the database from an automatic backup file. For details, see Managing Databases.
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2.4.4 Save Dispatcher Settings

The Save Dispatcher Settings feature provides the ability to export the SmartPTT Dispatcher database and settings to a ZIP file for their

further transfer to the same or another SmartPTT Dispatcher. For details, see Restore Dispatcher Settings.

NOTE

The feature is unavailable if SmartPTT Dispatcher is connected to a remote database.

Export of the SmartPTT Dispatcher settings and database can be useful for the following purposes:

• Transfer of the SmartPTT Dispatcher database and current configuration settings to another SmartPTT Dispatcher

• Transfer of the current SmartPTT Dispatcher position to another computer

• Settings and database backup

The exported file is an archive in the ZIP format that contains XML and JSON files storing data on the current configuration settings.

The SmartPTT Dispatcher database is exported to a BAK file stored in the same archive.

2.4.4.1 Saving Dispatcher Settings

Follow the procedure to export the SmartPTT Dispatcher database and/or settings in their current state to a ZIP file.

Prerequisites: 

Ensure that you have access to the desired export destination folder.

Procedure: 

1. On the menu bar, click Service → Save Dispatcher Settings.

The Save Dispatcher Settings window appears.

2. In the Archive File area, click Browse (   ).

3. In the Specify File Name window, specify the path to the desired folder and the name of the exported ZIP file, and then click Save.
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4. In the Objects area, configure the desired export parameters:

To export the SmartPTT Dispatcher settings, select the Settings check box.

To export the SmartPTT Dispatcher database, select the Database check box.

To export the SmartPTT Dispatcher database and settings, select the Settings and Database check boxes.

5. At the bottom of the Save Dispatcher Settings window, click Save.

6. In the window indicating successful export, click OK.

Postrequisites: 

Import the SmartPTT Dispatcher database and/or settings. For details, see Restoring Dispatcher Settings.

2.4.5 Restore Dispatcher Settings

The Restore Dispatcher Settings feature provides the ability to import the SmartPTT Dispatcher database and settings from the current

or another SmartPTT Dispatcher. For details, see Save Dispatcher Settings.

NOTE

The feature is unavailable if SmartPTT Dispatcher is connected to a remote database.

Using this feature, you can perform the following actions:

• Import SmartPTT Dispatcher settings, including language settings, layout, and other configuration settings

• Import the SmartPTT database

• Overwrite the Globally Unique Identifier (GUID) of the current SmartPTT Dispatcher with the imported one

Import of the SmartPTT Dispatcher settings and database can be useful for the following purposes:

• Transfer of the SmartPTT database and configuration settings from another SmartPTT Dispatcher

• Transfer of a SmartPTT Dispatcher position from one computer to another

• Restoring the SmartPTT Dispatcher settings and database from a backup file

Dispatch Console GUID

Each SmartPTT dispatch console has a globally unique identifier (GUID), which is assigned to it when installing the SmartPTT Dispatcher

application and is used to access records in a database.

Simultaneous operation of two dispatch consoles with the same GUID within the same system is impossible.

The dispatch console GUID can be restored from a file in the Restore Dispatcher Settings window only alongside with other settings of

the dispatch console.

Restoring GUID is required only if the dispatch console must continue working with the same database with which operated the dispatch

console where the recovery file was generated.

WARNING

If the dispatch console GUID is restored from a file generated in another dispatch console, ensure that the dispatch console in which

the recovery file was generated has stopped its operation. Otherwise, only one of these consoles will be able to receive data from the

radioserver.

Important

When recovering a database from another SmartPTT Dispatcher, you also need to restore the dispatch console GUID to save access

to records in the database to be restored.
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2.4.5.1 Restoring Dispatcher Settings

Follow the procedure to import the SmartPTT Dispatcher database and/or settings from a ZIP file and/or overwrite the Globally Unique

Identifier (GUID) of the current SmartPTT Dispatcher.

Procedure: 

1. On the menu bar, click Service →Restore Dispatcher Settings.

The Restore Dispatcher Settings window appears.

2. In the Archive File area, click Browse (   ).

3. In the Specify File Name window, specify the path to the desired ZIP file, and then click Open.

4. In the Objects to restore area, depending on the desired and available import parameters, perform the following actions:

To import the SmartPTT Dispatcher settings, select the Settings check box.

To import the SmartPTT Dispatcher database, select the Database check box.

Important

When recovering a database from another SmartPTT

Dispatcher, you also need to restore the dispatch console

GUID to save access to records in the database to be

restored.

To replace your GUID with the GUID from the imported file, perform the following actions:

1. Select the Settings check box.

2. Select the Overwrite Dispatcher GUID check box.

WARNING

Do not replace GUID if you want to keep using the SmartPTT

Dispatcher from which the settings were exported. If two

dispatch consoles with the same GUID operate in the radio

system at the same time, it may lead to errors and

malfunctioning.
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5. At the bottom of the Restore Dispatcher Settings window, click Restore.

6. In the window indicating successful import, click OK.

7. Restart SmartPTT Dispatcher to apply changes.

2.5 Control Devices

SmartPTT Dispatcher provides support for the following types of control devices:

• Computer mouse

• Touchscreen

• Keyboard

Pointing Devices

Pointing devices in SmartPTT Dispatcher include a computer mouse and a touchscreen.

For pointing devices, SmartPTT Dispatcher provides the ability to set the following actions that will be executed after clicking the call

element:

• Select (the call element is selected when you click or tap it)

• Call (a call is initiated when you click or tap the call element)

In SmartPTT Dispatcher, the following modes are available for calls:

• Hold (initiate a transmission when the control is pressed and finish it when it is released)

• Single click (initiate a transmission with a single press of the control)

Keys

SmartPTT Dispatcher provides the ability to add and assign hotkeys to system objects and actions.

In SmartPTT Dispatcher, the following call modes are available for hotkeys:

• Hold (you must press and hold the hotkey to initiate and continue a call)

• Single click (you must press the hotkey once to perform an action)

You can add any amount of hotkeys but each hotkey must have the unique key or key combination assigned.

SmartPTT Dispatcher supports the following hotkey input devices:

• A standard keyboard connected to the computer.

• An external DirectInput device connected to the computer via USB port.

Important

If you use the D-9 by Holmco microphone, do not select it as a DirectInput device.

• An external HID device connected to the computer via USB port.

NOTE

The SmartPTT system provides a dispatcher with the ability to assign all the actions listed on the Keys tab of the Control Devices

window to the keys programmable on the Tipro console. For details, see Tipro Console.

• An external device connected to the computer via COM port.

http://www.holmco.de/en/623/tischsprechstelle-mit-usb-anschluss.html
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For information on some other supported devices configuration, see Supported Devices.

If you use a keyboard as an input device, use the following information to assign hotkeys properly:

• Esc, Print Screen, and Windows keys cannot be assigned as hotkeys.

• F1 and Enter keys can be assigned only in Alt+Key and Shift+Alt+Key combinations.

Other keys can be used either separately or in the following combinations:

• Alt+Key

• Shift+Key

• Ctrl+Key

• Shift+Ctrl+Key

• Shift+Alt+Key

• Ctrl+Alt+Key

For information on objects and actions for which hotkey assigning is available, see the SmartPTT Dispatcher embedded help.

Control Device Configuration

In SmartPTT Dispatcher, you can configure control devices in the following ways:

• Configure the call element actions. For details, see Configuring Call Element Actions.

• Assign hotkeys. For details, see Assigning Hotkeys.

2.5.1 Configuring Call Element Actions

Follow the procedure to configure actions on clicking or tapping the call element for interaction with the radio object using a pointing

device.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.
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2. In the windows that appears, open the Pointing Devices tab.

3. Configure the desired pointing device:

To configure a mouse, in the Mouse area, perform one of the following actions:

• To configure selection upon clicking, select Select.

• To configure call upon clicking, perform one of the following

actions:

• Select Hold for clicking and holding the call element to

initiate and continue a call.

• Select Single click for clicking the call element once to

initiate and continue a call.

To configure a touchscreen, in the Touchscreen area, perform one of the following actions:

• To configure selection upon tapping, select Select.

• To configure call upon tapping, perform one of the following

actions:
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• Select Hold for tapping and holding the call element to

initiate and continue a call.

• Select Single click for tapping the call element once to

initiate and continue a call.

4. Click Finish to save changes and close the window.

2.5.2 Assigning Hotkeys

Follow the procedure to assign a hotkey for an action or radio object in the SmartPTT system.

Prerequisites: 

Ensure the desired input device is connected to the computer and is active.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.

2. In the windows that appears, open the Keys tab.
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3. Perform the desired actions:

To assign a hotkey for an action, in the Objects and actions area, click the desired action.

In the Keys area, the Add key (   ) button appears.

To assign a hotkey for an action which is related to the

specific object (radio, channel, talkgroup, category,

telephone subscriber, or dispatcher),

in the Objects and actions area, expand the desired node, and then

click the desired object.

In the Keys area, the Add key (   ) button appears.

To change the hotkey input device for an action or

object,

perform the following actions:

1. In the Objects and actions area, select the desired object

or action by expanding the desired node.

2. Proceed to step 6.

To assign another hotkey to an action or object, perform the following actions:

1. In the Objects and actions area, select the desired object

or action by expanding the desired node.

2. Proceed to step 7.

To delete a hotkey, perform the following actions:

1. In the Objects and actions area, select the desired object

or action by expanding the desired node.

In the Keys area, the hotkey assigned to the object or

action appears.

2. To the right of the desired assigned hotkey, click Delete ( 

 ).

The hotkey disappears from the Keys area.

3. Proceed to step 9.

To delete all added hotkeys, perform the following actions:

1. Click Reset All.

All the hotkeys assigned to objects and actions in

SmartPTT Dispatcher are deleted.

NOTE

The Reset All button cannot delete the default Space hotkey

entry of the PTT button, but it can reset a hotkey assigned by

the user.

2. Proceed to step 9.

4. Click Add key (   ).

Controls for the hotkey configuration appear in the Keys area.

5. From the Input Devices list, select the desired input device:

To use a keyboard, select Keyboard.
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To use an external DirectInput device connected

via USB port,

perform the following actions:

1. Select Input Device (DirectInput).

The list of available devices appears next to the Input Devices list.

2. From the list that appears, select the desired USB device.

To use an external HID device connected via USB

port,

perform the following actions:

1. Select Input Device (HID).

The list of available devices appears next to the Input Devices list.

2. From the list that appears, select the desired USB device.

NOTE

Before assigning hotkeys on the Tipro console, configure them as HID

buttons using the ChangeMe Utility application.

To use an external device connected via COM

port,

perform the following actions:

1. Select External Device COM Port.

The list of available pins of COM port appears under the Input

Devices list.

2. From the list that appears, select the desired pin.

3. Proceed to step 9.

6. Under the Input Devices list, click the Assign Hotkey (   ) button.

White dots appear on the button, and the Press desired key message appears next to it.

7. Press the key or key combination you want to assign to the object or action. For details, see Control Devices.

The key or key combination that you pressed is displayed on the Assign Hotkey button, and the Press desired key message

disappears.

8. Click Finish to save changes and close the window.

2.6 Audio System

In SmartPTT Dispatcher, you can configure general sound settings and settings of connected audio output devices.

Audio Input

SmartPTT Dispatcher provides the ability to configure the primary audio input (microphone) used for capturing the dispatcher voice.

More than one audio input device cannot be selected. You can configure the following audio input settings:

• Input line used to capture sound.

• Noise reduction to make dispatcher sound clearer by reducing noises.

You can select a level of noise reduction from 3 to 18 dB.

• Audio input test to check a sound of the audio input device.

Audio Output

SmartPTT Dispatcher provides settings for one primary and an unlimited number of additional audio outputs (speakers, headphones)

used for incoming call playback, as well as to play sound alerts and audio archive records.
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NOTE

Additional audio outputs are treated in SmartPTT Dispatcher as virtual sets consisting of the real output devices.

Configuration of additional audio outputs in SmartPTT Dispatcher provides the ability to assign different audio outputs to different

objects and thus separate the incoming sound. For example, different speakers can be assigned to the first and second radio network

channels, and the headphones can be assigned to selected objects.

SmartPTT Dispatcher provides the ability to assign personal audio outputs separately to the following objects and events:

• Selected objects.

The objects that are selected or whose Call Window is open and active (the window has the blue title bar, and the PTT button has

the blue frame).

For information on selected objects, see Radio System Object Selection.

NOTE

Telephone subscribers, other dispatchers, and conferences cannot be selected objects.

• Unselected objects.

• Channels of a radio network or a control station.

• Talkgroups, dynamic groups.

• Emergency and emergency calls.

• System sounds.

SmartPTT Dispatcher supports the ability to turn on and off the sound as well as adjust the volume for various radio system objects. For

details, see Sound Management.

Sound Customization Options

SmartPTT Dispatcher provides the Administrator with the ability to configure such volume parameters as:

• Minimum volume.

Dispatcher cannot mute SmartPTT Dispatcher sound, but only turn down the volume to minimum.

NOTE

The minimum volume level affects only SmartPTT Dispatcher and depends on the volume level of the operating system.

• Disable muting of private calls to dispatcher.

Incoming transmissions are not muted in SmartPTT Dispatcher, even if the channel sound is muted.

• Mute incoming calls while transmitting.

• Mute other dispatcher transmissions in the system.

• Amplification of dispatcher voice in outgoing transmissions.

• Automatic gain control to adjust the volume of incoming calls.

Sound Configuration

To configure sound in SmartPTT Dispatcher, the following actions must be performed:

• General sound settings must be configured. For details, see Configuring General Sound Settings.
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• (Optional) Multichannel sound can be configured. For details, see Configuring Audio Output Devices and Assigning Audio Output

Devices.

• (Optional) Additional volume options can be configured. For details, see Configuring Additional Sound Settings.

2.6.1 Configuring General Sound Settings

Follow the procedure to configure general sound settings in SmartPTT Dispatcher.

Prerequisites: 

Ensure the desired audio input or output devices are connected and enabled.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.

2. In the window that appears, open the General Settings tab.

3. In the Audio Input area, in the Device list, select the desired input device.

4. Check audio input:

a. Click Record and speak into the device.

The button changes to Stop.

b. Click Stop to stop the recording.

The button changes to Record and other buttons become unlocked.
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c. Click Play to listen to the recorded voice.

The button changes to Stop, and you will hear the voice if the input device works properly.

a. (Optional) To save the recorded voice sample, click Save.

5. In the Audio Output area, configure settings of the audio output device:

a. From the Main device list, select the desired output device.

b. Click Check to check the selected output device.

The button changes to Stop, and you will hear the sound if the output device works properly.

c. Click Stop to stop the output device check.

6. In the VoIP Parameters area, configure settings of the voice transmitting:

a. From the Codec list, select the desired audio stream compression method.

b. From the Codec Format list, select the desired audio stream sampling frequency.

c. In the VoIP Port field, type a number of the desired port for sound stream receiving.

7. (Optional) To adjust the volume of incoming calls, select the Automatic Gain Control check box.

Important

The TIPRO phone module: switching audio input and audio output when answer a call check box must always be cleared.

8. Click Finish to save changes and close the window.

2.6.2 Configuring Audio Output Devices

Follow the procedure to configure virtual audio output device.

Prerequisites: 

Ensure the desired audio input or output devices are connected and enabled.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.
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2. In the window that appears, open the Audio Output Devices tab.

3. Perform the following actions:

To add a new output device, click Add (   ).

A new audio output device appears in the upper-left area.

To rename the added output device, perform the following actions:

1. Select the desired device and click Edit (   ).

NOTE

For the main output device, editing is not available.

2. Type the desired name.

3. Proceed to step 7.

To delete the output device, perform the following actions:

1. Select the desired device and click Delete (   ).

NOTE

For the main output device, deletion is not available.
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2. Proceed to step 7.

4. At the lower-left area, select the desired sound channels for the added audio output device.

5. In the upper-left area, next to the selected device, click Check to check the selected sound channels.

The button changes to Stop.

6. Click Stop to stop the sound check.

7. Click Finish to save changes and close the window.

Postrequisites: 

Assign devices to the desired system objects and events. For details, see Assigning Audio Output Devices.

2.6.3 Assigning Audio Output Devices

Follow the procedure to assign virtual audio output device to a system object or event.

Prerequisites: 

Ensure the desired virtual audio device is added and properly configured. For details, see Configuring Audio Output Devices.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.
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2. In the window that appears, open the Audio Output Devices tab.

3. In the Objects area of the Audio Output Devices tab, select the desired object.

4. From the Personal audio output list, select a virtual device for the object.

5. (Optional) For the system object to use only the device selected from the Personal audio output list, select the Use the personal

audio output only check box.

NOTE

The check box is unavailable to selected/unselected objects, system sounds, and alarm.

6. Click Finish to save changes and close the window.

Postrequisites: 

To reset all manually assigned output devices, click Clear All.
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2.6.4 Configuring Additional Sound Settings

Follow the procedure to configure muting options.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.

2. In the window that appears, open the Other Settings tab.

3. In the Incoming call volume area, configure the mute settings:

To disable muting of incoming private calls, select the Disable muting of private calls to dispatcher check box.

To mute all incoming calls during outgoing

transmissions,

select the Mute incoming calls while transmitting check box.

To mute transmissions from all other dispatchers

in the system,

perform the following actions:

1. Select the Mute other dispatcher voice check box.

2. Select For all dispatchers.
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To mute transmissions from specific other

dispatchers in the system,

perform the following actions:

1. Select the Mute other dispatcher voice check box.

2. Select For dispatchers in this location, and then, in the unlocked

field on the right, type the name or number of the location where

the desired dispatchers are located.

3. Repeat these steps for other SmartPTT Dispatcher applications

whose operators should not hear each other.

Operators who have identical data in the For dispatchers in this

location field of SmartPTT Dispatcher are unable to hear each

other. The location value can contain no more than 50 characters.

4. Configure sound parameters for a dispatcher:

To prevent dispatchers from completely muting

SmartPTT Dispatcher sound,

perform the following actions:

1. In the Incoming call volume area, select the Set minimum volume

check box.

2. Move the slider to the desired minimum volume level.

The specified volume level will be used when the dispatcher turns

off the sound.

To amplify dispatcher voice in outgoing

transmissions,

in the Amplify dispatcher voice area, move the Amplification slider to the

desired volume level.

5. Click Finish to save changes and close the window.

2.7 Supported Devices

SmartPTT Dispatcher supports third-party digital and analog devices including the following:

• VM-1S USB Dispatch Microphone.

For information on the VM-1S USB microphone configuration, see Configuring VM-1S USB Microphone.

• VCC-3 USB Dispatch Microphone.

For information on the VCC-3 USB microphone configuration, see Configuring VCC-3USB Microphone.

• D-9 Dispatch Microphone.

For information on the D-9 microphone configuration, see Configuring D-9 Microphone.

• PTT13-USB PTX-QD Microphone.

For information on the PTT13-USB PTX-QD microphone configuration, see Configuring PTT13-USB PTX-QD Microphone.

• PS12/PS20 USB Microphone.

For information on the PS12/PS20 USB microphone configuration, see Configuring PS12/PS20 USB Microphone.

• DM-160 Microphone.

For information on the DM-160 microphone configuration, see Configuring DM-160 Microphone.

• C310-M/C320-M USB Headset.

For information on the C310-M/C320-M USB Headset configuration, see Configuring C310-M/C320-M USB Headset.

• X-keys XK-3 Foot Switch.

For information on the X-keys XK-3 foot switch configuration, see Configuring X-keys XK-3 Foot Switch.
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• Tipro Modular Console. For details, see Tipro Console.

For the full list of supported devices, see “Third-Party Products” in SmartPTT Installation and Configuration Guide.

For information on connection of the aforementioned supported devices, see the sections below.

2.7.1 Configuring VM-1S USB Microphone

Follow the procedure to configure the VM-1S USB microphone.

Prerequisites: 

Connect your microphone to the computer with SmartPTT Dispatcher installed and ensure that it appears in Windows Device Manager

without errors.

Procedure: 

1. In SmartPTT Dispatcher, on the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.

2. In the window that appears, open the General Settings tab.

3. In the Audio Input area, configure settings of the audio input device:

a. From the Device list, select Microphone (USB PnP Sound Device).
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b. From the Input Line list, select the desired audio mixer line used to connect a microphone.

c. (Optional) From the Noise Reduction list, select the desired level of noise reduction.

4. Check the selected audio input device:

a. Click Record and speak into the device.

The button changes to Stop.

b. Click Stop to stop the recording.

The button changes to Record and other buttons become unlocked.

c. Click Play to listen to the recorded voice.

The button changes to Stop. If the device works properly, you will hear the record.

d. (Optional) To save the recorded voice sample, click Save.

5. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.

6. In the window that appears, open the Keys tab.

7. From the Objects and actions list, select PTT Key.

8. (Optional) To add a new key, click Add key (   ).
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9. Select Input Device (HID).

The list of available USB devices appears next to the Input Devices list.

10. From the list that appears, select FP-1.

11. Under the Input Devices list, click the Assign Hotkey (   ) button.

White dots appear on the button, and the Press desired key message appears next to it.

12. Press the PTT button on the VM-1S USB microphone base.

The Button 1 text is displayed on the Assign Hotkey button, and the Press desired key message disappears.

13. Click Finish to save changes and close the window.

2.7.2 Configuring VCC-3USB Microphone

Follow the procedure to configure the VCC-3 USB microphone.

Prerequisites: 

Connect your microphone to the computer with SmartPTT Dispatcher installed and ensure that it appears in Windows Device Manager

without errors.

Procedure: 

1. In SmartPTT Dispatcher, on the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.
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2. In the window that appears, open the General Settings tab.

3. In the Audio Input area, configure settings of the audio input device:

a. From the Device list, select Microphone (ETC VCC-3).

b. From the Input Line list, select the desired audio mixer line used to connect a microphone.

c. (Optional) From the Noise Reduction list, select the desired level of noise reduction.

4. Check the selected audio input device:

a. Click Record and speak into the device.

The button changes to Stop.

b. Click Stop to stop the recording.

The button changes to Record and other buttons become unlocked.

c. Click Play to listen to the recorded voice.

The button changes to Stop. If the device works properly, you will hear the record.

d. (Optional) To save the recorded voice sample, click Save.

5. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.
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6. In the window that appears, open the Keys tab.

7. From the Objects and actions list, select PTT Key.

8. (Optional) To add a new key, click Add key (   ).

9. Select Keyboard.

10. Under the Input Devices list, click the Assign Hotkey (   ) button.

White dots appear on the button, and the Press desired key message appears next to it.

11. Press the PTT button on the VCC-3 USB microphone base.

The F8 text is displayed on the Assign Hotkey button, and the Press desired key message disappears.

Important

The PTT button of the VCC-3 USB microphone is displayed in the system as the F8 key, therefore when you assign actions to this

button they will also be executed when you press the F8 key on the keyboard.

12. Click Finish to save changes and close the window.
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2.7.3 Configuring D-9 Microphone

Follow the procedure to configure the D-9 microphone by Holmco.

Prerequisites: 

Connect your microphone to the computer with SmartPTT Dispatcher installed and ensure that the microphone appears in Windows

Device Manager without errors.

Procedure: 

1. In SmartPTT Dispatcher, on the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.

2. In the window that appears, open the General Settings tab.

3. In the Audio Input area, configure settings of the audio input device:

a. From the Device list, select Microphone (D9 USB TSS V1.00).

b. From the Input Line list, select the desired audio mixer line used to connect a microphone.

c. (Optional) From the Noise Reduction list, select the desired level of noise reduction.

4. Check the selected audio input device:
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a. Click Record and speak into the microphone.

The button changes to Stop.

b. Click Stop to stop the recording.

The button changes to Record. The Play and Save buttons become unlocked.

c. Click Play to listen to the recorded voice.

The button changes to Stop. If the device works properly, you will hear the record.

d. (Optional) To save the recorded voice sample as a file, click Save.

5. In the Audio Output area, select a device that will play the sound. If you want to use D-9, from the Main device list, select Speakers

(D9 USB TSS V1.00).

6. Check the selected audio output device by clicking the Check button.

The button changes to Stop. If the device works properly, you will hear the sound.

7. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.

8. In the window that appears, open the Keys tab.

9. From the Objects and actions list, select PTT Key.

10. (Optional) To add a new key, click Add key (   ).
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11. Select Input Device (HID).

The list of available USB devices appears to the right of the Input Devices list.

12. From the list that appears, select D9 USB TSS V1.00.

13. Under the Input Devices list, click the Assign Hotkey (   ) button.

The ellipsis symbol appears on the button, and the Press desired key message appears to the right of the button.

14. Press the PTT button on the D-9 microphone base.

The Button 0 text is displayed on the Assign Hotkey button.

15. Click Finish to save changes and close the window.

2.7.4 Configuring PTT13-USB PTX-QD Microphone

Follow the procedure to configure the PTT13-USB PTX-QD microphone by Imtradex.

Prerequisites: 

Connect your microphone to the computer with SmartPTT Dispatcher installed and ensure that the microphone appears in Windows

Device Manager without errors.

Procedure: 

1. In SmartPTT Dispatcher, on the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.
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2. In the window that appears, open the General Settings tab.

3. In the Audio Input area, configure settings of the audio input device:

a. From the Device list, select Microphone (PTT-13-USB, PLX-QD).

b. From the Input Line list, select the desired audio mixer line used to connect a microphone.

c. (Optional) From the Noise Reduction list, select the desired level of noise reduction.

4. Check the selected audio input device:

a. Click Record and speak into the microphone.

The button changes to Stop.

b. Click Stop to stop the recording.

The button changes to Record. The Play and Save buttons become unlocked.

c. Click Play to listen to the recorded voice.

The button changes to Stop. If the input device works properly, you will hear the record playing.

d. (Optional) To save the recorded voice sample as a file, click Save.

5. In the Audio Output area, select a device that will play the sound. If you want to use the PTT13-USB PTX-QD device, from the Main

device list select Speakers (PTT-13-USB, PLX-QD).
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6. Check the selected audio output device by clicking the Check button.

The button changes to Stop. If the device works properly, you will hear the sound.

7. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.

8. In the window that appears, open the Keys tab.

9. From the Objects and actions list, select PTT Key.

10. (Optional) To add a new key, click Add key (   ).

11. Select Input Device (HID).

The list of available USB devices appears to the right of the Input Devices list.

12. From the list that appears, select PTT13-USB, PTX-QD.

13. Under the Input Devices list, click the Assign Hotkey (   ) button.

The ellipsis symbol appears on the button, and the Press desired key message appears to the right of the button.

14. Press the PTT button on the PTT13-USB PTX-QD handle.

The Button 1 text is displayed on the Assign Hotkey button.

15. Click Finish to save changes and close the window.
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2.7.5 Configuring PS12/PS20 USB Microphone

Follow the procedure to configure the PS12 USB or PS20 USB microphone by pei tel.

Prerequisites: 

Connect your microphone to the computer with SmartPTT Dispatcher installed and ensure that the microphone appears in Windows

Device Manager without errors.

Procedure: 

1. In SmartPTT Dispatcher, on the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.

2. In the window that appears, open the General Settings tab.

3. In the Audio Input area, configure settings of the audio input device:

a. From the Device list, select Microphone (PTC USB).

b. From the Input Line list, select the desired audio mixer line used to connect a microphone.

c. (Optional) From the Noise Reduction list, select the desired level of noise reduction.

4. Check the selected audio input device:
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a. Click Record and speak into the microphone.

The button changes to Stop.

b. Click Stop to stop the recording.

The button changes to Record. The Play and Save buttons become unlocked.

c. Click Play to listen to the recorded voice.

The button changes to Stop. If the input device works properly, you will hear the record playing.

d. (Optional) To save the recorded voice sample as a file, click Save.

5. In the Audio Output area, from the Main device list, select a device that will play the sound.

6. Check the selected audio output device by clicking the Check button.

The button changes to Stop. If the device works properly, you will hear the sound.

7. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.

8. In the window that appears, open the Keys tab.

9. From the Objects and actions list, select PTT Key.

10. (Optional) To add a new key, click Add key (   ).
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11. Select Input Device (HID).

The list of available USB devices appears to the right of the Input Devices list.

12. From the list that appears, select PTC USB.

13. Under the Input Devices list, click the Assign Hotkey (   ) button.

The ellipsis symbol appears on the button, and the Press desired key message appears to the right of the button.

14. Press the button on the microphone base.

If you use the PS12 USB microphone, the Button 0 text is displayed on the Assign Hotkey button.

If you use the PS20 USB microphone, one of the following texts is displayed on the Assign Hotkey

button:

• Button 0 if you press the green key.

• Button 1 if you press the black key.

• Button 2 if you press the red key.

15. (Optional) If you need to assign other actions to other PS20 USB microphone hardware keys, select the required action from the

Objects and actions list, and then repeat the procedure starting from step 10.

Important

If you use the PS20 USB microphone, you can assign only one object or one action to one of the three hardware keys.

16. Click Finish to save changes and close the window.

2.7.6 Configuring DM-160 Microphone

Follow the procedure to configure the DM-160 microphone by CXD.

Prerequisites: 

Connect your microphone to the computer with SmartPTT Dispatcher installed and ensure that the microphone appears in Windows

Device Manager without errors.

Procedure: 

1. In SmartPTT Dispatcher, on the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.
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2. In the window that appears, open the General Settings tab.

3. In the Audio Input area, configure settings of the audio input device:

a. From the Device list, select Microphone (4- PDP Audio Device).

b. From the Input Line list, select the desired audio mixer line used to connect a microphone.

c. (Optional) From the Noise Reduction list, select the desired level of noise reduction.

4. Check the selected audio input device:

a. Click Record and speak into the microphone.

The button changes to Stop.

b. Click Stop to stop the recording.

The button changes to Record. The Play and Save buttons become unlocked.

c. Click Play to listen to the recorded voice.

The button changes to Stop. If the input device works properly, you will hear the record playing.

d. (Optional) To save the recorded voice sample as a file, click Save.

5. In the Audio Output area, from the Main device list, select a device that will play the sound.

6. Check the selected audio output device by clicking the Check button.

The button changes to Stop. If the device works properly, you will hear the sound.
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7. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.

8. In the window that appears, open the Keys tab.

9. From the Objects and actions list, select PTT Key.

10. (Optional) To add a new key, click Add key (   ).

11. Select Input Device (HID).

The list of available USB devices appears to the right of the Input Devices list.

12. From the list that appears, select 4- PDP Audio Device.

13. Under the Input Devices list, click the Assign Hotkey (   ) button.

The ellipsis symbol appears on the button, and the Press desired key message appears to the right of the button.

14. Press the PTT button on the DM-160 microphone base.

The Button 0 text is displayed on the Assign Hotkey button.

15. Click Finish to save changes and close the window.



71

SmartPTT Dispatcher Functionality Configuration Supported Devices

2.7.7 Configuring C310-M/C320-M USB Headset

Follow the procedure to configure the C310-M/C320-M USB headset by Plantronics.

Prerequisites: 

Connect your headset to the computer with SmartPTT Dispatcher installed and ensure that the headset appears in Windows Device

Manager without errors.

Procedure: 

1. In SmartPTT Dispatcher, on the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.

2. In the window that appears, open the General Settings tab.

3. In the Audio Input area, configure settings of the audio input device:

a. From the Device list, select Headset Microphone (Plantronics C310-M) or Headset Microphone (Plantronics C320-M)

depending on your model.

b. From the Input Line list, select the desired audio mixer line used to connect a headset.

c. (Optional) From the Noise Reduction list, select the desired level of noise reduction.

4. Check the selected audio input device:
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a. Click Record and speak into the microphone.

The button changes to Stop.

b. Click Stop to stop the recording.

The button changes to Record. The Play and Save buttons become unlocked.

c. Click Play to listen to the recorded voice.

The button changes to Stop. If the input device works properly, you will hear the record playing.

d. (Optional) To save the recorded voice sample as a file, click Save.

5. In the Audio Output area, select a device that will play the sound. If you want to use the C310-M/C320-M USB headset, from the

Main device list, select Headset Earphone (Plantronics C310-M) or Headset Earphone (Plantronics C320-M).

6. Check the selected audio output device by clicking the Check button.

The button changes to Stop. If the device works properly, you will hear the sound.

7. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.

8. In the window that appears, open the Keys tab.

9. From the Objects and actions list, select PTT Key.

10. (Optional) To add a new key, click Add key (   ).
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11. Select Input Device (HID).

The list of available USB devices appears to the right of the Input Devices list.

12. From the list that appears, select Plantronics C310-M or Plantronics C320-M depending on your model.

13. Under the Input Devices list, click the Assign Hotkey (   ) button.

The white dots appear on the button, and the Press desired key message appears to the right of the button.

14. Press the Answer button on the headset inline control.

The Button 0 text is displayed on the Assign Hotkey button.

15. Click Finish to save changes and close the window.

2.7.8 Configuring X-keys XK-3 Foot Switch

Follow the procedure to configure the X-keys XK-3 foot switch by P.I. Engineering to work as a PTT button.

Prerequisites: 

Connect the foot switch to the computer with SmartPTT Dispatcher installed and ensure that it appears without errors in the Human

Interface Devices section of the Windows Device Manager.

Procedure: 

1. In SmartPTT Dispatcher, on the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.

2. In the window that appears, open the Keys tab.
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3. From the Objects and actions list, select PTT Key.

4. (Optional) To add a new key, click Add key (   ).

5. Select Input Device (HID).

The list of available USB devices appears to the right of the Input Devices list.

6. From the list that appears, select XK-3 Switch Interface Thumb.

7. Under the Input Devices list, click the Assign Hotkey (   ) button.

The ellipsis symbol appears on the button, and the Press desired key message appears to the right of the button.

8. Press the X-keys XK-3 foot switch.

The Button 0 text is displayed on the Assign Hotkey button.

9. Click Finish to save changes and close the window.
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2.7.9 Tipro Console

SmartPTT Dispatcher supports the Tipro modular console. The hardware buttons located on different modules of the Tipro console can

be programmed and assigned to objects and actions in SmartPTT Dispatcher.

The Tipro modular console can consist of the following modules:

• Touchcomputer module

• Speakerbox module (equipped with programmable buttons)

• Handset module (equipped with 2 programmable buttons)

• Keyboard module with dial pad (equipped with programmable buttons)

Due to this modularity, the Tipro console switches audio output between the speakerbox and the handset. The handset is activated when

it is lifted from the base and the speakerbox is activated when the handset is placed on the base.

The hardware buttons located on different modules of the Tipro console can be programmed and assigned to objects and actions in

SmartPTT Dispatcher. It optimizes the dispatcher's workstation and the response time to various events.

In SmartPTT Dispatcher, a dispatcher can assign actions to the programmable buttons of the speakerbox module (increase or decrease

the sound level, mute or unmute the microphone, enable the hands-free module, switch between the audio bargraph modes), as well as

assign actions to 2 programmable buttons of the handset module and to the programmable buttons of the keyboard module with dial

pad.

Important

Currently, only the Tipro TM-HHA-6AW console with analog interface has been tested with SmartPTT. For more information on this

model, see the documentation on the Tipro website. Other models are connected and programmed in a similar way. The number of

programmable buttons may vary depending on the Tipro model.

Preparing to Tipro Configuration in SmartPTT

Before you start configuring the Tipro console in SmartPTT Dispatcher, you must perform the following actions:

• For Tipro modular console without touchcomputer, connect the Tipro console to the PC with SmartPTT Dispatcher installed.

• Install additional applications: ChangeMe Utility, Tipro OPOS (these are delivered together with the Tipro console), Microsoft

Point of Service for .NET v1.14 (POS for .NET).

• Contact SmartPTT Technical Support Center for obtaining the Tipro configuration file.

Configuring Tipro in SmartPTT

To configure the Tipro console, perform the following actions:

• Upload the SmartPttTiproConfig file onto the Tipro console.

• Update the Tipro console settings in the ChangeMe Utility application according to the config file and program the desired buttons.

• Install SmartPTT Dispatcher on the Tipro console (for a Tipro console with a BeFREE touchcomputer) or install SmartPTT

Dispatcher on the computer (for a Tipro console without a touchcomputer).

• In SmartPTT Dispatcher, configure the general sound settings for the Tipro console. For details, see Configuring Tipro in

SmartPTT Dispatcher.

• Assign hotkeys. For details, see Configuring Tipro in SmartPTT Dispatcher.

SmartPTT Dispatcher provides a dispatcher with the ability to assign all actions listed on the Keys tab of the Control Devices

window to the programmable buttons on the Tipro console.

http://www.tipro.net/shared_files/support/technical_documentation/technical_overview/handset_to_8_2.pdf
https://www.microsoft.com/en-us/download/details.aspx?id=42081
https://www.microsoft.com/en-us/download/details.aspx?id=42081
http://support.smartptt.com/
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Tipro Buttons Programming in SmartPTT

SmartPTT Dispatcher provides the ability to assign hotkeys to radio objects and actions. The Tipro console is one of the devices that

support hotkey assignment. When assigning hotkeys, the Tipro console can be treated as a HID input device or as a keyboard.

Before assigning hotkeys to objects and actions in SmartPTT Dispatcher, you must configure the Tipro console programmable buttons

using the ChangeMe Utility application.

Important

ChangeMe Utility provides the ability to configure only a limited number of hardware buttons as HID buttons.

In ChangeMe Utility, you can program as HID buttons 15 buttons of the keyboard module, dial pad (12 telephone buttons), as well as 2 HID

commands, they are Hook switch and Microphone mute.

Important

If you want to use the dial pad for dialing, its buttons must be programmed as keyboard keys, not HID buttons.

The two buttons on the handset module can also be programmed as HID buttons. One button is located on the handset itself, and the

second one is triggered when you pick up the handset.

The speakerbox module is equipped with 6 buttons that can be programmed as HID buttons. However, these buttons are preset with

default actions, so they do not need to be programmed as HID buttons.

2.7.9.1 Configuring Tipro without Touchscreen in ChangeMe Utility

Follow the procedure to configure the Tipro console in the ChangeMe Utility application.

NOTE

If you have any questions about the application, you can open the ChangeMe Utility embedded help from the Help menu at the top of

the application or in the button settings window.

Prerequisites: 

Obtain the Tipro configuration file from SmartPTT Technical Support Center.

Procedure: 

1. Run the ChangeMe Utility application.

http://support.smartptt.com/
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2. In the left part of the application, open the configuration file by clicking the Open button.

3. In the left part of the application, click the Update button to update the Tipro console settings according to the configuration file.

4. At the top of the application, click the image of the desired module to program its buttons.

The settings window of the desired module appears.

5. In the window that appears, configure the buttons of the desired module:

To program buttons as HID buttons, perform the following actions:

1. Click the * icon located on the desired button.

The button settings window appears.

2. In the window that appears, in the Layer 1 field, right click,

and then select HID Telephony Module3 (SBX)

→Programmable button→<number of the button>.

The button's HID identifier appears in the Layer 1 field.

3. Click OK to apply changes and close the window.

To program buttons as HID commands Hook switch

(switching between speakers) or Microphone mute

(switching off the microphone sound),

perform the following actions:
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1. Click the * icon located on the desired button.

The button settings window appears.

2. In the window that appears, in the Layer 1 field, right click,

and then select HID Telephony Module3 (SBX)→Hook switch

or HID Telephony Module3 (SBX)→Microphone mute.

The button's HID identifier appears in the Layer 1 field.

3. Click OK to apply changes and close the window.

To program the dial pad buttons located on the keyboard

module as HID buttons,

perform the following actions:

1. Click the * icon located on the desired button.

The button settings window appears.

2. In the window that appears, in the Layer 1 field, right click,

and then select HID Telephony Module3 (SBX)→Phone

keys→<number of the button>.

The button's HID identifier appears in the Layer 1 field.

NOTE

Dial pad button 1 is not the same as HID phone key 1.

3. Click OK to apply changes and close the window.

To program the dial pad buttons located on the keyboard

module as keyboard keys,

NOTE

Do this if you want to use the dial pad to dial

telephone numbers.

perform the following actions:
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1. Click the * icon located on the desired button.

The button settings window appears.

2. In the window that appears, click the Layer 1 field, and then

press the desired dial pad button on the keyboard module.

The button's identifier appears in the Layer 1 field.

3. Click OK to apply changes and close the window.

To program preconfigured functions of the buttons of

the speakerbox module,

perform the following actions:

1. In the settings window of the speakerbox module, click

Keys functionality.

The Keys functionality window appears.

2. In the window that appears, configure the buttons you want

to use:

a. For buttons 1 and 2, select the check box to use them

to control handset and headset volume.

b. For buttons 3 and 4, choose between using button 3 to

toggle audio bargraph display and using both buttons

to control speakerbox volume.

c. For button 5, select the check box to use it to toggle

hands-free mode.
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d. For button 6, select the check box to use it to toggle

muting or unmuting the microphone.

3. Click OK to apply changes and close the window.

6. Click the Update and verify button in the left part of the application to update and confirm the changes in the Tipro configuration.

7. Close ChangeMe Utility.

2.7.9.2 Configuring Tipro with Touchscreen in ChangeMe Utility

Follow the procedure to configure the Tipro console in the ChangeMe Utility application.

NOTE

If you have any questions about the application, you can open the ChangeMe Utility embedded help from the Help menu at the top of

the application or in the key settings window.

Prerequisites: 

Obtain the Tipro configuration file from SmartPTT Technical Support Center.

Procedure: 

1. Run the ChangeMe Utility application.

2. In the left part of the application, open the configuration file by clicking the Open button.

3. In the left part of the application, click the Update button to update the Tipro console settings according to the configuration file.

4. At the top part of the application, click Tools > TTY Terminal.

5. In the window that appears, select the COM port connecting the keyboard module to the touchcomputer module, and then click

OK.

http://support.smartptt.com/
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6. Check whether the COM port is selected correctly. To check, type something using the keyboard with the dial pad. If symbols

appear, the COM port is selected correctly. If no symbols appear, select another COM port.

7. Close ChangeMe Utility.

2.7.9.3 Configuring Tipro in SmartPTT Dispatcher

Follow the procedure to configure the Tipro console in SmartPTT Dispatcher.

Important

Currently, SmartPTT Dispatcher supports only the Tipro TM-HHA-6AW console with analog interface.

Prerequisites: 

Configure the programmable buttons as HID buttons using the ChangeMe Utility application.

ChangeMe Utility allows to configure only a limited number of hardware buttons as HID buttons.

Procedure: 

1. Install and run SmartPTT Dispatcher.

2. To configure sound for the Tipro console, perform the following actions:

a. On the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.
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b. In the window that appears, open the General Settings tab.

c. In the Audio Input area, configure settings of the Tipro console:

i. From the Device list, select the Tipro console microphone.

ii. Click Record and speak into the speakerbox module microphone, to check audio input. Pick up the phone on the handset

module and speak into the receiver.

The button changes to Stop.

iii. Click Stop to stop the recording.

The button changes to Record and other buttons become unlocked.

iv. Click Play to listen to the recorded voice.

The button changes to Stop, and you will hear the voice if the Tipro console microphone works properly.

v. (Optional) To save the recorded voice sample, click Save.

d. In the Audio Output area, configure settings of the Tipro console:

i. From the Main device list, select the Tipro console speakerbox.

ii. Click Check to check the Tirpo console.

The button changes to Stop, and you will hear the sound if the Tipro console speakerbox works properly.

iii. Click Stop to stop the Tipro console speakerbox check.



83

SmartPTT Dispatcher Functionality Configuration Supported Devices

e. Click Finish to save changes and close the window

Important

The TIPRO phone module: switching audio input and audio output when answer a call check box must always be cleared.

3. To configure hotkeys, on the Keys tab, perform the following actions:

a. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.

b. In the windows that appears, open the Keys tab.

c. In the Objects and actions area, select a radio object or an action for which it is required to assign a hotkey on the Tipro

console:

To assign a hotkey for an action, in the Objects and actions area, click the desired action.

In the Keys area, the Add key (   ) button appears.

To assign a hotkey for an action which is related to the

specific object (radio, channel, talkgroup, category,

telephone subscriber, or dispatcher),

in the Objects and actions area, expand the desired node, and

then click the desired object.

In the Keys area, the Add key (   ) button appears.

d. Click Add key (   ).

Controls for the hotkey configuration appear in the Keys area.
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e. From the Input Devices list, select the desired device:

To assign objects and actions to Tipro buttons programmed

as HID buttons,

select Input Device (HID), and then, from the list that appears

next to it, select the Tipro console.

To assign objects and actions to Tipro buttons programmed

as keyboard keys,

select Keyboard.

f. Under the Input Devices list, click the Assign Hotkey (   ) button.

White dots appear on the button, and the Press desired key message appears next to it.

g. On the Tipro console, press the desired button for an object or an action.

The button's HID identifier will be displayed on the Assign Hotkey button, and the Press desired key message disappears.

NOTE

You cannot assign two or more actions or objects to the same button.

h. Click Finish to save changes and close the window.

Postrequisites: 

• To delete the hotkey, in the Objects and actions area, select the desired object or action by expanding the desired node, and then,

to the right of the desired assigned hotkey, click Delete (   ).

• To delete all assigned hotkeys, click Reset All.

2.8 Operators

SmartPTT Dispatcher provides two types of roles for its users: Administrator and operator. The role determines the rights granted to the

user of the application.

Administrator Role

The Administrator account has unlimited access to all functionality of the system, including the possibility to add new administrator and

operator accounts and provide operators with access to the specific functionality of SmartPTT Dispatcher. For example, most of the

functionality in the Settings (   ) menu is available only to administrators.

The first Administrator account is created by default when you start SmartPTT for the first time. It cannot be deleted. The Administrator

role can be assigned to any operator account created by the first administrator.

Upon configuring SmartPTT Dispatcher for the first time after installing the SmartPTT software, you must set a password for the

Administrator account. For details, see Configuring SmartPTT Dispatcher at First Start.

Operator Role

An operator account is limited by functionality that the Administrator determined. The number of operator accounts in SmartPTT

Dispatcher is unlimited.

For an operator account, two types of status are available:

• The Active status is applied for operator accounts that are used currently.

• The Archive status is used for operator accounts which are not used any longer, but cannot be removed from the system as the

Event Log contains entries referring to them.
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The following operator rights can be limited by the Administrator in SmartPTT Dispatcher:

Right Description

Edit radio lists

Allows/denies adding, editing, or deleting radios on the Radio Fleet panel and in the Radios

window.

Manage unregistered radios Shows/hides radios which were not added to SmartPTT Dispatcher.

Make voice calls Allows/denies initiating voice calls (except conference calls).

Connect with external dispatchers Allows/denies communicating with other SmartPTT dispatchers.

Make telephone calls Allows/denies communicating with telephone subscribers.

Change channel on control station Allows/denies selecting control station channels.

Block/Unblock radios Allows/denies using Block Radio and Unblock Radio commands.

Remote monitor Allows/denies using the Remote Monitor command (turning on the microphone on the radio).

Reboot control station Allows/denies rebooting (restarting) control stations.

Manage radio location settings Allow/denies configuring settings of radio location update.

Request radio location

Allows/denies performing the following actions related to the radio location:

• Set Location (   )

• Find on Map (   )

• Show Address (   )

• Remove from Map (   )

• Find on Indoor Map (   )

Send text messages Allows/denies sending text messages to radios, talkgroups, and radio categories.

Send telemetry commands

Allows/denies sending telemetry commands.

NOTE

The right does not affect the data acquisition module.

Manage bridging settings Allows/denies configuring bridging service for SmartPTT Radioserver.

Manage routes Allows/denies managing routes on a map and building plan.

Manage geofences Allows/denies managing geofences on a map and building plan.

Manage points of interest Allows/denies managing points of interest on a map.

Manage cameras Allows/denies managing camera markers on a map.

Manage tracks Allows/denies displaying tracks and the radio movement along the track on a map.
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Right Description

View coverage map Allows/denies working with a coverage map.

Build reports Allows/denies building reports.

Edit custom radio properties Allows/denies managing parameters on the Others tab of the Radio Properties window.

Make conference calls Allows/denies initiating conference calls.

View radioserver event log Allows/denies showing the SmartPTT Radioserver Event Log.

Create deferred actions Allows/denies creating deferred actions for radios.

Manage statuses Allows/denies managing radio statuses.

Manage custom rules Allows/denies managing custom rules.

Manage positioning rules Allows/denies managing positioning rules.

Manage lone worker rules Allows/denies managing Lone Worker profiles.

Assigning Client Accounts to Operators

You can limit the functionality available in SmartPTT Dispatcher using client accounts.

If desktop client authentication on SmartPTT Radioserver is enabled, you must specify the credentials of the client account to connect

an operator's account to SmartPTT Radioserver. This allows the radioserver to send to operators in SmartPTT Dispatcher only

information that is permitted for the client account. If the client’s name and password are not set for an operator, this operator will not

be able to connect to the radioserver.

If no client account is assigned, an operator can manage all radios, talkgroups, and services provided by the radioserver.

For information on clients and their authentication, see “Client Connections” in SmartPTT Installation and Configuration Guide.

Important

The same client account can be used for different operator accounts.

Important

The functionality available in SmartPTT Dispatcher can also be limited by licenses. For details, see Licenses.

Windows Authentication

For the Administrator and operator accounts, configuring of automatic authorization for the current Windows account is available.

Windows authentication is activated in the SmartPTT Dispatcher general settings. For details, see Configuring SmartPTT Dispatcher

General Settings.

To use Windows authentication, the operator account name must match the name of a Windows user or the group to which the user

belongs.

NOTE

Starting from Windows 8, users can be authorized if they are members of either domain or local user groups.
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NOTE

To access the SmartPTT Dispatcher Authorization window when Windows authentication is enabled, start the program using a

Windows user account whose name or the name of the group to which the user belongs does not match the name of the existing

SmartPTT Dispatcher operator account.

Operators Configuration

SmartPTT Dispatcher provides the ability to perform the following operator-related actions:

• Add, edit or delete operator accounts. For details, see Managing Operator Accounts.

• Assign a client account to an operator if authentication of desktop clients is enabled on SmartPTT Radioserver. For details, see

Managing Radioservers.

• Log over SmartPTT Dispatcher using other operator credentials. For details, see Changing Operator.

2.8.1 Managing Operator Accounts

Follow the procedure to add a new operator, edit or delete an existing operator account.

Prerequisites: 

Ensure that you are logged in as the operator with the Administrator status.

Procedure: 

1. On the menu bar, click Settings (   ) → Operators.

The Operators window appears.

2. In the window that appears, perform one of the following actions:

To add a new operator, click Add (   ).

The Operator window appears.

To edit an existing operator account, select the desired account, and then click Edit (   ).

The Operator window appears.

To delete an operator account, perform the following actions:

1. Select the desired account.

2. Click Delete (   ).
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NOTE

An operator account cannot be deleted if the Event Log has

entries associated with it.

For information on the Event Log, see Event Log and

Notification Panels.

3. In the Delete Record window, click OK.

4. Proceed to the last step of the procedure.

3. In the Operator window, in the Name field, type the desired operator name.

If Windows authentication is activated, the account name must match the name of a Windows user or group.

Important

If using Windows authentication, the name of the Windows user or group must not match the operator account name with the

Administrator status not to lose access to the Administrator account.
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4. To set or change an account password, perform the following actions:

a. Click Set/Change Password.

The <Operator name>: Enter/Change Password window appears.

b. In the window that appears, in the Password field, type the desired password using 8 or more characters from at least three

categories: uppercase and lowercase letters (A–Z, a–z), numbers (0–9), and special characters (!, $, #, %, etc.). To view the

entered password, click the eye icon (   ).

SmartPTT does not support entering a password using the Input Method Editor (IME).

c. In the Confirmation field, type the desired password again.

d. Click OK to save the changes and close the window.

5. From the Role list, select the desired operator role: Operator or Administrator.

6. From the Status list, select the desired status:

To make an account available for authorization, select Active.

To make an account not available for authorization, select Archive.

7. (Optional) For an operator account, isn the Rights area, select the desired check boxes for assigning rights to an operator. For

details, see Operators.

8. Click OK to apply changes and close the window.

9. In the Operators window, click Finish.

2.8.2 Changing Operator

Follow the procedure to log in to SmartPTT Dispatcher using other operator credentials.

Procedure: 

1. On the menu bar, click Change Operator (   ).

The user logs off from SmartPTT Dispatcher, and the Authorization window appears.

2. In the window that appears, from the Operator list, select the desired operator account.
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3. In the Password field, type the operator's password. To view the entered password, click the eye icon (  ).

SmartPTT does not support entering a password using the Input Method Editor (IME).

4. Click OK to log in SmartPTT Dispatcher and get started.

2.9 Radios Configuration

Added radios are stored in the SmartPTT Dispatcher database providing the operator the ability to manage radios when they are offline.

Unregistered radios are not displayed in SmartPTT Dispatcher when they are offline. An operator can perform the same actions with

unregistered radios as with registered ones, but can not add them to categories and select as a condition for triggering a positioning

rule.

Important

Managing radios that are not saved in SmartPTT Dispatcher is available only to the Administrator and operators with the Manage

unregistered radios right. For operators who are not granted this permission, SmartPTT Dispatcher does not display unregistered

radios, but provides the ability to monitor voice calls involving them.

For information on operator rights, see Operators.

NOTE

Radios with the ID in the MDC-1200 or 5 Tone format always appear offline because they do not provide registration information.

For radio configuration, the following actions are available:

• Adding radios in SmartPTT Dispatcher. For details, see Adding Radios.

• Radio settings configuration. For details, see Radio Configuration.

• Configuration of radio display on the Radios panel. For details, see Configuring Radios Panel.

For detailed information on radios as SmartPTT system objects, radio management, and radio list export/import, see Radios.

Radio List Export and Import

The current list of radios can be exported for further configuration of other SmartPTT Dispatcher instances, adding new radios, and

updating their properties. Radio lists can also be used for generating reports.

For information on radio list export and import, see Radio List Export and Import.

2.9.1 Adding Radios

To add radios to SmartPTT Dispatcher manually, you can perform the following actions:

• Add a new radio using the Radio Fleet panel. For details, see Adding Radios on Radio Fleet Panel.

• Add one radio to the SmartPTT Dispatcher list of radios. For details, see Adding Single Radio to List of Radios.

• Add multiple radios to the SmartPTT Dispatcher list of radios. For details, see Adding Multiple Radios to List of Radios.

Important

Adding radios is available only to the Administrator and operators with the Edit radio lists right. For details, see Operators.
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2.9.1.1 Adding Radios on Radio Fleet Panel

Follow the procedure to add a new radio to the dispatch system manually using the Radio Fleet panel.

Prerequisites: 

Ensure the operator has the Edit radio lists right. For details, see Operators.

Procedure: 

1. If the Radio Fleet panel is closed, on the menu bar, click Tools → Radio Fleet.

2. On the Radio Fleet panel, click Add radio (   ).

The Radio Properties window appears.

3. In the window that appears, open the Common tab.

4. In the upper-left corner of the tab, click the underlined Radio ID.

The Radio ID type window appears.
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5. In the window that appears, select the desired ID format:

To add a DMR radio, select Radio ID.

To add a SmartPTT Mobile user, select SmartPTT ID.

To add an MDC radio, select MDC ID.

To add a 5 Tone radio, select 5 Tone ID.

6. Click OK to close the Radio ID type window.

7. In the field next to the selected ID format, type the desired radio ID.

8. Configure the general radio parameters. For details, see Configuring General Radio Parameters.

9. Configure the radio outdoor and indoor location settings. For details, see Configuring Radio GPS Settings and Configuring Indoor

Radio Tracking.

10. Configure the custom radio properties. For details, see Configuring Custom Radio Properties.

Postrequisites: 

To delete the radio, on the Radio Fleet panel, select the desired radio, click Delete radio (   ), and then, in the confirmation window, click

OK.
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2.9.1.2 Adding Single Radio to List of Radios

Follow the procedure to add a single radio to the SmartPTT Dispatcher list of radios.

Prerequisites: 

Ensure the operator has the Edit radio lists right. For details, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → List of Radios.

The Radios window appears.

2. In the left part of the window, click Add (   ).

The new radio properties appear in the Properties area on the right.

3. In the Properties area, under the Common heading, specify the radio ID. For details, see Adding Radios on Radio Fleet Panel.

4. In the Properties area, under the Common heading, specify the other radio parameters. For details, see Configuring General Radio

Parameters.

5. (Optional) Under the Location heading, specify the radio location parameters. For details, see Configuring Radio GPS Settings and

Configuring Indoor Radio Tracking.

6. Click Save.

The added radio appears in the Radios list.
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Postrequisites: 

• To edit properties of a radio, see Managing List of Radios.

• To delete a radio, see Managing List of Radios.

2.9.1.3 Adding Multiple Radios to List of Radios

Follow the procedure to add multiple radios to the SmartPTT Dispatcher list of radios.

Prerequisites: 

Ensure the operator has the Edit radio lists right. For details, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → List of Radios.

The Radios window appears.

2. In the left part of the window, click Multiple Adding (   ).

Common radio properties appear in the Properties area on the right.

3. In the Properties area, in the Radio ID field, specify the added radio IDs using hyphens and/or commas. For example, 1-99, 150.
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NOTE

The Multiple Adding mode is available only for the Radio ID input format. SmartPTT Mobile users and radios that use analog signaling

(MDC-1200 or 5 Tone) must be added individually. For details, see Adding Single Radio to List of Radios.

4. In the Properties area, under the Common heading, specify the desired properties of the added radios. For details, see Configuring

General Radio Parameters.

5. (Optional) Under the Location heading, specify the desired location properties of the added radios. For details, see Configuring

Radio GPS Settings and Configuring Indoor Radio Tracking.

6. Click Save.

The added radios appear in the Radios list.

Postrequisites: 

• To edit properties of multiple radios, see Managing List of Radios.

• To delete multiple radios, see Managing List of Radios.

2.9.2 Radio Configuration

To configure radio parameters in SmartPTT Dispatcher, you can perform the following actions:

• Configure general radio settings:

• Give a name

• Customize an avatar and icon

• Select a status

• Assign a Lone Worker profile

• Assign telemetry actions

For details, see Configuring General Radio Parameters.

• Configure radio outdoor and indoor location settings. For details, see Configuring Radio GPS Settings and Configuring Indoor

Radio Tracking.

• Edit properties or delete radios using the list of radios. For details, see Managing List of Radios.

• Configure custom radio properties. For details, see Custom Radio Properties.

• Configure radio statuses. For details, see Statuses.

• Configure categories of radios and talkgroups. For details, see Categories.

2.9.2.1 Configuring General Radio Parameters

Follow the procedure to configure or edit the general radio settings.

Prerequisites: 

• (Optional) Add the radio status. For details, see Managing Statuses.

• (Optional) Add the Lone Worker profile. For details, see Managing Lone Worker Profiles.

• (Optional) Add a custom radio icon.
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Procedure: 

1. Open the Radio Properties window.

2. In the Radio Properties window, open the Common tab.

3. In the Name field, type the radio name.

4. (Optional) Perform the desired actions:

To assign a status to the radio, from the Status list, select the desired status.

To configure the radio user avatar, perform the following actions:

1. Click Select.

2. In the window that appears, select the desired image file

and click Open.

To delete the selected radio avatar and set the default

avatar image,

click Delete the current radio image (   ).

To set the radio icon, perform the following actions:

1. Under the Select button, click the current radio icon.

2. From the list that appears, select the desired image.

5. (Optional) For a DMR radio, perform one of the following actions:

To assign a Lone Worker profile to the radio, perform the following actions:

1. Select the Lone Worker check box.

2. From the list below, select the desired profile.

To assign telemetry actions to the radio, see Assigning Telemetry to Radios.
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6. In the Radio Properties window, click Save.

2.9.2.2 Managing List of Radios

Follow the procedure to edit properties or delete one or multiple radios.

Prerequisites: 

Ensure the operator has the Edit radio lists right. For details, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → List of Radios.

The Radios window appears.

2. In the Radios window, perform one of the following actions:

To edit properties of a single radio, perform the following actions:

1. In the left part of the window, in the Radios area, select the

desired radio.

The properties of the selected radio appear in the Properties

area on the right.
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2. In the Properties area, edit the desired properties, and then

click Save.

To edit properties of multiple radios, perform the following actions:

1. In the left part of the window, in the Radios area, select the

desired radios in one of the following ways:

• Press and hold Ctrl, and then click the desired radios.

• Press and hold Shift, and then click the first and the last

radio in the desired part of the list.

Radio properties common to all of the added radios appear

in the Properties area on the right.

2. In the Properties area, edit the desired radio properties, and

then click Save.

NOTE

If property values differ among the selected radios, the value in

the corresponding field is cleared.

The check boxes of such properties are filled with solid gray ( 

 ).

By changing a common property value, you will change it for

each of the selected radios.

To delete a single radio, perform the following actions:

1. In the left part of the window, in the Radios area, select the

desired radio, and then click Delete (   ).

2. In the Confirmation window, click OK.

The radio is deleted from the Radios area.

To delete multiple radios, perform the following actions:

1. In the left part of the window, in the Radios area, select the

desired radios in one of the following ways:

• Press and hold Ctrl, and then click the desired radios.

• Press and hold Shift, and then click the first and the last

radio in the desired part of the list.

2. Click Delete (   ), and then, in the Confirmation window, click

OK.

The selected radios are deleted from the Radios area.
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2.9.2.3 Custom Radio Properties

SmartPTT Dispatcher provides the ability to create custom properties for providing additional information on a radio user. Custom

properties are available for configuration on the Other tab of the Radio Properties window.

Important

Creating custom radio properties is available only to the Administrator.

Configuring custom properties for radios is available only to the Administrator and operators with the Edit custom radio properties

right.

For information on operator rights, see Operators.

When creating, it is possible to specify a property type that defines the data input format in the Radio Properties window:

• The Text type provides data input in the text format.

• The Numeric type provides data input in the numeric format.

• The Date type provides data input in the date format.

• The List type provides the ability to select a value from a preconfigured list.

Custom Radio Properties Configuration

To configure custom radio properties, the following actions must be performed:

• (Optional) To create properties of the List type, the desired lists must be configured. For details, see Managing Lists.

• Property groups must be created and the desired properties must be added to the groups. For details, see Managing Custom Radio

Properties.

• Custom properties must be configured for the desired radios in the Radio Properties window. For details, see Configuring Custom

Radio Properties.
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2.9.2.3.1 Managing Lists

Follow the procedure to create, edit, or delete a list that is used for custom property configuration.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → Custom Radio Properties.

The Custom Radio Properties window appears.

2. In the window that appears, click Create/Edit Lists (   ).

The Lists window appears.

3. At the top of the window that appears, perform one of the following actions:

To add a new list, click Add new list (   ).

To change elements of an existing list, perform the following actions:

1. Select the desired list.

2. Proceed to step 4.

To change a list name, perform the following actions:

1. Double-click the desired list name, and then type a new

name.
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2. Proceed to step 5.

To delete a list, perform the following actions:

1. Select the desired list.

2. Click Delete selected list (   ).

3. Proceed to step 5.

4. At the bottom of the window, perform one of the following actions:

To add a new element to the list, click Add list element (   ).

A new element appears in the List Elements table.

To change an element name, in the List Elements table, double-click the desired element

name, and then type a new name.

To delete an element from the list, in the List Elements table, select the desired element, and

then click Delete selected element (   ).

5. Click OK to confirm changes and close the window.

Postrequisites: 

Create a custom radio property of the List type. For details, see Managing Custom Radio Properties.
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2.9.2.3.2 Managing Custom Radio Properties

Follow the procedure to create, edit, or delete custom radio properties.

Prerequisites: 

To create a property of the List type, add the desired list in the Lists window. For details, see Managing Lists.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → Custom Radio Properties.

The Custom Radio Properties window appears.

2. At the top of the window that appears, perform one of the following actions:

To add a new property group, click Add new property group (   ).

To change properties of an existing group, perform the following actions:

1. From the Property Group List, select the desired group.

2. Proceed to step 3.

To change a property group name, perform the following actions:
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1. In the Property Group List, double-click the desired group

name, and then type a new name.

2. Proceed to step 9.

To delete a property group, perform the following actions:

1. From the Property Group List, select the desired property

group.

2. Click Delete selected property group (   ).

3. Proceed to step 9.

3. At the bottom of the window, perform one of the following actions:

To add a new property to the group, click Add new property to selected group (   ).

The Radio Property window appears.

To change parameters of an existing property,  perform the following actions:

1. In the Group Properties Table, select the desired property,

and then perform the following actions:

a. In the Property name column, click the property name,

and then type a new name.

b. In the Description column, click the property

description, and then type a new description.

c. In the Active column, select or clear the check box to

display or hide the property in the Radio Properties

window.

NOTE

The property type cannot be changed after creation.

2. Proceed to step 9.

To delete a property, perform the following actions:

1. In the Group Properties Table, select the desired property.

2. Click Delete selected property (   ).

3. Proceed to step 9.

4. In the Radio Property window, in the Name field, type the property name.
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5. From the Type list, select the property type that defines an input format on the Other tab of the Radio Properties window:

To use text format, select Text.

To use numeric format, select Numeric.

To use date format, select Date.

To select values from a preconfigured list, perform the following actions:

1. Select List.

2. From the List list, select the desired preconfigured list.

6. (Optional) In the Property Description field, type additional information about the property.

7. (Optional) Select the Active check box to display the property in the Radio Properties window.

8. Click OK to confirm changes and close the Radio Property window.

The property appears in the Group Properties Table.

9. Click Finish to close the Custom Radio Properties window.

Postrequisites: 

Configure custom properties for the desired radio on the Other tab of the Radio Properties window. For details, see Configuring Custom

Radio Properties.

2.9.2.3.3 Configuring Custom Radio Properties

Follow the procedure to configure the custom properties for a radio.

Prerequisites: 

• Ensure the additional properties of a radio are created and activated in the Custom Radio Properties window. For details, see

Managing Custom Radio Properties.

• Ensure the operator has the Edit custom radio properties right. For details, see Operators.

Procedure: 

1. Open the Radio Properties window.

2. In the Radio Properties window, open the Other tab.
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3. To the left of the desired property group name, click Expand (   ).

The list of properties appears.

4. For each of the desired properties, perform the following actions:

a. (Optional) To view a property description, click the desired property entry.

If the property has a description, it appears at the bottom of the Other tab.

b. In the right column, configure the desired properties:

To configure a property with a text or numeric value, in the corresponding field, type the desired value.

To configure a date property, in the corresponding field, click Calendar (   ), and then

select the desired date.

To configure a list property, from the corresponding list, select the desired value.

5. Repeat step 3, and then step 4 for the remaining property groups.

6. In the Radio Properties window, click Save.
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2.9.2.4 Statuses

Statuses provide the ability to specify current condition of radios. These statuses are not related to the ones set in radio codeplugs.

Important

Configuring statuses is available only to the Administrator and operators with the Manage statuses right. For details, see Operators.

The configured status is assigned to the radio in one of the following ways:

• Manually by the dispatcher in the Radio Properties window.

• Automatically when a radio sends a specific message to the dispatcher or to any other recipient.

The dispatcher can set a sound notification for automatic status assignment initiated by the radio.

• Automatically when a rule triggers the corresponding dispatcher alert.

Statuses are displayed:

• On the Radio Fleet panel to track and assign statuses, as well as filter radios by their statuses.

• On the Radios panel to filter radios by their statuses.

• On the map panel to track current radio statuses (a frame of the status color around radio icon).

• In the radio Call Window to view the current radio status. For details, see Call Windows.

Archived Statuses

If the status is currently assigned or was assigned to a radio, it cannot be deleted. You can move it to the archive, and, if needed, restore

the archived status later.

Archived statuses cannot be assigned to radios and cannot be used when configuring alerts for dispatchers in rules. However, the

statuses remain valid for rules in which they were configured before moving to the archive.

Archived statuses are also displayed in the Event Log.

Status Configuration and Use

To use a status, perform the following actions:

• Create and configure the desired status. For details, see Managing Statuses.

• Perform the desired actions:

• Assign the status to the desired radio. For details, see Configuring General Radio Parameters.

• Assign the status to radios of the desired category. For details, see Managing Categories.

• Set the status as the value of the Status condition for triggering the desired custom rule. For details, see Managing Custom

Rules and Positioning Rules.

• Configure status assignment as a dispatcher alert performed when the desired rule triggers. For details, see Configuring

Dispatcher Alerts.

• Filter radios on the Radio Fleet panel by status. For details, see Working with Objects Table.

• Filter radios on the Radios panel by status. For details, see Filtering Radios.
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2.9.2.4.1 Managing Statuses

Follow the procedure to add, edit, delete, or restore radio statuses.

Prerequisites: 

Ensure the operator has the Manage statuses right. For details, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → Statuses.

The Statuses window appears.

2. In the window that appears, perform one of the following actions:

To add a status, click Add (   ).

The Radio Status window appears.

To edit an existing status, select the desired status, and then click Edit (   ).

The Radio Status window appears.

To delete an existing status, perform the following actions:

1. Select the desired status, and then click Delete (   ).
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NOTE

If the status is currently assigned or was assigned to a radio, it cannot be deleted.

You can move it to the archive.

2. In the Confirmation window, click ОК.

3. Proceed to step 5.

To restore an archived status, perform the following actions:

1. Open the Archive tab.

2. Select the desired status, and then click Restore (   ).

3. In the Confirmation window, click ОК.

4. Proceed to step 5.

3. In the Radio Status window, in the Name field, type the status name.

4. Perform the desired actions:

To set a color for the status, from the expandable Color palette, select the desired color.

To configure automatic status assignment initiated by

the radio,

perform the following actions:

1. In the Text message for automatic status change field, type

the desired text of the message that initiates status

assignment when sent by the radio.

NOTE

Text messages cannot be the same for different statuses.

2. (Optional) Set a sound notification which will be played when

the status is automatically assigned to a radio:

a. Select the Play Sound check box.

b. Click Select Sound File (   ).

The Sound File Selection window appears.

c. In the window that appears, select the desired audio file

and click Open.
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5. In the Radio Status window, click OK.

6. In the Statuses window, click Finish.

2.9.2.5 Categories

SmartPTT Dispatcher provides the ability to use categories for grouping radios and talkgroups.

Categories can include the following objects:

• Radios registered in SmartPTT Dispatcher

• Talkgroups

• Dynamic groups

• Other categories (subcategories)

Important

Creating categories is available only to the Administrator.

Operators can edit the created category by clicking View Properties (   ) in the category Actions menu. Editing GPS parameters of

radios in the category is available only to operators with the Manage radio location settings right.

For information on operator rights, see Operators.

Categories are displayed on the following panels:

• On the Radio Fleet panel to view objects organized according to the categories and sub-categories, as well as perform actions

with category objects.

The dispatcher can configure the display of objects not included in any category under the No Category folder.

• On the Radios panel to filter radios by categories.

• On the map panel to track radios of the category.

You can use categories in SmartPTT Dispatcher as follows:

• Apply certain actions to all category objects simultaneously:

• Assign a status to radios in category properties

• Configure the update rules of radio outdoor coordinates in category properties

• Send a message to radios using the category Actions menu

• Show radios on a map or remove them from a map using the category Actions menu

• Configure various SmartPTT Dispatcher features using categories:

• Set the category of objects that will not be hidden on the map when a radio sends an emergency alarm

• Select categories as a condition for triggering a positioning rule

• Select categories to send a message when the rule triggers

• Select categories to build a coverage map

• Select categories to create a report on radio movement

Category Configuration and Use

To use a category, perform the following actions:
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• Create and configure the desired category. For details, see Managing Categories.

• Perform the desired actions:

• Apply the desired action to category objects using the category Actions (   ) menu.

• Configure displaying radios of the category on a map. For details, see Displaying Radio Categories.

• Set the category as a category for emergency. For details, see Configuring Emergency Processing.

• Set the category as a condition for triggering the desired positioning rule. For details, see Adding and Editing Positioning

Rules.

• Configure sending a message to radios of the category when the desired rule triggers. For details, see Configuring Radio

Alerts.

• Set the category as a parameter for building a coverage map. For details, see Building Coverage Map.

• Set the category as a parameter for creating the Radio Movement report. For details, see Creating Radio Movement Report.

• Filter radios on the Radios panel by category. For details, see Filtering Radios.

2.9.2.5.1 Managing Categories

Follow the procedure to add new, or edit/delete an existing category, or configure category settings.

Prerequisites: 

• Ensure the desired radios are registered in SmartPTT Dispatcher.

• (Optional) To assign a status to all radios of the category, ensure the desired status is created in SmartPTT Dispatcher. For

details, see Managing Statuses.

• (Optional) To receive outdoor coordinates of the radios included in the category, ensure that GPS is activated in the radio

properties. For details, see Configuring Radio GPS Settings.
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Procedure: 

1. On the menu bar, click Settings (   ) → Radios → Categories.

The Categories window appears.

2. In the window that appears, perform one of the following actions:

To add a new category, click Add (   ).

The Category window appears.

To edit an existing category, select the desired category, and then click Edit (   ).

The Category window appears.

To delete an existing category, perform the following actions:

1. Select the desired category, and then click Delete (   ).

Important

If the selected category has nested categories, these

categories will also be deleted.

2. In the Confirmation window, click ОК.

3. Proceed to the last step of the procedure.
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To change the order of categories, perform the following actions:

1. Select the desired category, and then change its position

using the Up (   ) and Down (   ) buttons.

2. Proceed to the last step of the procedure.

To change the nesting of categories, perform the following actions:

1. Drag the desired category to another one.

2. Proceed to the last step of the procedure.

To display objects not included in categories on the

Radio Fleet panel,

perform the following actions:

1. Select the Show "No Category" Folder check box.

2. Proceed to the last step of the procedure.

3. In the Category window, in the Name field, type the category name.

4. (Optional) From the Status list, select the status that will be assigned to all radios of the category.

5. Set the category objects:

To add radios to the category, perform the following actions:

1. Open the Radios tab.

2. Select the check boxes next to the desired radios.
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NOTE

You can add several radios simultaneously by selecting them

using the Shift or Ctrl key, and then pressing Space.

To add talkgroups to the category, perform the following actions:

1. Open the Talkgroups tab.

2. Expand nodes of the desired radio systems, and then

select the check boxes next to the desired talkgroups.

To delete a radio or talkgroup from the category, perform the following actions:

1. Open the tab with the desired radios or talkgroups.

2. Clear the check boxes next to the desired objects.

6. (Optional) On the Common tab, configure the update rules of radios' outdoor coordinates:

NOTE

You cannot configure location parameters if the category does not include any radios with GPS enabled.

To apply a parameter to all radios in the category, perform the following actions:

1. Select the check box (   ) next to the desired parameter.

2. If available, select the desired option or, in the field to the

right of the check box, enter the desired value.

To apply parameters that are set in individual settings of

each radio in the category,

leave the check box filled with solid gray (   ).

To not apply a parameter to all radios in the category, clear the check box (   ) next to the desired parameter.

7. In the Category window, click ОК to save changes and close the window.

8. In the Categories window, click Finish.

2.9.3 Radio List Export and Import

SmartPTT Dispatcher provides the ability to export current properties and settings of the radios from the database to a separate file, as

well as import a list of radios to the application.

The exported files can be used for the following purposes:

• Transfer of the exported radio list to another SmartPTT Dispatcher

• Adding new radios to the radio list

• Updating properties and settings of the exported radios

• Performing the radio system analysis

• Generating reports

For information on exporting the radio list, see Exporting Radio List.

The imported files can be used for the following purposes:

• Transfer of the radio list from another SmartPTT Dispatcher
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• Adding new radios to the SmartPTT Dispatcher radio list

• Updating current properties and settings of radios in the SmartPTT Dispatcher radio list

For information on importing the radio list, see Importing Radio List.

The export or import file can be in one of the following formats:

• Microsoft Excel 97-2003 (XLS)

• XML

• CSV

The choice of the export format depends on the export purposes and does not affect its informational content.

The exported file provides information in the form of a table whose columns correspond to radio properties in SmartPTT Dispatcher.

XLS File Example

The exported table consists of the following columns:

Column Name Description

ID Automatically generated radio ID.

Radio IP address Radio IP address.

Network ID Radio network ID that is set in the radio codeplug.

Radio ID Unique radio identifier.

Name Radio name in SmartPTT Dispatcher.

GPS Indicates whether SmartPTT Dispatcher processes the radio GPS coordinates.

MDC ID Identifier of the radio from an analog radio system in MDC-1200 format.

Icon Path to the icon that is set for the radio in SmartPTT Dispatcher. If the default icon is used,

the cell is left empty.

Show on map Indicates whether the radio is displayed on the map in SmartPTT Dispatcher.

Lone Worker Indicates whether the radio is in the Lone Worker mode.

Select 5 ID Identifier of the radio from an analog radio system in the Select 5 format.

Indoor Support Indicates whether indoor positioning is enabled for the radio.

Indoor Request Indicates whether a time interval for sending indoor coordinates requests to the radio is set.
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Column Name Description

Indoor Update Interval Time interval in seconds after which indoor location data requests are sent to the radio.

GPS update with time interval Indicates whether a time interval for the radio to send GPS coordinates is set.

Time Interval Time interval in seconds after which the radio provides its GPS coordinates.

GPS update with distance interval Indicates whether the radio sends location updates after it travels a certain distance.

Distance Interval Distance in meters or feet after which the radio provides its GPS coordinates.

GPS on GPIO pin status change Indicates whether the radio provides its GPS coordinates when it sends a telemetry signal.

GPS on emergency Indicates whether the radio provides its GPS coordinates when it sends an emergency alarm.

GPS on pressing PTT button Indicates whether the radio provides its GPS coordinates when the PTT button is pressed on

it.

NOTE

Some properties have only two possible values: True and False.

If a property is not applicable to the radio, the cell in the corresponding column is left empty.

2.9.3.1 Exporting Radio List

Follow the procedure to export the list of radios to a CVS file.

Prerequisites: 

Ensure that you have access to the desired export destination folder.

Procedure: 

1. On the menu bar, click Service → Export Radio List.

The Export Radio List (*.csv) window appears.

2. To the right of the Save Export File As field, click Browse (   ).

3. In the Specify File Name window, specify the path to the desired folder, and then perform one of the following actions:

To export the radio list to a new file, in the File name field, type the name for the exported file, and

then click Save.

In the Save Export File As field, the path to the file and its

name appear.
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To export the radio list to an existing file, select the file that you want to replace, and then click Save.

In the Save Export File As field, the path to the file and its

name appear.

4. In the Delimiter field, specify the character that will divide parameters and its values in the exported file. If you leave the field

blank, the comma character will be used by default.

5. Click the OK button.

6. In the window indicating successful radio list export, click OK.

2.9.3.2 Importing Radio List

Follow the procedure to import the list of radios from a file.

Procedure: 

1. On the menu bar, click Service → Import Radio List.

The Import Radio List window appears.

2. To the right of the File for import field, click Browse (   ).

3. In the Specify File Name window, specify the file that you want to import, and then click Open.

The specified path and file name are displayed in the File for import field.

NOTE

You can also type or paste the full file path into this field.

4. In the Separator field, specify the character that delimits values in the imported file. If you leave the field blank, the comma

character is taken as a delimiter by default.

5. At the bottom of the Import Radio List window, select the desired option:

To only add new radios from the imported file, select the Add new entries check box.

To only update properties and settings of existing radios, select the Update existing entries check box.

To both add new and update the existing radios, select both the Add new entries and Update existing entries

check boxes.
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To specify that the first row of the imported file contains

column names,

select the First row contains column names check box.

6. In the Import Radio List window, click OK.

To cancel the radio list import, click Cancel.

7. In the window indicating successful radio list import, click OK.

8. Restart SmartPTT Dispatcher to complete the radio list import.

NOTE

If the imported file contains no changes that can be uploaded to the current radio list, a window indicating the absence of changes

appears.

2.10 Positioning Settings Configuration

Positioning settings configuration includes the following actions:

• GPS and Indoor settings configuration. For details, see Configuring Positioning Settings.

• Radio GPS settings configuration as well as map creation and configuration. For details, see Geopositioning Configuration.

• Radio indoor tracking settings configuration as well as building plan creation and configuration. For details, see Indoor Tracking

Configuration.

For detailed information on positioning in SmartPTT Dispatcher, map types as well as map and building plan actions, see Positioning.

2.10.1 Configuring Positioning Settings

Follow the procedure to configure GPS and Indoor settings.

Prerequisites: 

• (Optional) To use Google as the address data provider, obtain the Google API key. For details, see “Google Map Keys” in

SmartPTT Installation and Configuration Guide.

• (Optional) To use the dedicated OpenStreetMap Nominatim server as the address data provider, obtain the server address.

Procedure: 

1. On the menu bar, click Settings (   ) → Positioning Systems.

The Positioning Systems window appears.
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2. From the Source of location data list, select whether SmartPTT Dispatcher will use subscribers' coordinates obtained from any

radio network, or only from the network in which the radio is currently registered.

3. In the Validity of GPS coordinates (min) field, specify the period in minutes after which the radio label is removed from the map if

new GPS coordinates were not received from the radio.

4. In the Validity of beacon signals (min) field, specify the period in minutes after which the radio label is removed from the building

plan if new beacon signals were not received from the radio.

5. In the Time interval for GPS coordinates update (s) field, specify the interval for updating radio location data in seconds which will

be applied to all unregistered radios.

6. In the Accuracy Radius field, specify the maximum coordinate error margin required to consider received coordinates valid.

7. (Optional) To use the address service (reverse geocoding), perform the following actions:

a. Select the Address data provider check box.

b. Configure the desired provider:

To use Google, perform the following actions:

1. From the list to the right of the Address data provider

check box, select Google.

2. In the Google API Key field, type an API key.
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To use the official OpenStreetMap Nominatum server, from the list to the right of the Address data provider check box,

select OpenStreetMap Nominatum.

To use a private or public OpenStreetMap Nominatim

server,

perform the following actions:

1. From the list to the right of the Address data provider

check box, select Dedicated OpenStreetMap Nominatim

server.

2. In the Address field, type the desired server address.

8. In the Data Format area, configure the format of radio location data to display:

a. From the Coordinates list, select the format for displaying GPS coordinates: Decimal Degrees, Universal Transverse Mercator

Coordinate System, or Degrees, Minutes, Seconds.

b. From the System of Units list, select the measurement system for configuring, displaying and saving location data: Metric or

Imperial.

c. From the Speed list, select the units in which radio speed will be displayed.

9. (Optional) To save radio GPS data in the SmartPTT Dispatcher database, perform the following actions:

a. Select the Save GPS Locations in Database check box.

b. In the Database cleanup settings area, perform one of the following actions:

To prevent coordinates from deletion by SmartPTT

Dispatcher,

select Do not delete GPS locations.

To delete outdated coordinates, perform the following actions:

1. Select Coordinates retention period (days).

2. In the field on the right, type the desired retention period

in days.

10. Click Finish to save changes and close the window.

2.10.2 Geopositioning Configuration

Geopositioning settings configuration includes the following actions:

• Radio GPS settings configuration. For details, see Configuring Radio GPS Settings.

• Map creation and configuration. For details, see Map Creation and Configuration.

For detailed information on positioning in SmartPTT Dispatcher, map types as well as map actions, see GPS.

2.10.2.1 Configuring Radio GPS Settings

Follow the procedure to configure the radio positioning feature using outdoor coordinates received from SmartPTT Radioserver.

Prerequisites: 

• Ensure the GPS location service is configured in SmartPTT Radioserver Configurator. For details, see “Configuring GPS” in

SmartPTT Installation and Configuration Guide.

• Ensure an operator has the Manage radio location settings and Request radio location rights. For details, see Operators.
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Procedure: 

1. By right-clicking the existing radio on the Radio Fleet panel, open the Radio Properties window.

2. In the Radio Properties window, open the Location tab.

3. Select the GPS Support check box to enable the GPS feature for the radio.

4. (Optional) Configure the radio-specific update rules of outdoor coordinates:

To update the location of the radio with a specified time

interval,

perform the following actions:

1. Select the with time interval (sec) check box.

2. In the field next to the check box, type the desired update

interval.

To update the location after the radio moves by a

specified distance,

perform the following actions:

1. Select the with distance interval check box.

2. In the field next to the check box, type the desired

distance.

To update the location when the radio sends telemetry

data,

select the on GPIO pin status change check box.

Important

To ensure correct operation of the feature, the GNSS Report

check box must be selected for the desired GPIO physical

pins in the radio codeplugs.
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To update the location when the radio sends an

emergency alarm,

select the on emergency check box.

To update the location each time the PTT button is

pressed on the radio,

perform the following actions:

1. Select the on pressing PTT check box.

2. Select always.

To update the location only when the PTT button is

pressed on the radio to make an emergency call,

perform the following actions:

1. Select the on pressing PTT check box.

2. Select only in emergency mode.

5. In the Radio Properties window, click Save.

2.10.2.2 Map Creation and Configuration

NOTE

Before you can start working with maps, you must add them to the Map menu. For details, see Configuring Maps in Use.

SmartPTT Dispatcher provides the following types of maps:

• Google Maps.

• OpenStreetMap (online and offline).

• Baidu Maps.

• Maps in Polish format

• MapInfo.

For information on creating and editing MapInfo maps, see Configuring MapInfo Map.

• Raster maps.

For information on creating and editing raster maps, see Adding and Creating Raster Maps.

• Maps from database.

For information on database maps configuration, see Managing Maps from Database.

For information on adding maps to the menu as well as the Google Maps, Baidu Maps and OpenStreetMap servers connection, see

Configuring Maps in Use.

For detailed information on the available types of maps, see Maps.

To display information about the RSSI signal strength on the specific territory, you can configure a coverage map. For details, see

Configuring Coverage Map.

For information on radios on a map display configuration, see Configuring Radios on Map Settings.

You can add radios, cameras, data sources, points of interest, geofences, and routes as well as display tracks on maps.

For information on actions with radios, tracks, and objects on a map, see Map Actions.
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2.10.2.2.1 Configuring Maps in Use

Follow the procedure to configure maps in use and add the desired maps to the Map menu.

Prerequisites: 

• Obtain a valid API key for Google or Baidu maps to use Google or Baidu maps. To obtain the key, contact your system

administrator.

• Obtain URL address of the OpenStreetMap server to use OpenStreetMap maps. To obtain the address, contact your system

administrator.

Procedure: 

1. On the menu bar, click Map → Map Settings.

The Map Settings window appears.

2. In the Maps in Use area, select the desired maps:

To enable Google Maps, perform the following actions:

1. Select the Google Maps check box.

2. In the Google API Key field, type the API key for Google

maps. To view the entered key, click the eye icon (   ).

For security reasons, the key will not be available for

viewing in subsequent sessions.

To enable OpenStreetMap maps located on a server, perform the following actions:

1. Select the OpenStreetMap check box.

2. In the Address field, type the map server address.
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To enable OpenStreetMap from files, select the OpenStreetMap (file) check box.

To enable Baidu Maps, perform the following actions:

1. Select the Baidu Maps check box.

2. In the Baidu API Key field, type the API key for Baidu maps.

To view the entered key, click the eye icon (   ). For

security reasons, the key will not be available for viewing

in subsequent sessions.

To enable maps in polish format, select the Maps in Polish Format check box.

To enable MapInfo maps, select the MapInfo check box.

To enable raster maps, select the Raster Maps check box.

To enable maps from databases, select the Maps from Database check box.

3. Click ОК to save changes and close the window.

2.10.2.2.2 Configuring Radios on Map Settings

Follow the procedure to configure displaying radios on a map.

Procedure: 

1. On the menu bar, click Map → Map Settings.

The Map Settings window appears.



124

SmartPTT Dispatcher Functionality Configuration Positioning Settings Configuration

2. In the Radios on Map field, set the desired displaying settings of radios on outdoor maps:

To hide radios with outdated coordinates, select the Hide radios with outdated coordinates check box.

NOTE

This setting does not affect indoor positioning. Radios

whose beacon signal validity timeout has expired are always

hidden on building plans.

To hide offline radios, select the Hide offline radios on outdoor maps check box.

3. From the Information displayed on Radio Map Label list, select the information that is displayed on the radio label:

To display radio name and time when coordinates were

received,

select Radio Name and Location Time.

To display only radio name, select Radio Name.

To display only radio icons, select None.

4. From the Radio icon size list, select the desired size for radio icons on a map:

To set the icon size to 16х16 pixels, select 16х16.

To set the icon size to 24х24 pixels, select 24х24.

5. Click ОК to save changes and close the window.

2.10.2.2.3 Configuring MapInfo Map

Follow the procedure to create or edit the MapInfo map to use in SmartPTT Dispatcher.

Prerequisites: 

Ensure that the MapInfo check box is selected in the Map Settings window. For details, see Configuring Maps in Use.

Procedure: 

1. On the menu bar, click Map → MapInfo → New Map.

The Map Settings window appears.
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2. To the right of the Map Description File field, click the Browse (   ) button, and then specify the path to the desired SPMAP file or

enter a new file name and click Open.

3. In the Map Settings window, perform one of the following actions:

To add a new map layer, perform the following actions:

1. Click Add (   ).

The Select Map Layer File window appears.

2. In the window that appears, select the desired file with a

map layer in the TAB format.

3. Click Open.

To edit a layer, perform the following actions:

1. Select the desired layer.

2. In the Min. Object Size to Show on Map (pixels) field,

specify the minimum size of the object on the map.

3. In the Scale to Draw Layer field, specify the scale factor

beyond which the elements of the layer will not be

displayed on the map.

To change an order of the layers, select the desired layer and change its position using the Move

Layer Up (   ) and Move Layer Down (   ) buttons.
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To delete a layer, select the desired layer and click Delete (   ).

4. Click Save to save changes and close the window.

5. (Optional) To open the MapInfo map, perform the following actions:

a. On the menu bar, click Map → MapInfo → Open Map.

The Select map file window appears.

b. In the window that appears, select the desired file in the SPMAP or TTKGP format and click Open.

The selected map appears in the SmartPTT Dispatcher main area.

NOTE

You can create a map in the TTKGP format using the free TatukGIS Viewer software.

Postrequisites: 

To open the map after saving it, click Save and Open.

2.10.2.2.4 Adding and Creating Raster Maps

To create a raster map from the BMP, JPEG, or PNG file to use it in SmartPTT Dispatcher, you must perform the following actions:

• Obtain the coordinates of corresponding points selected on the image and world map to use it as guidelines. For details, see

Obtaining Coordinates for Raster Map Configuration.

• Match the image and world map coordinates in the Raster Map window. For details, see Configuring Raster Map.

Obtaining Coordinates for Raster Map Configuration

Follow the procedure to obtain coordinates for raster map configuration.

Prerequisites: 

Select an image of the desired area in the BMP, JPEG, or PNG format.

Procedure: 

1. Open an image of the desired area using an image editing program.

2. On the image, select four points using the following guidelines:

• Point 1 must be located as close as possible to the upper-left corner of the image.

• Point 2 must be located as close as possible to the upper-right corner of the image.

• Point 3 must be located as close as possible to the lower-left corner of the image.

http://www.tatukgis.com/Products/EditorViewer/Editions/Viewer.aspx
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• Point 4 must be located as close as possible to the lower-right corner of the image.

NOTE

It is recommended to use points that are easy to identify on a map (crossroads, tourist attractions, etc.).

3. For each point, note X and Y coordinates in pixels. Coordinates are usually displayed in the lower pane of an image editing

program.

4. Find the same points on Google Maps or in a similar service. Note longitudes and latitudes in decimal format.

NOTE

If coordinates are displayed in degrees, minutes, and seconds, convert them to the decimal format using the following formula:

Decimal Degrees = Degrees + Minutes/60 + Seconds/3600.

Postrequisites: 

In the Points area of the Raster Map window, enter the obtained values for each point. For details, see Configuring Raster Map.

Configuring Raster Map

Follow the procedure to create or edit a raster map in SmartPTT Dispatcher.

Prerequisites: 

• Obtain point coordinates to match. For details, see Obtaining Coordinates for Raster Map Configuration.

• Ensure that the Raster Maps check box is selected in the Map Settings window. For details, see Configuring Maps in Use.

Procedure: 

1. On the menu bar, click Map → Raster Maps → New Map.

The Raster Map window appears.
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2. In the window that appears, perform one of the following actions:

To create a new map, perform the following actions:

1. To the right of the Select Image of Map field, click the

Browse (   ) button.

2. In the window that appears, select the desired BMP, JPEG,

or PNG file and click Open.

3. In the Points area, specify the coordinates of four guiding

points which will be used to draw a map.

To edit an existing raster map, perform the following actions:

1. Click Open.

2. In the window that appears, select the desired MAP file and

click Open.

3. In the Points area, make the desired changes.

3. Once all necessary changes are made, click Finish.

4. In the window that appears, enter the map name, specify the path, and then click Save.
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Important

The created raster map file and the raster map image must be in the same folder.

5. (Optional) To open the raster map, perform the following actions:

a. On the menu bar, click Map → Raster Maps → Open Map.

The Select map file window appears.

b. In the window that appears, select a file in the MAP format.

The selected map appears in the SmartPTT Dispatcher main area.

2.10.2.2.5 Managing Maps from Database

Follow the procedure to configure a raster map from a database.

Prerequisites: 

• Ensure that the Maps from Database check box is selected in the Map Settings window. For details, see Configuring Maps in Use.

• Request a raster map database, and then restore it from the received backup.

Procedure: 

1. On the menu bar, click Map → Maps from Database → Settings.

The Maps from Database window appears.

2. In the window that appears, click Scan Databases to display all maps from the SmartPTT Dispatcher databases.

3. In the Maps from the Database Table, perform one of the following actions:

To change the map name, double-click the current map name, and then type the desired

name.

To display a map in the Map menu, in the Show column, select the check box for the desired

map.
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To delete a map from the table, select the desired map, and then click Delete (   ).

4. Click Save to confirm changes and close the window.

Postrequisites: 

To open the map, select the desired map in Map → Maps from Database.

2.10.2.2.6 Configuring Coverage Map

To configure the coverage map for a radio, you must perform the following actions:

• Configure the RSSI ranges. For details, see Configuring RSSI Ranges.

• Configure the coverage map building settings. For details, see Building Coverage Map.

Configuring RSSI Ranges

Follow the procedure to configure RSSI ranges.

Prerequisites: 

• Ensure you have the corresponding license. For details, see Licenses.

• Ensure an operator has the View coverage map right. For details, see Operators.

Procedure: 

1. On the menu bar, click Map → Coverage map → Coverage Map Settings.

The Coverage Map Settings window appears.

2. In the window that appears, perform one of the following actions:

To add a new range, perform the following actions:
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1. Click Add (   ).

2. In the RSSI Range Table, in the To, dBm column, specify

the end value of the added range.

To delete a range, in the RSSI Range Table, select the desired range, and then click

Delete (   ).

NOTE

The initial and end ranges cannot be deleted.

To configure the range color, in the corresponding table entry, in the Color column, from the

expandable palette, select the desired color.

To reset ranges settings to default,

click Reset(   ).

3. Click ОК to confirm changes and close the window.

Postrequisites: 

Build the coverage map. For details, see Building Coverage Map.

Building Coverage Map

Follow the procedure to build a coverage map.

Prerequisites: 

• Ensure you have the corresponding license. For details, see Licenses.

• Ensure the operator has the View coverage map right. For details, see Operators.

• Ensure that the GPS is enabled for the desired radios, and the database contains GPS data. For details, see Configuring Radio GPS

Settings.

• Configure RSSI ranges in the RSSI settings window. For details, see Configuring RSSI Ranges.

Procedure: 

1. On the menu bar, click Map → Coverage map → Show.

The Coverage Map Settings window appears.
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2. In the window that appears, select radios to build a coverage map:

To build a coverage map for all available radios, select All radios.

To build a coverage map for specific radios, perform the following actions:

1. Select Select radios.

2. Select the desired check boxes in the area on the right.

To build a coverage map for specific radio categories, perform the following actions:

1. Select Select categories.

2. Select the desired check boxes in the area on the right.

3. From the Source list, select the data source to build a coverage map:

To use the SmartPTT Dispatcher database as the data

source,

select Dispatcher.

To use the database of one of the available radioservers as

the data source,

select the value with the desired SmartPTT Radioserver

name.

4. From the Resolution list, select the desired radius for checking signal strength.

5. In the Start date and End date fields, enter the desired date and time to build a coverage map for a specific period.

6. Click OK to confirm changes and close the window.

The coverage map appears in the main area of SmartPTT Dispatcher.

Postrequisites: 

To hide the coverage map, on the menu bar, click Map → Coverage map → Hide.
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2.10.3 Indoor Tracking Configuration

Indoor tracking configuration in SmartPTT Dispatcher includes the following actions:

• Indoor tracking support configuration for a radio in SmartPTT Dispatcher. For details, see Configuring Indoor Radio Tracking.

• Building plan creation and configuration. For details, see Creating and Editing Building Plan.

For detailed information on the indoor tracking feature in SmartPTT Dispatcher, building plans and building plan actions, see Indoor

Tracking.

2.10.3.1 Configuring Indoor Radio Tracking

Follow the procedure to configure indoor features support for a radio in SmartPTT Dispatcher.

Prerequisites: 

• Ensure the beacon-based location service is configured in SmartPTT Radioserver Configurator. For details, see “Configuring

Beacons in SmartPTT” in SmartPTT Installation and Configuration Guide.

• Ensure the operator has the Manage radio location settings right. For details, see Operators.

Procedure: 

1. Open the Radio Properties window.

2. In the Radio Properties window, open the Location tab.

3. Select the Indoor tracking check box to enable the Indoor Tracking feature for the radio.

4. If the iBeacon technology is used, configure the radio indoor position update:
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a. Select the Update interval (sec) check box.

b. In the field next to the check box, type the position update interval value in seconds.

5. In the Radio Properties window, click Save.

2.10.3.2 Creating and Editing Building Plan

Follow the procedure to create or edit a building plan.

Prerequisites: 

• Ensure you have the Indoor license. For details, see Licenses.

• Obtain plans of the desired building floors.

Procedure: 

1. Perform one of the following actions:

To create a building plan, on the menu bar, click Map → Indoor Tracking → New Building

Map.

To edit a building plan, perform the following actions:

1. On the indoor map panel, click Expand the Control Panel ( 

 ) to expand the Control Panel.

2. On the Control Panel, expand the Floor Plan (   ) tab.

3. Click Edit Plan (   ).

 The Floor Plan window appears.
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2. In the Building Name field, type the desired name of a plan.

3. Perform the desired actions:

To add a new floor to the building plan, click Add (   ).

A new floor entry appears in the Floor Table.

To change the name of a floor, for the desired entry of the Floor Table, in the Floor column, click

the old name, and then type a new one.

To change the floor order, in the Floor Table, select the desired entry, and then click Up ( 

 ) or Down (   ).

To link a file to a floor or change the linked file, perform the following actions:

1. For the desired entry of the Floor Table, in the right part of

the File Path column, click the Browse (   ) button.

2. In the window that appears, select the file with the

corresponding floor plan and click Open.

The path to the selected file appears in the File Path

column.

To remove a floor from the building plan, perform the following actions:

1. In the Floor Table, select the desired entry.

2. Click Delete (   ).

An entry with the desired floor is deleted from the Floor

Table.

4. Save the changes:

To save a new building plan, perform the following actions:

1. Click Save.

2. In the window that appears, select the file format (SPLAN

or SPLANX) that will be used to save the plan and click

Save.

The created file appears on the indoor map panel in

SmartPTT Dispatcher.

To save changes added to the created file, click Save.

2.11 Job Ticket Statuses Configuration

SmartPTT Dispatcher provides the ability to create job ticket statuses and configure their settings (for example, assign a color to status

or add a sound notification that will play when the status is changed). When a job ticket is sent to a radio, the radio user can change its

status to notify the dispatcher about the job implementation phase.

Statuses can be configured in the Job ticket window where you can also configure automatic numbering, notifications that are sent to

radios when an uncompleted job ticket is deleted, and status that is displayed by default.
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For each job ticket status, you can configure the color that is used in the Job Ticket Table and the sound notification to play when the

status will be assigned.

For information on job ticket statuses configuration, see Managing Job Ticket Statuses.

Important

Added statuses must match the statuses set in radio codeplugs, otherwise, the color, sound signal, and status completion settings

will not be applied to display these statuses in SmartPTT Dispatcher.

NOTE

The Job Tickets feature is not available in Capacity Max systems.

NOTE

The Job Tickets feature is not available to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

For detailed information on job tickets and actions with them, see Job Tickets.

2.11.1 Managing Job Ticket Statuses

Follow the procedure to add, edit, or delete job ticket statuses.

Important

The job ticket statuses can be configured only by the Administrator.

For information on user roles in SmartPTT Dispatcher, see Operators.

Prerequisites: 

Before adding statuses in SmartPTT Dispatcher, ensure the corresponding statuses are set in radio codeplugs.
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Procedure: 

1. On the menu bar, click Settings (   ) → Radios → Job Ticket Statuses.

The Job Tickets window appears.

2. (Optional) Configure additional job ticket parameters:

To assign a unique number to each new job ticket, select the Enable Automatic Numbering check box.

To send notifications to radios when the dispatcher

deletes uncompleted job tickets,

select the Send notification to radio when uncompleted job ticket

was deleted by dispatcher check box.

To configure the status that will be used for each new job

ticket by default,

perform the following actions:

1. In the Default Status field, type the desired status name.

2. From the expandable Color palette, select the desired

default status color.
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3. Perform one of the following actions:

To add a new status, click Add (   ).

The Job Ticket Status window appears.

To edit an existing status, in the Job Ticket Status Table, double-click the desired status or

select the status, and then click Edit (   ).

The Job Ticket Status window appears.

To delete a status, perform the following actions:

1. In the Job Ticket Status Table, select the desired status,

and then click Delete (   ).

2. In the Confirmation window, click OK.

The status is deleted from the table.

3. Proceed to step 7.

4. In the Job Ticket Status window, in the Name field, type the status name.

5. (Optional) Configure additional job ticket status parameters:

To specify a color other than the default for highlighting

the status name,

from the expandable Color palette, select the desired color.

To hide job tickets with the status from the Job Tickets

Table on the Job Tickets panel if the Show completed

tickets check box is cleared in the Management area.

select the Completion Status check box.

To configure the sound notification which will be played

when the status is assigned to a job ticket,

perform the following actions:

1. Select the Play Sound check box.

2. Click Select Sound File (   ).

The Sound File Selection window appears.

3. In the window that appears, select the desired audio file

and click Open.

6. Click OK to apply changes and close the window.

7. Click Finish to close the Job Tickets window.

Postrequisites: 

 Add the desired job tickets and send them to a single or multiple radios or talkgroups. For details, see Managing Job Tickets.
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2.12 Telemetry Configuration

To configure the Telemetry feature, the following actions must be performed:

• Configure the Telemetry feature in the desired radio codeplug.

• Connect the desired devices to the GPIO (General-purpose Input/Output) pins of the radio.

• Activate the Telemetry feature in SmartPTT Radioserver Configurator. For details, see “Activating Telemetry” in SmartPTT

Installation and Configuration Guide.

• Add, edit, or delete telemetry actions. For details, see Managing Telemetry Actions.

• (Optional) Assign the desired telemetry action to a radio. For details, see Assigning Telemetry to Radios.

NOTE

The telemetry actions can be assigned only to the radios that are registered in the system. If the radio is not registered, the Telemetry

feature will be unavailable.

• (Optional) Assign the desired telemetry action to a talkgroup. For details, see Assigning Telemetry to Talkgroups.

The telemetry settings are configured in the Telemetry Settings window. You can open the Telemetry Settings window by clicking

Settings (   ) → Radios → Telemetry on the menu bar.

NOTE

The Telemetry feature is available only to DMR radios.

Telemetry Example

The garage door is equipped with a sensor that monitors the door state (open or close) and an actuator that provides the ability to

open or close the door remotely.

For this configuration, you must set the following telemetry settings in SmartPTT Dispatcher:

• Door is closed: GPIO Pin 1, incoming telemetry event, low level of the signal

• Door is open: GPIO Pin 2, incoming telemetry event, high level of the signal

• Open or close the door: GPIO Pin 3, outgoing telemetry event, switch the signal level

When the door is opened or closed, an operator receives a notification about the telemetry event in the SmartPTT Dispatcher Event

Log. It is also possible to open or close the door by sending a command from a radio or SmartPTT Dispatcher to switch the signal

level.

Important

Telemetry features are unavailable if desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned to

the client prohibits access to telemetry actions. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

For detailed information on telemetry and performing telemetry actions, see Telemetry.
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2.12.1 Managing Telemetry Actions

Follow the procedure to add, edit, or delete telemetry actions.

Prerequisites: 

• Ensure the operator has the Send telemetry commands right.

For information on operator rights, see Operators.

• Ensure the telemetry service is activated in SmartPTT Radioserver Configurator. For details, see “Activating Telemetry” in

SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → Telemetry.

The Telemetry Settings window appears.

2. In the Telemetry Settings window, perform one of the following actions:

To add a new telemetry action, at the top of the window, click Add (   ).

The Telemetry Settings window appears.

To edit an existing telemetry action, in the table, select the desired action, and then click Edit (   ).

The Telemetry Settings window appears.
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To delete an existing telemetry action, perform the following actions:

1. In the table, select the desired telemetry action, and then

click Delete (   ).

2. In the Confirmation window, click OK.

The action is deleted from the table.

3. Proceed to step 8.

3. In the window that appears, in the Description field, type the name of the telemetry action.

4. From the GPIO Pin list, select the number of the radio contact or VIO (Virtual Input/Output) to assign the telemetry action.

NOTE

Ensure the selected contact or VIO matches a physical GPIO (General-purpose Input/Output) line in the radio codeplug.

5. From the Direction list, select the desired telemetry event direction:

To configure an outgoing telemetry event, select Outgoing

To configure an incoming telemetry event, select Incoming.

6. From the Action list, select the desired telemetry action type:

To make a telemetry event happen when an impulse with

configured length was sent,

select Impulse.

Important

The Impulse action can only be used in combination with

the Outgoing direction.

NOTE

The length of an impulse can be configured in the radio

codeplug.

To make a telemetry event happen when GPIO pin voltage

level is high,

select High Level.

To make a telemetry event happen when GPIO pin voltage

level is low,

select Low Level.

To make a telemetry event happen when GPIO pin voltage

level is changed,

select Toggle Level.
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7. Click OK to save changes and close the window.

8. Click Finish to close the Telemetry Settings window.

Postrequisites: 

 Assign the telemetry action to radios or talkgroups. For details, see Assigning Telemetry to Radios and Assigning Telemetry to

Talkgroups.

2.12.2 Assigning Telemetry to Radios

Follow the procedure to assign telemetry actions to a radio.

Prerequisites: 

• Configure telemetry actions in the Telemetry Settings window. For details, see Managing Telemetry Actions.

• Ensure the desired radio is registered in the radio system.

• Ensure the radioserver is online.

Procedure: 

1. On the Radio Fleet panel, right-click the desired radio.

The Radio Properties window appears.

2. Click Telemetry (   ) to open the Telemetry for - <radio name> window where you can assign available telemetry actions to the

radio.



143

SmartPTT Dispatcher Functionality Configuration Telemetry Configuration

3. Select the desired actions to assign them to the radio.

4. (Optional) To set the automatic GPIO pins' status updates, in the Update GPIO pins' status area, perform the following actions:

a. In the Interval, s field, specify the interval to update pin signal data in seconds.

b. Select the desired GPIO Pin check boxes.

NOTE

The automatic GPIO pins' status update is applied only to incoming telemetry data.

5. Click OK to save changes and close the window.

The corresponding telemetry messages will be displayed in the Event Log, the selected actions become available in custom

consoles, and outgoing actions can be executed from the Call Window of the radio.

6. Click Save to close the Radio Properties window.

Postrequisites: 

Execute an outgoing telemetry action from the radio Call Window. For details, see Executing Telemetry Actions from Radio Call Window.

2.12.3 Assigning Telemetry to Talkgroups

Follow the procedure to assign telemetry actions to a talkgroup.

Prerequisites: 

• Configure telemetry actions in the Telemetry Settings window. For details, see Managing Telemetry Actions.

• Ensure the radioserver is online.
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Procedure: 

1. On the Radio Fleet panel, right-click the desired talkgroup or select the Properties (   ) in the Actions (   ) menu of the talkgroup.

The talkgroup properties window appears.

2. Click Telemetry (   ) to open the Telemetry for - <talkgroup name> window where you can assign available telemetry actions to

the talkgroup.

3. Select the desired actions to assign them to radios in the talkgroup.

4. Click OK to save changes and close the window.

Outgoing actions become available in the talkgroup Call Window.

5. Click Save to close the talkgroup properties window.

Postrequisites: 

 Execute an outgoing telemetry action from the talkgroup Call Window. For details, see Executing Telemetry Actions from Talkgroup Call

Window.
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2.13 Event Log Configuration

Events that are registered in SmartPTT Dispatcher, such as voice calls, TMS, emergency, etc., are logged into the SmartPTT Dispatcher

Event Log. The SmartPTT Dispatcher Event Log is stored in the corresponding database. Its information is displayed on the Event Log

panel. To display the SmartPTT Dispatcher Event Log information on the Event Log panel, you must activate and configure it.

For additional information on the SmartPTT Dispatcher Event Log and its use, see SmartPTT Dispatcher Event Log.

For information on the SmartPTT Radioserver Event Log and its use, see SmartPTT Radioserver Event Log.

2.13.1 Configuring Event Logging for SmartPTT Dispatcher

Follow the procedure to enable and configure event logging for SmartPTT Dispatcher.

Procedure: 

1. On the menu bar, click Event Log → Event Log Settings.

The Event Log Settings window appears.

2. In the window that appears, select the Enable event logging check box to record events to the SmartPTT Dispatcher database.

3. (Optional) In the Maximum number of Event Log records field, type the desired value. The maximum value is 9999.

4. In the Options of Event Log clearing area, perform one of the following actions:

To record new events in the database until the hard drive

is full,

select Do not clear Event Log.

To delete records made a specified amount of days ago, perform the following actions:

1. Select Period of records retention (days).

2. Type the desired number of days to keep records.

The maximum value is 999. The default value is 30 days.

5. (Optional) Select the Show time with milliseconds check box to display milliseconds in the Data/Time column of the Event Log.

6. Click OK to apply changes and close the window.
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2.14 Call Records Configuration

The SmartPTT Dispatcher Event Log provides the ability to play call records. To use the Call Records feature, it must be activated in

SmartPTT Dispatcher.

For information on playing and downloading call records as well as opening their location, see Call Records.

2.14.1 Configuring Audio Recording

Follow the procedure to configure the audio recording settings in SmartPTT Dispatcher.

Procedure: 

1. On the menu bar, click Settings (   ) → Information Storage → Records.

The Audio Record Settings window appears.

2. In the Audio Record Settings window, in the Records area, click Record Calls.

3. To the right of the Audio records folder field, click Browse (   ), and then, in the window that appears, select a folder for storing

call recordings.

The path to the selected folder appears in the Audio records folder field.

4. In the Audio file extension field, select the desired audio file format from the list.
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5. (Optional) Select or clear the Fixed sample rate check box to activate or deactivate application of the fixed sample rate (8 kHz)

for all call recordings.

6. (Optional) Increase or decrease the call recordings sound volume by moving the Recording volume of outgoing calls slider to the

left or right, respectively.

7. (Optional) In the Audio files search paths area, specify additional call recordings locations:

To add a new folder, click Add (   ), and then, in the window that appears, select the folder

in which call recordings are stored.

The path to the selected folder appears in the table.

To edit a folder, perform the following actions:

1. In the Audio files search paths table, click the desired path.

2. Click Edit (   ), and then, in the window that appears, select the

desired folder.

The path to the selected folder changes in the table.

To delete a folder, in the Audio files search paths table, click the desired path, and then

click Delete (   ).

The path to the selected folder disappears from the table.

8. In the Audio records cleanup settings area, select the desired cleanup option:

To keep call recordings for as long as there is

available disk space,

select Do not delete audio records.

To keep call recordings for a specified period of

time,

select Records retention period, and then, in the field to the right,

specify the desired retention period in days.

9. Click Finish to save changes and close the window.

2.15 Telephone Interconnect Settings

The connection to telephone subscribers can be established in the client mode (SIP account) or in the gateway mode (SIP trunk).

For detailed information on the Telephone Interconnect feature, telephone subscriber list configuration, and calls, see Telephone

Interconnect.

To provide correct functioning of the Telephone Interconnect feature, you need to configure parameters of connection between

SmartPTT Dispatcher and telephone subscribers in the Telephone Interconnect window. You can configure the following parameters:

• General telephone interconnect settings. For details, see Configuring General Telephone Interconnect Settings.

• Audio codecs. For details, see Managing Audio Codecs.

• SIP trunk authentication. For details, see Configuring SIP Trunk Authentication.

• SIP accounts. For details, see Managing SIP Accounts.

SIP Trunk and SIP Account Differences

The SIP account service provides an end device with a registration to a call control server. The end device has a username and SIP

server IP address. It registers on that server to make calls. The SIP account service usually restricts the number of simultaneous calls.

In SmartPTT System, SIP account can only be used to connect SmartPTT Dispatcher to a telephone network.
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For SmartPTT Radioserver and PBX connection, you only can use the SIP trunk service. It enables multiple simultaneous calls using

SmartPTT Radioserver. SmartPTT Dispatcher can also be connected to a telephone network using SIP trunk though it can be less cost

effective.

Establishing Connection via SIP Account

Connection via SIP account is established using accounts created on the PBX. SmartPTT Dispatcher sends its authentication data and

current IP address at predetermined intervals to re-register on the PBX and update identification information.

To establish a connection using SIP account, the following conditions must be met:

• In the PBX settings, create a SIP account.

• Add the SIP account to SmartPTT Dispatcher. For details, see Managing SIP Accounts.

• Allow calls to telephone subscribers in SmartPTT Dispatcher (by selecting the corresponding check box). For details, see

Configuring General Telephone Interconnect Settings.

Establishing Connection via SIP Trunk

If connection via SIP trunk is used, registration on the PBX is required only for the first session. SIP trunking provides security by means

of password authentication for incoming and outgoing calls.

To establish a connection using SIP trunk, the following conditions must be met:

• In the PBX settings, create a SIP trunk connection for SmartPTT Dispatcher.

• Connect SmartPTT Dispatcher to the PBX.

• Allow calls to telephone subscribers in SmartPTT Dispatcher (by selecting the corresponding check box). For details, see

Configuring General Telephone Interconnect Settings.

Important

If SIP trunk for SmartPTT Dispatcher is configured in the PBX settings, telephone calls will be established via SIP trunk by default,

even if the SIP account mode is configured in SmartPTT Dispatcher.

2.15.1 Configuring General Telephone Interconnect Settings

Follow the procedure to configure general Telephone Interconnect settings.

Important

The SmartPTT Dispatcher settings must match the corresponding settings of the PBX.

Prerequisites: 

• Determine the IP address and network ports of the SmartPTT Dispatcher computer used to connect to a PBX.

• From the PBX settings, obtain the following data:

• Network protocol used for the SIP commands transmit.

• Code used as a prefix for callbacks.

• For SIP trunk authentication, determine the number for calling SmartPTT Dispatcher.

• Obtain the VoIP gateway parameters (dial prefix for outgoing calls, IP address, and SIP port).
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Procedure: 

1. On the menu bar, click Settings (   ) → Telephone Interconnect → Telephone Interconnect.

The Telephone Interconnect window appears.

2. In the Telephone Interconnect window, open the General Settings tab.

3. In the Dispatcher Settings area, configure basic settings for connection between SmartPTT Dispatcher and a PBX:

a. Select the Allow Calls to Telephone Subscribers check box.

b. From the Transport list, select the desired protocol for the SIP commands transmit.

c. From the Interface list, select the desired interface of the SmartPTT Dispatcher computer that must be used for connection

to telephone subscribers:

To use any physical interface of the computer, select Automatically.

To use a specific IP address of the computer, select the desired IP address.

NOTE

Before selecting the interface manually, ensure that it is

available to the VoIP gateway.
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d. In the SIP Port field, type the desired port number for the SIP data packets transmit.

NOTE

If SmartPTT Dispatcher and SmartPTT Radioserver are installed on the same computer, specify a SIP port number that is different

from the one used by the radioserver.

e. In the RTP Ports fields, specify the lower and upper boundaries of the port range to be used for connection to telephone

subscribers.

f. For SIP trunk authentication, in the Phone Number field, type the desired number used for calling SmartPTT Dispatcher.

g. (Optional) To display a specific name on the screen of the device receiving a call from SmartPTT Dispatcher, in the Displayed

Subscriber Name field, type the desired name.

4. In the VoIP Gateway Default Settings area, configure settings for connection to telephone subscribers via SIP trunk (for example,

using the SIP trunk authentication or conference calls):

a. In the Dial Prefix for Outgoing Calls field, type a numeric prefix to add to the subscriber's number for identifying the call

initiator.

b. (Optional) In the Dial Prefix for Incoming Calls field, type a numeric prefix to add to the SmartPTT Dispatcher number for the

callback capability.

c. In the Default VoIP Gateway Address field, type the VoIP gateway IP address.

d. In the SIP Port field, type the VoIP gateway port number for the SIP data packets transmit.

5. (Optional) Configure a sound alert for telephone calls:

To play an alert sound when a telephone subscriber calls

SmartPTT Dispatcher,

select Play sound alert for incoming calls check box.

To play an alert sound when SmartPTT Dispatcher calls a

telephone subscriber,

select Play sound alert for outgoing calls check box.

6. Adjust the sound volume of calls received from telephone subscribers in SmartPTT Dispatcher by moving the Sound Level slider

to the desired level.

7. Click Finish to apply changes and close the window.

Postrequisites: 

• Configure codecs for the audio processing. For details, see Managing Audio Codecs.

• Configure the SIP trunk or SIP account authentication. For details, see Configuring SIP Trunk Authentication and Managing SIP

Accounts.



151

SmartPTT Dispatcher Functionality Configuration Telephone Interconnect Settings

2.15.2 Managing Audio Codecs

Follow the procedure to activate/deactivate an audio codec or change its priority level.

Procedure: 

1. On the menu bar, click Settings (   ) → Telephone Interconnect → Telephone Interconnect.

The Telephone Interconnect window appears.

2. In the window that appears, open the Codec Settings tab.

3. Perform the desired action:

To activate or deactivate the audio codec, in the Available codecs table, in the Active column, select or clear the

corresponding check box.

NOTE

You must select the codecs that are supported by the PBX.

To change the audio codec priority, perform the following actions:

1. In the Available codecs table, click the desired audio codec.

2. To the right of the Available codecs table, click Raise priority ( 

 ) or Lower priority (   ) to raise or lower the codec priority

respectively.



152

SmartPTT Dispatcher Functionality Configuration Telephone Interconnect Settings

NOTE

The order of codecs determines their priority that will be used to

suggest codecs to connect to the PBX. For example, if the PBX does

not support the first codec, it will try the second one and so on.

4. Click Finish to save changes and close the Telephone Interconnect window.

2.15.3 Configuring SIP Trunk Authentication

Follow the procedure to configure SIP trunk authentication for incoming and outgoing calls.

Prerequisites: 

• Configure general Telephone Interconnect settings. For details, see Configuring General Telephone Interconnect Settings.

• From the PBX settings, obtain the credentials (username, password, and realm) to be used for authentication.

Procedure: 

1. On the menu bar, click Settings (   ) → Telephone Interconnect → Telephone Interconnect.

The Telephone Interconnect window appears.

2. In the window that appears, open the SIP Trunk Authentication tab.

3. On the SIP Trunk Authentication tab, perform the desired actions:



153

SmartPTT Dispatcher Functionality Configuration Telephone Interconnect Settings

To configure telephone subscriber authentication, in the Incoming Calls Authentication area, perform the following

actions:

1. Select the Enabled check box.

2. (Optional) In the Realm field, type the user group name the

telephone subscriber must belong to.

3. In the User Name field, type the name of the account to be

used for authentication.

4. In the Password field, type the password of the account

used for authentication. To view the entered password,

click the eye icon (   ). For security reasons, the

password will not be available for viewing in subsequent

sessions.

To configure SmartPTT Dispatcher calls authentication, in the Outgoing Calls Authentication area, perform the following

actions:

1. Select the Enabled check box.

2. (Optional) In the Realm field, type the user group name the

SmartPTT Dispatcher account belongs to.

3. In the User Name field, type the name of the SmartPTT

Dispatcher account in the PBX.

4. In the Password field, type the password of the SmartPTT

Dispatcher account in the PBX. To view the entered

password, click the eye icon (   ). For security reasons,

the password will not be available for viewing in

subsequent sessions.

4. Click Finish to apply changes and close the window.
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2.15.4 Managing SIP Accounts

Follow the procedure to add a new SIP account or activate/deactivate, edit, or delete an existing one.

Procedure: 

1. On the menu bar, click Settings (   ) → Telephone Interconnect → Telephone Interconnect.

The Telephone Interconnect window appears.

2. In the window that appears, open the SIP Accounts tab.

3. On the SIP Accounts tab, perform the desired action:

To add a new account, perform the following actions:

1. In the top part of the tab, click Add (   ).

The SIP Account window appears.



155

SmartPTT Dispatcher Functionality Configuration Telephone Interconnect Settings

2. In the SIP Account window, in the Username and SIP Server

fields, type your username and the desired PBX IP address.

3. (Optional) Complete other fields with desired information.

4. Click OK.

The new account appears in the table on the SIP Accounts tab.

To activate or deactivate an existing account, in the table, select or clear the check box in the Active column.

To edit an existing account, perform the following actions:

1. In the table, click the desired account, and then click Edit (   ),

or double-click the desired account.

The SIP Account window appears.

2. In the SIP Account window, edit the desired information, and

then click OK.

To delete an existing account, perform the following actions:

1. In the table, click the desired account, and then click Delete ( 

 ).

The Confirmation window appears.

2. In the Confirmation window, click OK.

The selected account is removed from the table.

4. Click Finish to save changes and close the Telephone Interconnect window.

2.16 Third-Party Solutions Configuration

SmartPTT Dispatcher provides the ability to integrate the following third-party solutions:

• Avigilon video monitoring system.

For information on Avigilon video monitoring system configuration, see Avigilon Configuration.

• AdapTel devices for telemetry data collection and processing.

For details, visit the AdapTel page of the SmartPTT website.

https://smartptt.com/products/adaptel/
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2.16.1 Avigilon Configuration

SmartPTT supports integration with the Avigilon video monitoring system. It helps dispatchers monitor what happens at various objects,

for example, when a radio sends an alarm, providing the ability to control the situation at these objects.

The Avigilon video monitoring system provides the ability to watch camera translations directly in SmartPTT. To watch live video from

cameras, perform the following actions:

• Install Avigilon Control Center Server 7 software. For details, see the Avigilon Control Center 7 Software web page on the Avigilon

website.

• Add cameras to the Avigilon system.

• Instal the corresponding license. For information on licenses, see Licenses.

• Connect SmartPTT to the Avigilon system in SmartPTT Radioserver Configurator. For details, see “Configuring Avigilon

Connection” in SmartPTT Installation and Configuration Guide.

• Add cameras on a map in SmartPTT Dispatcher. For details, see Adding Cameras.

Important

Cameras can be managed by the operators with the Manage cameras right. For details, see Operators.

NOTE

Video recording in the SmartPTT system is not available.

For information on watching real time video in the SmartPTT system, see Objects on Map.

2.16.2 Data Provider Configuration

In SmartPTT Dispatcher, you can integrate with data providers. After connection, data from sensors is displayed directly on the Data

provider panel.

To connect to the data provider, you must perform the following actions:

• Create a client account and configure connection settings in SmartPTT Radioserver Configurator. For details, see “Data Providers”

in SmartPTT Installation and Configuration Guide.

• Activate the data acquisition module and specify the data provider URL address. For details, see Activating Data Acquisition

Module.

Important

To use the feature in SmartPTT Dispatcher, the corresponding license is required.

For information on licenses, see Licenses.

Data Acquisition Features in SmartPTT

Data acquisition module provides the following capabilities in SmartPTT:

• Real-time equipment monitoring.

• Collecting data from IoT sensors, automated control systems, access monitoring and control systems, etc.

• Remote equipment control.

• Alarm and warning notifications.

• Web access from different devices (HMI panels, workstations, tablets).

• Displaying reports.

https://www.avigilon.com/products/acc/7#overview
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NOTE

At the moment, you can download reports only from the web version of the data provider app.

• Recording parameter changes and equipment states.

• Logging of events, operator actions, alarms, and warning signals.

• Configuring rules for events registered in the data provider system.

For information on rule configuration, see Custom Rules.

• Displaying data sources on a map. For details, see Objects on Map.

2.16.2.1 Activating Data Acquisition Module

Follow the procedure to activate the Data Acquisition module in SmartPTT Dispatcher.

Important

This procedure is available only to the Administrator.

Prerequisites: 

• Ensure that the corresponding license is installed. For details, see Licenses.

• Obtain the URL address of the data source that will be accessed through the Data Acquisition module in SmartPTT Dispatcher.
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Procedure: 

1. On the menu bar, click Settings (   ) → Interface → Data provider.

The Data provider window appears.

2. In the window that appears, select the Activate data acquisition module check box.

The URL address field becomes available.

3. In the URL address field, type the URL address of the data provider.

The URL address format is http://<IP address or domain name of the data provider host>:5000

4. Click Finish to save changes and close the window.

5. Restart SmartPTT Dispatcher to apply changes.

The Data provider option appears in the Tools menu on the menu bar.

Postrequisites: 

To open the Data provider panel, click Tools → Data provider on the menu bar.
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2.17 Dispatcher List Configuration

SmartPTT Dispatcher provides the ability to communicate with other operators of the SmartPTT system. You can add other dispatchers

and edit their settings in the Dispatchers window of the SmartPTT Dispatcher Settings (   )  menu. The window is available only to the

Administrator.

In the Dispatchers window, you can perform the following actions:

• Configure SmartPTT Dispatcher settings for communication with other dispatchers. For details, see Configuring Dispatcher

Settings.

• Add contacts of other dispatchers. For details, see Adding Dispatcher Contacts.

• Manage added dispatchers contacts.

Important

To communicate with other dispatchers, an operator must have the Connect with external dispatchers right. If the operator does not

have this permission, the Dispatchers (   ) button will be disabled in the SmartPTT Dispatcher menu bar. If no dispatchers are added

to SmartPTT Dispatcher, this button will also be disabled.

For information on user roles in SmartPTT Dispatcher, see Operators.

For additional information on initiating calls between dispatchers, see Dispatchers.
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2.17.1 Configuring Dispatcher Settings

Follow the procedure to configure the SmartPTT Dispatcher settings for communicating with other dispatchers.

Prerequisites: 

Obtain UDP and TCP ports of your SmartPTT Dispatcher computer.

Procedure: 

1. On the menu bar, click Settings (   ) → Dispatchers.

The Dispatchers window appears.

2. In the window that appears, in the VoIP port field, type the UDP port of the current dispatcher computer.

3. In the Session port field, type the TCP port of the current dispatcher computer.

4. (Optional) Select the Play sound alert for incoming call check box for playing a tone in case of incoming dispatcher calls.

5. (Optional) Select the Play sound alert for outgoing call check box for playing a tone in case of outgoing dispatcher calls.

6. Add contacts of the desired dispatchers. For details, see Adding Dispatcher Contacts.

7. Click Finish to close the window.
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Postrequisites: 

• To edit the desired dispatcher, select the entry in the Dispatchers table, and then click Edit (   ).

• To delete the desired dispatcher, select the entry in the Dispatchers table, and then click Delete (   ).

2.17.2 Adding Dispatcher Contacts

Follow the procedure to add a new dispatcher contact.

Prerequisites: 

Obtain another dispatcher IP address, UDP, and TCP ports.

Procedure: 

1. On the menu bar, click Settings (   ) → Dispatchers.

The Dispatchers window appears.

2. In the window that appears, click Add (   ).

The Dispatcher window appears.
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3. In the window that appears, in the Name field, type the dispatcher name.

4. In the Address field, specify the dispatcher IP address.

5. In the VoIP port field, specify the UDP port of the dispatcher computer.

6. In the Session port field, specify the TCP port of the dispatcher computer.

7. (Optional) In the left part of the window, click Select, and then in the window that appears, select the avatar for the dispatcher.

8. (Optional) Click Browse (   ), and then in the window that appears, select a tone for incoming dispatcher calls.

9. Click OK to save the changes and close the window.

The added dispatcher appears in the Dispatchers Table.

Postrequisites: 

• To delete the dispatcher avatar, click Clear the image of the dispatcher.

• To set the default call alert, click Use a system sound.

2.18 Rules and Lone Worker Mode

SmartPTT Dispatcher provides the ability to configure rules. A rule is a combination of preconfigured conditions and actions. When the

system has registered an event matching the specified rule, the rule triggers, and the system performs preconfigured actions.

Important

Rules configuration is available to the Administrator or to operators with the corresponding permission. For details, see Operators.

SmartPTT Dispatcher provides the following rules:

• Custom rules. For details, see Custom Rules.

• Positioning rules. For details, see Positioning Rules.

• Lone Worker rules. For details, see Lone Worker Rules.

When the specified conditions are met, SmartPTT Dispatcher can perform the following actions directed at DMR radios:

• Block a radio.

• Assign the Lone Worker profile.

• Enable the Man Down mode.
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• Send a text message.

Furthermore, the following actions can be configured in SmartPTT Dispatcher:

• Play a special sound.

• Display the radio or point of interest location.

• Change a radio status.

• Send an alert.

For information on SmartPTT Dispatcher action configuration, see Rule Management.

To see the examples for custom, positioning and lone worker rules, see Examples.

Man Down

Rules provide the ability to enable or disable the Man Down mode if the specified event will happen. The Man Down feature receives radio

position data from its sensor. If the radio is tilted, SmartPTT Dispatcher will display the Man Down capture on the radio element of the

Radio panel or Custom Console. This feature can be useful, for example, if the radio user fell after some accident. For details, see

Configuring Initiator Alerts.

Important

The rule for activating the Man Down option will only work on radios with the Generic Option Board (GOB) and only in the IP Site

Connect radio network with a direct connection to repeaters. The rules for activating Man Down do not apply if data is transmitted via

the NAI interface, as well as if you use radios with the integrated Man Down function.

If the radio has an optional GOB board, you can configure the Man Down option with the help of SmartPTT GOB Configurator.

If the radio does not have the optional GOB board, you can configure the Man Down option with the help of Radio Management (create a

profile, enable Man Down and Emergency).

2.18.1 Custom Rules

Custom rules are used to automatically notify dispatchers, radios, and other recipients.

NOTE

Custom rules are not available for SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

Rules can also be configured in SmartPTT Radioserver Configurator. For information on rule configuring in the SmartPTT system, see

“Rules” in SmartPTT Installation and Configuration Guide.

For information on configuring the custom rules, see the sections below.

2.18.1.1 Custom Rule Conditions

Rule conditions are set of logical expressions that consist of the following elements:

• Attribute (for example, Event Type). For details, see Condition Attributes.

• Operation (for example, Equal to). For details, see Condition Operations.

• Value (for example, Call).

Each rule can have several expressions. For example, one rule can consist of the “Incoming Call” and “Incoming Message” expressions.

To trigger a rule, all attributes must match the event.
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SmartPTT does not prevent users from invalid conditions configuration. For example, it does not prevent users from configuring the

“Outgoing ARS” condition.

2.18.1.1.1 Condition Attributes

The following attributes are provided for conditions:

Attribute Description

Direction The event direction can be Incoming (events are addressed to SmartPTT Dispatcher) or

Outgoing (events are initiated by SmartPTT Dispatcher).

To select the desired direction, you need to set the Equal to value in the Operation column.

The No value causes the attribute to be ignored.

Event type The list of available event types.

• Registration — radio registration or de-registration.

• Call — group or private voice call (including emergency call) or voice notification or the

Remote Monitor voice.

• Message — text message.

• Telemetry — telemetry information and/or remote control command.

• Alarm — incoming emergency alarm.

• Status — events related to the radio status change in the SmartPTT system.

• Block Radio — Block Radio or Unblock Radio command.

• Job Ticket — events concerning sending special assignments to radios or talkgroups.

• Lone Worker — events related to the assignment of Lone Worker profiles to a radio.

• User Authorization — radio user signs in or signs out from the radio.

• Radio Check — events concerning sending the Radio Check command.

• Temporary Talkgroup — events concerning temporary talkgroups in the SmartPTT

system.

• Dynamic Group — events concerning dynamic groups in the SmartPTT system.

To select the desired event type, you need to set the Equal to value, or the Not Equal to value

in the Operation column.

The No value causes the attribute to be ignored.

Date/Time The date interval, when the rule can be triggered.

To select the desired date period, you need to set the Between value in the Operation column.

If the dates are not selected, the rule will be triggered without reference to dates.

The No value causes the attribute to be ignored.

Important

For the Date/Time attribute it is possible to select only date without time.
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Attribute Description

Additional information You can type the information corresponding to the event type, or leave the box empty. For

example:

• Alarm — the date and time when the alarm was received and the operator name who

received it.

For data sources, the parameter that reported the alarm state.

• Call — the identifiers of call initiators, or operator name.

• Dynamic Group — information on operator actions related to a dynamic group.

• Job Ticket — the job ticket number, name, and description.

• Lone Worker — empty column at activating/deactivating lone worker profile. The

column is filled when the profile changes.

• Message — the message text.

• Radio Check — empty column.

• Registration — empty column.

• Status — changing of the radio status.

• Telemetry — the description of telemetry action set in telemetry settings.

Additional information is displayed in the Event Log in the Additional Information column.

To type information, you need to set the Equal to value, or the Contains value in the Operation

column.

The No value causes the attribute to be ignored.

Not read The message status: Read, or Not read that triggered the rule.

To select the desired message status, you need to set the Equal to value in the Operation

column.

The No value causes the attribute to be ignored.

Operator The name of the operator who participates in the event.

To select the desired name, you need to set the Equal to value, or the Not Equal to value in the

Operation column.

The No value causes the attribute to be ignored.

Radioserver The radioserver name where the rule is triggered.

To select the desired radioserver, you need to set the Equal to value, or the Not equal to value

in the Operation column.

The No value causes the attribute to be ignored.

Channel The channel name where the rule is triggered.

To select the desired channel, you need to set the Equal to value, or the Not equal to value in

the Operation column.

The No value causes the attribute to be ignored.

Radio The name of the radio that participates in the event.

To select the desired radio, you need to set the Equal to value, or the Not equal to value in the
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Attribute Description

Operation column.

The No value causes the attribute to be ignored.

Talkgroup The name of the talkgroup that receives a voice or another transmission.

To select the desired talkgroup, you need to set the Equal to value, or the Not equal to value in

the Operation column.

The No value causes the attribute to be ignored.

Status The event status from the list of statuses.

To select the desired status, you need to set the Equal to value, or the Not equal to value in

the Operation column.

The No value causes the attribute to be ignored.

Duration The event duration in seconds.

To type the desired duration, you need to set one of the values in the Operation column.

The No value causes the attribute to be ignored.

Connection Type The list of available connection types:

• DMR: Over-the-air connection made via repeaters and control stations.

• IP: Dispatcher-Dispatcher connection.

• PBX: Telephone connection.

To select the desired connection type, you need to set the Equal to value, or the Not equal to

value in the Operation column.

The No value causes the attribute to be ignored.

Destination The name of the recipient that participates in the event.

To select the desired connection type, you need to set the Equal to value, or the Not equal to

value in the Operation column.

The No value causes the attribute to be ignored.

Record The call record availability: Recorded, or Not recorded.

To select the desired value, you need to set the Equal to value in the Operation column.

The No value causes the attribute to be ignored.

User The name of the authorized radio user that participates in the event.

To select the desired user, you need to set the Equal to value, or the Not equal to value in the

Operation column.

The No value causes the attribute to be ignored.

Data source The data source from the list of data sources added to SmartPTT Dispatcher.

To select the desired data source, you need to set the Equal to value in the Operation column.

The No value causes the attribute to be ignored.

NOTE

If a data source is deleted from the SmartPTT Dispatcher list of data sources, or if it is

currently unavailable, the rules that affect it are not deleted.
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Attribute Description

Data Source Alarm The data source parameter capable of indicating alarm states.

To select the desired alarm, you need to set the Equal to value in the Operation column.

The No value causes the attribute to be ignored.

NOTE

This attribute is not set without selecting a data source.

2.18.1.1.2 Condition Operations

The following operations are available for attributes:

Attribute Equal to Not equal to Between Contains

Direction YES

Event Type YES YES

Date/Time YES

Additional

Information

YES YES

Not read YES

Operator YES YES

Radioserver YES YES

Channel YES YES

Talkgroup YES YES

Radio YES YES

User YES YES

Status YES YES

Duration YES YES YES

Connection Type YES YES

Destination YES YES

The following operations are only available for the Duration attribute:

• Greater than

• Greater than or equal to

• Less than
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• Less than or equal to

2.18.1.2 Adding and Editing Custom Rules

Follow the procedure to add a new custom rule or edit an existing one.

Prerequisites: 

Ensure the operator has the Manage Custom Rules right.

For information on operator rights, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Rules → Custom Rules.

The Custom Rules window appears.

2. In the window that appears, perform one of the following actions:

To add a new custom rule, in the top part of the window, click Add (   ).

To edit an existing rule, in the Custom Rules Table, select the desired rule, and then

click Edit (   ).

 The Rule Settings window appears.
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3. (Optional) In the window that appears, select or clear the Active check box for activating or deactivating an existing rule.

4. In the Name field, type the rule name.

5. In the Conditions table, set the desired rule conditions:

a. In the Attribute column, select the desired attribute.

b. In the Operations column, select the desired operation.

c. In the Value 1 column, set the desired value.

d. If required, set the desired values in the Value 2 and Value 3 columns.

NOTE

Some fields in the Value 2 and Value 3 columns are impossible to fill.

6. In the Actions area, configure actions that will be performed when the rule is triggered:

To configure alerts addressed to the event initiator, see Configuring Initiator Alerts.

To configure alerts addressed to the dispatcher, see Configuring Dispatcher Alerts.

To configure sending messages to a list of recipients, see Configuring Radio Alerts.

To configure sending messages using web, SMS, or E-mail

services,

see Configuring Other Services.
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7. Click OK to save changes and close the window.

The configured rule appears in the Custom Rules window.

8. Click Finish to close the Custom Rules window.

Postrequisites: 

For information on activating, deactivating, or deleting a rule, see Managing Custom Rules and Positioning Rules.

2.18.2 Positioning Rules

In SmartPTT Dispatcher, you can set rules for GPS and Indoor events registered in the SmartPTT system. These events include receiving

(or not receiving for a specified period) GPS coordinates from the radio or positioning data from beacons.

A positioning rule is a combination of the following components:

• Type (for example, No radio/mobile client movement). For details, see Positioning Rule Types.

• Conditions (for example, All Radios and Time period with no motion detected (min)). For details, see Positioning Rule Conditions.

• Actions (for example, Alert). For details, see Rule Management.

2.18.2.1 Positioning Rule Types

The following types are available for positioning rules:

Type Description

No radio/mobile client movement The rule type triggers when the radio or SmartPTT Mobile user

coordinates are not changed for a specified time.

Location data received The rule type triggers if the radio sends its coordinates after a

specified time without coordinates updates.

No location data The rule type triggers when SmartPTT Dispatcher does not receive

valid radio coordinates for a period longer than the specified one.

Zone/route entry The rule type triggers when the radio enters the specified zone or

route, i.e. the previous radio coordinates were outside this zone or

route, and the current coordinates are within it.

Zone/route exit The rule type triggers when the radio leaves the specified zone or

route.

Speeding The rule type triggers when the specified speed is exceeded based

on the received GPS data.

NOTE

The rule type is only available for GPS rules. It is not applicable

to SmartPTT Mobile users.

Number of radios/mobile clients in geofences / on routes The rule type triggers when the number of radios or SmartPTT

Mobile users in geofences / on routes meets the specified

condition.
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Type Description

Proximity Alerts The rule type triggers when any radio approaches the selected

radios, users, categories, or mobile clients to the specified

distance. For details, see Proximity Alerts Rule.

2.18.2.1.1 Proximity Alerts Rule

Heavy vehicles, such as haul trucks and loaders, have large blind spots that can prevent their drivers from noticing other vehicles or

people. This can lead to collisions and fatal accidents.

In SmartPTT Dispatcher, the Proximity Alerts rule provides the ability to configure actions in case workers, machines, or vehicles are too

close for safe operation. You can select radios that will be considered dangerous to approach (for example, radios inside haul trucks),

specify a dangerous distance to them, and configure notifications for dispatchers, participants of the dangerous proximity event, and any

other radios. You can also configure geofences to make the rule work only within the selected areas.

The radius of dangerous distance can be displayed on a map as a colored circle around the selected objects to provide the ability to

monitor radios near dangerous objects in real time. You can configure several dangerous proximity rules with different dangerous

distances for the same object. These distances will be displayed as circles of various radii around the dangerous object.

You can also configure different notifications and actions for each rule. For example, you can configure to send a warning sound when

any radio is within 250 m from the dangerous object, and an alarm sound when it approaches the dangerous object to 150 m.

Example
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2.18.2.2 Positioning Rule Conditions

Conditions may vary depending on the selected rule type. The table contains descriptions of the conditions used for positioning rules:

Condition Description

All Radios

Select Radios

Select Users

Select Categories

Select Mobile Clients

This condition provides the ability to select all radios, specific

radios, authorized users, categories, or mobile clients to apply the

rule.

NOTE

When selecting the All Radios, Select Radios, Select Users,

Select Categories conditions, SmartPTT Mobile users are not

taken into account.

NOTE

If the Select Mobile Clients condition is selected, the Initiator

Alert and Radio Alert tabs are not available.

Time period with no motion detected (min) The period during which a radio stays in one place (min).

Time period before receiving location data (min) The period after which radio coordinates are received again (min).

Time period with no location data received (min) The period when no radio coordinates are received (min).

Geofences

Routes

This condition provides the ability to select geofences or routes.

Speeding This condition provides the ability to specify maximum speed. The

rule triggers when the speed is exceeded. It is possible to select

such units as meters per second, kilometers per hour, and knots.

NOTE

If you select the Select Area check box and specify geofences or

routes, the rule will only apply when the speed is exceeded in the

specified geofences or on the routes.

Number of radios/mobile clients in geofences/on routes This condition provides the ability to specify the number of radios

or SmartPTT Mobile users in geofences or on routs and select a

condition under which the rule will be triggered. The number of

radios or SmartPTT Mobile users can be less than, less than or

equal to, greater than, greater than or equal to a given value.

Notify constantly When this check box is selected, the dispatcher will constantly

receive notifications as long as the rule is triggered. If the check

box is cleared, the dispatcher will be notified once.

Notify about new location When this check box is selected, the dispatcher will be notified if

the radio moves to a new location.
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Condition Description

Distance to object (m) The distance to the selected dangerous objects. When any radio

approaches to the specified distance or closer, the rule triggers.

Show on map When this check box is selected, the area of dangerous proximity

will be displayed on a map as a circle. You can select the color of

the dangerous proximity area from the menu to the right of the

check box.

2.18.2.3 Adding and Editing Positioning Rules

Follow the procedure to add a new positioning rule or edit an existing one.

Prerequisites: 

Ensure the operator has the Manage Positioning Rules right. For information on operator rights, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Rules → Positioning Rules.

The Positioning Rules window appears.

2. In the Positioning Rules window, perform one of the following actions:

To add a new positioning rule, in the top part of the window, click Add (   ).

To edit an existing positioning rule, in the Positioning Rules Table, click the desired rule, and

then click Edit (   ).

 The Positioning Rule window appears.

3. (Optional) In the window that appears, select or clear the Active check box to activate or deactivate the rule.

4. In the Name field, type the rule name.

5. Select GPS or Indoor for using the corresponding data.

6. From the Type list, select the type of the rule.

7. In the Conditions area, set the desired rule conditions.

To configure conditions for the No radio/mobile

client movement rule type,

perform the following actions:

1. Select All radios or specific radios, authorized users, SmartPTT

Mobile users, or categories.

2. In the Time period with no motion detected (min) field, set a time

period in minutes during which a radio stays in one place.

3. (Optional) Select the Notify constantly or Notify about new

location check box to receive the corresponding notifications.

To configure conditions for the Location data

received rule type,

perform the following actions:

1. Select All radios or specific radios, authorized users, SmartPTT

Mobile users, or categories.
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2. In the Time period before receiving location data (min) field, set a

time period in minutes after which radio coordinates are received

again.

To configure conditions for the No location data

rule type,

perform the following actions:

1. Select All radios or specific radios, authorized users, SmartPTT

Mobile users, or categories.

2. In the Time period with no location data received (min) field, set a

time period in minutes when no coordinates are received.

3. (Optional) Select the Notify constantly or Notify about new

location check box to receive the corresponding notifications.

To configure conditions for the Zone/route entry

rule type,

perform the following actions:

1. Select All radios or specific radios, authorized users, SmartPTT

Mobile users, or categories.

2. Select Geofences or Routes.

3. Click Select geofences/routes (   ) and select objects. The rule

triggers when the radio enters the specified zone or route.

To configure conditions for the Zone/route exit

rule type,

perform the following actions:

1. Select All radios or specific radios, authorized users, SmartPTT

Mobile users, or categories.

2. Select Geofences or Routes.

3. Click Select geofences/routes (   ) and select objects. The rule

triggers when the radio exits the specified zone or route.

To configure conditions for the Speeding rule

type,

perform the following actions:

1. Select All radios or specific radios, authorized users, or

categories.

2. In the Speeding field, set maximum speed. The rule triggers if the

speed is exceeded. It is possible to select such units as meters

per second, kilometers per hour, and knots.

3. (Optional) Select Select Area check box and specify geofences or

routes where the rule triggers.

To configure conditions for the Number of

radios/mobile clients in geofences / on routes rule

type,

perform the following actions:

1. Select All radios or specific radios, authorized users, SmartPTT

Mobile users, or categories.

2. For the Number of radios/mobile clients in geofences/on routes

condition, set the number of radios in geofences / on routes and

select a condition under which the rule will be triggered.

3. Select Geofences or Routes.

4. Click Select geofences/routes (   ) and select the desired

objects.
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To configure conditions for the Proximity alerts

rule type,

see Configuring Proximity Alerts Rule.

8. In the Actions area, configure actions that will be performed when the rule is triggered:

To configure alerts addressed to the event initiator, see Configuring Initiator Alerts.

NOTE

This action is not available for SmartPTT Mobile users. For

information on the mobile application, see “SmartPTT

Mobile” in SmartPTT Installation and Configuration Guide.

To configure alerts addressed to the dispatcher, see Configuring Dispatcher Alerts.

To configure sending messages to a list of recipients, see Configuring Radio Alerts.

NOTE

This action is not available to SmartPTT Mobile users.

To configure sending messages using web, SMS, or e-mail

services,

see Configuring Other Services.

9. Click OK to save changes and close the window.

The configured rule appears in the Positioning Rules window.

10. Click Finish to close the Positioning Rules window.

Postrequisites: 

For information on subsequent activating, deactivating, or deleting a rule, see Managing Custom Rules and Positioning Rules.

2.18.2.3.1 Configuring Proximity Alerts Rule

Follow the procedure to configure the proximity alerts rule.

Prerequisites: 

• Ensure the operator has the Manage Positioning Rules right. For information on operator rights, see Operators.

• (Optional) Configure the category for dangerous objects. For details, see Managing Categories.

• (Optional) Configure geofences. For details, see Geofences.
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Procedure: 

1. On the menu bar, click Settings (   ) → Rules → Positioning Rules.

The Positioning Rules window appears.
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2. In the window that appears, at the top of the window, click Add (   ).

The Positioning Rule window appears.

3. In the window that appears, select the Active check box to activate the rule.

4. In the Name field, type the rule name.

5. Select GPS to use geopositioning data.

6. From the Type list, select Proximity alerts.

7. Select specific radios, authorized users, SmartPTT Mobile users, or categories that are considered dangerous to approach.

8. In the Distance to object (m) field, type the distance value that will trigger the rule when any radio approaches within this distance

to the dangerous object.

9. (Optional) To receive notifications constantly when the object is within the dangerous proximity area, select the Notify constantly

check box.

10. (Optional) To display the dangerous proximity area as a circle around the dangerous object on a map, select the Show on map

check box. You can select the color of the dangerous proximity area from the menu to the right of the check box.
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11. (Optional) To make the rule trigger only within specific geofences, click Select geofences (   ), and then select the desired

geofences.

12. In the Actions area, configure actions that will be performed when the rule is triggered:

To configure the initiator notification, see Configuring Initiator Alerts.

To configure the dispatcher notification, see Configuring Dispatcher Alerts.

To configure sending messages to a list of recipients, see Configuring Radio Alerts.

NOTE

This action is not available for SmartPTT Mobile users.

To configure sending messages using web, SMS, or e-mail

services,

see Configuring Other Services.

13. Click OK to save changes and close the window.

The configured rule appears in the Positioning Rules window.

14. Click Finish to close the Positioning Rules window.

Postrequisites: 

For information on subsequent activation, deactivation, or deleting a rule, see Managing Custom Rules and Positioning Rules.

2.18.3 Lone Worker Rules

SmartPTT Dispatcher supports the Lone Worker mode for DMR radios. The Lone Worker profile is a set of rules that are applied when

the specified conditions are met. SmartPTT supports multiple profile creation, so you can assign its own profile for each radio.

The Lone Worker mode provides the ability to automatically track the following conditions:

• Absence of calls from a radio during the specified period

• Absence of GPS coordinates from a radio during the specified period

• No change in location of a radio during the specified period

When one of the conditions triggers, SmartPTT Dispatcher sends alerts to the radio or performs configured actions. The following alerts

are available for Lone Worker rules:

• Text messages

• Audio messages

• Call alerts

For information on the Lone Worker rules action configuration, see Rule Management.

Lone Worker profiles are assigned to the desired radios in the Radio Properties window. For details, see Configuring General Radio

Parameters.

All radios with assigned Lone Worker profiles are displayed on the Lone Workers panel.

For information on configuring the Lone Worker profile, see the section below.
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Tallysman

In the Lone Worker window, you can set the condition based on the Tallysman Sprite™ TW251 option board data.

If the No heartbeat messages (s) check box is selected in the window, the actions configured for the profile are executed when the radio

built-in option board does not send information on the radio presence in the network during the specified period (in seconds).

NOTE

For the condition to be triggered, the radio must have the built-in Tallysman option board that is configured properly, and the

Tallysman feature must be enabled in SmartPTT Radioserver Configurator. For details, see “Location with Option Boards” in

SmartPTT Installation and Configuration Guide.

2.18.3.1 Managing Lone Worker Profiles

Follow the procedure to add a new Lone Worker profile or edit an existing one.

Prerequisites: 

Ensure the operator has the Manage lone worker rules right.

For information on operator rights, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → Lone Worker Rules.

The Lone Worker window appears.
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2. In the window that appears, perform one of the following actions:

To add a new profile, in the top part of the window, click Add (   ).

The Profile Settings window appears.

To edit an existing profile, in the Lone Worker Profiles Table, select the desired profile, and

then click Edit (   ).

The Profile Settings window appears.

To delete an added profile, perform the following actions:

1. In the table, select the desired profile, and then click

Delete (   ).

NOTE

The default profile cannot be deleted.

2. In the confirmation window, click OK.

The profile is deleted from the table.

3. Proceed to the last step of the procedure.

3. In the Profile Settings window, in the Name field, type the profile name.
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4. In the Conditions area, configure the desired conditions to perform actions:

To perform actions when SmartPTT Dispatcher

does not receive any calls from the radio,

perform the following actions:

1. Select the No calls (min) check box.

2. In the field to the right of the check box, specify the desired time

in minutes. If the radio does not make a call during this time, the

profile actions will be performed.

To perform actions when SmartPTT Dispatcher

does not receive any location data from the radio,

perform the following actions:

1. Select the No location data received (min) check box.

2. In the field to the right of the check box, specify the desired time

in minutes. If the radio does not send its GPS or Indoor data

during this time, the profile actions will be performed.

To perform actions when location data is not

changed,

perform the following actions:

1. Select the No change in location data (min) check box.
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2. In the field to the right of the check box, specify the desired time

in minutes. If the radio does not change its GPS or Indoor data

during this time, the profile actions will be performed.

NOTE

The No change in location data condition must be used together with

the No location data received condition.

5. (Optional) Configure sending alerts to the radio:

a. In the Radio Alert area, configure the alerts that will be sent to the radio after one of the conditions is met:

To send a text message to the radio, perform the following actions:

1. Select the Text Message check box.

2. In the field to the right of the check box, type the

message text.

To send an audio message to the radio, perform the following actions:

1. Select the Audio Message check box.

2. Click Record and speak into the microphone.

3. Click Stop after you finished speaking.

4. (Optional) Click Play to listen to the recorded message.

5. (Optional) Click Delete to delete the added message and

record a new one.

To send the Call Alert command to the radio, select the Call Alert check box.

b. In the Actions delay (min) field, specify the time in minutes after sending an alert when actions will be performed if the radio

is still inactive.

6. In the Actions area, configure actions that will be performed when one of the conditions is met:

To configure alerts addressed to the event initiator, see Configuring Initiator Alerts.

To configure alerts addressed to the dispatcher, see Configuring Dispatcher Alerts.

To configure sending messages to a list of recipients, see Configuring Radio Alerts.

To configure sending messages using web, SMS, or e-mail

services,

see Configuring Other Services.

7. Click OK to save changes and close the window.

The configured profile appears in the Lone Worker window.

8. Click Finish to close the Lone Worker window.

Postrequisites: 

 Assign the profile to the desired radios. For details, see Configuring General Radio Parameters.
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2.18.4 Rule Management

Managing rules includes the following actions:

• Configuring alerts addressed to the event initiator. For details, see Configuring Initiator Alerts.

• Configuring alerts addressed to the dispatcher. For details, see Configuring Dispatcher Alerts.

• Configuring sending messages to the desired recipients in SmartPTT. For details, see Configuring Radio Alerts.

• Configuring sending messages using web, SMS, or E-mail services. For details, see Configuring Other Services.

• Configuring the message format. For details, see Configuring Message Format.

• Activating, deactivating, and deleting the existing custom and positioning rules. For details, see Managing Custom Rules and

Positioning Rules.

2.18.4.1 Configuring Initiator Alerts

Follow the procedure to configure alerts addressed to the event initiator and performed when the rule is triggered.

Prerequisites: 

• Set the desired conditions that will trigger the rule.

• (Optional) Ensure that the Lone Worker profile is configured.

For information on the Lone Worker mode, see Managing Lone Worker Profiles.

Procedure: 

1. In the Rules Settings or Positioning Rule window, in the Actions area, open the Initiator Alert tab.

2. On the Initiator Alert tab, perform one of the following actions:

To select an audio file to play when the rule is triggered, perform the following actions:

1. Select the Play Sound check box.

2. To the right of the check box, click Select Sound File ( 

 ).

The Sound File Selection window appears.
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3. In the Sound File Selection window, select the desired

audio file, and then click Open.

The path to the audio file appears in the field to the right of

the Select Sound File (   ) button.

To block the radio when the rule is triggered, select the Block Radio check box.

To activate/deactivate the Lone Worker mode for the

radio when the rule is triggered,

perform the following actions:

1. Select the Lone Worker check box.

2. Select On or Off to activate or deactivate the mode.

3. If the On option is selected, select the desired Lone

Worker profile from the list to the right of the option.

To activate/deactivate the Man Down mode for the radio

when the rule is triggered,

perform the following actions:

1. Select the Man Down check box.

2. Select On or Off to activate or deactivate the mode.

To send a message to the event initiator when the rule is

triggered,

perform the following actions:

1. Select the Message check box.

2. To the right of the check box, in the Message field, type a

message text.

3. (Optional) Configure the message format on the Message

Format tab. For details, see Message Format.

NOTE

The Message Format tab is only available in the Rule Setting

window.

Postrequisites: 

For information on configuring other actions in the Actions area, see Configuring Dispatcher Alerts, Configuring Radio Alerts, Configuring

Other Services.

2.18.4.2 Configuring Dispatcher Alerts

Follow the procedure to configure alerts addressed to the dispatcher that will be performed when the rule is triggered.

Prerequisites: 

• Set the desired conditions that will trigger the rule.

• (Optional) Depending on the desired settings, perform the following actions:

• Ensure that the desired audio files are available on your PC.

• Ensure that the desired points of interests are added to SmartPTT Dispatcher.

• Ensure that the desired statuses are added to SmartPTT Dispatcher.

Procedure: 

1. In the Rule Settings or Positioning Rule window, in the Actions area, open the Dispatcher Alert tab.
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2. On the Dispatcher Alert tab, perform one of the following actions:

To select an audio file to play when the rule is

triggered,

perform the following actions:

1. Select the Play Sound check box.

2. To the right of the check box, click Select Sound File (   ).

The Sound File Selection window appears.

3. In the Sound File Selection window, select the desired audio file,

and then click Open.

The path to the audio file appears in the field to the right of the

Select Sound File (   ) button.

To show the event initiator on the currently open

map when the rule is triggered,

perform the following actions:

1. Select the Show on Map check box.

2. Select one of the following options:

• Select radio/mobile client to show the radio or SmartPTT

Mobile user on the map.

NOTE

Displaying a mobile client on the map can only be configured for

positioning rules.

• Select point of interest to show the point of interest on the

map.

3. If the point of interest option is selected, select the desired point

of interest from the list to the right of the option.

Important

The object will not be displayed on a map if the map is not open in

SmartPTT Dispatcher.

To assign status to the event initiator when the

rule is triggered,

perform the following actions:

1. Select the Set Radio/Mobile Client Status check box.

NOTE

The mobile client status can only be configured for positioning rules.
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2. To the right of the check box, select the desired status from the

list of statuses.

To display the notification on the Notifications

panel when the rule is triggered,

perform the following actions:

1. Select the Alert check box.

2. To the right of the check box, in the Alert Caption field, type an

alert title.

3. To the right of the check box, in the Alert Text field, type an alert

text.

Postrequisites: 

For information on configuring other actions in the Actions area, see Configuring Initiator Alerts, Configuring Radio Alerts, Configuring

Other Services.

2.18.4.3 Configuring Radio Alerts

Follow the procedure to configure sending messages to a preconfigured list of recipients when the rule is triggered.

Prerequisites: 

• Set the desired conditions that will trigger the rule.

• Ensure that the desired recipients are available in SmartPTT Dispatcher.

Procedure: 

1. In the Rule Settings or Positioning Rule window, in the Actions area, open the Radio Alert tab.

2. On the Radio Alert tab, select the Send Message check box.

3. Specify a list of desired recipients:

To send a message to radios when the rule is triggered, perform the following actions:

1. To the right of the Radios option, click Open Radio List ( 

 ).

The Radios window appears.

2. Select the desired radios from the list.
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3. Click OK to save the changes and close the window.

To send a message to authorized users when the rule is

triggered,

perform the following actions:

1. To the right of the Users option, click Select From List ( 

 ).

The Users window appears.

2. Select the desired users from the list.

3. Click OK to save the changes and close the window.

To send a message to talkgroups when the rule is

triggered,

perform the following actions:

1. To the right of the Talkgroups option, click Select From

List (   ).

The Talkgroups window appears.

2. Select the desired talkgroups from the list.

3. Click OK to save the changes and close the window.

To send a message to radios that belong to the

specified category when the rule is triggered,

perform the following actions:

1. To the right of the Categories option, click View List of

Categories (   ).

The Categories window appears.

2. Select the desired categories from the list.

3. Click OK to save the changes and close the window.

 The selected recipients appear in the field to the right of the options.

4. In the Message field, type a message text.

5. (Optional) Configure the message format on the Message Format tab. For details, see Configuring Message Format.

NOTE

The Message Format tab is only available in the Rule Setting window for custom rule configuration.

Postrequisites: 

For information on configuring other actions in the Actions area, see Configuring Initiator Alerts, Configuring Dispatcher Alerts,

Configuring Other Services.

2.18.4.4 Configuring Other Services

Follow the procedure to configure sending messages using web, SMS, or E-mail services when the rule is triggered.

Prerequisites: 

• Set the desired conditions that will trigger the rule.

• (Optional) Depending on the desired settings, perform the following actions:

• Obtain the third-party server address to send HTTP request to.

• Ensure that the desired statuses are added to SmartPTT Dispatcher.

• Obtain the e-mail addresses or phone numbers to send a message to.
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• Obtain the desired radioserver name.

Procedure: 

1. In the Rule Settings or Positioning Rule window, in the Actions area, open the Other tab.

2. On the Other tab, perform one of the following actions:

To notify a third-party server about changing the radio

status when the rule is triggered,

perform the following actions:

1. Select the HTTP Request check box.

2. In the field to the right of the check box, type the desired

request.

To send an e-mail when the rule is triggered, perform the following actions:

1. Select the E-mail check box.

2. To the right of the check box, from the Radioserver list,

select the desired SmartPTT Radioserver.

3. In the E-mail field, type one or several electronic

addresses for sending messages.

Use semicolons to separate multiple e-mail addresses.

4. In the Message field, type a message text.

To send SMS when the rule is triggered, perform the following actions:

1. Select the SMS check box.

2. To the right of the check box, from the Radioserver list,

select the desired SmartPTT Radioserver.

3. In the Phone Numbers field, type one or several telephone

numbers for sending SMS.

Use semicolons to separate multiple phone numbers.

4. In the Message text field, type a message text.

3. (Optional) Configure the message format on the Message Format tab. For details, see Configuring Message Format.

NOTE

The Message Format tab is only available in the Rule Setting window for custom rule configuration.
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Postrequisites: 

For information on configuring other actions in the Actions area, see Configuring Initiator Alerts, Configuring Dispatcher Alerts,

Configuring Radio Alerts.

2.18.4.5 Configuring Message Format

Follow the procedure to configure the message format (text message, SMS or e-mail) sent when the custom rule is triggered.

Important

The Message Format tab is available only when configuring a custom rule in the Rule Settings window. For details, see Adding and

Editing Custom Rules.

Prerequisites: 

• Configure the desired criteria for triggering a custom rule.

• Configure the list of recipients on the Initiator Alert tab, Radio Alert tab, or Other tab. For details, see Configuring Initiator Alerts,

Configuring Radio Alerts, or Configuring Other Services.

Procedure: 

1. In the Rule Settings or Positioning Rule window, in the Actions area, open the Message Format tab.

2. On the Message Format tab, perform one of the following actions:

To specify the type of event in messages, select the Event Type check box.

To specify the date and/or time in messages, perform the following actions:

1. Select the Date/Time check box.

2. From the list, select the desired value:

a. To specify the date and time, select Date/Time.

b. To specify time only, select Time.

3. (Optional) To specify the time zone in messages, select the

Time Zone check box.

To specify the last recorded coordinates of a radio in

messages,

perform the following actions:

1. Select the Coordinates check box.
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2. From the list, select the format for displaying the

coordinates:

a. To display degrees in a fractional format, select

Decimal Degrees.

b. To display degrees, minutes and seconds, select

Degrees, Minutes, Seconds.

To specify the radio identifier in messages, select the Radio ID check box.

To specify the name of a radio in messages, select the Radio Name check box.

2.18.4.6 Managing Custom Rules and Positioning Rules

Follow the procedure to activate, deactivate, or delete an existing rule.

Prerequisites: 

Ensure the operator has the Manage Custom Rules or Manage Positioning Rules right.

For information on operator rights, see Operators.

Procedure: 

1. To open the desired rule configuration window, perform one of the following actions:

To open the Custom Rules window, on the menu bar, click Settings (   ) → Rules → Custom

Rules.

To open the Positioning Rules window, on the menu bar, click Settings (   ) → Rules → Positioning

Rules.

2. In the window that appears, perform one of the following actions:

To activate an existing rule, perform the following actions:

1. In the table, select the desired rule.

2. Select the Active check box.

NOTE

You can also activate the desired rule by selecting the Active

check box in the upper-left corner of the Rule Settings or

Positioning Rule window.

To deactivate an existing positioning rule, perform the following actions:

1. In the table, select the desired rule.

2. Clear the Active check box.

NOTE

You can also deactivate the desired rule by clearing the Active

check box in the upper-left corner of the Rule Settings or

Positioning Rule window.

To delete an existing positioning rule, perform the following actions:
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1. In the table, select the desired rule, and then click Delete ( 

 ).

2. In the confirmation window, click OK.

The rule is deleted from the table.

Postrequisites: 

For information on adding a new rule or editing an existing one, see Adding and Editing Custom Rules and Adding and Editing Positioning

Rules.

2.18.5 Examples

The examples of the SmartPTT Dispatcher rule configuration are presented below in the user guide:

• For information on custom rule configuration, see Custom Rule Example.

• For information on positioning rule configuration, see Positioning Rule Example.

• For information on Lone Worker rule configuration, see Lone Worker Rule Example.

2.18.5.1 Custom Rule Example

Assume that you need to configure a rule that is triggered by an incoming alarm from the radio named John. When the rule triggers, the

radio must change its status, the alarm sound must be played, and the Notifications panel with a specified text must display.

Set the conditions in the following way:

Set the actions in the following way:



192

SmartPTT Dispatcher Functionality Configuration Rules and Lone Worker Mode

After clicking OK the changes will be saved, the Alarm rule will be configured and added to the Rule Table, where you can activate,

deactivate, or delete it. The rule will be triggered when SmartPTT Dispatcher receives an incoming alarm signal from the radio named

John. The alarm sound will be played, the radio status will change to Alarm, and the dispatcher will get the Urgently contact the foreman!!!

message.

2.18.5.2 Positioning Rule Example

Assume that you need to configure a rule that triggers when data show that the radio named John has exceeded the specified speed limit

in the selected geofence. When the rule triggers, the radio must change its status, the special sound must be played, and the radio must

be displayed on a map.

Set the conditions in the following way:

Set the actions in the following way:
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After clicking OK the changes will be saved, the rule Speeding in a danger zone will be configured and added to the Rule Table, where you

can activate, deactivate, or delete it. The rule will be triggered when SmartPTT Dispatcher receives incoming data that show the specified

speed limit was exceeded by the radio named John. The sound will be played, the radio status will change to Alarm, and the radio will be

displayed on a map.

2.18.5.3 Lone Worker Rule Example

Assume that you need to configure the Lone Worker rule named Security that triggers under the following conditions: if the user has not

called for 15 min, the Call Dispatcher ASAP message is sent. If after that message the user does not call in 5 min, the dispatcher will

receive an alarm, and the radio will be displayed on the map.

Set the conditions in the following way:
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Set the actions in the following way:

Click OK to finish the rule configuration.

The Security rule will be saved and added to the Rule Table. It also can be assigned to the radio in the Radio Properties window. The rule

triggers if the user that has not called for 15 minutes does not call within 5 minutes after receiving the text message. In this case, an

alarm sound will be played and the radio will be displayed on the map.
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Chapter 3. SmartPTT Dispatcher Interface Configuration

This chapter describes SmartPTT Dispatcher interface configuration.

All settings described in this section, except for main area customization and managing layouts, are available only to the Administrator.

For information on user roles in SmartPTT Dispatcher, see Operators.

The SmartPTT Dispatcher interface configuration includes the following actions:

• The SmartPTT Dispatcher main area configuration. For details, see SmartPTT Dispatcher Interface Configuration.

• Call Window settings configuration. For details, see Call Windows.

• Notification panel settings configuration. For details, see Notification Panel Configuration.

• Custom console creation. For details, see Custom Console Configuration.

• Adding web pages. For details, see Web Pages.

3.1 SmartPTT Dispatcher Interface Overview

SmartPTT Dispatcher interface includes various elements and controls that provide you with the necessary information and functionality.

NOTE

Some SmartPTT Dispatcher elements are unavailable if the operator does not have the corresponding rights.

SmartPTT Dispatcher interface is divided into the following sections:

• The title bar is located at the top of the SmartPTT Dispatcher window, contains the standard Windows Minimize (   ),

Maximize (   ), and Close (   ) buttons, as well as provides the ability to view the current operator name.

• The menu bar is located under the title bar and provides menus and quick launch buttons to perform most of the functions

available in the application and configure SmartPTT Dispatcher.



196

SmartPTT Dispatcher Interface Configuration SmartPTT Dispatcher Interface Overview

• The information bar is located at the bottom of the SmartPTT Dispatcher window and provides the ability to view the number of

unread messages, the name of the currently selected object, the licensee name and license expiration date, as well as the

application version.

• The main area is the central part of SmartPTT Dispatcher where all open panels and windows appear.

Main Area Customization

SmartPTT Dispatcher provides the ability to customize its main area in the following ways:

• Move panels. For details, see Moving Panels.

• Tab panels. For details, see Tabbing Panels.

• Undock panels. For details, see Undocking Panels.

• Resize panels.

Main Area Layouts

The UI Layout Settings (   ) menu provides the ability to save the current dispatch console layout.

In addition to manually added layouts, the dispatcher can use two default layouts: Calls and Event log and Calls, Channels and Event log.

For information on managing user interface layouts, see Managing Layouts.

For the Administrator, the UI Layout Settings (   ) menu also provides the ability to lock the current layout.

When the layout is locked, the dispatcher cannot perform the following actions:

• Open and close panels

• Move and tab panels

• Switch between user interface layouts

• Resize open panels

For information on locking the user interface layout, see Locking Layout.

3.1.1 Moving Panels

Follow the procedure to move a panel inside the main area.

Prerequisites: 

Ensure the current layout is not locked. For details, see Locking Layout.

Procedure: 

1. Press and hold the title bar of the desired separate or tabbed panel, and then drag it.

In the main area, the positioning controls appear.

2. Move the panel to the desired position:
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To move the panel and attach it to one of the

main area sides,

drop it on the corresponding positioning control of the main area.

The panel is moved and attached to the selected main area side. Other

open panels move in the opposite direction.

To move the panel to the side of another panel, drop it on the corresponding positioning control inside the other panel.

The first panel is moved and attached to the selected side of the second

panel. The second panel moves in the opposite direction.

NOTE

Do not drop the panel on the Tabbing (   ) control unless you want to

tab panels.

For information on tabbing panels, see Tabbing Panels.

3.1.2 Tabbing Panels

Follow the procedure to tab panels.

NOTE

The Calls, Sound, Cross Patches, and Radio Fleet panels cannot be tabbed.

Prerequisites: 

• Ensure the current layout is not locked. For details, see Locking Layout.

• Ensure at least two panels that can be tabbed are open in the main area.
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Procedure: 

1. Press and hold the title bar of the desired panel, and then drag it over the second panel.

On the second panel, the positioning controls appear.

2. Drop the panel on the Tabbing (   ) control.

The panels will be tabbed.

3.1.3 Undocking Panels

Follow the procedure to undock a panel into a separate window.

Prerequisites: 

Ensure the current layout is not locked. For details, see Locking Layout.

Procedure: 

In the main area, press and hold the title bar of the desired panel, and then drag it to any place of the screen except the positioning

controls.

The panel appears as a separate window.
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3.1.4 Managing Layouts

Follow the procedure to save, apply, or delete the layout.

Prerequisites: 

Ensure the current layout is not locked. For details, see Locking Layout.

Procedure: 

1. On the menu bar, click UI Layout Settings (   ) → Set UI Layout.

The Set UI Layout window appears.



200

SmartPTT Dispatcher Interface Configuration SmartPTT Dispatcher Interface Overview

2. In the window that appears, perform one of the following actions:

To save the current layout, perform the following actions:

1. Click Add.

The New UI Layout window appears.

2. In the window that appears, in the Layout name field, type

the layout name.

3. Click OK to apply changes and close the window.

The saved layout appears in the list of layouts.

To apply an existing layout, select the desired layout from the list, and then click Apply.

To delete the layout, select the desired layout from the list, and then click Delete.

NOTE

The default layouts (Calls and Event log and Calls, Channels

and Event log) cannot be deleted.

3. In the Set UI Layout window, click Close to close the window.

3.1.5 Locking Layout

Follow the procedure to lock the current layout.

Procedure: 

On the menu bar, click UI Layout Settings (   ) → Lock UI Layout.

The check mark icon appears to the left of the Lock UI Layout option. The layout is locked.

NOTE

If the Event Log is open when the layout is locked, all features for the Event Log management are available to the dispatcher. If

closed, the Event Log becomes unavailable.

Postrequisites: 

To unlock the layout, click Lock UI Layout again.

The check mark icon disappears.
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3.2 Call Windows

SmartPTT Dispatcher provides the ability to quickly respond to events related to radio system objects using Call Windows.

Call Windows are available for the following radio system objects:

• Radios (including mobile clients)

• Talkgroups

• Dynamic groups

• All Calls

The Call Window opens in one of the following ways:

• When registering an event whose type is configured to automatically open the Call Window. For details, see “Events Opening Call

Windows” below.

• When double-clicking the desired object on the Radio Fleet panel.

You can also open the Call Window of a radio in one of the following ways:

• By right-clicking the desired radio element on the Radios panel or in the custom console.

• By double-clicking the desired radio icon on the map panel.

• By double-clicking the entry of an event initiated by the desired radio on the Incoming Events element of the custom console.

• By clicking the desired radio name on the Recent Incoming Calls panel.

• By clicking the desired radio name on the Lone Workers panel.

• By clicking Show Address (   ) in the Actions (   ) menu of the desired radio.

Events Opening Call Windows

In the Call Window Settings window, you can configure the types of events that trigger the automatic opening of Call Windows.

For information on configuring Call Windows, see Configuring Call Windows.
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Call Windows of different radio objects appear for the configured events according to the following table:

Event Type Event Radios Mobile Clients Talkgroups All Calls,

Dynamic Groups

Registration Change of object availability in

the radio system

YES YES N/A N/A

Call Call to the object YES YES YES YES

Call to a dispatch console

operator initiated by the object

YES YES N/A N/A

Successful Call Alert delivery to

the object

NO N/A N/A N/A

Failed Call Alert delivery to the

object

YES N/A N/A N/A

Remote object monitoring YES N/A N/A N/A

Message Message sent by the object YES NO N/A N/A

Message from an operator of

another dispatch console

received by the object

YES NO YES N/A

Telemetry Sending a telemetry signal to

the object

YES N/A YES N/A

Receiving a telemetry signal

from the object

YES N/A NO N/A

Alarm Emergency alarm from the

object

YES NO N/A N/A

Status Object status change YES YES N/A N/A

Block radio Blocking or unblocking the

object

YES N/A N/A N/A

Job ticket Sending a job ticket to the

object

NO N/A YES N/A

Delivery of a job ticket to the

object

YES N/A NO N/A

Job ticket status update by the

object

YES N/A NO N/A

User Authorization User registration or

deregistration on the object

YES N/A N/A N/A
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Event Type Event Radios Mobile Clients Talkgroups All Calls,

Dynamic Groups

Radio Check Sending the Radio Check

command to the radio

YES N/A N/A N/A

Call Window Features

The Call Window provides information on events related to the radio object and various controls for interacting with it.

Depending on the radio object, the following features are available in the Call Window:

Feature Radios Mobile Clients Talkgroups All Calls,

Dynamic Groups

Make a call to the object YES YES YES YES

Send a message to the

object

YES NO YES N/A

View events related to

the object

YES YES YES YES

View the object avatar

image

YES YES YES (default avatar only) YES (default avatar only)

View the object channel YES YES YES YES

View the current object

status

YES YES N/A N/A

View object coordinates

and perform geolocation-

related actions

YES YES N/A N/A

View available beacons

and find the object on a

building plan

YES N/A N/A N/A

Send signaling

commands to the object

YES N/A N/A N/A

Remotely monitor the

object

YES N/A N/A N/A

Start a conference call

with the object

YES N/A YES N/A

Establish connection

between the object and a

telephone subscriber

YES N/A YES N/A
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Feature Radios Mobile Clients Talkgroups All Calls,

Dynamic Groups

Send a deferred action to

the object

YES NO N/A N/A

Exit Emergency Mode YES NO YES YES (for emergency All

Calls only)

Send a telemetry signal

to the object

YES N/A YES N/A

Receive the current

status of object

telemetry contacts

YES N/A NO N/A
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3.2.1 Configuring Call Windows

Follow the procedure to configure Call Window appearance and behavior.

Procedure: 

1. On the menu bar, click Settings (   ) → Interface → Call Windows.

The Call Window Settings window appears.

2. In the window that appears, perform the desired actions:

To automatically close Call Windows after a certain time

period,

in the Call Window Closing Timeout (s) field, type the desired

value in seconds.

NOTE

To disable automatic closing of Call Windows, type 0.

To automatically open Call Windows when specific events

occur in the system,

in the Open Call Window for Event Types area, select check

boxes next to the desired event types.

To set the maximum number of Call Windows that can be

opened automatically,

in the Maximum Number of Opened Call Windows field, type the

desired value.
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NOTE

To disable automatic opening of Call Windows, type 0.

To display the object avatar in the Call Window, select the Show Photo in Call Window check box.

To open pinned Call Windows when SmartPTT Dispatcher is

launched,

select the Show Pinned Call Windows On Console Launch check

box.

To make the last of the automatically opened Call Windows

active,

select the Set Focus to Call Window upon Popup check box.

NOTE

If selected, already open Call Windows also become active

when a relevant event occurs.

To reset the position of pinned Call Windows on the

monitor screen,

click Reset Saved Call Window Positioning.

3. Click Finish to save changes and close the window.

3.3 Notification Panel Configuration

For some SmartPTT Dispatcher notification panels, you can configure additional settings for handling events or information display on

the panel. You can configure the following panels:

• The Emergency panel. For details, see Configuring Emergency Processing.

• The System Messages panel. For details, see Configuring System Messages Processing.

• The Recent Incoming Calls panel. For details, see Configuring Recent Incoming Calls Display.

For detailed information on all notification panels available in SmartPTT Dispatcher, see Notification Panels.

3.3.1 Configuring Emergency Processing

Follow the procedure to configure emergency processing.

Prerequisites: 

• To select a category for emergency, first add at least one category. For details, see Managing Categories.

• (Optional) Ensure that a map is open to display the radios activated the emergency mode and the objects added to the category for

emergency.

Procedure: 

1. On the menu bar, click Settings (   ) → Interface → Notification Panels.

The Notification Panels window appears.
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2. Select the Notify dispatcher about emergency check box to enable emergency processing.

3. (Optional) Configure additional settings for emergency processing:

To add the category of objects that will not be hidden on

the map upon receiving an emergency alarm from a

radio,

perform the following actions:

1. Next to the Category for Emergencies field, click Browse ( 

 ).

2. In the Categories window, select the corresponding

category.

3. Click OK.

To activate playback of the default audio file upon

receiving an emergency alarm from a radio,

select the Play Sound check box.

To configure a sound notification upon receiving an

emergency alarm from a radio,

perform the following actions:

1. Select the Play Sound check box.

2. Click Browse (   ) to specify the path to the desired audio

file.

4. Click Finish in the bottom part of the window to save changes and close the window.



208

SmartPTT Dispatcher Interface Configuration Notification Panel Configuration

3.3.2 Configuring System Messages Processing

Follow the procedure to configure the system messages processing.

Prerequisites: 

(Optional) To process hardware events, ensure that Monitoring is activated.

For details, see “Configuring Monitoring Database Connection” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Settings (   ) → Interface → Notification Panels.

The Notification Panels window appears.

2. In the window that appears, open the System Messages tab.

3. Configure the system status messages processing in the Network events area:

To display error messages on the System Messages panel, select the Errors check box.

To display error messages in separate windows, clear the Errors check box.

To display warning messages, select the Warnings check box.
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To display information messages, select the Information Messages check box.

4. Configure the radio network functionality messages processing in the Hardware events area:

To show messages about the loss of a significant part of the

radio network functionality,

select the Critical problems check box.

To show messages about the loss of an insignificant part of

the radio network functionality,

select the Non-critical problems check box.

5. Configure an emergency alarm:

To activate playback of the default audio file at the

emergency situation,

select the Play Sound check box.

To configure a sound notification at the emergency

situation,

perform the following actions:

1. Select the Play Sound check box.

2. Click Browse (   ) to specify a path to the desired audio

file.

6. Click Finish at the bottom of the window to save changes and close the window.

3.3.3 Configuring Recent Incoming Calls Display

Follow the procedure to configure the number of recent calls on the Recent Incoming Calls panel.

Procedure: 

1. On the menu bar, click Settings (   ) → Interface → Notification Panels.

The Notification Panels window appears.

2. In the window that appears, select the Recent Incoming Calls tab.
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3. Select the Remember recent incoming calls check box.

4. In the Number of recent calls field, specify the number of calls that must be displayed on the Recent Incoming Calls panel.

5. Click Finish at the bottom of the window to save changes and close the window.

3.4 Custom Console Configuration

The Custom Console feature provides the ability to create one or several custom workspaces to meet the specific workflow demands.

To configure a Custom Console, you must perform the following actions::

• Add a Custom Console. For details, see Managing Custom Consoles.

• Add the desired elements to the Custom Console. For details, see Configuring Console Workspace.

• Configure Custom Console elements.

For information on custom consoles, their elements, as well as custom console elements configuration and usage, see Custom

Consoles.

NOTE

Access to some of the elements may require the corresponding operator permission and/or license. For details, see the description

of the desired element in the Custom Console Elements Table. For details, see Custom Console Elements.
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3.4.1 Managing Custom Consoles

Follow the procedure to add, edit, activate, deactivate, or delete a Custom Console.

Important

This procedure is available only to the Administrator.

Procedure: 

1. On the menu bar, click Settings (   ) → Interface → Custom Consoles.

The Custom Consoles window appears.

2. In the window that appears, perform the desired action:

To add a new Custom Console, perform the following actions:

1. At the top of the window, click Add (   ).

The Console Configuration window appears.
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2. In the window that appears, configure a new console as you

desire. For details, see Configuring Console Workspace.

3. Click Save at the bottom of the Console Configuration

window to save changes and close the window.

The configured console appears in the Custom Consoles

window.

To edit an existing Custom Console, perform the following actions:

1. In the Custom Consoles Table, select the desired console,

and then click Edit (   ) or double-click it.

The Console Configuration window for editing the console

appears.

2. In the window that appears, edit the desired settings and/or

elements. For details, see Configuring Console Workspace.

3. Click Save to save changes and close the window.

To activate/deactivate an existing Custom Console, in the Custom Consoles Table, select the desired Custom

Console, and then select or clear the Active check box.

The console appears or disappears from the Tools menu.

To delete an existing Custom Console, perform the following actions:

1. In the Custom Consoles Table, select the desired Custom

Console, and then click Delete (   ).

2. In the window that appears, click OK.

The console is removed from the Custom Consoles Table.
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3.4.2 Configuring Console Workspace

Follow the procedure to set the custom console name and background image as well as add, move, or resize the elements in the main

area of the Custom Console.

Important

This procedure is available only to the Administrator.

Procedure: 

1. If the Custom Consoles window is closed, open it by clicking Settings (   ) → Interface → Custom Consoles on the menu bar.

The Custom Consoles window appears.

2. In the window that appears, in the Custom Consoles Table, double-click the desired console name or select it, and then click Edit ( 

 ).

The Console Configuration window for editing the console appears.
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3. (Optional) In the Name field at the top of the window, type the Custom Console name.

New consoles have the Console <number> name by default.

4. (Optional) To the right of the Wallpaper field, at the top of the window, click Browse (   ), and then, in the window that appears,

select the desired image.

5. Add the desired elements to the main area of the Custom Console in one of the following ways:

To add elements in the upper-left corner of the window, expand the list of the corresponding element type, and then

drag the desired element to the console workspace.

NOTE

Some of the radio system objects, such as Radios and

Channels, can be located in expandable lists under the main

objects.

To add elements in the lower-left corner of the window, drag the desired element to the workspace.

6. Select the element added to the console workspace, and then, in the Properties area, edit the desired element properties. For

details, see Custom Console Elements.

7. (Optional) Resize the element by dragging the resizing controls that appear when you select the element.

Postrequisites: 

• To remove the element added to the console workspace, select it, and then press the Delete key, or click Delete (   ) at the top of

the window.

• To remove the wallpaper, click Delete (   ) to the right of the Wallpaper field.
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3.5 Web Pages

In SmartPTT Dispatcher, you can open web pages compatible with Internet Explorer 11. The desired web pages must be added in the Web

Pages window. After adding a web page, the panel with this page becomes available in the Tools menu. The name of the panel

corresponds to the specified web page name.

3.5.1 Adding Web Pages

Follow the procedure to add a new web page to SmartPTT Dispatcher.

Important

This procedure is available only to the Administrator.

NOTE

To ensure stable performance, it is not recommended to add web pages containing audio or video.

Prerequisites: 

Obtain URL address of the desired web page.

Procedure: 

1. On the menu bar, click Settings (   ) → Interface → Web Pages.

The Web Pages window appears.
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2. In the window that appears, click Add (   ).

A new entry in the table appears.

3. In the Page name column, type the desired page name.

4. In the URL address column, enter the URL address.

5. Click Finish to save changes and close the window.

The added web page appears in the Tools menu.

Postrequisites: 

• To edit the web page name or address, double-click the desired value and change it.

• To delete the web page, click the desired entry in the table, and then click Delete (   ).
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Chapter 4. SmartPTT Dispatcher Operation

This chapter describes the SmartPTT Dispatcher operation. It includes sections regarding the following topics:

• Radio system object operation. For details, see Radio System Objects.

• Voice calls. For details, see Voice Calls.

• Emergency. For details, see Emergency.

• Signaling features, including call alerts, radio checks, remote monitoring, and radio disable. For details, see Signaling Features.

• Event Log operation as well as information about notification panels. For details, see Event Log and Notification Panels.

• Call records actions. For details, see Call Records.

• GPS and indoor map actions. For details, see Positioning.

• Cross patches. For details, see Cross Patches.

• Custom console elements description and actions with them. For details, see Custom Consoles.

• Bridging. For details, see Bridging.

• Text messages sending. For details, see Text Messages.

• Job ticket management. For details, see Job Tickets.

• Telephony and initiating calls. For details, see Telephone Interconnect.

• Conference calls. For details, see Conference Calls.

• Communication with other dispatchers. For details, see Dispatchers.

• Monitoring and topology features. For details, see Monitoring.

• Creating reports. For details, see Reports.

• Telemetry actions. For details, see Telemetry.

4.1 Radio System Objects

To use the SmartPTT radio system, configure and add radio system objects in SmartPTT Radioserver Configurator. After that, the

objects appear in SmartPTT Dispatcher, and the operator will be able to make calls and perform actions with them. Radios, temporary

talkgroups, and dynamic groups are added directly in SmartPTT Dispatcher.

SmartPTT Dispatcher provides the following radio system objects:

• SmartPTT Radioservers

For details, see Radioservers.

• Radios, mobile clients.

For details, see Radios.

• Talkgroups.

For details, see Talkgroups.

• All Calls.

For details, see All Calls.
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• Dynamic groups.

For details, see Dynamic Groups.

• Channels, including the following objects:

• Control stations

• Virtual control stations

• System-wide and local channels of conventional radio systems

• Single- and multisite trunked radio systems

For details, see Channels and Systems.

Radio system objects are displayed on the Radio Fleet panel. The operator can use this panel to perform various actions related to the

desired radio system objects and manage their parameters.

NOTE

The panel does not show non-radio objects, for example other SmartPTT dispatchers, phone users, SmartPTT Web Clients, and third-

party dispatch applications.
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The Radio Fleet panel is open by default. If the panel is closed, you can open it by clicking Tools → Radio Fleet on the menu bar.

The Radio Fleet panel provides the ability to perform the following actions:

• Make calls.

• Add and delete radios. For details, see Adding Radios on Radio Fleet Panel.

• Use the Actions (   ) menu of radio fleet objects.

• Configure the display of objects on the panel:

• Hide and show the desired objects.

• Change a view of the Objects Table.

• Search radios using their names or IDs.
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• Filter radios by status.

For information on object display configuration, see Working with Objects Table.

4.1.1 Working with Objects Table

Follow the procedure to configure display of the objects on the Radio Fleet panel.

Procedure: 

1. If the Radio Fleet panel is closed, open it by clicking Tools → Radio Fleet on the menu bar.

2. On the Radio Fleet panel, perform one of the following actions:

• To hide or show radios, or talkgroups in the Objects Table, perform the following actions:

To hide or show all talkgroups, click Hide talkgroups (   ) or Show talkgroups (   ).

To hide or show online radios, click Hide online radios (   ) or Show online radios (   ).

To hide or show offline radios,

click Hide offline radios (   ) or Show offline radios (   ).
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• To change the view of the Object Table, perform the following actions:

To activate the channel view, select Filter by channel (   ).

To activate the category view, select Filter by category (   ).

• To search the desired radio in the Objects Table by name or ID, in the search field, type the name or ID of the radio.

• To filter radios by status, from the Filter radios by status list, select the desired status.

4.1.2 Radio System Object Selection

In SmartPTT Dispatcher, you can select radio system objects, and then perform different actions with them.

Selected objects are objects that were clicked by an operator. They are highlighted on a panel or a Custom Console. The object whose

Call Window is open and active is also considered selected.

For information on Call Windows, see Call Windows.

Important

In SmartPTT Dispatcher, you can set actions that will happen after you click an object. Depending on the settings, after clicking the

object, it will be selected, or a call to the object will be initiated. For details, see Configuring Call Element Actions.

The name of the selected object is displayed as green on the SmartPTT Dispatcher information bar. The selected object is outlined with

a blue frame. The Call Window of the selected object has a blue title bar, and its PTT button is outlined with a blue frame too.

NOTE

You can clear an object selection only by selecting another object.

In the Custom Console and on the Radios and Channels panels, you can select several objects by clicking them while holding down the

Ctrl key.

On the Radios panel, you can select several radios in a row. For this, while holding down the Shift key, click the first and last desired

objects in the row.

Due to the possibility to select multiple objects, SmartPTT Dispatcher provides the ability to initiate calls simultaneously to several

selected radios and/or talkgroups, including an All Call. If several objects are selected, then the Multiselect caption appears on the

SmartPTT Dispatcher information bar.

Actions with Selected Object

Depending on the selected object location (SmartPTT Dispatcher panels or the Custom Console), you can perform the following actions

with the selected objects:

• Delete the selected radio using the Delete radio (   ) button (the Radio Fleet panel).

NOTE

You can delete a dynamic group in its Actions (   ) menu by clicking Delete (   ). Other radio system objects can be deleted only in

SmartPTT Radioserver Configurator. For details, see SmartPTT Installation and Configuration Guide.

• Open the Actions (   ) menu of the selected object (the Radio Fleet panel, the Radios and Channels panels, the Custom Console).

• Initiate a call to the selected object by pressing the assigned hotkey. The default hotkey for initiating a call is Space. You can also

assign other hotkey actions, and then use hotkeys to perform the desired actions with the selected object (the Radio Fleet panel,

the Radios and Channels panels, the Custom Console). For details, see Assigning Hotkeys.

• Configure the sound volume separately for selected objects. Sound volume is configured on the Sound panel (all panels and

Custom Consoles).
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NOTE

Configuring the sound volume separately for unselected objects is also available on the Sound panel. When changing the sound

volume on the Sound panel, the volume is changed simultaneously on all panels and consoles with selected or unselected objects.

• Listen to the call sound for the selected object using the desired audio output device (all panels and Custom Consoles).

NOTE

You can also listen to the call sound for the unselected object using a desired audio output device. SmartPTT Dispatcher provides the

ability to separate the incoming sound. For example, headphones can play sound from the selected object, and speakers can play

sound from the unselected object. You can configure sound settings on the Audio Output Devices tab of the Sound Settings window.

For details, see Assigning Audio Output Devices.

4.1.3 Radioservers

To work with radio system objects, you need to connect to SmartPTT Radioserver.

For information on managing radioservers in SmartPTT Dispatcher, see Managing Radioservers.

Important

Before adding a radioserver to SmartPTT Dispatcher, desktop clients connection must be configured in SmartPTT Radioserver

Configurator. For details, see “Configuring Desktop Clients Connection” in SmartPTT Installation and Configuration Guide.

Available radioservers are displayed on the Radio Fleet panel as nodes. The Actions (   ) menu provides the ability to perform various

actions related to radioservers.

You can open the Actions menu by clicking the Actions (   ) button to the right of the radioserver name on the Radio Fleet panel.

In the Actions menu of the radioserver, you can perform the following actions:

• Display the radioserver Event Log for the selected period.

For information on the radioserver Event Log, see Displaying SmartPTT Radioserver Event Log.

NOTE

The action is available if the radioserver Event Log is activated in SmartPTT Radioserver Configurator. For details, see “Configuring

Event Log Database Connection” in SmartPTT Installation and Configuration Guide.

• Open the Bridging Configuration window where you can configure the bridging service.

For information on bridging, see Adding Route Groups.

NOTE

The action is available if bridging is activated in SmartPTT Radioserver Configurator. For details, see “Managing Bridging” in

SmartPTT Installation and Configuration Guide.

• Select audio output device to play voice transmissions from the radioserver.

For information on configuring and assigning audio output devices, see Configuring Audio Output Devices and Assigning Audio

Output Devices.

• Open the radioserver properties window, where you can see the current version of the radioserver and type a note for other

SmartPTT Dispatcher users.

The radioserver nodes are displayed only when the Filter by channel (   ) view is active.

The radioserver icon displays the state of the radioserver:

• Blue color (   ) indicates that the server is online.

• Gray color (   ) indicates that the server is offline.

The radioserver node can be expanded or collapsed to show or hide the channels and subscribers configured on this radioserver.

If the radioserver has no configured objects or they are hidden, the element is unavailable.
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Redundant Radioservers

SmartPTT Dispatcher supports operation with redundant radioservers.

For information on redundancy, see “Alternation (Redundancy)” in SmartPTT Installation and Configuration Guide.

If a redundant radioserver is used in the system, you must add both primary and redundant radioservers to SmartPTT Dispatcher.

When a redundant radioserver is added, it is displayed in the Radio Fleet panel as active with no objects belonging to it. When the

connection to a primary server is lost, all objects from the primary radioserver appear under the redundant one.

NOTE

A primary radioserver can have only one redundant radioserver.

4.1.4 Radios

Radios are the most important objects of the whole dispatch system.

In SmartPTT Dispatcher, the operator can work with radios registered in digital and analog radio systems, mobile clients.

Mobile clients are SmartPTT Mobile application users authorized on SmartPTT Radioserver.

For information on mobile clients, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

NOTE

In this guide, the term “radios” also includes mobile clients, unless specified otherwise.

SmartPTT Dispatcher provides the following features to work with radios:

• Configuring parameters. For details, see Radio Configuration.

• Making and receiving voice calls, viewing the activity of ongoing calls. For details, see Voice Calls.

• Performing actions. For details, see Radio Actions.

Radios available in the radio system are automatically displayed in SmartPTT Dispatcher. To register the desired radio in SmartPTT

Dispatcher, click Save in its Radio Properties window.

Information about registered radios is stored in the SmartPTT Dispatcher database providing the operator the ability to perform actions

related to radios when they are offline. You can export current properties and settings of the radios from the database to a separate file,

as well as import a list of radios to SmartPTT Dispatcher. For details, see Radio List Export and Import.

Unregistered radios are not displayed in SmartPTT Dispatcher when they are offline. An operator can perform the same actions with

unregistered radios as with registered ones, but can not add them to categories and select as a condition for triggering a positioning

rule.

Important

Managing radios that are not saved in SmartPTT Dispatcher is available only to the Administrator and operators with the Manage

unregistered radios right. For operators who are not granted this permission, SmartPTT Dispatcher does not display unregistered

radios, but provides the ability to monitor voice calls involving unregistered radios.

For information on operator rights, see Operators.

You can also add a new radio to the dispatch system manually on the Radio Fleet panel or using the list of radios. For details, see Adding

Radios.

NOTE

Radios with the ID in the MDC-1200 or 5 Tone format always appear offline since they do not provide registration information.

Radios as objects of the radio system are displayed in SmartPTT Dispatcher as follows:

• Entries on the Radio Fleet panel. For details, see Radio System Objects.

• Elements on the Radios panel. For details, see Radios Panel.
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• Elements on the custom console.

Radio Management

The main tool for managing radios in SmartPTT Dispatcher is the Radios panel. For information on the panel, see Radios Panel.

You can also add radio elements to a custom console for managing individual objects.

SmartPTT Dispatcher provides various actions for interacting with radios. The actions can be performed from the Actions (   ) menu of

the corresponding radio. For details, see Radio Actions.

Deferred actions created from the radio Actions menu are available for editing and deleting using the Service menu. For information on

the Deferred Actions feature, see Deferred Actions.

4.1.4.1 Radios Panel

The Radios panel provides controls for monitoring and interacting with radios registered in SmartPTT Dispatcher. The panel provides the

ability to perform the following actions with radios:

• Open the radio Actions menu by clicking the Actions (   ) button in the lower-right corner of the element. For details, see Radio

Actions.

• Open the radio Call Window by right-clicking the element. For details, see Call Windows.

• Initiate a private voice call to the radio. For details, see Initiating Private Voice Calls.

• Initiate a multicall to multiple radios.

You can open the Radios panel by clicking Tools → Radios on the menu bar.

You can configure the font size for radio names on the panel elements, width of elements, and display of radio icons on elements. For

details, see Configuring Radios Panel.

SmartPTT Dispatcher provides various parameters for filtering objects on the Radios panel: by online presence, by assigned status, by

category.

The dispatcher can add radios to the panel manually by dragging them from the Radio Fleet panel, and then display these radios by

selecting Manual selection.

The Radios panel also provides the ability to search for objects by characters contained in their names or IDs.

For information on filter configuration, see Filtering Radios.
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Indication on Radio Element

The radio elements on the Radios panel, as well as on the custom console, have different color indication depending on the voice call

status.

For information on color indication of voice calls to and from the radio, see Color Indication of Voice Calls.

The following indication is also used on the radio elements:

• The color of the element indicates the current status of a radio (blue means that a radio is online, gray means that a radio is

offline).

• The Missed Call (   ) icon indicates that there are missed calls from the radio. Next to the icon, the number of missed calls is

displayed.

• The Valid Coordinates (   ) or Outdated Coordinates (   ) icon indicates that the radio GPS coordinates are valid or

outdated/missing. The icon appears only if the GPS service is activated and the coordinates update parameters are specified in

the radio location settings. For details, see Configuring Radio GPS Settings.

• The Man Down caption indicates that the radio is currently in the Man Down mode.

• The Emergency caption indicates that the radio activated the emergency mode. You can manage the reported emergency from the

Emergencies panel or using the Exit Emergency Mode option of the radio Actions menu. For details, see  and Radio Actions.

NOTE

The Man Down mode is unavailable to SmartPTT Mobile users

• A notification about the reason why a call cannot be initiated can appear when you point at the element. After that the call

attempts are continued.

4.1.4.1.1 Configuring Radios Panel

Follow the procedure to configure display of radios on the Radios panel.

Procedure: 

1. On the menu bar, select Tools → Radios.

The Radios panel appears.

2. On the Radios panel, customize the display of elements:

To change the font size for radio names on all elements

of the panel,

click the icon (   ) corresponding to the desired font size

(small, medium or large).
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To change the width of all elements on the panel,

click the icon (   ) corresponding to the desired element

width (narrow, medium, or wide).

To display or hide the radio icon for all elements of the

panel,

click Show Icon (   ).

The radio icon disappears or appears on radio elements.

Postrequisites: 

(Optional) Configure filtering on the Radios panel. For details, see Filtering Radios.

4.1.4.1.2 Filtering Radios

Follow the procedure to filter radios on the Radios panel.

Prerequisites: 

• To filter radios by category, ensure the desired radio categories are created in SmartPTT Dispatcher. For details, see Managing

Categories.

• To filter radios by statuses, ensure the desired statuses are created in SmartPTT Dispatcher. For details, see Managing Statuses.

Procedure: 

1. On the menu bar, select Tools → Radios.

The Radios panel appears.

2. (Optional) To select radios manually, perform the following actions:

a. Select Manual selection.

b. Drag and drop the desired radios from the Radio Fleet panel to the Radios panel.

Added radios appear when filtering using manual selection.

c. (Optional) To delete a manually added radio from the panel, select the desired radio, and then press the Delete key.

3. Configure filtration:

To display all radios registered in SmartPTT Dispatcher,

regardless of their presence in the network at the

moment,

select All Radios.

NOTE

With this option selected, unregistered radios that are

currently online are also displayed.
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To display radios that are currently online, select Online.

To display radios added manually from the Radio Fleet

panel,

select Manual selection.

To display all radios that belong to a category created in

SmartPTT Dispatcher,

select the option with the name of the desired category.

To display the radios that are assigned a certain status, from the status list, select the desired status.

To display radios that are not assigned any status, from the status list, select (empty).

To display specific radios, perform the following actions:

1. In the search field (   ), type the characters contained in

the name or ID of the desired radios.

NOTE

The search is performed only among the radios that are

currently displayed on the panel after applying all other filter

parameters.

2. (Optional) To clear the search field and remove filtration,

in the right part of the search field, click Clear (   ).

Postrequisites: 

(Optional) Configure the display of radio elements on the Radios panel. For details, see Configuring Radios Panel.

4.1.4.2 Radio Actions

The radio Action menu provides the ability to perform various actions for interacting with a radio.

You can open the Actions menu in one of the following ways:

• By clicking the Actions (   ) button to the right of the radio name on the Radio Fleet panel.

• By clicking the Actions (   ) button on the desired radio element on the Radios or custom console panel.

• By right-clicking the radio on a map.

NOTE

You can also perform the desired actions in the radio Call Window.

For information on Call Windows, see Call Windows.

Hotkeys can be assigned to all actions related to radios. For details, see Assigning Hotkeys.

In the Actions menu of the radio, the following actions can be available:

Action Description Restrictions

Send Message (   ) Opens the Send Message window in which you

can type and send messages or manage

message templates.

Available to DMR radios only.

Unavailable if the operator does not

have the Send text messages right.

For information on the operator rights,

see Operators.
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Action Description Restrictions

Call Alert (   )

Sends the Call Alert command to the desired

radio.

Available to DMR radios only.

Radio Check (   )

Sends the Radio Check command to the

desired radio.

Available to DMR radios only.

Monitoring (   )

Initiates remote monitoring of the desired

radio during which you can listen to the radio

without notifying it.

While the remote monitoring is active, the

radio cannot initiate calls.

Available to DMR radios only.

Unavailable if the operator does not

have the Remote monitor right.

Unavailable if desktop client

authentication on SmartPTT

Radioserver is enabled and the profile

assigned to the client prohibits the

Monitoring action. For details, see

“Profiles” in SmartPTT Installation and

Configuration Guide.

Set Location (   )

Provides the ability to set the location of the

radio on a map manually. If no map panel is

open in the main area, the action opens the

Select Map window from which you can select

the map to set the radio location.

For information on setting radio location, see

Setting Radio Location.

Unavailable if the operator does not

have the Request radio location right.

Show Track (   ) Shows the track of the radio for a specific

period of time.

You can select the following periods to show

the track:

• For the last hour

• For today

• Specify a time range (a custom period)

If no map is open in the main area, the action

opens the Select Map window, from which you

can select the map to show the track.

If Specify a time range is selected, you should

manually set the Start date and End date in the

open Track panel of the map control panel, and

then click Show.

For information on showing tracks showing,

see Displaying Tracks.

Unavailable if the operator does not

have the Manage tracks right.

Find on Map (   ) Shows the radio on a map. Unavailable if the operator does not

have the Request radio location right.

Unavailable if desktop client

authentication on SmartPTT
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Action Description Restrictions

Radioserver is enabled and the profile

assigned to the client prohibits the Radio

location request action.

Show Address (   )

Shows the radio address in the log of the open

radio Call Window. Opens the window if it is

closed.

The radio address is based on the current GPS

coordinates. If the address is unavailable, the

No Coordinates entry appears in the log.

If you reopen the Call Window, the address

disappears from the log.

Important

The action is available only when the

service of address data provider is active in

SmartPTT Dispatcher. For details, see

Configuring Positioning Settings.

Unavailable if the operator does not

have the Request radio location right.

Remove from Map (   ) Hides the radio on a map. Unavailable if the operator does not

have the Request radio location right.

Find on Indoor Map (   ) Shows the radio on the open building map.

If the building map is closed, the action opens

the Select building plan window in which you

can specify a path to the desired map.

NOTE

The action is available only if the Indoor

tracking check box is selected in the radio

properties. For details, see Configuring

Indoor Radio Tracking.

Unavailable for SmartPTT Mobile users.

Unavailable if the operator does not

have the Request radio location right.

Unavailable if desktop client

authentication on SmartPTT

Radioserver is enabled and the profile

assigned to the client prohibits the Radio

location request action.

Block Radio (   ) Depending on SmartPTT Radioserver settings,

the action denies access to a trunked system,

or remotely switches the radio off.

For information on blocking settings, see

“Configuring Radioserver” in SmartPTT

Installation and Configuration Guide.

Available to DMR radios only.

Unavailable if the operator does not

have the Block/Unblock radios right.

Unavailable if desktop client

authentication on SmartPTT

Radioserver is enabled and the profile

assigned to the client prohibits the

Block/Unblock radios action.

Unblock Radio (   ) Sends the command to the radio which is

opposite to the Block Radio (   ) command.

Make Conference Call (   ) Opens the Conference Calls window from which

the conference call can be initiated.

For information on conference calls, see

Conference Calls.

Available to DMR radios only.

Unavailable if the operator does not

have the Make conference calls right.
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Action Description Restrictions

Call Telephone Subscriber (   ) Opens the Telephone Subscribers window,

from which a call between the selected radio

and a telephone subscriber can be initiated.

Important

The call is possible if the required settings

are configured on SmartPTT Radioserver.

For details, see “Connecting to SIP Server”

in SmartPTT Installation and Configuration

Guide.

Available to DMR radios only.

Unavailable if the operator does not

have the Make telephone calls right.

Create Point of Interest (   ) Opens the Point of interest window in which

you can set the parameters of a point of

interest and create it.

By default the last radio coordinates are used.

NOTE

The action is unavailable if SmartPTT

cannot request coordinates from a radio.

For details, see Configuring Radio GPS

Settings.

Unavailable if the operator does not

have the Manage points of interest right.

Create Deferred Action (   ) Opens the Create Deferred Action window in

which you can create a deferred action.

For details, see Creating Deferred Messages.

Available to DMR radios only.

Unavailable if the operator does not

have the Create deferred actions right.

Properties (   ) Opens the Radio Properties window.

Exit Emergency Mode (   )

Acknowledges an incoming emergency alarm.

It turns off the emergency tone and the

emergency indication.

NOTE

The action is available when a radio sends

an emergency alarm.

Available to DMR radios only.

4.1.4.3 Deferred Actions

The Deferred Actions feature provides the ability to create and deliver various messages to offline and online radios. Offline radios

receive the sent messages after becoming online, and online radios receive them right after sending.

In SmartPTT Dispatcher, the following types of deferred actions are possible:

• Actions with voice messages

• Actions with text messages

• Actions with combined messages (both voice and text)

Important

The Deferred Actions feature is available only to the Administrator and operators with the Create deferred actions permission. For

details, see Operators.
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After the radio receives the deferred message, the corresponding entry appears in the SmartPTT Dispatcher Event Log and SmartPTT

Radioserver Event Log. If only a text message is sent, its entry also appears in the log of the radio Call Window.

You can use the Deferred Actions feature to perform the following actions:

• Create audio, text and combined deferred messages. For details, see Creating Deferred Messages.

• Edit and delete deferred actions. For details, see Managing Deferred Actions.

4.1.4.3.1 Creating Deferred Messages

Follow the procedure to create a deferred message.

Prerequisites: 

• If you want to record an audio message, ensure the recording device is connected to the computer and is active.

• Ensure the operator has the Create deferred actions right. For details, see Operators.

Procedure: 

1. Open the Create Deferred Action window in one of the following ways:

To open the window from the Radio Fleet panel, click the Actions (   ) button next to the desired radio, and

then click Create Deferred Action (   ).

To open the window from the Radios panel, click the Actions (   ) button on the desired radio element,

and then click Create Deferred Action (   ).

To open the window from the map panel, on the map or on the expandable Radios panel, right-click the

desired radio, and then click Create Deferred Action (   ).

To open the window from the radio Call Window, in the Call Window of the desired radio, click Create Deferred

Action (   ).

2. In the window that appears, from the Radioserver list, select the desired radioserver.

3. Create the desired deferred message:

To create an audio message, perform the following actions:

1. Clear the Send Text Message check box.

The field for typing message becomes unavailable.

2. Select the Send Audio Message check box.

The Record button becomes available.

3. Click Record.

The button changes to Stop; other elements become

unavailable.

4. Speak into the microphone.

5. Click Stop after you have finished speaking.

The button changes to Record; the Play button becomes

available.

6. (Optional) Click Play to listen to the recorded message.
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To create a text message, perform the following actions:

1. Clear the Send Audio Message check box.

The Record button becomes unavailable.

2. Select the Send Text Message check box.

The field for typing message below becomes available.

3. Type the desired message in the field.

To create a combined message that includes both audio

and text messages,

perform the following actions:

1. Select the Send Audio Message and Send Text Message

check boxes.

2. Record the audio message and type the text message

according to the instructions above.

4. Click Save.

If the action creating is successful, the The action was successfully saved message appears.

Postrequisites: 

• To re-record the deferred audio message, repeat the corresponding actions of the step 3.

If the re-recording is successful, when clicking Save, the Changes were successfully saved message appears.

• To change the text message, delete the text from the corresponding field, type a new text, and then click Save.

4.1.4.3.2 Managing Deferred Actions

Follow the procedure to edit or delete an existing deferred action.

Prerequisites: 

• Ensure the radioserver whose deferred actions you want to manage is online.

• Ensure the operator has the Create deferred actions right. For details, see Operators.

Procedure: 

1. Open the Deferred Actions window in one of the following ways:

To open the window from the Create Deferred Action window, click the View Deferred Actions button.

To open the window from the menu bar, click Service → Deferred Actions.

2. In the window that appears, from the Current Radioserver list, select the desired radioserver or All radioservers.

3. Click Load Action List.

Existing deferred actions appear in the Deferred Actions Table below.

4. In the Deferred Actions Table, select the desired deferred action.

5. Perform the desired operation:

To edit the deferred action, perform the following actions:

1. Click Edit (   ).

The Create Deferred Action window appears.
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2. In the window that appears, perform the desired changes.

3. Click Save.

If the action changing is successful, the Changes were

successfully saved message appears.

To delete the deferred action, click Delete (   ).

The selected deferred action disappears from the Deferred

Actions Table.

NOTE

If connection to the radioserver to which the selected deferred action belongs is lost after loading the action list, when clicking Edit ( 

 ) or Delete (   ), the Radioserver is unavailable message appears.

4.1.5 Talkgroups

Talkgroups provide the ability to group several radios into a single group to transmit voice and other data to all group radios

simultaneously. Dispatchers can perform various actions regarding radios in talkgroups, for example, receive and initiate calls, receive

and send text messages, and assign tickets. To use talkgroups in SmartPTT Dispatcher, they must be configured in SmartPTT

Radioserver Configurator. For details, see SmartPTT Installation and Configuration Guide.

Available talkgroups are displayed on the Radio Fleet panel as nodes. The Actions (   ) menu provides the ability to perform various

actions with talkgroups. For details, see Talkgroup Actions.

You can use categories to group talkgroups. For details, see Categories.

The talkgroup icon (   ) is displayed next to talkgroup nodes. If the talkgroup is muted, the Mute (   ) icon is displayed.

The same icon is used for All Calls.

For information on All Calls, see All Calls.

The Talkgroup element is available for Custom Consoles. It provides the ability to interact with talkgroups and make All Calls.

Depending on the settings, the Call Window appears automatically when events connected with the talkgroup occur. You can also open

this window by double-clicking the desired talkgroup on the Radio Fleet pane. For details, see Call Windows.

4.1.5.1 Talkgroup Actions

The talkgroup Actions menu provides the ability to perform various actions related to the talkgroups.

You can open the Actions menu by clicking the Actions (   ) button to the right of the talkgroup name on the Radio Fleet panel.

In the Actions menu of the talkgroup, you can perform the following actions:

Action Description

Send Message (   ) Opens the Send Message window where you can type and send messages or

manage message templates.

For details, see Sending Messages from the Send Message Window.

The action is unavailable if the operator does not have the Send text messages

right.

For information on the operator rights, see Operators.

Make Conference Call (   ) Opens the Conference Calls window where you can initiate a conference call.

For information on the window, see Initiating Conference Calls from the

Conference Calls Window.
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Action Description

The action is unavailable if the operator does not have the Make conference

calls right.

Call Telephone Subscriber (   ) Opens the Telephone Subscribers window where you can call a telephone

subscriber.

Important

The call is possible if the required settings are configured on SmartPTT

Radioserver. For details, see “Connecting to SIP Server” in SmartPTT

Installation and Configuration Guide.

Mute (   ) / Unmute (   )

Mutes or unmutes the talkgroup.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting.

For information on the sound settings, see Configuring Additional Sound

Settings.

Selection of Audio Output Device (   )

Provides a list of audio output devices used to play the sound of the talkgroup.

By default, <No> and Main device values are available.

For information on configuring and assigning audio output devices,

see Configuring Audio Output Devices and Assigning Audio Output Devices.

Exit Emergency Mode (   )

Confirms an incoming alarm, and then stops the alarm sound and emergency

indication.

NOTE

The action is available when a radio sends an emergency alarm.

Properties (   ) Opens the talkgroup properties window, where you can assign telemetry actions

and type a note for other SmartPTT Dispatcher users.

4.1.6 Dynamic Groups

SmartPTT Dispatcher provides the ability to display virtual groups created in the SmartPTT Mobile application. In SmartPTT Dispatcher,

virtual groups that consist only of SmartPTT Mobile users are called dynamic groups.

To manage dynamic groups, you can perform the following actions:

• Create new and edit existing dynamic groups. For details, see Adding and Editing Dynamic Groups.

• Add members to a dynamic group and remove members from it. For details, see Adding and Editing Dynamic Groups.

• Mute and unmute dynamic groups.

NOTE

Dynamic group management is unavailable if desktop client authentication on SmartPTT Radioserver is enabled and the profile

assigned to the client prohibits managing dynamic groups. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

You can use categories to group dynamic groups. For details, see Categories.

Virtual groups consisting of talkgroups and SmartPTT Mobile users appear in SmartPTT Dispatcher as cross patches between

talkgroups and dynamic groups and are called multigroups. For details, see Cross Patches.
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Dynamic groups can also be created in SmartPTT Dispatcher. The group must have at least two SmartPTT Mobile users. The dispatcher

can add only registered users of the SmartPTT Mobile application (active or not) to the group.

NOTE

When creating a dynamic group in SmartPTT Dispatcher, a virtual group with the same members is created in the SmartPTT Mobile

application.

The dispatcher can also edit the name or participants of dynamic groups, as well as delete them. The dispatcher can edit and delete

dynamic groups both created in SmartPTT Dispatcher and created in the SmartPTT Mobile application.

NOTE

SmartPTT Mobile users cannot edit or delete dynamic groups created in SmartPTT Dispatcher.

The dynamic groups available in SmartPTT Dispatcher are displayed under the SmartPTT Mobile node on the Radio Fleet panel.

Dynamic Group Icon (   ) displays a dynamic group and its state:

• The blue color (   ) indicates that the group is active. If the group sound is muted, the Mute (   ) icon is displayed.

• The gray color (   ) indicates that the group is inactive. If the group sound was muted, the Mute (   ) icon is displayed.

Depending on the settings, the Call Window appears automatically when events connected with the dynamic group occur. You can also

open this window by double-clicking the desired dynamic group on the Radio Fleet pane. For details, see Call Windows.

4.1.6.1 Adding and Editing Dynamic Groups

Follow the procedure to add a new or edit the existing dynamic group on the Radio Fleet panel.

Prerequisites: 

Ensure the Mobile Subscribers virtual control station is added on the Radio Fleet panel.

Procedure: 

1. On the Radio Fleet panel, perform one of the following actions:

To add a new dynamic group, open the Actions (   ) menu of the Mobile Subscribers virtual

control station, and then select Create dynamic group (   ).

To edit an existing dynamic group, open the Actions (   ) menu of the desired group, and then

select Properties (   ).

 The Dynamic group window appears.
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2. (Optional) In the window that appears, in the Name field, type the dynamic group name.

3. Edit the dynamic group member list:

To add the SmartPTT Mobile user to the dynamic

group,

select the desired mobile client in the Mobile devices area, and then click

the Add (   ) button.

The selected mobile client appears in the Temporary Talkgroup Members

area.

To remove the SmartPTT Mobile user from the

dynamic group,

select the desired mobile client in the Temporary Talkgroup Members

area, and then click the Remove (   ) button.

The selected mobile client disappears from the Temporary Talkgroup

Members area.

NOTE

You can also add or remove the SmartPTT Mobile users by double-clicking or dragging them to the desired area.

4. To complete configuration, click Create/OK.

Postrequisites: 

To delete a dynamic group, in the Actions (   ) menu of the desired group, click Delete (   ), and then, in the Confirmation window, click

OK. After a dynamic group is deleted, its members will receive a notification about it.

NOTE

If a dynamic group is participating in a cross patch or voice call, after you click Delete, a warning window appears with the indication

that the group cannot be deleted.
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4.1.7 Channels and Systems

Channels and systems represent control stations or virtual control stations, system-wide and local channels of conventional radio

systems, and trunked radio systems.

Available radio systems and channels are displayed on the Radio Fleet panel as nodes. These nodes group radios, talkgroups, dynamic

groups, and All Calls.

The channel icon displays the state of the channel:

• The blue color (   ) indicates that the channel is active. If the channel is muted, the Mute (   ) icon is displayed.

• The gray color (   ) indicates that the channel is inactive (the device is turned off or it is out of the network coverage). If the

channel is muted, the Mute (   ) icon is displayed.

The channel node can be expanded or collapsed to show or hide the radios, talkgroups, dynamic groups, and All Calls. If the connection

to the system is lost, the control disappears and all sub-entries are hidden.

You can select channels directly on the Radio Fleet panel. The selector appears in the Status column of the Object Table.

Important

To switch between the control station channels, an operator needs to have the Change channel on control station right. For

information on the operator rights, see Operators.

NOTE

If no statuses are added in SmartPTT Dispatcher, the Status column disappears from the Object Table, and the channel selection

control will be available only in the custom console.

The Actions (   ) menu provides the ability to perform various actions related to channels.

The Custom Console feature provides the Channel element to work with control stations and IP Site Connect available in the radio

system. Using the Channel Selector element on the Custom Console, you can switch to the control station channel represented by the

element.

The Channels panel provides the ability to manage channels and radio systems. For details, see Channels Panel.

4.1.7.1 Channel and System Actions

The channel Actions menu provides the ability to perform various actions related to channels.

You can open the Actions menu in one of the following ways:

• By clicking the Actions (   ) button to the right of the channel name on the Radio Fleet panel

• By clicking the Actions (   ) button of the desired channel on the Channels panel or in the Custom Console

In the Actions menu of the channel, you can perform the following actions:

Action Description

Radio Dekey (   )

Interrupts all calls that are being made on the channel of the control station.

Available to MOTOTRBO control stations only.

Reset Control Station (   )

Resets a control station.

Available to MOTOTRBO control stations only.

The action is unavailable if the operator does not have the Reboot control

station right.

For information on the operator rights, see Operators.
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Action Description

Mute (   ) / Unmute (   )

Mutes or unmutes the channel.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting.

For information on the sound settings, see Configuring Additional Sound

Settings.

Mute Others (   )

Mutes all objects except for the desired channel.

Create dynamic group (   )

Opens the Dynamic group window where you can add a new dynamic group.

For information on dynamic groups, see Dynamic Groups.

Available to the SmartPTT Mobile virtual control station only.

Selection of Audio Output Device (   )

Provides a list of audio output devices used to play the sound of the channel

objects. By default, <No> and Main device values are available.

For information on configuring and assigning audio output devices,

see Configuring Audio Output Devices and Assigning Audio Output Devices.

Properties (   ) Opens the channel properties window.

Exit Emergency Mode (   )

Confirms an incoming alarm, and then stops the alarm sound and emergency

indication.

NOTE

The action is available when a radio sends an emergency alarm.

Available to control stations only.

4.1.7.2 Channels Panel

The Channels panel displays information and provides controls for working with the control stations and IP Site Connect channels

available in the radio system.

You can perform the following actions in the Channels panel:

• Initiate All Call on the desired channel. For details, see Initiating Group Voice Calls.

• Initiate a group call on the desired channel. For details, see Initiating Group Voice Calls.

• Open the control station or IP Site Connect channels Actions menu by clicking the Actions (   ) button on the channel element.

For details, see Channel and System Actions.

• Mute or unmute the channel sound.

You can open the Channels panel by clicking Tools → Channels on the menu bar.

The font size for radio names on the panel elements, width of elements, and display of radio icons on elements can be configured. For

details, see Configuring Channel Panel.

The Channels panel provides the ability to select groups and control station channels directly on channel elements. For details, see

Configuring Channel Panel.

Important

To switch between the control station channels, an operator needs to have the Change channel on control station right. For

information on the operator rights, see Operators.
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On the Channels panel, you can see the name of the current call initiator and the call target. The call target is the list of available All Call

and group call options on the channel. During an incoming group call, the selected group name changes to the group name to which the

call is initiated.

The element color indicates the current state of the call on the channel. For information on call statuses and their color indication, see

Color Indication of Voice Calls.

If there are no active calls on the channel, the color of its element indicates its current state:

• The blue color indicates that the channel is currently active but there are no active transmissions on it.

• The gray color indicates that the channel is currently inactive (the device is turned off or out of the network coverage).

4.1.7.2.1 Configuring Channel Panel

Follow the procedure to configure display of channels on the Channels panel.

Procedure: 

1. On the menu bar, select Tools → Channels.

The Channels panel appears.

2. On the Channels panel, perform one of the following actions:

To change the font size for channel names on all

elements of the panel,

click the icon (   ) corresponding to the desired font size

(small, medium, or large).

To change the width of all elements on the panel,

click the icon (   ) corresponding to the desired element

width (narrow, medium, or wide).

To display or hide the channel icon for all elements of

the panel,

click Show Icon (   ).

The channel icon disappears or appears on channel elements.

To mute or unmute a channel, click Mute (   ) or Unmute (   ).

To select a channel, click Channel Selector buttons (   /   ).

NOTE

The Channel Selector is available to control stations only.

To select a group, perform the following actions:

1. Click the down arrow (   ) to open the group list.
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2. Select the desired group.

4.1.8 All Calls

The All Call feature provides the ability to initiate calls to all radios registered on a channel or in a system.

To use All Calls in SmartPTT Dispatcher, they must be configured in SmartPTT Radioserver Configurator. For details, see SmartPTT

Installation and Configuration Guide.

The All Call Actions (   ) menu provides the ability to perform various actions related to All Calls.

You can open the Actions menu by clicking the Actions (   ) button to the right of the All Call entry on the Radio Fleet panel.

The Actions menu provides the following actions:

• Muting and unmuting All Calls.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting. For information on the sound settings, see Configuring

Additional Sound Settings.

• Selecting audio output device to play the sound of All Call.

For information on audio output devices configuring and assigning procedures, see Configuring Audio Output Devices and

Assigning Audio Output Devices.

• Opening the All Call properties window, where you can type a note for other SmartPTT Dispatcher users.

The All Call nodes are displayed only when the Filter by channel (   ) view is active.

The All Call icon (   ) is displayed next to All Call nodes. If All Call is muted, the Mute (   ) icon is displayed.

The same icon is used for talkgroups.

For information on talkgroups, see Talkgroups.

Depending on the settings, the Call Window appears automatically when events connected with All Call occur. You can also open this

window by double-clicking the desired All Call entry on the Radio Fleet pane. For details, see Call Windows.

4.2 Voice Calls

SmartPTT Dispatcher provides the ability to initiate and receive voice calls.

Important

For voice calls to be available, the installed license must include voice transmission for the corresponding radio system. For details,

see Licenses.

Making voice calls to the radio network and receiving calls from radios in SmartPTT Dispatcher are available only to the

Administrator and operators with the Make voice calls right. For details, see Operators.

A dispatcher can monitor calls initiated by radios and telephone calls transmitted within the radio network, as well as transmissions

from other dispatchers in the system.

For information on muting other dispatchers, see Configuring Additional Sound Settings.

SmartPTT Dispatcher supports the ability to turn sound on and off and select an audio output device for specific talkgroups, channels,

and systems. For details, see Sound Management.

An operator can send voice notifications to talkgroups. For this, voice notifications must be configured on SmartPTT Radioserver: the

sound file to be played and the list of channels where it will be played must be specified. Voice notifications are sent to radio networks

as voice transmissions. They cannot be sent in radio networks where voice calls are not licensed or configured. For details, see Voice

Notifications.
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Important

Initiating and receiving voice calls, monitoring private calls, as well as voice actions applicable to individual radio system objects

(configuring sound, calling telephone subscribers, making conference calls, sending voice notifications) are unavailable if desktop

client authentication on SmartPTT radioserver is enabled and the profile assigned to the client prohibits actions with voice calls. For

details, see “Profiles” in SmartPTT Installation and Configuration Guide.

The main tool for monitoring ongoing calls and viewing call history in SmartPTT Dispatcher is the Calls panel.

For information on the panel, see Calls Panel.

All voice calls in SmartPTT Dispatcher have various color indication depending on their status.

For information on color indication of voice calls, see Color Indication of Voice Calls.

The Administrator can select the desired call mode (single click/tap or hold a call element) in the settings of pointing devices. For

details, see Control Devices.

Private and Group Calls

SmartPTT Dispatcher provides the ability to make private calls to radios and group calls which include calls to talkgroups and All Calls.

A dispatcher can initiate private and group calls in one of the following ways:

• Using a PTT button on the Radio Fleet panel. For details, see Radio System Objects.

• Using the PTT button in the corresponding Call Window. For details, see Call Windows.

• Using the corresponding custom console element. For details, see Custom Consoles.

• Using a finished call entry on the Calls panel.

• Using hotkeys. For details, see Assigning Hotkeys.

Private calls can also be initiated using radio elements on the Radios panel. For details, see Radios Panel.

Group calls in IP Site Connect networks and over control stations can be initiated using channel elements on the Channels panel. For

details, see Channels Panel.

For information on initiating a voice call from SmartPTT Dispatcher panels or a Call Window, see Initiating Private Voice Calls and

Initiating Group Voice Calls.

For information on initiating voice calls using a finished call entry, see Initiating Voice Calls on Calls Panel.

Dispatchers can receive private calls from any radio that appears in the list of radios available in SmartPTT Dispatcher. They also receive

group calls targeted to any talkgroup (or All Call) they see in the user interface.

Multicalls

For operator convenience, SmartPTT Dispatcher provides the ability to initiate calls to several selected radios and/or talkgroups,

including All Call, simultaneously.

Multicalls can be initiated in the following ways:

• On the Radios panel

• On the Channels panel

• On the custom console panel

To initiate a multicall, it is necessary to select the desired radio object elements while holding the Ctrl or Shift key. The blue frame

appears on the object elements.

NOTE

The same action must be performed to deselect the radio object elements.
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A call to the selected objects is initiated using a hotkey for the PTT button (the Space key by default). When the call is initiated, the radio

objects become yellow ( ⬛ ).

Multicalls can also be initiated using the PTT element on the Panel element of a custom console if multiple radios and/or talkgroups are

added to the Panel element, and using the Multiselect element. For details, see Custom Consoles.

Other Calls

SmartPTT also supports the following types of voice calls:

• The broadcast call is a group call or an All Call on all available channels of the dispatched radio system at the same time made

using the Broadcast Call element of a custom console. For details, see Custom Consoles.

• Phone calls:

• Voice call from a radio to a telephone subscriber

• Voice call from a talkgroup to a telephone subscriber

• Voice call from a telephone subscriber to a talkgroup or the All Call ID

• Voice call from a telephone subscriber to a radio

• Voice call from SmartPTT Dispatcher to a telephone subscriber

• Voice call from a telephone subscriber to SmartPTT Dispatcher

For information on phone calls, see Telephone Interconnect Settings and Telephone Interconnect. Also, see “SIP Telephony” in

SmartPTT Installation and Configuration Guide.

Important

Access to full functionality of the telephony features requires installing the corresponding license.

An operator can also call telephone subscribers for the desired radios or talkgroups. For details, see Connecting Radios with

Telephone Subscribers.

Important

Communicating with telephone subscribers is available only to the Administrator and operators with the Make telephone calls right.

• Voice calls between dispatchers. For details, see Dispatchers.

Important

Communicating with external dispatchers is available only to the Administrator and operators with the Connect with external

dispatchers right.

• Conference calls with radios, talkgroups, dispatchers, and telephone subscribers. For details, see Conference Calls.

Important

Conference calls are available only to the Administrator and operators with the Make conference calls right.
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4.2.1 Color Indication of Voice Calls

For operator convenience, all voice calls in SmartPTT Dispatcher have color indication that depends on the voice call status. This

indication informs the operator about the current voice call status, thus allowing to work faster with the main functionality of the

dispatch system.

In SmartPTT Dispatcher, the following colors of radio object elements are used during voice calls:

Color Indication Call Status

Light yellow Establishing connection via the radio channel. Refers to outgoing calls

made by the dispatcher.

Yellow Sending a voice transmission to a radio. Refers to outgoing calls made

by the dispatcher.

Green Sending a voice transmission from a radio to SmartPTT Dispatcher,

including the (remote) monitoring mode. Refers to incoming calls

received by the dispatcher.

Blue Channel hold mode (none of the parties are transmitting the voice call).

Clicking the PTT button before the hold time expires resumes the call.

Clicking it after initiates a new call.

NOTE

The duration of hangtime can be different for different radio objects.

During voice calls, color indication is displayed on the following SmartPTT Dispatcher controls:

• Ongoing call entries on the Calls panel. For details, see Calls Panel.

• PTT buttons of the Radio Fleet panel. For details, see Radio System Objects.

• The Radios panel elements. For details, see Radios Panel.

• The Channel panel elements. For details, see Channels Panel.

• The custom consoles elements. For details, see Custom Consoles.

• The PTT button in a Call Window. For details, see Call Windows.

• PTT buttons of the Cross Patches panel. For details, see Cross Patches.

• The PTT button of an emergency notification on the Emergencies panel. For details, see Emergency.

• The PTT button of an alert notification on the Notifications panel. For details, see Notification Panels.

Color indication of radio objects elements during voice calls is accompanied by additional information (for example, the names of the

voice call initiator and recipient).

In addition, the color of radio objects elements can be changed in the following cases:

• During the radio object status change (online or offline)

• When changing the radio object element color in the Custom Console
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4.2.2 Initiating Private Voice Calls

Follow the procedure to initiate a private call.

NOTE

A call can also be initiated using hotkeys.

For information on hotkeys, see Control Devices.

Prerequisites: 

• Check the current settings of pointing devices. For details, see Control Devices.

• Ensure one of the following panels or windows is open:

• The Radio Fleet panel. For details, see Radio System Objects.

• The Radios panels. For details, see Radios Panel.

• The radio Call Window. For details, see Call Windows.

• The Сustom Сonsole panel. For details, see Custom Consoles.

• Ensure the operator has the Make voice calls right.

For information on the operator rights, see Operators.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows voice

calls. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. Initiate a private call in one of the following ways:

To initiate a private call using the PTT button, press and hold, or click the PTT button of the desired radio.

For information on configuring the way to initiate a voice call, see

Configuring Call Element Actions.

To initiate a private call using the Radio element

on the Radios panel,

press and hold, or click the Radio element of the desired radio.

For information on configuring the way to initiate a voice call, see

Configuring Call Element Actions.

The PTT button or the Radio element becomes light yellow (⬛ ), and three dots appear on it.

2. After the color indication appears, perform the following actions:

If the PTT button or the Radio element becomes

yellow ( ⬛ ), and three dots appear on it,

perform the following actions:

1. Speak in your microphone.

2. Release or click again the PTT button or the Radio

element to end the radio transmission.

If the PTT button or the Radio element becomes light-

green ( ⬛ ),

perform the following actions:

1. When the PTT button or Radio element becomes

green ( ⬛ ), listen to the radio transmission.

The PTT button or the Radio element becomes blue ( ⬛ ),

when the radio ends the transmission.

2. Click the PTT button or the Radio element again.
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3. When the PTT button or the Radio element becomes

yellow ( ⬛ ), speak in your microphone.

4. To end the radio transmission, release or click again the

PTT button or the Radio element.

 When the radio transmission is over, the PTT button or the Radio element becomes blue ( ⬛ ).

3. When the blue color indication ( ⬛ ) appears, perform one of the following actions:

To transmit again, repeat step 1.

To listen to the radio transmission, wait until the PTT button or the Radio element becomes green ( ⬛ ),

and you hear the other participant's voice from your speakers or

headset.

To end the call, wait until the blue indication ( ⬛ ) disappears.

4.2.3 Initiating Group Voice Calls

Follow the procedure to initiate a call into a talkgroup, or an All Call.

NOTE

A call can also be initiated using hotkeys.

For information on hotkeys, see Control Devices.

Prerequisites: 

• Check the current settings of pointing devices. For details, see Control Devices.

• Ensure one of the following panels or windows is open:

• The Radio Fleet panel. For details, see Radio System Objects.

• The Channels panel with a talkgroup or an All Call selected on the desired channel element. For details, see Channels Panel.

• The desired Call Window. For details, see Call Windows.

• The Custom Console panel. For details, see Custom Consoles.

• Ensure the operator has the Make voice calls right.

For information on the operator rights, see Operators.

• If desktop client authentication on SmartPTT radioserver is enabled, ensure that the profile assigned to the client allows voice

calls. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. Initiate a group call or All Call in one of the following ways:

To initiate a call using the PTT button, press and hold, or click the PTT button of the desired

talkgroup or All Call.

To initiate a call using the Radio element, press and hold, or click the Group Call or All Call element.

 The PTT button or the call element becomes light yellow ( ⬛ ), and three dots appear on it.

2. When the PTT button or the call element becomes yellow ( ⬛ ), speak in your microphone.
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3. To end the transmission, release or click again the PTT button or the call element.

The PTT button or the element becomes blue ( ⬛ ).

4. When the blue color indication ( ⬛ ) appears, perform one of the following actions:

To transmit again, repeat step 1.

To listen to the radio transmission, wait until the PTT button or the call element becomes green ( ⬛ ), and

you hear the other participant's voice from your speakers or headset.

To end the call, wait until the blue indication ( ⬛ ) disappears.

4.2.4 Calls Panel

The Calls panel provides the list of entries with information on ongoing and finished calls. These entries provide the ability to perform

the following actions:

• Make a call to the recipient radio or into the recipient talkgroup by clicking the call entry

• Answer the incoming call for the dispatcher by clicking the call entry

• Track the ongoing call state

• See the history of all calls in the radio network, time of a call, and its duration (during the current session only)

• Initiate a call by clicking the button with the initiator or recipient name

The panel displays only calls that occur in the radio system.

The first time you install SmartPTT Dispatcher, the Calls panel opens automatically. The panel can also be opened or closed manually.

You can open the Calls panel by clicking Tools → Calls on the menu bar.

Important

To initiate voice calls, an operator must have the Make voice calls right.

For information on the user roles, see Operators.

Important

If desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned to the client prohibits actions with voice

calls, you will not be able to initiate and receive voice calls. For details, see “Profiles” in SmartPTT Installation and Configuration

Guide.

A call entry on the Calls panel can be of two types:

• Ongoing call entry

• Finished call entry
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An ongoing call entry displays the current transmission or hang time. It provides dispatchers with the ability to answer an incoming call

or make a call to the recipient radio or to the recipient talkgroup by clicking anywhere on the call entry.

A call status is determined by the color of the call entry.

For information on the color indication of voice calls, see Color Indication of Voice Calls.

NOTE

During remote monitoring, the monitored radio is displayed as Call Initiator and Speaker.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the radio name in

parentheses.

If a call cannot be initiated but call attempts continue, the reason why call is not initiated can be displayed on the call entry instead of the

speaker name.

Entries of finished calls provide the ability to see information about the registered call and to initiate a call by clicking the Call Initiator or

the Call Recipient name.

For information on initiating voice calls on the Calls panel, see Initiating Voice Calls on Calls Panel.
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4.2.4.1 Initiating Voice Calls on Calls Panel

Follow the procedure to initiate a private or a group call using the finished call entry on the Calls panel.

NOTE

A call can also be initiated using hotkeys.

For information on hotkeys, see Assigning Hotkeys.

Prerequisites: 

• Check the current settings of pointing devices. For details, see Configuring Call Element Actions.

• Ensure the Calls panel is open.

Procedure: 

1. Initiate a call by clicking the Call Initiator or the Call Recipient name.

A new ongoing call entry appears at the top of the Calls panel. The call entry becomes light yellow ( ⬛ ), and the button with three

dots appears on it.

2. When the call entry becomes yellow ( ⬛ ), start speaking in your microphone.

3. To end the transmission, click the ongoing call entry.

The call entry becomes blue ( ⬛ ).

4. When the blue color indication ( ⬛ ) appears, perform one of the following actions:

To start the transmission again, click the ongoing call entry.

To listen to the transmission of another

participant of the call,

wait until the ongoing call entry becomes green ( ⬛ ), and you hear the

another participant's voice from your speakers or headset.

To end the call, wait until the blue indication ( ⬛ ) disappears.
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4.2.5 Sound Management

SmartPTT Dispatcher provides advanced sound management features for various objects and events in the radio system:

• Audio output device selection.

To assign a personal audio output other than the main device, the desired audio output device must be added and configured by

the Administrator in the Sound Settings window. For details, see Configuring Audio Output Devices.

• Muting and unmuting.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting. For details, see Audio System.

• Adjusting volume.

The main tool for managing volume of selected/unselected objects and system sounds in SmartPTT Dispatcher is the Sound panel.

Selected objects are objects that were selected by the user. These objects are highlighted with a blue frame. The objects with an open

and active Call Window are also considered selected.

NOTE

The name of the selected object is displayed on the SmartPTT Dispatcher information bar in green. For details, see SmartPTT

Dispatcher Interface Configuration.

If several objects are selected, the Multiselect caption appears.

System sounds include the following sounds:

• Alert sound for a triggered rule

• Sound of a transmission initiating

• Notifications of dispatcher and telephone subscriber incoming calls

• Ringing sound when calling a telephone subscriber or dispatcher

• Sound of call records played from the SmartPTT Dispatcher or SmartPTT Radioserver Event Log

• Sound of system messages

• Call Alert tone

The Sound panel also provides the ability to adjust the microphone volume and contains the audio visualizer that displays the volume of

incoming and outgoing sound (voice, audio, tones) on audio frequencies supported by the codec.

NOTE

In addition to the Sound panel, muting/unmuting the dispatcher's microphone is available in the Dispatchers (when communicating

with another dispatcher) and Conference Calls windows.

For information on adjusting volume on the Sound panel, see Adjusting Volume of Objects and System Sounds and Adjusting Microphone

Volume.

Sound management features are available in SmartPTT Dispatcher according to the following table:

Objects or Events Selection of Audio Output Device Muting/Unmuting Adjusting Volume

Selected Objects

Unselected Objects

System Sounds

In the Sound Settings window

Important

The window is available only

to the Administrator.

On the Sound panel On the Sound panel
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Objects or Events Selection of Audio Output Device Muting/Unmuting Adjusting Volume

Call Records In the Sound Settings window

(System sounds)

On the Sound panel (System

sounds)

• On the Sound panel (System

sounds)

• In the Play Records window

Call Alert In the Sound Settings window

(System sounds)

On the Sound panel (System

sounds)

• On the Sound panel (System

sounds)

• In the General Settings

window

Important

The window is available only

to the Administrator.

Emergency Alarms In the Sound Settings window

(Alarm)

On the Emergencies panel N/A

Emergency Calls In the Sound Settings window

(Alarm)

• In the Actions menu of the

corresponding channel

• On the corresponding channel

element of the Channels panel

• On the corresponding channel

element of a Custom Console

In the Control Station window of

the corresponding channel

Radioservers

• In the Sound Settings window

• In the Actions menu

N/A N/A

Channels and Systems

• In the Sound Settings window

• In the Actions menu

• In the Actions menu

• On the element of the

Channels panel

• On the element of a Custom

Console

In the Control Station window

Talkgroups

• In the Sound Settings window

• In the Actions menu

• In the Actions menu

• On the element of a Custom

Console

N/A

All Calls In the Actions menu

• In the Actions menu

• On the element of a Custom

Console

N/A

Dynamic Groups N/A In the Actions menu N/A

Cross Patches

Multiselect Groups

N/A

• In the Actions menu

N/A
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Objects or Events Selection of Audio Output Device Muting/Unmuting Adjusting Volume

• On the element of a Custom

Console

Phone Calls N/A N/A In the Telephone Interconnect

window

Important

The window is available only

to the Administrator.

Conference Calls N/A In the Conference Calls window N/A

SmartPTT Dispatcher also provides the ability to mute all objects except for the desired channel using the Actions menu of that channel.

4.2.5.1 Adjusting Volume of Objects and System Sounds

Follow the procedure to adjust the volume of selected/unselected objects or system sounds.

Procedure: 

1. If the Sound panel is closed, on the menu bar, click Tools → Sound.

2. On the Sound panel, click Speakers (   ).

The volume sliders appear.

3. Adjust the volume of selected/unselected objects or system sounds:

To increase the volume, move the desired volume slider to the right, or click the

Increase Volume (   ) button.
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To decrease the volume, move the desired volume slider to the left, or click the

Decrease Volume (   ) button.

To mute the sound, click Mute (   ) next to the desired slider.

The button changes to Unmute (   ).

To unmute the sound, click Unmute (   ).

4.2.5.2 Adjusting Microphone Volume

Follow the procedure to adjust the microphone volume.

Procedure: 

1. If the Sound panel is closed, on the menu bar, click Tools → Sound.

2. On the Sound panel, click Microphone (   ).

The volume slider appears.

3. Adjust the volume of the microphone:

To increase the volume, move the volume slider to the right, or click the Increase Volume (   )

button.

To decrease the volume, move the volume slider to the left, or click the Decrease Volume (   )

button.

To mute the microphone,

click Mute (   ) next to the slider.

The button changes to Unmute (   ).

To unmute the microphone,

click Unmute (   ).

4.2.6 Voice Notifications

A voice notification is a preconfigured audio file that can be sent to a talkgroup or during All Call as a voice transmission.

The Voice Notification feature provides the ability to play pre-recorded messages for the selected talkgroups and All Calls to inform

users about emergencies or deliver other important information in audio format.

Voice notifications are created and configured in SmartPTT Radioserver Configurator. For details, see “Voice Notifications” in SmartPTT

Installation and Configuration Guide.

Voice notifications are visible only to operators whose profiles have the corresponding permissions and can only be managed by them.
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If all recipients are busy, voice notifications will be put in queue and transmitted when their recipients become available.

A voice notification can interrupt an ongoing transmission. The voice notification priority depends on the system settings.

For information on voice notifications priority in the dispatched radio systems, contact your system administrator.

All voice notifications are logged in the SmartPTT Dispatcher and SmartPTT Radioserver event logs as a separate type of events. The

notification icon color in the SmartPTT Dispatcher Event Log determines if the iteration was successful (blue icon) or played with

errors/not all recipients were reached (red icon).

During voice notification transmissions, SmartPTT Dispatcher provides amount of successful and failed transmissions as well as how

many iterations left. Operator is notified when a voice notification was queued or not delivered.

NOTE

SmartPTT Dispatcher does not provide details on voice notifications. To obtain information about the selected audio file, channels

for which the notification is assigned, and playback parameters, contact your system administrator.

Voice notifications can be played in one of the following ways:

• From the Voice Notifications window. For details, see Playing Voice Notifications.

• Using the Voice Notification element in custom consoles. For details, see Custom Console Elements.

• Automatically, when triggered by a rule configured in SmartPTT Radioserver Configurator. For details, see “Rules” in SmartPTT

Installation and Configuration Guide.

The Voice Notifications window displays the notification playback details even if the notification is played from a custom console or

triggered by an event configured in the rule in SmartPTT Radioserver Configurator.

The voice notification playback status is indicated by the color of its entry in the Channels table of the Voice Notifications window:

• Yellow ( ⬛ ) indicates that the voice notification is currently playing. The lighter yellow shade means that the notification is in

queue.

• Green ( ⬛ ) indicates that the voice notification has been successfully played.

• Red ( ⬛ ) indicates that the voice notification was not played due to connection, audio file, or hardware problems.

If the same notification is available for several operators, all operators will see its playback status change.

Conflict Resolution

If multiple voice notifications are started simultaneously, it can lead to situations where two or more notifications must be played for

the same recipient. Such situations are resolved automatically by SmartPTT based on the current state of the system.

Only one time slot of a conventional radiosystem can be used to transmit a notification at a given moment. SmartPTT Radioserver

Configurator does not allow to select more than one talkgroup for each conventional channel to prevent collisions. Trunking networks

do not have such limit, so the system is able to send notifications to as many talkgroups as there are free channels. If the number of

available channels is not enough, only the first talkgroups in the list will be notified.

If a voice notification is configured to be played to a specific list of recipients, no matter who starts it, it will be sent to all those

recipients, even if the profile of the current initiator of the voice notification limits access to some of them.

If some of the recipients are busy or unavailable, the voice notification will be played only for the currently available recipients. The

system will notify the operator that the voice notification was not properly played for all recipients.

If all recipients are currently busy, the voice notification will be put in queue until any recipient become available. Once the recipient is

available, voice notification will start playing. The system notifies the operator about queued voice notifications.

If all recipients are unavailable (radio system is disconnected from the radioserver), the voice notification will be canceled, and the

operator will be notified about it.

If multiple notifications are to be transmitted to the same recipient, there are two possible ways to resolve it:
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• If none of the notifications is set to interrupt other notifications, they will use queueing to be played one after another.

• If one of the notifications is allowed to interrupt other notifications, it will clear the channel and start the transmission.

Voice notifications can not interrupt the following types of calls:

• Ongoing phone call

• Ongoing analog call on an analog control station

• All Call in NAI CPSS and NAI CMSS systems

• All Call or Emergency call in the Capacity Max system

Access Control

A voice notification configuration contains a set of talkgroups. If any of these talkgroups are available to the operator, the voice

notification will be available to that operator. Voice notification will be unavailable to operator only if all talkgroups in voice notification

are unavailable to them.

Unavailable voice notifications will be hidden from the Voice Notifications window. If any voice notifications were used as elements of

custom console, the elements will be grayed out and there will be no information about voice notification content, recipients and/or its

state.
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4.2.6.1 Playing Voice Notifications

Follow the procedure to send a voice notification from the Voice Notification window.

Prerequisites: 

Ensure the voice notifications are activated and configured in SmartPTT Radioserver Configurator. For details, see “Managing Voice

Notifications” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Service → Voice Notifications.

The Voice Notifications window appears.

2. In the Radioserver area, select the desired server from the list.

NOTE

Only servers that are currently active and registered in SmartPTT Dispatcher are displayed in the Radioserver list.

3. In the Voice Notifications area, in the table, select the desired voice notification to send.

4. At the bottom of the window, click Start to start the voice notification playback.

The information on the playback appears in the Channels table.

Postrequisites: 

To stop the voice notification playback, click Stop.

NOTE

If you click the Stop button, you will not be able to resume the current voice notification playback.
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4.2.7 Interrupt/Remote Dekey

SmartPTT Dispatcher provides the ability to interrupt voice calls for higher priority information transmission. This option depends on the

type of call (its priority) and the radio network settings.

Feature Glossary

Voice call interrupt — polite termination of a voice call from another radio performed by a dispatcher. Voice call interrupt clears the

corresponding channel in compliance with the interrupt protocol. It provides the ability to clear the channel for a higher priority call and

can also be useful when the channel is busy due to some technical problem with the radio..

For information on the protocols, see the “Configuring SmartPTT Identification” section in SmartPTT Installation and Configuration

Guide.

Remote Dekey — polite termination of a voice call from another radio performed by a dispatcher with the subsequent occupation of the

channel and initiation of a new voice call on the free channel. Remote dekey clears the corresponding channel in compliance with the

interrupt protocol. The Remote Dekey feature provides the ability to initiate a call immediately on the channel where the interrupted call

was made. Interruption can be initiated by a radio network object that has the right to interrupt a voice call.

Feature Description

In some networks, such as IP Site Connect, the dispatcher can interrupt voice calls from radios, and conversely, radios can interrupt

voice calls of the dispatcher if the appropriate settings are configured. The interrupt and Remote Dekey settings are configured on

SmartPTT Radioserver. For details, see “MOTOTRBO Radio Systems” in SmartPTT Installation and Configuration Guide or the SmartPTT

Radioserver Configurator embedded help.

To apply these settings, the permission to interrupt in both ways must be configured in the radio codeplug.

Important

Regardless of the specified settings, emergency calls from radios cannot be interrupted. They always have a higher priority than all

other voice calls.

For information on emergency calls and emergency signal, see Emergency.

All Calls also cannot be interrupted.

For information on All Calls, see All Calls.

When you interrupt/dekey a voice call that is transmitted on several channels, the voice call stops only on the channel where the voice

call interrupt/Remote Dekey was initiated.

If the corresponding settings are specified, then radio calls can be interrupted as the result of the following actions:

• Sending sound notifications to the radio network.

• Performing a deferred action with sending sound to the radio network.

• Performing a server rule related to sending sound to the radio network.

• Sending a voice message to a lone worker.

• Initiating a voice call to a cross patch or any other type of a voice call.
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4.3 Emergency

Emergency in the SmartPTT system is used to draw attention to a critical situation that must be resolved immediately. Radio users can

send emergency signals and initiate emergency calls to attract the attention of the dispatcher and other radio users. To use this feature,

the following conditions must be met:

• One of the following modes must be assigned to the alarm button on the radio:

• Emergency Alarm.

An emergency signal is sent from a radio.

• Emergency Alarm w/Call.

After sending an emergency signal from a radio, a radio user can press the PTT button and initiate an emergency call

following the emergency signal.

• Emergency Alarm w/Voice To Follow.

After sending an emergency signal from a radio, an emergency call is automatically initiated.

NOTE

The emergency calls from radios cannot be interrupted. They always have higher priority than all other voice calls.

• Emergency notifications must be configured in the Notification Panels window.

Emergencies Panel Configuration

The Emergencies panel is configured in the Notification Panels window. Its configuration is available only to the Administrator.

For information on user roles in SmartPTT Dispatcher, see Operators.

The following parameters can be configured in the Notification Panels window:

• Enabling and disabling emergency notification. If the emergency notification is not enabled, a corresponding entry will appear in the

Event Log when emergency occurs. No other emergency indication appears.

• The category of radios that will not be hidden on a map when an emergency is received.

For information on categories, see Categories.

• Sound that will be played in SmartPTT Dispatcher when emergency occurs.

For information on configuring emergency notification in the Notification Panels window, see Configuring Emergency Processing.

Emergencies Panel

The emergency signals and emergency calls trigger an alarm in SmartPTT Dispatcher. It can be indicated by a sound notification or the

Emergencies panel appearance.

This panel appears upon receiving an alarm signal from a radio. You cannot open it manually. When the Emergencies panel appears, the

alarm notification flashes for a time that depends on the value set in a radio. After the emergency mode is turned off on the radio, the

notification stops flashing and changes its background color to gray. The panel includes buttons for muting and resolving an emergency,

as well as the PTT button for initiating a call to a talkgroup to which the radio belongs.

If the Emergencies panel displays only one notification, clicking the Resolve emergency (   ) button closes the panel.
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For information on other notification panels, see Notification Panels.

Dispatcher Actions

In case of receiving an alarm signal, a dispatcher must respond to the situation immediately (initiate a call to a radio or talkgroup, send a

rescue team to the radio user, monitor the situation using Avigilon video monitoring system), and then confirm the emergency situation

resolution on the Emergencies panel or in the radio actions menu using the Resolve emergency (   ) button.

NOTE

Clicking the Resolve emergency button on SmartPTT Dispatcher will also resolve the emergency on SmartPTT Mobile.

Emergency Indication

SmartPTT Dispatcher provides visual indication for emergency that is displayed on the following controls:

• On the Emergencies panel.

The panel appears when an alarm is received and flashes red for a while.

• On the Radios panel.

The Alarm message and the corresponding icon (   ) appear on the element of the radio that sent the alarm.

• On the Custom Console.

The Alarm message and the corresponding icon (   ) appear on the element of the radio that sent the alarm.

• On the Map panel or on a building plan.

When the alarm is registered, the radio that sent the alarm will be centered on a map or a building plan, and a red frame will appear

around it. The radios in the emergency state and radios added to the category for emergency (for example, a rescue team) will be

displayed on a map or building plan too. Other radios will be hidden. After resolving the emergency situation, the hidden radios will

not be automatically displayed, but only after selecting them on the Radios On Plan (   ) tab of the indoor map panel or on the

Radios tab of the outdoor map panel.

• In the Event Log.

An alarm entry is marked with the corresponding icon(   ) and highlighted in red.

• On the Radio Fleet panel.

The name of the radio that sent an alarm is displayed in red.
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NOTE

If the Alarm check box is selected for the Open Call Windows for Event Types parameter in the radio call window settings, then, when

an alarm is received from a radio, its Call Window will open. If the Call check box is selected, then, when you receive an emergency

call from a radio, its Call Window will open as well.

Emergency visual indication stops after a dispatcher confirms the resolution of the alarm situation.

The audible alarm stops when a dispatcher turns off the sound notification or confirms the resolution of all alarm situations.

NOTE

SmartPTT Dispatcher can read radio position data from the Man Down option board. If the radio is tilted for longer than the specified

period, SmartPTT Dispatcher will generate an alarm.

For information on the Man Down mode, see Rules and Lone Worker Mode.

4.4 Signaling Features

SmartPTT Dispatcher provides the operator with the Digital Signaling features used to send various commands to DMR radios.

The commands include:

• Call Alert

• Radio Check

• Remote Monitor

• Radio Disable or Radio Inhibit

Important

Signaling commands are only available in radio systems for which the voice transmission license is installed. For details, see

Licenses.

The command result is displayed in the Status column of the Event Log and in the log of the target radio Call Window. For details, see

SmartPTT Dispatcher Event Log and Call Windows.

Digital Signaling also provides radios with the ability to send emergency alarms. For details, see Emergency.

Call Alert

Sending the Call Alert command activates a preconfigured signal on the target radio to attract the user's attention. This signal notifies

the radio user that the dispatcher wants to start a transmission.



260

SmartPTT Dispatcher Operation Signaling Features

You can send the Call Alert command to a radio using the controls provided by SmartPTT Dispatcher panels. For details, see Sending

Commands from Dispatcher Panels.

Radios can also send Call Alerts to SmartPTT Dispatcher and trigger the corresponding tone for the operator.

An audio file with a call alert tone, its duration and volume are set in the General Settings window. For details, see Configuring SmartPTT

Dispatcher General Settings.

Sending the Call Alert command can be set as a radio alert when configuring a Lone Worker profile. For details, see Managing Lone

Worker Profiles.

Radio Check

Sending the Radio Check command provides the ability to check whether a radio is currently available in the radio system. This feature

can be useful in several cases:

• If the radio does not respond for some reason, for example, it is participating in a call or is offline.

• If you want to check radio availability manually before the radio inactivity timeout expires.

For information on inactivity timeout, see “Configuring ARS” in SmartPTT Installation and Configuration Guide.

When the radio receives a Radio Check command, it automatically sends the acknowledgment, no user involvement is required. The only

indication available to the user of the checked radio is the Busy LED on it.

The following statuses are available to the checked radios:

• The Radio is available status means that the checked radio is available and it is online.

• The Radio is unavailable status means that the checked radio is busy at the moment (for example, participates in a call) or is

offline.

NOTE

If the checked radio is offline, and its inactivity timeout has not yet expired, the radio is displayed as online in SmartPTT Dispatcher

until inactivity timeout expiration, regardless of the sent Radio Check commands.

You can send the Radio Check command in one of the following ways:

• Using the controls provided by SmartPTT Dispatcher panels or the radio Call Window. For details, see Sending Commands from

Dispatcher Panels.

• Using the ID of the target radio. For details, see Sending Radio Check Using Radio ID.

This method is recommended in the following cases:

• If the target radio is not displayed in SmartPTT Dispatcher.

• If each radio in the dispatched radio system has a unique ID.

NOTE

If more than one radio with the same radio ID operate in the dispatched radio system, it is recommended to use the controls provided

by SmartPTT Dispatcher panels or the radio Call Window for sending the Radio Check command.

Remote Monitor

Sending the Remote Monitor command provides the dispatcher with the ability to remotely turn on the microphone of the target radio

without notifying the user and listen to the environment. While remote monitoring is active, the radio cannot initiate calls.
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Important

Remote monitoring is available to operators with the Remote monitor right. For information on user roles in SmartPTT Dispatcher,

see Operators.

Remote monitoring is unavailable if desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned to the

client prohibits the Remote Monitor action. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

You can remotely monitor a radio using the controls provided by SmartPTT Dispatcher panels. For details, see Sending Commands from

Dispatcher Panels.

When the dispatcher initiates the remote monitoring, a call entry with the corresponding icon (   ) appears on the Calls panel. The

monitored radio is displayed on the entry as the call initiator and talker. For details, see Calls Panel.

Block and Unblock Radio

Depending on SmartPTT Radioserver settings, performing the Block Radio (   ) action may result in sending one of the following

commands:

• The Radio Disable command making a radio inoperable.

• The Radio Inhibit command prohibiting a radio from starting and receiving transmissions on the channel it is registered on.

For information on blocking settings, see “Configuring Radioserver” in SmartPTT Installation and Configuration Guide.

Performing the Unblock Radio (   ) action sends a command that is the opposite of the command corresponding to the Block Radio

action.

The Unblock Radio action also provides the ability to unblock radios configured in SmartPTT Radioserver Configurator for automatic

blocking after registration in the network. For details, see “White and Black Lists” in SmartPTT Installation and Configuration Guide.

Important

Blocking and unblocking radios are available only to the Administrator and operators with the Block/Unblock radios right.

Blocking and unblocking are unavailable if desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned

to the client prohibits the Block/Unblock radios action.

You can block or unblock radios using the controls provided by SmartPTT Dispatcher panels. For details, see Sending Commands from

Dispatcher Panels.

4.4.1 Sending Commands from Dispatcher Panels

Follow the procedure to send the Call Alert or Radio Check command, remotely monitor, block or unblock the radio displayed in one of

the SmartPTT Dispatcher panels.

Procedure: 

Send a command in one of the following ways:

To send a command from the Radio Fleet panel, click the Actions (   ) button next to the desired radio, and then

select the option corresponding to the desired command.

For information on the Actions menu, see Radio Actions.

To send a command from the Radios or custom console panel, click the Actions (   ) button on the desired radio element, and

then select the option corresponding to the desired command.

To send a command from the map panel, on the map or on the expandable Radios panel, right-click the

desired radio, and then, from the Actions menu, select the option

corresponding to the desired command.



262

SmartPTT Dispatcher Operation Signaling Features

To send a command from the radio Call Window, in the Call Window of the desired radio, click the button

corresponding to the desired command.

For information on Call Windows, see Call Windows.

The command result is displayed in the Status column of the Event Log and in the log of the target radio Call Window.

For information on the Event Log, see SmartPTT Dispatcher Event Log.

4.4.2 Sending Radio Check Using Radio ID

Follow the procedure to send the Radio Check command using the target radio ID.

Prerequisites: 

• Obtain the ID of the desired radio.

• Ensure the radio registration service is activated and configured in SmartPTT Radioserver Configurator. For details, see

“Configuring ARS” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Service → Radio Check.

The Radio Check window appears.

2. In the Radio ID field, type the radio ID.

3. Click Send to send the Radio Check command to the radio.

The radio status appears in the Status column of the Event Log and in the Call Window of the target radio. Call Windows.

NOTE

If the target radio is not displayed in SmartPTT Dispatcher, its status appears only in the Event Log. In this case, the Call Window does

not appear.

4.5 Event Log and Notification Panels

SmartPTT Dispatcher provides various tools to inform operators about radio network events (voice calls, messages, alarms, etc.). This

information is recorded into the Event Log as well as it displays on notification panels.

The Event Log that is stored in the corresponding database. The Event Log information is displayed on the Event Log panel. SmartPTT

Dispatcher provides two types of the Event Log:

• The SmartPTT Dispatcher Event Log. For details, see SmartPTT Dispatcher Event Log.

• The SmartPTT Radioserver Event Log. For details, see SmartPTT Radioserver Event Log.

Event Log Actions

SmartPTT Dispatcher provides the ability to perform the following actions with the Event Log:

• Enable and configure the Event Log. For details, see Configuring Event Logging for SmartPTT Dispatcher.
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• Display the SmartPTT Radioserver Event Log. For details, see Displaying SmartPTT Radioserver Event Log.

• View unread messages. For details, see Viewing Unread Messages.

• Manage event entries. For details, see Managing Event Log Entries.

• Record incoming and outgoing calls, and then listen to them and download using the Event Log panel. For details, see Call

Records.

Notification

To track events in real time, SmartPTT Dispatcher provides notification panels. They display the event notifications and provide the

ability to manage radios and other system elements. The following notification panels are available:

• Lone Workers

• Recent Incoming Calls

• Notifications

• Emergencies

• System Messages

• Server Tasks

For information on notification panels, see Notification Panels.

4.5.1 SmartPTT Dispatcher Event Log

The SmartPTT Dispatcher Event Log provides information on all events registered in the application. The Event Log data are stored in the

SmartPTT Dispatcher database.

For information on the SmartPTT Dispatcher database, see Database.

To display events in the Event Log, you must activate it.

For information on activating the Event Log, see Configuring Event Logging for SmartPTT Dispatcher.

You can open the Event Log panel by clicking Event Log → All Events on the menu bar. The panel consists of the Event Table, the

informational area with a brief event description, and the Note field.

The Event Table contains information on all events registered in the system, including calls, messages, job tickets, registrations, status

changes, radio checks, radio blocks, alarms, etc.

NOTE

Alerts and events initiated in the emergency mode are displayed in the Event Log in red.

For information on this table, see the SmartPTT Dispatcher embedded help.

The Brief Event Description area provides short information on the selected event.

In the Note field, you can add notes to the Event Log entries. The text from this field is displayed in the Note column of the Event Table.

The Event Log entries can be selected in the following ways:

• Clicking a single entry selects only one entry.

• Clicking multiple entries with the Ctrl or Shift keys selects multiple entries.
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The Call type records can be downloaded or played on the Event Log panel and in the Play Records window. You can also open their

location from this panel. To perform these actions, activate recording of incoming and outgoing calls in SmartPTT Dispatcher. For

details, see Configuring Audio Recording.

For information on call records, see Call Records.

Important

Playing, downloading, and opening location of the call records is unavailable for calls made before activating the incoming and

outgoing calls recording features.

4.5.1.1 Managing Event Log Entries

Follow the procedure to manage the SmartPTT Dispatcher Event Log entries.

Procedure: 

Perform one of the following actions:

To display the SmartPTT Dispatcher Event Log panel with

all events,

on the menu bar, click Event Log → All Events.

To display events of SmartPTT Dispatcher for a certain

period,

perform the following actions:

1. On the menu bar, click Event Log → Events for Period.

The Period window appears.

2. In the window that appears, set the period to show events:

• To display events starting from the specified date only,

select the Start Date check box.

• To display events before the specified date only, select

the End Date check box.

• To display events for a certain period of time only, select

the Start Date and the End Date check boxes.

• To display all events from the SmartPTT Dispatcher

database, clear the Start Date and the End Date check

boxes.

3. Click the Calendar (   ) button, and select the desired start

and end dates, or enter the dates manually.

4. (Optional) In the date fields, type the start and end time.

5. Click OK to apply changes, and display the SmartPTT

Radioserver Event Log.

If events for the specified period exist in the database, they
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will be displayed in the SmartPTT Radioserver Event Log that

appears.

To remove all Event Log entries added in the SmartPTT

Dispatcher Event Log before the specific date,

perform the following actions:

1. On the menu bar, click Event Log → Clear Event Log.

The Clear Event Log window appears.

2. In the window that appears, set the desired date manually, or

click the Calendar (   ) button.

3. Click OK to remove Event Log entries.

All Event Log entries added before the set date disappear from

the Event Log.

4.5.1.2 Viewing Unread Messages

Follow the procedure to view unread messages in the SmartPTT Dispatcher Event Log.

Procedure: 

View unread messages in one of the following ways:

To open the unread messages from the menu bar, click Event Log → Unread Messages.

To open the unread messages from the notification, click Unread messages: <number> if it is displayed in the

lower-left corner of SmartPTT Dispatcher.

 The Event Log: messages not read panel appears.
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4.5.2 SmartPTT Radioserver Event Log

The SmartPTT Radioserver Event Log provides information on the events from all client applications connected to SmartPTT

Radioserver.

The SmartPTT Radioserver Event Log is activated and configured in SmartPTT Radioserver Configurator.

For information on configuring the Event Log, see “Configuring Event Log Database Connection” in SmartPTT Installation and

Configuration Guide.

Important

The SmartPTT Radioserver Event Log is available to operators with the View radioserver event log right.

For information on user roles in SmartPTT Dispatcher, see Operators.

Important

The SmartPTT Radioserver Event Log is unavailable if desktop client authentication on SmartPTT Radioserver is enabled and the

profile assigned to the client prohibits access to the SmartPTT Radioserver Event Log. For details, see “Profiles” in SmartPTT

Installation and Configuration Guide.

For information on opening the SmartPTT Radioserver Event Log, see Displaying SmartPTT Radioserver Event Log.

The SmartPTT Radioserver Event Log panel consists of the Event Table, the informational area with a brief event description, and the

Note field.

The Event Log table contains information on the events registered in all client applications connected to SmartPTT Radioserver,

including calls, messages, job tickets, registrations, status changes, radio checks, radio blocks, alarms, etc.

NOTE

Alerts and events initiated in the emergency mode are displayed in the Event Log in red.

For information on this table, see the SmartPTT Dispatcher embedded help.

The Brief Event Description area provides short information on the selected event.

In the Note field, you can add notes to the SmartPTT Radioserver Event Log entries. The text from this field is displayed in the Note

column of the Event Table.

The Event Log entries can be selected in the following ways:

• Clicking a single entry selects only one entry.

• Clicking multiple entries with the Ctrl or Shift keys selects multiple entries.

The Call type records can be downloaded or played on the Event Log panel and in the Play Records window. To perform these actions,

activate recording of incoming and outgoing calls in SmartPTT Radioserver Configurator. For details, see “Configuring Centralized Voice

Logging” in SmartPTT Installation and Configuration Guide.

For information on call records, see Call Records.

4.5.2.1 Displaying SmartPTT Radioserver Event Log

Follow the procedure to open the SmartPTT Radioserver Event Log panel.

Prerequisites: 

• Ensure theSmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator. For details, see “Configuring

Event Log Database Connection” in SmartPTT Installation and Configuration Guide.

• Ensure the operator has the View radioserver event log right. For details, see Operators.
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• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows access

to the SmartPTT Radioserver Event Log. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the Radio Fleet panel, in the right part of the radioserver entry, click the Actions (   ) button, and then select Show

Radioserver Event Log (   ).

The Period window appears.

2. In the window that appears, set the period of events to be shown in the SmartPTT Radioserver Event Log:

To display events starting from the specified date only, select the Start Date check box.

To display events before the specified date only, select the End Date check box.

To display events for a certain period of time only, select the Start Date and the End Date check boxes.

To display all events from the SmartPTT Radioserver

database,

clear the Start Date and the End Date check boxes.

3. Click the Calendar (   ) button, and select the desired start and end dates, or enter the dates manually.

4. (Optional) In the fields with the dates, type the start and end time.

5. Click OK to apply changes, and display the Event Log.

If events for the specified period exist in the database, they will be displayed in the SmartPTT Radioserver Event Log that appears.

4.5.3 Managing Event Log Elements

Follow the procedure to configure the Event Log display settings.

NOTE

The procedure below is applicable both to the SmartPTT Dispatcher and SmartPTT Radioserver Event Log.

Procedure: 

On the Event Log panel, perform one of the following actions:

To sort the entries in ascending order, click the column header until the Up (   ) icon appears.

To sort the entries in descending order, click the column header until the Down (   ) icon appears.

To group log entries by columns, perform the following actions:
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1. Drag the column header to the Move column header here

for grouping area.

2. (Optional) Repeat step 1 to group entries by values in

several columns.

To cancel grouping by columns, drag the header from the Move column header here for grouping

area, and drop it when the cross icon (   ) appears.

To filter column contents by specific values, perform the following actions:

1. Point to the desired column header, and then click the

icon (   ) that appears.

2. From the list, select the check boxes next to the desired

values, or click the Select All button.

Next to the filtered column header the filter icon (   )

appears.

To cancel filtering by specific values, click the filter icon, and then click the Clear Filter button.
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To hide or show columns, right-click any column header, and select the desired titles from

the list.

NOTE

By default, all the columns are displayed in the Event Log.

To change the order of columns, drag the desired column header to the left or right of any other

column.

To keep the desired columns position independently of

scrolling,

in the column headers, drag the element (   ) to the right of the

columns that must be kept in place and drop it.

All columns to the left of the element will be fixed.

4.5.4 Notification Panels

The SmartPTT Dispatcher notification panels inform about the SmartPTT system events in real time. They provide the ability to track

various data, for example, the status of radios in the Lone Worker mode.

SmartPTT Dispatcher provides the following notification panels:

• Lone Workers

• Recent Incoming Calls

• Notifications

• Emergencies

• System Messages

• Server Tasks

For information on notification panels, see descriptions below.
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All panels, except for Emergencies, can be opened from the Tools menu. The selected panels will be displayed in the main area of

SmartPTT Dispatcher. When one of the events occurs, the information about it will be displayed on the corresponding panel.

NOTE

The Emergencies panel appears in SmartPTT Dispatcher only when a radio sends an emergency signal.

Lone Workers

The Lone Workers panel displays radios in the Lone Worker mode highlighted with specific colors. The color indicates the status of the

Lone Worker mode showing if the radio meets the conditions of the Lone Worker profile assigned to a radio:

• The light gray color shows that the radio has not triggered the rule.

• The yellow color shows that the radio has triggered the rule and the timer set in the Actions delay (min) field has not expired.

• The red color shows that the radio has triggered the rule and the timer set in the Actions delay (min) field has expired.

For information on configuring rules for lone workers, see Managing Lone Worker Profiles.

NOTE

Only DMR radios are displayed on the Lone Workers panel.

You can open the Lone Workers panel by clicking Tools → Lone Workers on the menu bar.

By clicking the radio name, you can open the radio Call Window.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the radio name in

parentheses.

To the right of the radio name, you can see the name of the Lone Worker profile that was assigned to a radio. To the left of the radio

name, you can see the radio icon that was set in the Radio Properties window. For details, see Configuring General Radio Parameters.

When you point to an entry, the date and time when the Lone Worker status was changed is displayed. If you click the Delete (   ) button,

the color indication will be removed from the entry and the default Lone Worker status will be assigned to a radio.

Recent Incoming Calls

The Recent Incoming Calls panel displays the latest radios that made a call in the radio network. It also provides quick access to the Call

Windows of the radios.
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You can open the Recent Incoming Calls panel by clicking Tools → Recent Incoming Calls on the menu bar.

The number of radios on this panel can be configured on the Recent Incoming Calls tab of the Notification Panels window. For details,

see Configuring Recent Incoming Calls Display.

By clicking the radio name, you can open the radio Call Window.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the radio name in

parentheses.

To the left of the radio name, you can see the radio icon that was set in the Radio Properties window. For details, see Configuring General

Radio Parameters.

When you pointing to an entry, the date and time of the incoming call is displayed. The radio that made the most recent call is displayed

first. If you click the Delete (   ) button, the call notification will be deleted from the panel.

Notifications

The Notifications panel displays alerts configured for the following rules:

• Custom rules. For details, see Custom Rules.

• Positioning rules. For details, see Positioning Rules.

• Lone Worker rules. For details, see Lone Worker Rules.

For information on alert configuration, see Configuring Dispatcher Alerts.
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The Notifications panel appears when the rule with the configured alert triggers, or you can open the panel by clicking Tools →

Notifications on the menu bar.

When an alert notification appears, it flashes red for a while. After you click the message or the PTT button, the notification stops

flashing and changes its color to gray.

The alert displays the caption and text that were specified on the Dispatcher Alert tab. For details, see Configuring Dispatcher Alerts. In

addition, it displays the radio name as well as the date and time when the alert was received.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the radio name in

parentheses.

By clicking the PTT button, you initiate a call to the radio that triggered the rule. If you click the Delete (   ) button, the alert will be

deleted from the panel.

Emergencies

The Emergencies panel appears in SmartPTT Dispatcher when a radio sends an emergency signal.

To make the Emergencies panel appear automatically upon receiving an alarm signal from a radio, enable the emergency situation

processing. For details, see Configuring Emergency Processing.

When an emergency notification appears, it flashes red for a while. After the emergency mode is turned off on the radio, the notification

stops flashing and changes its color to gray. The emergency notification provides the time when emergency notification was received

and the radio name. The PTT button provides the ability to call the radio talkgroup. By clicking the Turn off sound alert (   ) button, you

mute an emergency alarm.

NOTE

The Turn off sound alert button is inactive, if a sound notification at the emergency situation is not activated. For details, see

Configuring Emergency Processing.
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By clicking the Resolve emergency (   ) button, you confirm the emergency situation resolution and close the notification. If the

Emergencies panel displays only one notification, clicking the button closes the panel.

For information on  the Emergencies panel, see Emergency.

System Messages

The System Messages panel displays the event messages related to the radio network functionality. The messages provide information

on the status of radio network and its components, status of connection to the server, and database status.

You can open the System Messages panel by clicking Tools → Notifications on the menu bar or it appears when events selected on the

System Messages tab in the Notifications Panels window occur.

For information on the System Messages tab configuration, see Configuring System Messages Processing.

You can see three types of system messages:

• Error messages (   ) indicate major failures that may lead to system inoperability.

NOTE

When an error message appears, it flashes red for a while. After you click the message, it stops flashing and changes its color to gray.

• Warning messages (   ) indicate minor failures that are not critical for system operation.

• Information messages (   ) indicate activation or restoration of system functionality.

System messages provide the time when the event was registered, the description of the event, and the name or type of the event source

(server, database, radio system, or its components).

NOTE

When you point to the message, the date and time of the event registration are displayed.

Server Tasks

The Server Tasks panel displays the SmartPTT Radioserver Event Log queries from SmartPTT Dispatcher to the radioserver that are

being processed at the moment.

You can open the Server Tasks panel by clicking Tools → Server Tasks on the menu bar.
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4.6 Call Records

SmartPTT provides the ability to record incoming and outgoing calls and listen to these records. The call record feature is available for

the SmartPTT Dispatcher Event Log and the SmartPTT Radioserver Event Log.

To record calls for the SmartPTT Dispatcher Event Log, you must activate the feature and configure it in the application. For details, see

Configuring Audio Recording.

To record calls for the SmartPTT Radioserver Event Log, you must activate the feature and configure it in SmartPTT Radioserver

Configurator. For details, see “Configuring Centralized Voice Logging” in SmartPTT Installation and Configuration Guide.

You can perform the following actions with recorded calls:

• Play call records.

For information on playing call records, see Playing Call Records.

• Open call records location.

For information on opening call records location, see Opening Call Records Location.

NOTE

You can open the call record folder only for the SmartPTT Dispatcher Event Log entries.

• Download call records to a folder. If a single call record is downloaded, you can also change the name of the downloaded audio

file.

For information on downloading call records, see Downloading Call Records.

NOTE

By default, the records are downloaded in the OGG format. To change the format of downloaded audio files, see Configuring Audio

Recording.

These actions can be performed from the shortcut menu that appears when you right-click one or multiple selected call entries in the

Event Log table.

Important

Playing, downloading and opening location of the call records is unavailable to the calls made before activating the incoming and

outgoing calls recording functionality.

4.6.1 Playing Call Records

Follow the procedure to play call records from the SmartPTT Dispatcher or SmartPTT Radioserver Event Log.

Prerequisites: 

• Configure the audio recording settings in SmartPTT Dispatcher. For details, see Configuring Audio Recording.

• Configure the audio recording settings in SmartPTT Radioserver Configurator. For details, see «Configuring Centralized Voice

Logging» in SmartPTT Installation and Configuration Guide.

Procedure: 

1. Depending on the amount of the desired records, play them in one of the following ways:

To play a single call record, right-click the desired call record, and then click Play audio file.
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To play multiple call records, perform the following actions:

1. Select the desired records.

2. Right-click any of the selected records, and then click Play

selected records.

The Play Records window appears and the playback of the selected records starts.

2. (Optional) In the Play Records window, perform one of the following actions:

To play all selected records one by one,

click Play all records (   ).

To activate the call records replay,

click Replay (   ).

Postrequisites: 

• To put the playback on pause, click Pause Playback (   ).

• To stop the playback, click Stop Playback (   ).

4.6.2 Opening Call Records Location

Follow the procedure to open the call records location from the SmartPTT Dispatcher Event Log.

NOTE

This function is unavailable to the SmartPTT Radioserver Event Log.

Procedure: 

Depending on the amount of desired records, open their location in one of the following ways:

To open the location of a single call record, right-click the desired call record, and then click Open in File

Explorer.

The folder containing the selected call record opens in a new

window.

To open the location of multiple call records, perform the following actions:

1. Select the desired records.

2. Right-click any of the selected records, and then click

Open in File Explorer.

The folder or folders containing the selected records

open in a new window.
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4.6.3 Downloading Call Records

Follow the procedure to download call records from the SmartPTT Dispatcher or SmartPTT Radioserver Event Log, or from the Play

Records window.

Procedure: 

Depending on the amount of the desired records, download them in one of the following ways:

To download a single call record, perform the following actions:

1. Right-click the desired call record, and then click Download audio

file.

2. In the window that appears, specify the folder for saving the

audio file and the file name, and then click Save.

The Downloading audio file window appears to display

information on the download progress.

To download multiple call records, perform the following actions:

1. Select the desired records.

2. Right-click any of the selected records, and then click Download

audio files.

3. In the window that appears, specify the existing folder or create a

new one for saving the audio files, and then click Save.

The Downloading audio files window appears to display

information on the download progress.

NOTE

When multiple call records are downloaded and the destination folder

contains audio files with the same names as the downloaded call

records, the corresponding error occurs. The Cancel button changes

to the Replace and Skip buttons.

Using these buttons, you can replace the audio file or skip it and

resume download.

Postrequisites: 

To open the folder with the downloaded call records, click Open in File Explorer.

4.7 Positioning

SmartPTT supports outdoor and indoor positioning services that provide the ability to receive location data from radios and track their

movement in real time or view the history of movement.

Outdoor positioning in SmartPTT includes:

• Working with maps. SmartPTT supports various types of maps. They are as follows:

• Maps that are available over HTTP.

• Maps that are available in file storage.

• Maps that are available in the database.

For details, see Maps.
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• Working with objects on a map that become available after configuring a map in SmartPTT Dispatcher. For details, see Map

Actions.

Indoor positioning in SmartPTT includes:

• Working with plans of multi-story buildings. For details, see Building Plan.

• Working with objects on a plan that become available after adding a plan to SmartPTT Dispatcher. For details, see Indoor Map

Actions.

The positioning settings are configured by the Administrator in the Settings (   ) menu.

For information on configuring positioning settings, see Configuring Positioning Settings.

For information on user roles in SmartPTT Dispatcher, see Operators.

4.7.1 GPS

SmartPTT supports radio positioning using outdoor GPS coordinates. Radios can be displayed on any map that can be open directly in

SmartPTT Dispatcher. The system supports various map formats (OSM, SPMAP, MP, etc.), as well as online maps. You can add objects

on maps, such as cameras, data sources, points of interest, geofences, routes, and interact with these objects. You can also display

radio tracks on a map.

SmartPTT also supports the Upload to KML feature that provides the ability to export radio coordinates from SmartPTT Dispatcher to a

separate KML file. The KML format is an XML notation and visualization within two-dimensional maps and three-dimensional Earth

browsers. KML was developed for use with Google Earth. For details, see Upload to KML.

To use the GPS features in SmartPTT Dispatcher, you must perform the following actions:

• Enable the GPS feature in SmartPTT Radioserver Configurator. For details, see “Configuring GPS” in SmartPTT Installation and

Configuration Guide.

• Enable the GPS feature for the radio. For details, see Configuring Radio GPS Settings.

• Display the desired maps. For details, see Maps.

• Display radios, tracks, or other objects on a map and perform the desired actions with them. For details, see Map Actions.

Important

To use GPS features, you must have the license that supports GPS. For details, see Licenses.

Important

GPS features configuration and usage are available to operators with the Manage radio location settings and Request radio location

rights. For details, see Operators.

4.7.1.1 Maps

SmartPTT supports various types of maps: OpenStreetMap, Google, Baidu, raster maps, maps in polish format, and vector maps.

You can open the desired map from the Map menu on the SmartPTT Dispatcher menu bar. The types of maps that are displayed in the

menu must be configured in the Map Settings window. For details, see Configuring Maps in Use.

Together with many useful features, such as displaying and animating tracks, maps provide the dispatcher with a better control over

radios. By double-clicking the radio displayed on the map, you can also open the Call Window, or open the Actions menu by right-clicking

the radio.

Important

To use maps, you must have the license that supports GPS. For details, see Licenses.

Maps provide the ability to set camera markers and data source coordinates, display them on a map, and monitor data source alarms in

real time.

https://www.google.com/earth/
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NOTE

To interact with cameras and data sources, you must install the corresponding licenses. For details, see Licenses.

To use data sources, the data acquisition module in SmartPTT Dispatcher settings must be activated.

Google Maps

Google Maps are received from the Google server. They require an Internet connection. To use these maps, you also need an API key. To

obtain the key, contact your system administrator.

Important

The Google Maps API key is provided under a paid subscription.

For information on Google Maps configuration, see Configuring Maps in Use.

OpenStreetMap

The OpenStreetMap maps are provided free by an OpenStreetMap server. They require an Internet connection. You can also download

OpenStreetMap maps on a local server to use them without an Internet connection. To use these maps, you must enter the server

address. The default server address is http://b.tile.openstreetmap.org/. If necessary, you can set additional attributes in

the ? <attribute 1>=<value 1>&<attribute 2>=<value 2> format in the server address field.

Important

SmartPTT does not support HTTP basic authentication, therefore, it must be disabled on a server.

NOTE

You can restore the default address by clearing the Address field, and then clicking OK.

For information on the OpenStreetMap maps configuration, see Configuring Maps in Use.

OpenStreetMap (file)

On the OpenStreetMap web site, you can export the map of the desired area to your computer, and then upload it to SmartPTT

Dispatcher. You can export the OpenStreetMap maps in the OSM or TILESURL format.

Baidu Maps

Baidu Maps are received from the Baidu server. They require an Internet connection. To use these maps, you also need an API key. To

obtain the key, contact your system administrator.

Baidu Maps support only Chinese language.

For information on Baidu Maps configuration, see Configuring Maps in Use.

Maps in Polish Format

SmartPTT Dispatcher provides the ability to upload MP format (polish format) maps from the local drive. Polish format maps are text

files that can be edited and converted into other formats. When you upload the Polish Format map, SmartPTT Dispatcher converts it into

a vector map and displays it in the main area.

MapInfo

SmartPTT Dispatcher provides the ability to use maps created in MapInfo software.

To use a MapInfo map, you must create or obtain the map file in the TTKGP or SPMAP format. A map in the SPMAP format can be

configured directly in SmartPTT Dispatcher by adding layers in the TAB format on the uploaded map. Before adding the layers, you also

must create or obtain the layer files. The map is stored on the local drive of the SmartPTT Dispatcher host.
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NOTE

You can create a map in the TTKGP format using the free TatukGIS Viewer software.

For information on MapInfo maps configuration, see Configuring MapInfo Map.

Raster Maps

SmartPTT Dispatcher provides the ability to create a map using any raster image in the BMP, JPEG, or PNG format. Maps created from

raster images are saved in the MAP format.

For information on raster map configuration, see Adding and Creating Raster Maps.

Maps from Database

SmartPTT Dispatcher provides the ability to work with large offline maps whose size is bigger than 5000 х 5000 pixels. This functionality

is used to display SmartPTT system objects located far from each other. This is achieved by dividing the original raster image into

pieces and storing them in the database.

To create a raster map database, send a request to SmartPTT Technical Support Center and attach the raster map image in the JPEG

format with the list of coordinates on the map, for example, in the TXT or MAP format.

Geographical positions are necessary to anchor image points to the geographical coordinates. You need to provide the coordinates of

four points at the corners of the map. After your request, our technical support specialist will provide you with the database backup of

the map in the BAK format.

NOTE

If the attachment size exceeds the limit of 50 MB, split the file into several small files using an archiver or file manager, or upload it

to a file hosting service and include the link to the file in your query message.

Then, restore the database from the received backup. For details, see Managing Databases.

For information on database map configuration, see Managing Maps from Database.

Coverage Map

Coverage maps display information on the received signal strength (RSSI) of radios in a specific area.

Important

The coverage map feature is available to operators with the View coverage map right. For details, see Operators.

Important

To use the coverage map feature, the corresponding license must be installed. For details, see Licenses.

To build a coverage map for a radio, ensure that it the GPS feature is enabled, and its GPS data are in the database. For details, see

Configuring Radio GPS Settings.

Important

A radio that uses the LIP protocol to transmit location data on the current channel cannot be used as a source of information about

RSSI when building a coverage map.

For information on protocol types, see “Location” in SmartPTT Installation and Configuration Guide.

For information on coverage map configuration, see Configuring Coverage Map.

http://www.tatukgis.com/Products/EditorViewer/Editions/Viewer.aspx
https://support.smartptt.com/hc/en-us
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4.7.1.2 Map Actions

After you configure the desired map in SmartPTT Dispatcher, it can be used to track radios, provide additional management features for

the system, and control the state of some objects.

For information on maps configuration, see Map Creation and Configuration.

SmartPTT Dispatcher provides the ability to perform actions with the following objects on a map:

• Radios. For details, see Radios.

• Tracks. For details, see Tracks.

• Other objects. For details, see Objects on Map.

Some actions can be performed directly on a map. For example, using a map, you can open the Call Window or the Actions menu of the

radio. Other actions can require to use the map control panel.

Map Control Panel

The control panel is available on any map in the right part of the screen. The panel provides features to manage display of radios and

other objects on maps. On the panel, you can perform the following actions:

• Display radios on a map

• Display records of radio movements within a specified period as tracks

• Animate radio tracks

• Mark important objects on a map as points of interest

• Display location of data sources and monitor their state

• Display location of cameras and watch live videos

• Configure radio geofences

• Configure radio routes

• Edit objects

• Delete objects

By default, the expanded control panel is not pinned, and it automatically collapses after clicking on a map. The Pin (   ) button pins the

expanded panel, and in this state you can collapse it only by clicking the Radios, Tracks, or Objects on Map buttons.

4.7.1.2.1 Radios

Radio locations can be displayed on any SmartPTT Dispatcher map.

NOTE

To display radios on a map, you must configure the location service in the Radio Properties window. For details, see Configuring Radio

GPS Settings.

Radios are displayed on a map as markers. Markers consist of the following elements:

• Radio icon — icon image that is set in the radio settings. For details, see Configuring General Radio Parameters.

NOTE

If a status is assigned to a radio, a frame appears around the radio icon. The color of the frame corresponds to the status color.

For information on radio statuses, see Statuses.
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• Radio label — label that contains radio name and/or time when coordinates were received. Radio labels with valid coordinates are

colored yellow on a map. Radio labels with outdated coordinates are colored gray. Radio label can be hidden.

On the SmartPTT Dispatcher maps, you can perform the following actions with radios:

• Display radios. For details, see Displaying Radios.

• Display radios by categories. For details, see Displaying Radio Categories.

• Display radios in the defined area. For details, see Displaying Radios in Area.

• Set the radio location manually. For details, see Setting Radio Location.

You can open the radio Call Window directly from a map by double-clicking the desired radio icon. You can also open the Actions menu

by right-clicking the desired radio icon.

Radios Panel

The Radios panel displays the list of mobile devices and radios that provide coordinates to the SmartPTT system. The specific user of

the dispatch console can have access to a limited amount of radios.

You can open the panel by clicking Radios in the right part of the map. The panel is divided into two tabs:

• The Radios tab provides a list of all radios. To find the desired radio using its name or ID, you can use the Search (   ) field.

• The Categories tab provides the list of categories configured in SmartPTT Dispatcher. For details, see Categories.

The panel provides various data on the radio state. Online radios are displayed in blue (   ), and offline radios are gray (   ). To the right

of the radio name, you can see the icon that indicates the validity of the radio GPS coordinates (   ). If coordinates are outdated or

missing, the corresponding icon (   ) appears.

NOTE

The validity period of GPS coordinates is determined by the Validity of GPS coordinates parameter in the Positioning Systems

window. For details, see Configuring Positioning Settings.

Indicators define how the radio is displayed on a map and provide the ability to change the state of its display. Depending on the element

that placed next to them, indicators define how radios will be displayed. The indicators are placed next to the radio name, category name

(on the Categories tab), and the All Radios element. Radios can be fixed on a map (   ) or hidden from a map (   ). They also can be

displayed (   ) or not be displayed on a map (   ). The Mixed state (   ) indicator can appear next to categories and the All Radios

element.

Category Actions

On the Categories tab, you can open the category Actions menu by right-clicking the desired category. The category Actions menu

provides the ability to perform various actions with all radios of the selected category. The following actions are available in the menu:

Action Description

Send Message (   ) Opens the Send Message window where you can type and send messages or manage message

templates.

For details, see Sending Messages from the Send Message Window.

The action is unavailable if the operator does not have the Send text messages right.

For information on the operator rights, see Operators.

Find on Map (   ) Shows members of the category on a map.

The action is unavailable if the operator does not have the Request radio location right.
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Action Description

Remove from Map (   ) Hides members of the category from a map.

The action is unavailable if the operator does not have the Request radio location right.

View Properties (   ) Opens the Category window for editing the category.

Displaying Radios

Follow the procedure to configure displaying radios on a map.

Prerequisites: 

Determine the radios to display or hide on a map.

Procedure: 

1. In the right part of the open map, click Radios.

The Radios panel appears.

2. (Optional) Click Pin (   ) to pin the panel.

3. On the Radios panel, select the Radios tab.

4. Configure radios displaying on a map:

To fix all radios on a map or hide them, click the indicator next to All Radios, until the desired state

appears.

To fix a single radio on a map or hide it, click the indicator next to the radio name, until the desired

state appears.

To unfix the radio, right-click the indicator next to the radio name.

To reset display settings of all radios, right-click the indicator next to All Radios.

The indicator changes to Mixed State (   ).

NOTE

Radios are hidden or displayed on a map depending on the map settings. For details, see Configuring Radios on Map Settings.
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Displaying Radio Categories

Follow the procedure to configure displaying radio categories on a map.

Prerequisites: 

Determine the radio categories to display or hide on a map.

Procedure: 

1. In the right part of the open map, click Radios.

The Radios panel appears.

2. (Optional) Click Pin (   ) to pin the panel.

3. On the Radios panel, select the Categories tab.

4. Configure radio categories displaying on a map:

To fix all radios from all categories on a map or hide them, click the indicator next to All Radios, until the desired state

appears.

To fix radios from the desired category on a map or hide

them,

click the indicator next to the category name, until the desired

state appears.

To fix a single radio from the desired category on a map or

hide it,

select the desired category, and then click the indicator next to

the radio name, until the desired state appears.

To unfix the radio, right-click the indicator next to the radio name.

To revert the applied earlier actions, right-click the indicator next to All Radios.

The indicator changes to Mixed State (   ).

NOTE

Radios are hidden or displayed on a map depending on the map settings. For details, see Configuring Radios on Map Settings.
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Displaying Radios in Area

Follow the procedure to display the list of radios located in the selected area of a map.

Prerequisites: 

Determine the desired area on a map, where you want to see radios.

Procedure: 

Press and hold the Ctrl key, and then select the desired area with the left button of a mouse.

On the Radios panel, the list of radios that are in the selected area appears.

Postrequisites: 

To cancel the selection and display all radios in the list, click the Cancel selection button.

Setting Radio Location

Follow the procedure to set the radio location on a map manually.

Prerequisites: 

Determine the radio for which you want to set the location.

Procedure: 

1. Open the Set Location panel in one of the following ways:

To open the panel when the map is open and radios are

displayed on it,

right-click the desired radio, and then select Set Location.

To open the panel when the map is closed, in the Actions Menu (   ) or Call Window of the radio, click

Set Locations and select the desired map in the Select Map

window.

 The Set Location panel appears.

2. Set the radio location in one of the following ways:

To indicate the radio location with a mouse, click the desired place on a map.

To indicate the radio location in the other way, on the Set Location panel, in the Latitude and Longitude fields,

type the desired coordinates.

3. Click Save to save changes.

The radio appears on a map with the specified coordinates.

Postrequisites: 

To remove the radio from a map, in the Actions Menu (   ) or Call Window of a radio, click Remove from Map.
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4.7.1.2.2 Tracks

Tracks provide the ability to view the radio movement history or track the radio movement in real time on any map in SmartPTT

Dispatcher.

Important

Tracks are available to operators with the Manage tracks right. For details, see Operators.

Tracks are built using databases of SmartPTT Dispatcher or one of the available radioservers as the data source.

Important

If the SmartPTT Radioserver Event Log is not activated in SmartPTT Radioserver Configurator or SmartPTT Radioserver is not

running, the radioserver will not be available as the data source.

Tracks Panel

The Tracks panel provides the list of tracks displayed on the current map and their control elements. You can configure various settings

to display tracks, including a period to use, color of the line, and its thickness.

The Tracks panel provides the ability to perform the following actions:

• Display a track on a map. For details, see Displaying Tracks.

• Play radio motion animation. For details, see Animating Tracks.

You can open the panel by clicking Tracks in the right part of the map.

The Add Track (   ) button opens the Track panel where you can configure track display settings. The added track appears on the map,

and its entry appears on the Tracks panel.

The track entry provides various information about the track, such as the radio name, date and time used to build the track, color and

thickness of its line.

The Track Details (   ) button opens the Track Details panel to play radio motion animation.

On the Tracks panel, you can edit (   ) or delete (   ) a track. You also can delete all tracks from the map using the Clear Tracks (   )

button.

NOTE

If you select the 30 minutes, 1 hour, or Today period for a track, and later decide to edit this track, when you save it, the track will be

rebuilt for the set period beginning from the moment the editing was finished.
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Displaying Tracks

Follow the procedure to display a radio track on a map.

NOTE

Track can be shown on a map when the radio has at least one coordinate.

Prerequisites: 

• Ensure that saving GPS locations in databases is enabled in the positioning settings. For details, see Configuring Positioning

Settings.

• If SmartPTT Radioserver is used as the data source, ensure that the desired radioserver is running, otherwise the track cannot be

built.

• Ensure the operator has the Manage tracks right. For details, see Operators.

• If SmartPTT Radioserver is selected as a data source, ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT

Radioserver Configurator, otherwise the track cannot be built. For details, see “Configuring Event Log Database Connection” in

SmartPTT Installation and Configuration Guide.

Procedure: 

1. In the right part of the open map, click Tracks.

The Tracks panel appears.

2. (Optional) Click Pin (   ) to pin the panel.
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3. On the Tracks panel, click Add Track (   ).

The Track panel appears.

4. From the Data Source list, on the Track panel, select the database which is used to create the track.

5. From the Radios list, select the radio whose track to be displayed.

6. From the Period list, select the time period of the track.

To set the time period of the radio track as 30 minutes, 1

hour, or today,

from the Period list select the corresponding values.

To set the time period of the radio track as several hours, perform the following actions:

1. From the Period list select the Several hours value.

2. In the Hours field, enter the desired amount of hours.

To set the other time period of the radio track, perform the following actions:

1. From the Period list select the Custom range value.

2. In the Start Date and End Date fields, set the desired date

and time.

7. From the Color palette, select the color of the track line on a map.

8. From the Line Thickness list, select the desired thickness of the track line.

9. Click Show to display the track on a map.

The track appears on the map, and the track entry appears on the Tracks panel.

Postrequisites: 

• To edit the track, on the Tracks panel, select the desired track from the list, and click Edit (   ).

• To remove a track, on the Tracks panel, select the desired track from the list, and click Delete (   ).

• To delete all tracks on the current map, on the Tracks panel, click Clear Tracks (   ).
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Animating Tracks

Follow the procedure to animate a radio track on a map.

Prerequisites: 

• Ensure the desired radio track is in the list of tracks.

• Ensure the operator has the Manage tracks right. For details, see Operators.

Procedure: 

1. In the right part of the open map, click Tracks.

The Tracks panel appears.

2. (Optional) Click Pin (   ) to pin the panel.

3. Select from the track list the desired track, and then click Track Details (   ).

The Track Details panel appears.

4. On the Track Details panel, perform the desired actions:

To start animation of a track,

click Start Playback (   ).

The track starts animating on a map. The button Start

Playback (   ) changes to Pause Playback (   ).

To pause animation of a track, click Pause Playback (   ).
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To change the animation speed of a track, click Decrease speed (   ) or Increase speed (   ).

To stop animation of a track, click Stop Playback (   ).

5. (Optional) To display the radio position at a certain time, double-click the desired entry in the Track Details table.

4.7.1.2.3 Objects on Map

SmartPTT Dispatcher provides the ability to display such objects as cameras, data sources, points of interest, geofences, and routes on

maps. Added objects provide additional information on the area with a radio and can be used to control some elements of the system.

You can display the radio route, add points of interest, and create geofences. Maps can be used to display cameras and data source

state in real time. You can perform the following actions on a map:

• Add camera markers. For details, see Adding Cameras.

• Add points of interest. For details, see Adding Points of Interest.

• Add geofences. For details, see Adding Geofences.

• Add routes. For details, see Adding Routes.

• Add data sources. For details, see Adding Data Sources.

• Edit objects. For details, see Editing Objects on Map.

• Delete objects. For details, see Deleting Objects.f

Objects on Map Panel

The Objects on Map panel provides the ability to add the following elements on a map:

• Points of interest that indicate important objects on a map

• Geofences that define specific areas on a map

• Routes that connect key points of the area

• Cameras that provide the ability to see the area at any moment from any place

• Data sources that indicate objects created in data provider and monitor their state

NOTE

To interact with cameras and data sources, you must instal the corresponding licenses. For details, see Licenses.

For data sources, the data acquisition module in SmartPTT Dispatcher settings must be activated. For details, see Activating Data

Acquisition Module.

You can open the panel by clicking Objects on Map in the right part of the map.

At the top of the Objects on Map panel, you can see the Add (   ) button that opens the corresponding object configuration panel for

adding an object. You can edit (   ) or delete (   ) any added object.

Cameras

SmartPTT Dispatcher provides the ability to add new or edit existing camera markers on the Cameras tab. You can watch live video

directly on a map.
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Important

To manage camera markers on a map, an operator must have the Manage cameras right.

For information on the operator rights, see Operators.

To add a camera marker on a map, it must first be added and configured in the Avigilon video monitoring system. For details, see

Avigilon Configuration.

The Cameras tab displays information about cameras, including their names and statuses. If camera was deleted in the Avigilon system,

the status Camera removed appears. If you cannot connect to cameras, the corresponding text appears next to the camera entry. The No

connection text can be displayed in the following cases:

• No connection between SmartPTT Dispatcher and SmartPTT Radioserver

• No connection between SmartPTT Radioserver and the Avigilon server

• No connection between the Avigilon server and the camera

Important

If connection is established, no status appears.

NOTE

After removing a camera from the Avigilon system, its name becomes pale gray in SmartPTT. The edit button becomes unavailable.

When you add or edit a camera marker, the Camera panel appears. It provides a list to select a camera that will be displayed on a map.

The list of cameras is duplicated from the Avigilon video monitoring system server. Cameras in the list are displayed in the same order

as in the Avigilon system.

NOTE

If SmartPTT is connected to two SmartPTT Radioservers, each of which is connected to its own Avigilon system, cameras in this list

are displayed in the following order: cameras of the first system, then cameras of the second system. If connection is not

established, the list with cameras will be empty.

Watching Live Video

SmartPTT with the integrated Avigilon video monitoring system provides operators the ability to monitor what happens on the object at

any time.

Live video from a camera opens in a separate window that appears when you click the marker of the desired camera on a map.

Only one window with live video can be opened at a time. If you have already opened the window and try to open another one, then a

previously opened window will automatically be closed.

If SmartPTT Dispatcher is minimized when a live video is open, when SmartPTT Dispatcher will be opened again, the window with live

video will restore its previous position on the operator’s screen. If SmartPTT Dispatcher is closed with a live video, the next time

SmartPTT Dispatcher opens, the window with live video will not be restored.
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Points of Interest

SmartPTT Dispatcher provides the ability to manage existing points of interest and adding new points on the Points of Interest tab. Using

points of interest, you can mark important objects on a map.

Important

To manage points of interest, an operator must have the Manage points of interest right. For details, see Operators.

When you add or edit a point of interest, the Point of Interest panel appears. The panel provides the ability to configure parameters of a

point of interest. You can add a point of interest either by clicking the desired place on a map or by entering its coordinates.

You can select one of the available images as point of interest marker or upload a custom one. The maximum size of a custom image is

5 MB.

Geofences

SmartPTT Dispatcher provides the ability to create geofences on a map and edit existing geofences on the Geofences tab. Geofences

are used in positioning rules to track radios in the area. For example, you can configure a positioning rule that will notify the dispatcher in

case of speeding in the area where speed limits are set. For details, see Positioning Rules.

Important

To manage geofences, an operator needs to have the Manage geofences right. For details, see Operators.

When you add or edit a geofence, the Geofence panel appears. The order of the geofence points in the table defines the sequence of

points on a map.

Routes

SmartPTT Dispatcher provides the ability to create routes on a map and edit existing routes on the Routes tab. Routes are used in

positioning rules to track radios in the area. For example, you can configure a positioning rule that will notify the dispatcher if the radio

exits the route. For details, see Positioning Rules.

Important

To manage routes, an operator needs to have the Manage routes right. For details, see Operators.

When you add or edit a route, the Route panel appears. The order of the route points in the table defines the sequence of points on a

map. You can select the Key point check box and specify a name for any point. Key points are used for creating Radio Location reports.

For details, see Creating Radio Location Report.

NOTE

A key point appears on a route as a circle after clicking the Save button. At hovering the mouse cursor over the point on a map, the

key point name set in the Name column appears.

Data sources

SmartPTT Dispatcher provides the ability to add new or edit existing data sources on the Data souces tab.

Important

The Data sources tab is only available if the data acquisition module was activated in SmartPTT Dispatcher. For details, see Data

Provider Configuration.

To add a data source on a map, the data source must be created and configured in the data provider system. For details, see the data

provider embedded help.

When you add or edit a data source, the Data source panel appears. The panel provides the ability to configure parameters of a data

source. The changes in data source settings are applied to it in all SmartPTT system.
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When you point to the object entry on the data source tab, the tooltip with information on all parameters of the data source appears.

Alternatively, all parameters of the point can be viewed on its dashboard, on the Data provider panel. For details, see the dat provider

embedded help.

When you click the name or marker of the point on the Data sources tab, the map automatically centers on it even if it is not displayed on

a map.

NOTE

The name of the data source is displayed on a map if the Name check box is selected on the Data source panel.

NOTE

The marker of the data source is displayed on a map if the Show on Map check box is selected on the Data source panel.

By clicking the Open (   ) button on the Data sources tab, you can open a data source in the data acquisition module where all its

parameters are available.

For information on data source dashboards, see the data provider embedded help.

NOTE

If a data source is deleted from the data provider system, it is not automatically deleted from SmartPTT Dispatcher. The name of the

deleted data source is displayed in gray. The settings that affect the data source are not deleted, and remain editable.

If one of the data source parameters reports an alarm, this data source is displayed on the Map panel with the corresponding indication.

Data Source Indication

To notify operators about emergencies on data sources, SmartPTT Dispatcher provides a number of indication options, including color

indication and animation.

When one of the data sources reports an alarm, SmartPTT Dispatcher attracts the operator's attention in the following ways:

• If the Map panel is opened, the map automatically centers on the data source that reported the alarm.

• If the data source was hidden, it appears on the map with the marker indicating the alarm.

• If the side panel is collapsed, it opens on the Data sources tab.

• If the side panel is expanded but another tab is active, the panel switches to the Data sources tab.

• The data source list scrolls down to the point that reported the alarm.

• If the Map panel is opened but another panel is active, the tab of the Map panel starts flashing red.

Depending on the parameter values and the operator actions regarding the emergency, data sources can be in several states. The

following table provides information on the data source states and their indication on the Map panel.

State Description Indication

Operating All the data source parameters are within the

normal range, or the emergency was

acknowledged and eliminated (became

outdated).

Standard colors, no animation.

Alarm One or several parameters reported the

alarm.

The point background flashes red.

Acknowledged One of the SmartPTT Dispatcher operators

acknowledged the alarm and is taking action

to eliminate it.

The red background that indicates alarm stops

flashing but does not disappear.
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State Description Indication

Outdated unacknowledged The emergency on the data source was

eliminated before any operator acknowledged

it in SmartPTT Dispatcher.

Red frame around the point.

The red background that indicates alarm disappears.

No connection The connection to the data source was lost,

the data source was deleted from the data

provider system, or the data acquisition

module was deactivated in SmartPTT

Dispatcher. 

The point icon and name are gray.

If the data source was deleted from the data

provider system, on the deleted point entry in the

list of data sources, the The Point was deleted

message appears.

Adding Cameras

Follow the procedure to add a camera marker on a map.

Prerequisites: 

• Ensure the desired camera was added and configured in the Avigilon system.

• Ensure an operator has the Manage cameras right.

For information on the operator rights, see Operators.

Procedure: 

1. In the right part of the desired map, click Objects on Map.

The Objects on Map panel appears.

2. (Optional) Click Pin (   ) to pin the panel.

3. On the Objects on Map panel, click the Cameras tab.

4. On the Cameras tab, click Add Camera (   ).

The Camera panel appears.

5. From the Camera list, select the desired camera.

6. In the Name field, type the desired camera name.
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7. (Optional) To show the name of the camera marker on a map, select the Show name on map check box.

8. Specify the camera marker location on a map in one of the following ways:

To specify the camera marker location on a map with a

mouse,

click the desired location on a map.

The camera marker appears in the specified location on a

map.

To specify the camera marker location in the other way, in the Latitude and Longitude fields, type the desired

coordinates.

The camera marker appears in the specified location on a

map.

9. Click Save to save the camera marker.

The added camera marker appears in the list of the Cameras tab of the Object on Map panel.

Postrequisites: 

• To edit the camera marker, see Editing Objects on Map.

• To delete the camera marker, see Deleting Objects.

Adding Points of Interest

Follow the procedure to add a point of interest on a map.

Prerequisites: 

Ensure the operator has the Manage points of interest right. For details, see Operators.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel appears.

2. (Optional) Click Pin (   ) to pin the panel.

3. On the Objects on Map panel, open the Points of Interest tab.

4. On the Points of Interest tab, click Add Point of Interest (   ).

The Point of Interest panel appears.

5. In the Name field of the Point of Interest panel, type the name of the point of interest.

6. (Optional) From the Icon list, select an image for the point of interest on a map.

NOTE

You can download the image by clicking the Browse (   ) button. Images of large size are cropped to 48×48.
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7. Set the point of interest location on the map in one of the following ways:

To set the point of interest location with a

mouse,

click the desired location on a map.

The point of interest appears at the specified location on a map.

To set the point of interest location in the other

way,

in the Latitude and Longitude fields, type the desired coordinates.

The point of interest appears at the specified location on a map.

8. Click Save to save the point of interest.

The added point appears on a map, and in the list of the Points of Interest tab of the Object on Map panel.

Postrequisites: 

• To display or hide the point of interest on a map, on the Points of Interest tab, select or clear the Show on Map check box next to

the desired point of interest.

• To edit the point of interest, see Editing Objects on Map.

• To remove the point of interest, see Deleting Objects.

Adding Geofences

Follow the procedure to add a geofence on a map.

Prerequisites: 

Ensure the operator has the Manage geofences right. For details, see Operators.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel appears.

2. (Optional) Click Pin (   ) to pin the panel.

3. On the Objects on Map panel, open the Geofences tab.
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4. On the Geofences tab, click Add Geofence (   ).

The Geofence panel appears.

5. In the Name field of the Geofence panel, type the name of the geofence.

6. From the Color palette, select the color for the geofence on a map.

7. Add a geofence on the map in one of the following ways:

To add a geofence using the map, perform the following actions:

1. Set the geofence location on a map by clicking at least three

desired points on a map. Double-click the last point to finish

drawing.

2. Click Save to save the geofence.

The added geofence appears on a map, and in the list of the

Geofences tab of the Objects on Map panel.

To add a geofence using the table, perform the following actions:

1. Click the Edit in Table button.

The Points table becomes active.

2. Add at least three points by clicking the Add coordinate (   )

button.

The entries for adding coordinates appear in the table.

3. In the table, perform the following actions:

a. In the Latitude column, type the desired latitude of points.

b. In the Longitude column, type the desired longitude of

points.

4. Click the Save button.

The current panel changes to the Objects on Map panel.
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Postrequisites: 

• To delete a point from the Points table, select the desired row, and then click Delete coordinate (   ).

• To display or hide the geofence, on the Geofences tab, select or clear the Show on map check box next to the desired geofence.

• To edit the geofence, see Editing Objects on Map.

• To remove the geofence, see Deleting Objects.

Adding Routes

Follow the procedure to add a route on a map.

Prerequisites: 

Ensure the operator has the Manage routes right. For details, see Operators.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel appears.

2. (Optional) Click Pin (   ) to pin the panel.

3. On the Objects on Map panel, open the Routes tab.

4. On the Routes tab, click Add Route (   ).

The Route panel appears.

5. In the Name field of the Route panel, type the name of the route.

6. In the Possible deviation (m) field, enter the possible deviation from the route.

7. From the Color palette, select the color for the route on a map.

8. Add a route on the map in one of the following ways:
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To add a route using the map, perform the following actions:

1. Set the route location on a map by clicking at least two desired

points on a map. Double-click the last point to finish drawing.

2. Click Save to save the route.

The current panel changes to the Objects on Map panel.

To add a route using the table, perform the following actions:

1. Click the Edit in Table button.

The Points table becomes active.

2. Add at least two points by clicking the Add coordinate (   )

button.

The lines for adding coordinates appear in the table.

3. In the table, perform the following actions:

a. In the Latitude column, type the desired latitude of points.

b. In the Longitude column, type the desired longitude of

points.

c. (Optional) In the Key point column, select the check box.

NOTE

Key points can be displayed in the Radio Locations report. For details,

see Creating Radio Location Report.

d. (Optional) In the Name column, in the desired entry, type the

key point name.

4. Click the Save button.

The current panel changes to the Objects on Map panel.

Postrequisites: 

• To display or hide a route, on the Routes tab, select or clear the Show on map check box next to the desired route.

• To edit a route, see Editing Objects on Map.

• To remove a route, see Deleting Objects.

Adding Data Sources

Follow the procedure to add a data source on a map.

Prerequisites: 

Ensure the desired data source is created and configured in the data provider system.

For information on data source configuration, see the data provider embedded help.

Procedure: 

1. In the right part of the desired map, click Objects on Map.

The Objects on Map panel appears.

2. (Optional) Click Pin (   ) to pin the panel.

3. On the Objects on Map panel, click the Data sources tab.
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4. On the Data sources tab, click Add data source (   ).

The Data source panel appears.

5. From the Data source list, select the desired data source.

The marker of the selected data source appears below.

6. (Optional) To show the name of the data source on a map, select the Name check box.

7. Specify the data source location on a map in one of the following ways:

To specify the data source location with a mouse, click the desired location on a map.

The data source icon appears in the specified location on a map.

To enter the data source coordinates manually, in the Latitude and Longitude fields, type the desired coordinates.

The data source icon appears in the specified location on a map.

8. Click Save to save the data source.

The added data source appears in the list of the Data sources tab of the Object on Map panel.

Postrequisites: 

• To display or hide the data source on a map, on the Data sources tab, select or clear the Show on Map check box.

• To edit the data source, see Editing Objects on Map.

• To delete the data source, see Deleting Objects.

Editing Objects on Map

Follow the procedure to edit a point of interest, geofence, route, camera marker or data source.

Prerequisites: 

Ensure at least one desired object is added on a map.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel appears.

2. (Optional) Click Pin (   ) to pin the panel.
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3. On the Objects on Map panel, select the desired tab.

4. On the selected tab, in the desired object entry, click Edit (   ).

The panel with the object parameters appears.

5. Perform the desired actions:

To edit a point of interest, camera marker or a

data source directly on a map,

click the desired place on a map.

To edit a geofence or a route directly on a map, drag the object points to the desired position.

To edit an object using the panel, on the panel that appears, perform the desired changes.

To cancel changes, perform one of the following actions:

• For Google maps: To cancel the last change made to a

geofence or route on a map, click (   ).

• To cancel changes and close the panel, in the upper-right

corner of the panel, click (   ).

The panel changes to the Objects on Map panel.

6. If the Camera, Point of interest, Geofence, Route, or Data source panel is open, click Save.

The panel changes to the Objects on Map panel.

Deleting Objects

Follow the procedure to remove a point of interest, geofence, route, camera marker or data source on the Objects on Map panel.

Prerequisites: 

Ensure that at least one desired object is added in the list.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel appears.

2. (Optional) Click Pin (   ) to pin the panel.

3. On the Objects on Map panel, select the desired tab.

4. On the selected tab, in the desired object entry, click Delete (   ).

The object disappears from the map and from the selected tab.

4.7.1.3 Upload to KML

The Upload to KML feature provides the ability to export radio coordinates from SmartPTT Dispatcher to a separate KML file.

The exported KML file contains location information only for those radios that are currently displayed on a map in SmartPTT Dispatcher.

For information on location tracking configuration, see Configuring Radio GPS Settings and Configuring Positioning Settings.

You can export the location data in one of the following ways:

• To a local file. For details, see Exporting Coordinates to Local KML File.

• To a file on the FTP server. For details, see Exporting Coordinates to KML File on FTP Server.
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Depending on the settings, the location information in the exported file may be fixed or updated regularly.

If the corresponding check box is selected in the export settings, the exported file will be updated at a defined interval to reflect the

location changes in the dispatched radio system.

Exported files can be viewed in a web browser or in compatible desktop applications. The KML file format is used in Google Maps,

Google Earth, and other services based on Google Maps.

For information on exporting location data to a local KML file or to a KML file on the FTP server, see the sections below.

4.7.1.3.1 Exporting Coordinates to Local KML File

Follow the procedure to export radio coordinates to a local KML file.

Prerequisites: 

• Ensure that the desired radios are displayed on a map in SmartPTT Dispatcher.

• Ensure that you have access to the desired export destination folder.

Procedure: 

1. On the menu bar, click Service → Upload to KML.

The Export to KML window appears.

2. At the top of the window, select Local File.

3. (Optional) Configure automatic update of the location data in the exported file:

a. Select the Auto upload time interval (sec) check box.

b. In the field to the right of the check box, specify the interval in seconds for the exported file to be updated.

NOTE

If you leave the Auto upload time interval (sec) field empty or move the exported file to another directory, the location data in the file

will not be updated.

4. To the right of the KML File field, click Browse (   ).

5. In the Select KML File window, specify the path to the desired folder, and then perform one of the following actions:

To export radio coordinates to a new file, perform the following actions:

1. In the File name field, type the name for the exported file,

and then click Save.

In the KML File field, the path to the file and its name

appears.

2. Click Export.



302

SmartPTT Dispatcher Operation Positioning

To export radio coordinates to an existing file, perform the following actions:

1. Select the file that you want to replace, and then click

Save.

In the KML File field, the path to the file and its name

appears.

2. Click Export.

3. In the Confirmation window, click OK.

6. In the window indicating successful export, click OK.

Postrequisites: 

To cancel the coordinates export and save current export settings, in the Export to KML window, click Cancel.

4.7.1.3.2 Exporting Coordinates to KML File on FTP Server

Follow the procedure to export radio coordinates to a KML file on the FTP server.

Prerequisites: 

• Ensure that the desired radios are displayed on the map in SmartPTT Dispatcher.

• Ensure that you have access to the desired export destination folder.

• (Optional) Obtain the user login and password for access to the desired FTP server.

Procedure: 

1. On the menu bar, click Service → Upload to KML.

The Export to KML window appears.

2. At the top of the window, select FTP.

3. In the KML File field, specify the path and the name for saving the exported file. For example,

ftp://myserver/smartptt/Radios_smartptt.kml.
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4. (Optional) If the target FTP server requires user authentication, perform the following actions:

a. In the Login field, type the login of the FTP server user.

b. In the Password field, type the user password for access to the FTP server. To view the entered password, click the eye

icon (   ).

5. (Optional) Configure automatic update of the location data in the exported file:

a. Select the Auto upload time interval (sec) check box.

b. In the field to the right of the check box, specify the interval in seconds for the location data in the exported file to be

automatically updated.

NOTE

If you leave the Auto upload time interval (sec) field empty or move the exported file to another directory, the location data in the file

will not be updated.

6. At the bottom of the Export to KML window, click Export.

7. In the window indicating successful export, click OK.

Postrequisites: 

To cancel the coordinates export and save current export settings, in the Export to KML window, click Cancel.

4.7.2 Indoor Tracking

SmartPTT supports the ability to display and control location of radios inside buildings. The SmartPTT system provides the Indoor

Tracking feature that is used to receive data from special beacons and transmit them to SmartPTT Dispatcher. The Indoor Tracking

feature tracks radio movements near beacons placed at key points in a building and display them on a building plan in SmartPTT

Dispatcher.

For information on indoor system operation, see “Beacon-Based Location (Indoor)” in SmartPTT Installation and Configuration Guide.

Important

To use Indoor Tracking, you need the corresponding license. For details, see Licenses.

Important

Indoor Tracking is available to operators with the Manage radio location settings right. For details, see Operators.

The SmartPTT system supports the following Indoor Tracking technologies and equipment manufacturers:

• iBeacon technology that uses MOTOTRBO radios with firmware version 2.6 or later, as well as beacons that support iBeacon

technology.

• BluFi Wireless that uses the Connect-RTLS RF800 option boards and beacons.

• Kilchherr Elektronik AG that uses the K-TERM 44 option boards and K-TERM 70 IC beacon transmitters.

To use indoor features in SmartPTT, you must perform the following actions:

• Configure indoor parameters in SmartPTT Radioserver Configurator. For details, see “Configuring Beacons in SmartPTT” in

SmartPTT Installation and Configuration Guide.

• Configure indoor support for a radio in SmartPTT Dispatcher. For details, see Configuring Indoor Radio Tracking.

NOTE

To enable Indoor Tracking using the Motorola platform (iBeacon technology), you must also select the Update interval (sec) check

box and set the desired interval value.

• Create or edit a building plan. For details, see Creating and Editing Building Plan.

• Configure the display parameters of objects and perform the desired actions with them. For details, see Indoor Map Actions.
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4.7.2.1 Building Plan

SmartPTT Dispatcher provides the ability to use the Indoor Tracking feature to track the location of the radio on a multi-story building

plan.

To open the panel with the configured building plan, click Map → Indoor Tracking → Open Indoor Map on the menu bar, and then select the

desired file in the window that appears. To create a new building plan, click Map → Indoor Tracking → New Building Map.

NOTE

To control more than one building in SmartPTT Dispatcher at the same time, you can open several indoor map panels.

The indoor map consists of a building plan and the Map Control Panel. The Map Control Panel is divided into three tabs: Floor Plan (   ),

Radios On Plan (   ), and Radio Tracks. You can collapse it or expand. For DWG maps, you can select 2D or 3D display and configure

resolution on the panel. The indoor map can also include the Track Details panel that is displayed when clicking Track Details (   ) on

the Radio Tracks tab of the Control Panel.

You can use a building plan in the DWG, SPLAN, SPLANX, or any raster format. You can also upload a separate plan file for each floor to

create a building plan. You must use a separate DWG file or raster image (such as JPG or PNG) for each floor.

NOTE

DWG is a binary file format used for 2D and 3D design data and metadata. It is the native format for several CAD applications.

To use a building plan, perform the following actions:

• Create and edit a building plan. For details, see Creating and Editing Building Plan.

• Configure the building plan display. For details, see Configuring Building Plan Display.

• Add configured beacons and other elements to display radio locations. For details, see Indoor Map Actions.

When you make changes to a building plan in SmartPTT Dispatcher, the changed file will be saved as the SPLAN file or zipped SPLANX

file.

The plan can display buttons for switching the floors of the building, the Coordinate Axes (   ) icon that provides the ability to specify

the position of 3D objects relative to coordinate axes, and buttons that provide the ability to control the building plan display. You can

zoom in the area selected on the plan (   ), zoom in or zoom out the plan (   ), move the plan (   ), and fit the scale of the building

plan to the size of the panel (   ). In the upper right corner, you can also see the View Cube (   ) that provides the ability to change

views of the displayed building.

NOTE

The View Cube is only available for 3D building plans.

4.7.2.1.1 Configuring Building Plan Display

Follow the procedure to configure the display of the building plan in SmartPTT Dispatcher.

Prerequisites: 

• Ensure you have the Indoor license. For details, see Licenses.

• Create or obtain a file with a plan of the desired building. For details, see Creating and Editing Building Plan.

Procedure: 

1. On the menu bar, click Map → Indoor Tracking → Open Indoor Map.
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2. In the window that appears, select the desired file and click Open.

The indoor map panel appears in the SmartPTT Dispatcher main area.

3. Perform the desired actions:

To enlarge a specific area on the building plan, perform the following actions:

1. Click Zoom Window (   ).

2. Select the desired area on the plan.

To increase or decrease the size of the building plan, perform one of the following actions:

• Click Zoom (   ), and then click anywhere on the plan and,

while holding the left mouse button, move the cursor up to

zoom in or down to zoom out.

• Use the scroll wheel.

To move the building plan on the screen, perform the following actions:

1. Click Pan (   ).

2. Click anywhere on the plan and, while holding the left

mouse button, drag the building plan to the desired

location on the screen.

To fit the scale of the building plan to the size of the

indoor map panel,

click Zoom Fit (   ).

To change the angle of the displayed building plan, perform one of the following actions:
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• Click the View Cube (   ) and, holding the left mouse

button, spin it to reach the desired angle.

• Click the circle of the View Cube (   ) and, holding the left

mouse button, drag it to reach the desired angle.

• Select the desired side of the View Cube (   ).

• On the circle of the View Cube (   ), select the desired

cardinal direction icon.

NOTE

These actions are only available for 3D building plans.

4.7.2.2 Indoor Map Actions

SmartPTT Dispatcher provides the ability to interact with objects on the building plan using the Indoor Map Control Panel. The Control

Panel buttons provide the ability to add beacons (   ), geofences (   ), routes (   ), and edit the plan (   ). You can configure the size

and color of the added beacon and radio labels.

For information on configuring the display of objects on the building plan, see Configuring Display of Objects on Building Plan.

Beacons

To display radios, you must place beacons on the plan considering their position inside the real building. The beacon numbers on the plan

must match the beacon numbers inside the real building. You can also specify the name for each beacon.

If you use the Motorola platform (iBeacon technology), the beacon number in this field must be typed in the Major.Minor format, where

the Major value is separated from the Minor value by a dot. Major stands for the number of the group of beacons and Minor stands for

the individual number of the beacon in the group. If you use the BluFi or Kilchherr platform, the beacon ID in this field must be the same

as in the beacon settings.

For information on adding, editing, and deleting beacons, see Managing Beacons.

Geofences

SmartPTT Dispatcher provides the ability to connect beacons to create geofences on the indoor map. Geofences can be used in

positioning rules to track the location of a radio.

For information on positioning rules, see Positioning Rules.

Beacons inside the specific geofence are highlighted with the color that was selected in settings.

For information on adding, editing, and deleting a geofence, see Managing Geofences.

Routes

SmartPTT Dispatcher provides the ability to connect beacons to create routes on the indoor map. Routes can be used in positioning

rules to track the location of a radio.

For information on positioning rules, see Positioning Rules.

Beacons are connected to create a route according to the order that was used to add them. The color of the route line can be configured

in settings. You can use the same beacon several times in one route.

For information on adding, editing, and deleting a route, see Managing Routes.
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Radios On Plan

The Radios On Plan (   ) tab contains a list of radios that support Indoor Tracking. To make the desired radio appear in the list, you must

enable the Indoor Tracking support in its Radio Properties window. For details, see Configuring Indoor Radio Tracking.

To make a radio label appear on the building plan, select the check box next to the desired radio.

Important

When the alarm is registered, the radio that sent the alarm will be centered on the building plan, and a red frame will appear around it

(if Indoor Tracking support is enabled). Other radios in the emergency state and radios added to the category for emergency (for

example, a rescue team) will be displayed on the plan too. All other radios will be hidden. After resolving the emergency situation, the

hidden radios will not be automatically displayed, but only after selecting them on the Radios On Plan (   ) tab.

For information on emergency categories, see Configuring Emergency Processing.

Radio Tracks

The Radio Tracks tab provides the ability to view the radio movement history in the building or track the radio movement in real time in

SmartPTT Dispatcher. You can animate the track for the desired period or activate the radio movement display in real time.

The radioserver databases are used as data sources to draw a track.

Important

If the radioserver Event Log is not activated in SmartPTT Radioserver Configurator or the radioserver is not running, the radioserver

will not be available as the data source.

The tracks can be built both for separate radios and users. The list of radios or users is received from the connected database.

Important

If the user authorization service is not activated and at least one user is not added in SmartPTT Radioserver Configurator, the list of

users is not displayed, and the Unavailable for this source message appears.

In SmartPTT Dispatcher, you can perform the following actions with radio tracks:

• Display all radio tracks. For details, see Displaying All Tracks.

• Display the specific radio track. For details, see Displaying Track.

• Animate the track on the building plan. For details, see Animating Track.

The Track Details panel provides the Tracks Details Table with additional information about the radio movements. The information

displays the location of the radio on the building plan. The panel appears when clicking Track details (   ) on the Radio Tracks tab of the

indoor map Control Panel. The Tracks Details Table provides the date and time when the track passed through the point, the floor, and

beacons that were used to identify the track point.

4.7.2.2.1 Configuring Display of Objects on Building Plan

Follow the procedure to configure the display of objects on the building plan.

Prerequisites: 

• Create or obtain a file with a plan of the desired building. For details, see Creating and Editing Building Plan.

• Ensure the Indoor Tracking support is activated for the desired radios. For details, see Configuring Indoor Radio Tracking.

• Ensure you have the Indoor license. For details, see Licenses.

• Ensure the beacon-based location service is configured in SmartPTT Radioserver Configurator. For details, see “Configuring

Beacons in SmartPTT” in SmartPTT Installation and Configuration Guide.
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Procedure: 

1. On the menu bar, click Map → Indoor Tracking → Open Indoor Map.

2. In the window that appears, select the desired file and click Open.

The indoor map panel appears in the SmartPTT Dispatcher main area.

3. On the indoor map, click Expand the Control Panel (   ) to expand the Control Panel.

4. On the Control Panel, expand the Floor Plan (   ) tab.

5. For the View Mode parameter, select the desired option:

To display the plan in 2D, select 2D.

To display the plan in 3D, select 3D.

 NOTE

The View Mode parameter is only available for building plans in DWG format.

6. In the Resolution field, enter the desired value to change the grid size of the building plan.

NOTE

The Resolution field is only available for building plans in DWG format.

7. In the Label size field, enter the desired value to resize the radio and beacon labels displayed on the building plan.

8. From the expandable Beacons palette, select the desired color for beacon labels.

9. From the expandable Radios palette, select the desired color for radio labels.

10. Perform the desired actions:

To add a beacon to the building plan,

click Add Beacon (   ). For details, see Managing Beacons.
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To create a geofence,

click Geofences (   ). For details, see Managing Geofences.

To create a route,

click Routes (   ). For details, see Managing Routes.

To change the building or floor name, floor order, or

floor plan file,

click Edit Plan (   ). For details, see Creating and Editing

Building Plan.

To display radios on the building plan, perform the following actions:

1. Expand the Radios On Plan (   ) tab.

2. Select the check boxes next to the desired radios.

Postrequisites: 

• To save the changes to the building plan in a SPLAN file or SPLANX archive, click Save (   ).

• To save a copy of the building plan in a SPLAN file or SPLANX archive with a different name, click Save As (   ).

4.7.2.2.2 Managing Beacons

Follow the procedure to add a new beacon to the building plan, edit the properties of a previously added beacon, or remove a beacon

from the building plan.

Prerequisites: 

• Obtain the numbers of the desired beacons.

• Obtain accurate beacon locations in the building.

Procedure: 

Perform one of the following actions:

To add a new beacon to the building plan, perform the following actions:

1. On the indoor map, click Expand the Control Panel (   ) to expand

the Control Panel.

2. On the Control Panel, expand the Floor Plan (   ) tab.

3. Click Add Beacon (   ).

The Beacon Properties window appears.

4. In the window that appears, in the Beacon Number field, type the

beacon number.

5. (Optional) In the Beacon Name field, type the desired beacon

name.
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6. Click OK.

Instead of the mouse cursor, a beacon (   ) icon appears.

7. Perform one of the following actions:

• To add a beacon to the building plan, move the icon to the

place on the building plan where the beacon is installed, and

then left-click.

The beacon label appears in the desired place on the plan.

• To cancel adding a beacon to the building plan, click Add

Beacon (   ) once again.

To edit the properties of an earlier added beacon, perform the following actions:

1. Double-click the label of the desired beacon on the building plan.

The Beacon Properties window appears.

2. In the window that appears, perform the desired changes.

3. Click OK to apply changes.

To remove the beacon from the building plan, perform the following actions:

1. Double-click the label of the desired beacon on the building plan.

The Beacon Properties window appears.

2. In the window that appears, click Delete.

The beacon label is deleted from the building plan.

4.7.2.2.3 Managing Geofences

Follow the procedure to create, edit, or delete a building plan geofence.

Prerequisites: 

• Ensure multiple beacons are located on the building plan to be united into a geofence. For details, see Managing Beacons.

• Ensure the operator has the Manage geofences right. For details, see Operators.

Procedure: 

1. On the indoor map, click Expand the Control Panel (   ) to expand the Control Panel.

2. On the Control Panel, expand the Floor Plan (   ) tab.
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3. Click Geofences (   ).

The Geofences window appears.

4. In the window that appears, perform one of the following actions:

To add a new geofence, click Add (   ).

The Geofence window appears.

To edit an existing geofence, perform the following actions:

1. In the Geofence table, select the desired geofence.

2. Click Edit (   ).

The Geofence window appears.

To delete the geofence, perform the following actions:

1. In the Geofence table, select the desired geofence.

2. Click Delete (   ).

The selected geofence is deleted from the table.

3. Proceed to the last step of the procedure.

To highlight the beacons including in the geofence on the

building plan,

perform the following actions:

1. For the desired entry of the Geofence Table, in the Show

column, select the check box.

2. Proceed to the last step of the procedure.

5. In the Geofence window, in the Name field, type the desired name of the geofence.



312

SmartPTT Dispatcher Operation Positioning

6. From the expandable Color palette, select the desired color to highlight the beacons included in the geofence.

7. Perform the desired action:

To add a new beacon to the geofence, perform one of the following actions:

• Select the desired beacon in the All beacons area, and then

click the Add (   ) button.

• Double-click the desired beacon in the All beacons area.

• Drag the desired beacon from the All beacons area to the

Geofence beacons area.

The selected beacon appears in the Geofence beacons area.

To remove a beacon from the geofence, perform one of the following actions:

• Select the desired beacon in the Geofence beacons area,

and then click the Remove (   ) button.

• Double-click the desired beacon in the Geofence beacons

area.

• Drag the desired beacon from the Geofence beacons area

to the All beacons area.

The selected beacon disappears from the Geofence beacons area.

8. Click OK.

9. In the Geofences window, click Finish.
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4.7.2.2.4 Managing Routes

Follow the procedure to create, edit, or delete a building plan route.

Prerequisites: 

• Ensure multiple beacons are located on the building plan to add them to the route. For details, see Managing Beacons.

• Ensure the operator has the Manage routes right. For details, see Operators.

Procedure: 

1. On the indoor map, click Expand the Control Panel (   ) to expand the Control Panel.

2. On the Control Panel, expand the Floor Plan (   ) tab.

3. Click Routes (   ).

The Routes window appears.

4. In the window that appears, perform one of the following actions:

To add a new route, click Add (   ).

The Route window appears.

To edit an existing route, perform the following actions:

1. In the Route table, select the desired route.

2. Click Edit (   ).

The Route window appears.

To delete the route, perform the following actions:

1. In the Route table, select the desired route.

2. Click Delete (   ).

The selected route is deleted from the table.



314

SmartPTT Dispatcher Operation Positioning

3. Proceed to the last step of the procedure.

To display a route on a building plan, perform the following actions:

1. For the desired entry of the Route Table, in the Show

column, select the check box.

2. Proceed to the last step of the procedure.

5. In the Route window, in the Name field, type the desired name of the route.

6. From the expandable Color palette, select the desired color for the route on the building plan.

7. Perform the desired action:

To add a new beacon to the route, perform one of the following actions:

• Select the desired beacon in the All beacons area, and then

click the Add (   ) button.

• Double-click the desired beacon in the All beacons area.

• Drag the desired beacon from the All beacons area to the

Route beacons area.

The selected beacon appears in the Route beacons area.

To reorder route points, perform the following actions:

1. In the Route beacons area, select the desired beacon.

2. Click Up (   ) or Down (   ) until the beacon reaches the

desired position in the list.
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To remove a beacon from the route, perform one of the following actions:

• Select the desired beacon in the Route beacons area, and

then click the Remove (   ) button.

• Double-click the desired beacon in the Route beacons area.

• Drag the desired beacon from the Route beacons area to

the All beacons area.

The selected beacon disappears from the Route beacons area.

8. Click OK.

9. In the Routes window, click Finish.

4.7.2.2.5 Displaying All Tracks

Follow the procedure to display the tracks of all radios for a certain period or track them in real time.

Prerequisites: 

• Ensure the operator has the Manage tracks right. For details, see Operators.

• Ensure the desired SmartPTT Radioserver is running, otherwise the tracks will not be available to built.

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator, otherwise the tracks will not

be available to built. For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and Configuration

Guide.

Procedure: 

1. On the indoor map, click Expand the Control Panel (   ) to expand the Control Panel.

2. On the Control Panel, expand the Radio Tracks tab.

3. Click Show All.

The All Radio Tracks window appears.
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4. From the Source list, select the desired SmartPTT Radioserver whose database will be used as a data source to build tracks.

5. In the Start Date field, set the time and date of the track recording start.

6. Set the date and time for the end of the track recording:

To specify the exact date and time of the track recording

ending,

select End Date and, in the field on the right, enter the desired

date and time.

To track the movement of radios in real time, select Update in real time.

7. Click ОК.

Tracks appear on the building plan, and track entries appear on the Radio Tracks tab.

Postrequisites: 

• To remove all tracks from the building plan, on the Radio Tracks tab, click Clear All.

• To add a single track to the building plan, on the Radio Tracks tab, click Add Track (   ). For details, see Displaying Track.

4.7.2.2.6 Displaying Track

Follow the procedure to show a radio track on a building plan.

Prerequisites: 

• Ensure the desired SmartPTT Radioserver is running, otherwise a track will not be available to built.

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator, otherwise the tracks will not

be available to built. For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and Configuration

Guide.

• To build a track for an authorized user, ensure the user authorization service is configured in SmartPTT Radioserver Configurator.

For details, see “Configuring User Database Connection” in SmartPTT Installation and Configuration Guide.

• Ensure the operator has rights to manage tracks. For details, see Operators.

Procedure: 

1. On the indoor map, click Expand the Control Panel (   ) to expand the Control Panel.

2. On the Control Panel, expand the Radio Tracks tab.
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3. Click Add Track (   ).

The Radio Track window appears.

4. From the Source list, select the desired SmartPTT Radioserver whose database will be used as a data source to build a track.

5. Select an object for which the track will be built:

To built a track for a radio, perform the following actions:

1. Select Radio.

2. From the list below, select a radio for which the track will

be built.

To built a track for an authorized user, perform the following actions:

1. Select User.

2. From the list below, select an authorized user for which

the track will be built.

6. From the expandable Color palette, select the desired track color.

7. In the Start Date field, set the time and date of the track recording start.

8. Set the date and time for the end of the track recording:

To specify the exact date and time of the track recording

ending,

select End Date and, in the field on the right, enter the desired

date and time.

To track the movement of the object in real time, select Update in real time.

9. Click OK to display the track on the building plan.

The track appears on the building plan, and the track entry appears on the Radio Tracks tab.

Postrequisites: 

• To edit a track, on the Radio Tracks tab, in the elements of the desired track, click Edit track (   ).
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• To remove a track, on the Radio Tracks tab, in the elements of the desired track, click Delete track (   ).

• To remove all tracks from the building plan, on the Radio Tracks tab, click Clear All.

• To not display a track on the building plan, on the Radio Tracks tab, clear the check box next to the desired track name.

4.7.2.2.7 Animating Track

Follow the procedure to animate a radio track on the building plan.

Prerequisites: 

• Ensure the operator has the Manage tracks right. For details, see Operators.

• Ensure the entry of the desired radio or authorized user track is displayed on the Radio Tracks tab. For details, see Displaying

Track and Displaying All Tracks.

Procedure: 

1. On the indoor map, click Expand the Control Panel (   ) to expand the Control Panel.

2. On the Control Panel, expand the Radio Tracks tab.

The entries of the added tracks appear.

3. In the elements of the desired track, perform the following actions:

a. Select the check box next to the track name to display a track on the building plan.

b. Click Start Playback (   ).

The track starts animating on the indoor map.

c. Perform the desired actions:

To pause animation of a track, click Pause Playback (   ).

To change the animation speed of a track, click Decrease speed (   ) or Increase speed (   ).

To stop animation of a track, click Stop Playback (   ).
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d. (Optional) To display the radio position at certain time, click Track details (   ), and then, on the Track Details panel, double-

click the desired entry in the Track Details Table.

4.8 Cross Patches

The Cross Patches feature provides the ability to establish connection between talkgroups that operate on different frequencies or

channels.

Important

You cannot combine several talkgroups from the same channel in one cross patch, or combine talkgroups from different non-

affiliated radioservers in one cross patch.

All participants of the cross patch receive a call made to it. All calls (including calls made by a dispatcher or a telephone subscriber)

made to a talkgroup included in the cross patch are transmitted to all participants of the cross patch.

Cross patches are created in SmartPTT Dispatcher by an operator. After creating a cross patch, all operators in the SmartPTT system

can see this cross patch, edit, enable or disable it (if they have a permission).

Important

Access to cross patches is unavailable if desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned

to the client prohibits cross patches management. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

If an operator who created the cross patch logs off or closes the application, the cross patch will remain available to other operators.

Important

When all operators log out or close the applications, the cross patch will remain enabled and will continue to operate.

Important

A voice call can be retransmitted to another server only from the server that originally received this voice call. That means, you can

not create a chain of cross patches.

NOTE

For private calls between various radio systems, you can use bridging. For details, see Bridging.

Cross Patches Panel

The Cross Patches panel is used to create and manage cross patches.

For information on creating and managing cross patches, see Creating and Editing Cross Patches.

You can open the Cross Patches panel by clicking Tools → Cross Patches on the menu bar.

NOTE

If SmartPTT Radioserver is inactive, the added cross patches are not displayed on the Cross Patches panel.

On the panel, you can display all or only active cross patches. The added cross patch entry provides the cross patch name, information

about its participants, the PTT button to make calls to the cross patch, and the Actions (   ) button to open the Actions menu.

For information on initiating cross patch calls, see Initiating Cross Patch Calls.
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Cross Patch Actions

The Actions menu provides the ability to perform the following actions:

• Disable or enable the cross patch. For details, see Disabling and Enabling Cross Patches.

• Mute or unmute the cross patch. For details, see Muting and Unmuting Cross Patches.

• Open the Cross Patch window for editing the cross patch. For details, see Creating and Editing Cross Patches.

• Delete the cross patch.

NOTE

You can also manage cross patches on the corresponding custom console element. For details, see Custom Consoles.

Cross patches between talkgroups and dynamic groups

In SmartPTT Dispatcher, virtual groups consisting of SmartPTT Mobile users and talkgroups have the form of cross patches between

talkgroups and dynamic groups and are called multigroups.

For information on dynamic groups and SmartPTT Mobile users, see Dynamic Groups in this guide and “SmartPTT Mobile” in SmartPTT

Installation and Configuration Guide.

A multigroup must have at least two members (a dynamic group and a talkgroup). If a multigroup was created in the SmartPTT Mobile

application, a cross patch with the same name and members will be displayed in SmartPTT Dispatcher. Similarly, if a cross patch with

dynamic groups was created in SmartPTT Dispatcher, a multigroup with the same name and members will be displayed in the SmartPTT

Mobile application.

NOTE

Cross patches between talkgroups and individual SmartPTT Mobile users are not supported.

NOTE

SmartPTT Mobile users cannot edit or delete cross patches with dynamic groups created in SmartPTT Dispatcher. Dispatchers can

edit and delete any cross patch, no matter where it was created.

For information on configuring and using cross patches, see the sections below. 

Inter-Server Patching

The Inter-Server Patching feature provides the ability to connect each SmartPTT Radioserver to one or several other radioservers. The

connected radioservers will be considered afilliated. You can use this feature to combine talkgroups from different radioservers in one

cross patch using the standard interface of the cross patch tool. The calls made to a talkgroup included in the cross patch will be

transmitted to all participants of the cross patch even if they are on different radioservers, provided that the radioservers are affiliated.

This feature provides the ability to perform the following actions:

• Connect two or more radioservers.

• Make and receive group calls to/from other radioservers.

• Use cross patches to connect talkgroups from different radioservers.

• Log and record voice calls on affiliated radioservers.
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4.8.1 Creating and Editing Cross Patches

Follow the procedure to create a cross patch.

Prerequisites: 

If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows managing

cross patches. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. If the Cross Patches panel is closed, on the menu bar, click Tools → Cross Patches.

The Cross Patches panel appears.

2. Perform one of the following actions:

To add a cross patch, perform the following actions:

1. On the Cross Patches panel, click Add cross patch (   ).

The Cross Patch window appears.

2. In the window that appears, add the desired object to the Cross

Patch Objects area in one of the following ways:

• Double-click the desired object.

• Drag the desired object to the area.
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• Select the desired object, and then click Add (   ).

NOTE

If the cross patch includes objects from non-affiliated radioservers,

the corresponding icon (   ) appears. Such objects will not

participate in voice retransmission.

3. Click the Create button.

A new cross patch appears in the Cross Patches panel, and

becomes enabled.

Important

A voice call can be retransmitted to another server only from the

server that originally received this voice call. That means, you can not

create a chain of cross patches.

To edit a cross patch,

perform the following actions:

1. Open the properties of the existing cross patch in one of the

following ways:

• On the Cross Patches panel, double-click the desired cross

patch.

• On the Cross Patches panel, in the right part of the desired

cross patch entry, click the Actions (   ) button, and then

select Properties (   ).

 The Cross Patch window appears.

2. In the window that appears, perform the desired changes.

3. Click OK to apply changes and close the window.

4.8.2 Initiating Cross Patch Calls

Follow the procedure to initiate a cross patch call.

Prerequisites: 

• Ensure the Cross Patches panel is opened.

• Ensure the desired cross patch is added and enabled. For details, see Creating and Editing Cross Patches.

• Obtain the current settings of pointing devices and hotkeys. For details, see Control Devices.

Procedure: 

Initiate the cross patch call in one of the following ways:

• Depending on pointing device settings, press and hold, or click the PTT button of the desired cross patch.

• Select the cross patch, and then, depending on the PTT button hotkey settings, press and hold, or press the hotkey.
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4.8.3 Disabling and Enabling Cross Patches

Follow the procedure to disable or enable a cross patch.

Prerequisites: 

If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows managing

cross patches.

An operator can also enable or disable a cross patch without waiting until current calls will be finished if the profile assigned to the client

allows immediate patch enable/disable. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. If the Cross Patches panel is closed, on the menu bar, click Tools → Cross Patches.

The Cross Patches panel appears.

2. On the Cross Patches panel, in the right part of the desired cross patch entry, click the Actions (   ) button.

The cross patch Actions menu appears.

3. In the Actions menu, depending on the cross patch state, perform one of the following actions:

To disable the cross patch, click the Disable (   ) button.

The button changes to Enable (   ); the cross patch entry becomes

shaded.

To enable the cross patch, click the Enable (   ) button.

The button changes to Disable (   ).

4.8.4 Muting and Unmuting Cross Patches

Follow the procedure to to mute or unmute a cross patch.

Prerequisites: 

If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows managing

cross patches. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. If the Cross Patches panel is closed, on the menu bar, click Tools → Cross Patches.

The Cross Patches panel appears.
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2. On the Cross Patches panel, perform one of the following actions:

To mute a cross patch, perform the following actions:

1. Click the Actions (   ) button.

2. Click Mute (   ).

To unmute a cross patch, perform the following actions:

1. Click the Actions (   ) button.

2. Click Unmute (   ).

4.9 Custom Consoles

Custom Consoles are fully customizable SmartPTT Dispatcher panels that provide access to radio system objects and SmartPTT

Dispatcher features.

SmartPTT Dispatcher provides the ability to create panels that meet requirements of the specific radio system and/or dispatcher. You

can configure the appearance of the panel, add elements and change their parameters to simplify access to system objects and features.

Any image in the BMP, JPG, or PNG format can be used as the console background.

You can open the Custom Consoles window for creating and configuring consoles by clicking Settings (   ) → Interface →

Custom Consoles on the menu bar.

Most of the console elements provide controls that can be used to interact with radio objects and features that they represent.

NOTE

Access to some of the elements may require the corresponding operator permission and/or license. For details, see the description

of the desired element in the Custom Console Elements Table below.

You can open the configured Custom Console by clicking Tools → <name of the custom console> on the menu bar. If no Custom Console

is created, the option is unavailable. To remove the configured Custom Console from the menu, clear the Active check box in the

Custom Consoles window.

You can work with more than one Custom Console at the same time.

For information on custom console configuration, see Custom Console Configuration.

Important

Custom console configuration is available only to the Administrator.

For information on custom console elements configuration and usage, see the sections below.
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4.9.1 Custom Console Elements

Custom Consoles provide various elements representing radio system objects and SmartPTT Dispatcher features. You can add the

desired elements, customize their appearance, or change their properties in the Console Configuration window.

NOTE

Access to some of the elements may require the corresponding operator permission and/or license.

SmartPTT Dispatcher provides the following Custom Console elements:

Element Description

Broadcast Call The Broadcast Call element provides the ability to initiate group calls and All Calls on

all available channels of the radio system at the same time. The element is unavailable

in the analog radio systems.

The element provides information on the number of all available channels and channels

used by SmartPTT Dispatcher for transmissions at the moment. For example, if 2 out of

3 is displayed, that means SmartPTT Dispatcher makes calls on 2 out of 3 available

channels.

NOTE

To initiate broadcast calls, you must configure talkgroups in the radio system

settings in SmartPTT Radioserver Configurator. For details, see “Adding and Editing

Talkgroups” in the corresponding network settings description in SmartPTT

Installation and Configuration Guide.

Channel Selector

 

The Channel Selector elements provide the ability to switch to the control station

channel represented by the element. Each element corresponds to one control station

channel.

If no control station is connected or active in the radio system, the element is

unavailable. For correct functioning of the Channel Selector element, the control

station channels must be configured in SmartPTT Radioserver Configurator.

For information on MOTOTRBO control stations see the “MOTOTRBO Control

Stations” section in SmartPTT Installation and Configuration Guide.

Channel

 

The Channel element provides the ability to work with the control stations and IP Site

Connect channels available in the radio system.

The Channel element can display the indicator that appears if the corresponding check

box is selected in the Custom Console settings. The indicator provides information on

the number of missed private calls (red number) and total number of missed calls on

the channel (blue number). You can view detailed information on all missed calls on the

channel in the Missed Calls window by clicking the Missed Calls (   ) button.
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Element Description

Cross Patch

 

The Cross Patch element provides the ability to interact with cross patches.

For information on cross patches, see Cross Patches.

You can add a new cross patch or edit an existing one. For details, see Adding and

Editing Cross Patch Elements.

You can assign the desired cross patch to the new Cross Patch element on the Custom

Console. For details, see Assigning Cross Patches.

Dispatcher

 

The Dispatcher element provides the ability to interact with other SmartPTT

dispatchers.

To call the desired dispatcher, double-click the corresponding element on the Custom

Console. The Dispatchers window appears, and the call will be initiated automatically.

Important

To interact with other dispatchers, an operator must have the Connect with external

dispatchers right. For details, see Operators.

Image The Image element is a non-interactive element that contains an image that can be

selected in the Custom Console settings. You can use BMP, JPG, or PNG.

Incoming Events The Incoming Events element provides information on incoming events in SmartPTT

Dispatcher, such as missed private calls, messages, and call notifications received

during the current operation session.

Incoming Telemetry The Incoming Telemetry element provides the ability to monitor the current status of

GPIO pins on the radios in the dispatched radio system.

Multiselect The Multiselect element provides the ability to create multiselect groups consisting of

radios and/or talkgroups.

For information on adding or deleting a radio or talkgroup from a multiselect group

using the Multiselect element, see Configuring Multiselect Group.

Multiselect groups can be used for the following purposes:

• Initiating calls to multiple radio objects at the same time (multiselect calls). All

participants of a multiselect call can hear an operator and cannot hear other

participants of their multiselect group.

• Sending messages to multiple radio objects at the same time using the TMS

element. For details, see Sending Messages from Custom Console.

• Performing other actions available to multiple radio objects using the hot keys

assigned in SmartPTT Dispatcher settings. For details, see Assigning Hotkeys.
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Element Description

Outgoing Telemetry The Outgoing Telemetry element provides the ability to send configured telemetry

commands and monitor the current status of GPIO pins in the dispatched radio system.

Panel The Panel element provides the ability to interact with multiple Custom Console

elements at the same time. Panels may hold all types of Custom Console elements

except another Panel element.

Actions applied using interactive elements, such as PTT, TMS, and Voice Notification

elements, will be applied to all available elements located within the same Panel

element.

You can drag the desired elements to the panel. All elements placed on the Panel

element will be moved together with it within the main area.

The actions performed on the panel are not applied to deleted from the Panel element

elements and elements that were moved outside the panel after its size was changed.

The elements on the panel borders are not considered as a part of the panel.

PTT The PTT element provides the ability to initiate a call to all available radios and

talkgroups that are located on the same panel with the PTT element. To use the PTT

element, you must add it to the Panel element with the desired radios and/or

talkgroups. The PTT element cannot be used on its own.

Radio

 

The Radio element provides the ability to initiate private voice calls to radios added to

the SmartPTT Dispatcher list of radios. You can use this element to perform the

following actions:

• Initiate a private voice call to the radio using the preferred method of the call

initiation. For details, see Configuring Call Element Actions.

• Initiate a group call to multiple radios by clicking the desired radios while holding

the Ctrl key, and then using the preferred method of the call initiation. For details,

see Configuring Call Element Actions.

• Open the radio Actions menu by clicking the Actions (   ) button on the

element.

• Open the radio Call Window by right-clicking the element.

The Custom Console provides two types of the Radio element:

• Element assigned to a specific (fixed or reassignable) radio.

• Element with a number pad for calling radios by entering their ID or selecting

them from the SmartPTT Dispatcher list of radios.
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Element Description

Data source The data source element provides information on the data source parameters in real

time and can be used for quick access to the Data provider panel in SmartPTT

Dispatcher.

NOTE

The data source element is available only if the data acquisition module is activated

in SmartPTT Dispatcher settings. For details, see Activating Data Acquisition

Module.

Talkgroup

 

The Talkgroups element provides the ability to interact with talkgroups and initiate All

Calls.

The Custom Console provides two types of the Talkgroup element:

• Element for interacting with talkgroups

• Element for initiating All Calls on the configured channel.

Telephone Subscriber

 

The Telephone Subscriber element provides the ability to interact with telephone

subscribers added to SmartPTT Dispatcher.

Important

The Telephone Subscriber element is available only if the Telephone Interconnect

license is installed and the operator has the Make telephone calls right. For details,

see Licenses and Operators.

TMS The TMS element provides the ability to send text messages to a single or multiple

radios and/or talkgroups in the radio system.

Using the TMS element, you can perform the following actions:

• Send a custom message or a message template.

• Send a custom message or a message template by opening the Send Message

window that provides extended functionality for sending messages. For details,

see Sending Messages from the Send Message Window.

For information on sending messages using the TMS element, see Sending Messages

from Custom Console.

Voice Notification The Voice Notifications element provides the ability to play a configured voice

notification for the selected talkgroup or channel.

Important

Voice notifications are created and configured in SmartPTT Radioserver

Configurator. For details, see “Voice Notifications” in SmartPTT Installation and

Configuration Guide.

For detailed information on Custom Console elements, see the SmartPTT Dispatcher embedded help.
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4.9.2 Adding and Editing Cross Patch Elements

Follow the procedure to add a new or edit an existing Cross Patch element in the Custom Console.

Prerequisites: 

Ensure that the Cross Patch element is added in the Custom Console.

For information on the Custom Consoles configuration, see Configuring Console Workspace.

Procedure: 

1. In the Custom Console, perform one of the following actions:

To add a new cross patch that will be assigned to the

element,

perform the following actions:

1. Click the empty Cross Patch element.

The Cross Patches window appears.

2. In the window that appears, click the Create (   ) button.

To edit an existing cross patch assigned to the element, open the Actions (   ) menu of the desired element, and then

click Properties (   ).

 The Cross Patch window appears.
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2. (Optional) In the window that appears, in the Name field, type the cross patch name.

3. Edit the list of cross patch members:

To add an object to the cross patch, perform one of the following actions:

• Select the desired object in the Radio Fleet area, and then

click the Add (   ) button.

• Double-click the desired radio in the Radio Fleet area.

• Drag the desired radio from the Radio Fleet area to the

Cross Patch Objects area.

The selected object appears in the Cross Patch Objects area.

To remove an object from the cross patch, perform one of the following actions:

• Select the desired object in the Cross Patch Objects area,

and then click the Remove (   ) button.
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• Double-click the desired radio in the Cross Patch Objects

area.

• Drag the desired radio from the Cross Patch Objects area

to the Radio Fleet area.

The selected object disappears from the Cross Patch Objects

area.

4. To complete configuration, click Create.

4.9.3 Assigning Cross Patches

Follow the procedure to assign the cross patch to the element in the Custom Console.

Prerequisites: 

• Ensure that the Cross Patch element is added in the Custom Console.

For information on the Custom Consoles configuration, see Configuring Console Workspace.

• Ensure the operator has at least one created cross patch.

For details, see Adding and Editing Cross Patch Elements or Creating and Editing Cross Patches.
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Procedure: 

1. Click the empty Cross Patch element.

The Cross Patches window appears.

2. In the window that appears, select the desired cross patch from the list, and then click OK.

The selected cross patch will be assigned to the element.

Postrequisites: 

To clear the element, in the Actions (   ) menu of the cross patch, click Clear Element (   ).

The selected element becomes empty.
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4.9.4 Configuring Multiselect Group

Follow the procedure to add a radio, or talkgroup to a multiselect group, edit it, or remove it from the multiselect group using the

Multiselect element in the Custom Console.

Prerequisites: 

Ensure that the Multiselect element is added in the Custom Console.

For information on the Custom Consoles configuration, see Configuring Console Workspace.

Procedure: 

1. Click the multiselect group icon (   ) on the element to open the Multiselect window.

The Multiselect window appears.

2. (Optional) In the window that appears, type the multiselect group name.

3. In the Radio Fleet area, select the Radios (   ) or Talkgroups (   ) tab to show the desired objects.

4. Perform the desired action:

To add a new participant to the multiselect group, perform one of the following actions:

• Select the desired radio object in the Radio Fleet area, and

then click the Add (   ) button.
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• Double-click the desired radio object in the Radio Fleet area.

• Drag the desired radio object from the Radio Fleet area to

the Multiselect objects area.

The selected object appears in the Multiselect objects area.

To remove a participant from the multiselect

group,

perform one of the following actions:

• Select the desired radio object in the Multiselect objects area,

and then click the Remove (   ) button.

• Double-click the desired radio object in the Multiselect objects

area.

• Drag the desired radio object from the Multiselect objects area

to the Radio Fleet area.

The selected object disappears from the Multiselect objects area.

5. Click Create to save changes.

4.9.5 Sending Messages

Follow the procedure to send a text message to a single or multiple radios and/or talkgroups using the TMS element.

Prerequisites: 

Ensure that the TMS element and the desired radios and talkgroups are added to the Custom Console.

For information on the Custom Consoles configuration, see Custom Console Elements.

Procedure: 

1. Select one or multiple radios and/or talkgroups to which you want to send a message.

NOTE

If the TMS element is located within the Panel element, you do not need to select recipients. The message will be sent to all radios

and talkgroups located on the same Panel element.

2. Perform one of the following actions:

To type a new message and send it from the TMS

element,

in the text field, type your message, and then click Send (   ).

To send a message template from the TMS

element,

to the left of the text field, click the Message (   ) button, and then,

from the Templates list, select the name of the desired template.
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To type a new message or edit a message

template before sending it from the Message

window,

perform the following actions:

1. Click the Message (   ) button to the right of the text field.

The Message window appears.

2. In the window that appears, type your message in the text field or

use a message template, and then click Send.

For information on working with the Message window,

see Sending Messages from the Send Message Window.

 The information that a message is sent appears in the radio and/or talkgroup Call Window and in the SmartPTT Dispatcher Event

Log.

4.10 Bridging

Bridging provides voice communication between radios and/or talkgroups from various sites and/or radio systems that cannot use

voice communication under normal conditions. Bridging, by contrast with cross patches, provides the ability to integrate both group and

private calls.

Important

To use bridging in SmartPTT Dispatcher, you must activate it in SmartPTT Radioserver Configurator. For details, see “Bridging” in

SmartPTT Installation and Configuration Guide.

Important

Access to bridging is unavailable if desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned to the

client prohibits bridging management. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Bridging Features

Important

To use the bridging feature, you need the corresponding license. For details, see Licenses.

The bridging service is supported for digital and analog channels in the following networks:

• IP Site Connect

• Capacity Plus sites

NOTE

The bridging service does not depend on whether SmartPTT Dispatcher is active or not.

By using the bridging service in SmartPTT, you can perform the following actions:

• Voice communication between radio systems with different frequency ranges

• Radio systems integration to increase the total voice communication coverage area

• Privileged radios integration into multiple radio systems
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You cannot use bridging to send text messages between radio systems.

Important

Bridging is unavailable for systems accessed over the 4-wire interfaces.

WARNING

To prevent unstable system operation, ensure routes do not create a loop.

Route Groups and Profiles

SmartPTT Dispatcher provides the ability to configure profiles and route groups to manage bridging. For example, you can configure two-

way bridging route. When somebody makes a call to the source radio system, the call will also be relayed to the destination radio

system, and vice versa.

Important

Bridging configuration is available only to the Administrator and operators with the Manage bridging settings right. For details, see

Operators.

You can use profiles to save route groups that provide settings to manage bridging routes.

Important

Bridging profiles in SmartPTT must be distinguished from profiles that are assigned to client accounts in SmartPTT Radioserver

Configurator. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Route is a basic unit of bridging process, and is an integral part of a route group. Routes cannot be used separately from route groups.

A route group unites several routes into one group. Route groups can be activated and deactivated for using routes inside these groups.

For information on adding route groups, see Adding Route Groups.

You can use profiles to switch quickly between activated configured route groups. Profiles can be created for general purposes, for

carrying out engineering work, for emergency situations, etc.

For information on configuring profiles, see Configuring Profiles.
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4.10.1 Adding Route Groups

Follow the procedure to add a route group.

Prerequisites: 

• Ensure the operator has the Manage bridging settings right.

For information on the operator rights, see Operators.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows bridging

management. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

• Ensure that the corresponding license is installed. For details, see Licenses.

Procedure: 

1. On the Radio Fleet panel, to the right of the desired SmartPTT Radioserver, click the Actions (   ) button.

2. In the Actions menu, select Configure Call Bridging Table.

The Bridging Configuration window appears.
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3. In the window that appears, click Add Route Group (   ).

The Add Route Group window appears.

4. In the window that appears, in the Name field, type the group name.

5. Add the desired routes to the group depending on the call types:

To route any type of voice calls, see Configuring All Routes.

To route group calls and All Calls, see Configuring Non-Private Routes.

To route private calls only, see Configuring Private Routes.

To route private voice calls initiated and received

by radios included in the radio group,

see Configuring Dynamic Routes.

6. Click OK to apply changes and close the window.

Postrequisites: 

• To edit the route group, in the Bridging Configuration window, select the desired group, and then click Edit Group (   ).

• To delete the route group, in the Bridging Configuration window, select the desired group, and then click Delete Group (   ).

4.10.1.1 Configuring All Routes

Follow the procedure to route all voice calls from the source network to the destination network.

Prerequisites: 

Ensure that the desired networks are configured in SmartPTT Radioserver Configurator.

Procedure: 

1. On the Radio Fleet panel, to the right of the desired SmartPTT Radioserver, click the Actions (   ) button.

The SmartPTT Radioserver Actions menu appears.

2. In the Actions menu, select Configure Call Bridging Table.

The Bridging Configuration window appears.
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3. In the window that appears, click Add Route Group (   ).

The Add Route Group window appears.

4. In the window that appears, click Add Route (   ).

The Route window appears.
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5. In the window that appears, in the Route Number field, type a unique route number.

6. From the Route Type list, select All.

7. From the Source Control Station list, select the desired source channel.

8. From the Destination Control Station list, select the desired destination channel.

9. From the Direction list, select one-way or two-way direction.

10. (Optional) Select the Process Routed Calls check box to route incoming calls by another route.

11. Click OK to apply changes and close the window.

Postrequisites: 

• To edit the route, in the Add Route Group window, select the desired route, and then click Edit Route (   ).

• To delete the route, in the Add Route Group window, select the desired route, and then click Delete Route (   ).

4.10.1.2 Configuring Private Routes

Follow the procedure to route private radio calls.

Important

Private calls cannot be routed in networks with control stations.

Prerequisites: 

• Ensure that the desired networks are configured in SmartPTT Radioserver Configurator.

• Obtain the desired radio ID from the source network.

Procedure: 

1. On the Radio Fleet panel, to the right of the desired SmartPTT Radioserver, click the Actions (   ) button.

The SmartPTT Radioserver Actions menu appears.

2. In the Actions menu, select Configure Call Bridging Table.

The Bridging Configuration window appears.
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3. In the window that appears, click Add Route Group (   ).

The Add Route Group window appears.

4. In the window that appears, click Add Route (   ).

The Route window appears.

5. In the window that appears, in the Route Number field, type a unique route number.

6. From the Route Type list, select Radio.

7. From the Source Control Station list, select the desired source channel.

8. From the Destination Control Station list, select the desired destination channel.

9. In the Source field, type the radio ID from the source network.

NOTE

The Target field is unavailable when you configure individual radio calls.

10. From the Direction list, select one-way or two-way direction.

11. (Optional) Select the Process Routed Calls check box to route incoming calls by another route.

12. Click OK to apply changes and close the window.
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Postrequisites: 

• To edit the route, in the Add Route Group window, select the desired route, and then click Edit Route (   ).

• To delete the route, in the Add Route Group window, select the desired route, and then click Delete Route (   ).

4.10.1.3 Configuring Non-Private Routes

Follow the procedure to route group calls or All Calls.

Prerequisites: 

Ensure that the desired networks are configured in SmartPTT Radioserver Configurator.

Procedure: 

1. On the Radio Fleet panel, to the right of the desired SmartPTT Radioserver, click the Actions (   ) button.

The SmartPTT Radioserver Actions menu appears.

2. In the Actions menu, select Configure Call Bridging Table.

The Bridging Configuration window appears.

3. In the window that appears, click Add Route Group (   ).

The Add Route Group window appears.
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4. In the window that appears, click Add Route (   ).

The Route window appears.

5. In the window that appears, in the Route Number field, type a unique route number.

6. From the Route Type list, select Talkgroup.

7. From the Source Control Station list, select the desired source channel.

8. From the Destination Control Station list, select the desired destination channel.

9. From the Source list, select the desired source talkgroup or All Call.

10. From the Target list, select the desired destination talkgroup or All Call.

11. From the Direction list, select one-way or two-way direction.

12. (Optional) Select the Process Routed Calls check box to route incoming calls by another route.

13. Click OK to apply changes and close the window.

Postrequisites: 

• To edit the route, in the Add Route Group window, select the desired route, and then click Edit Route (   ).

• To delete the route, in the Add Route Group window, select the desired route, and then click Delete Route (   ).
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4.10.1.4 Configuring Dynamic Routes

Follow the procedure to route private voice calls initiated and received by radios included in the radio group.

Important

Private calls cannot be routed in networks with control stations.

Prerequisites: 

Ensure the radio group is added in SmartPTT Radioserver Configurator. For details, see “Managing Radio Groups” in SmartPTT

Installation and Configuration Guide.

NOTE

Do not confuse radio groups (created in SmartPTT Radioserver Configurator) and talkgroups (radio system entities which are set in

radio codeplugs).

Procedure: 

1. On the Radio Fleet panel, to the right of the desired SmartPTT Radioserver, click the Actions (   ) button.

The SmartPTT Radioserver Actions menu appears.

2. In the Actions menu, select Configure Call Bridging Table.

The Bridging Configuration window appears.

3. In the window that appears, click Add Route Group (   ).

The Add Route Group window appears.



345

SmartPTT Dispatcher Operation Bridging

4. In the window that appears, click Add Route (   ).

The Route window appears.

5. In the window that appears, in the Route Number field, type a unique route number.

6. From the Route Type list, select Dynamic.

7. In the Subscriber Group field, select the desired radio group.

8. From the Direction list, select any direction.

9. Click OK to apply changes and close the window.

Postrequisites: 

• To edit the route, in the Add Route Group window, select the desired route, and then click Edit Route (   ).

• To delete the route, in the Add Route Group window, select the desired route, and then click Delete Route (   ).

4.10.2 Configuring Profiles

Configuration and managing of profiles in SmartPTT Dispatcher include the following:

• Adding profiles. For details, see Adding Profiles.

• Switching between added profiles, and renaming and deleting profiles. For details, see Managing Profiles.
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4.10.2.1 Adding Profiles

Follow the procedure to save the current configuration as a new profile.

Prerequisites: 

• Ensure you added the desired route groups. For details, see Adding Route Groups.

• Ensure the operator has the Manage bridging settings right.

For information on the operator rights, see Operators.

• Ensure the bridging service is activated in SmartPTT Radioserver Configurator. For details, see “Managing Bridging” in SmartPTT

Installation and Configuration Guide.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows bridging

management.

For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. In the Bridging Configuration window, in the Route Groups table, select the Active check boxes next to the desired route groups.

2. (Optional) To the right of Routes, click All or Active to display all or only active route groups.

3. Save the configuration as a new profile:

a. In the Bridging Configuration window, click Save As.

The Enter Profile Name window appears.
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b. In the window that appears, in the Profile Name field, type the desired profile name.

c. Click OK to apply changes and close the window.

The saved profile configuration appears.

4. To apply the profile settings, click Apply.

The asterisk character ( * ) appears next to the profile name.

4.10.2.2 Managing Profiles

Follow the procedure to switch, rename, or delete the profile.

Prerequisites: 

• Ensure the operator has the Manage bridging settings right.

For information on the operator rights, see Operators.

• Ensure that bridging is activated in SmartPTT Radioserver Configurator. For details, see For details, see “Managing Bridging” in

SmartPTT Installation and Configuration Guide.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows bridging

management. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. In the Bridging Configuration window, click Change Profile.

The Bridging Profiles window appears.

2. In the window that appears, click No Profile or Select Profile to manage groups using profiles.

3. If Select Profile is selected, in the Bridging Profiles window, perform one of the following actions:

To switch between profiles, select the desired profile from the list.

To rename the profile, perform the following actions:

1. Select the desired profile from the list, and click Edit (   ).

The Enter Profile Name window appears.
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2. In the window that appears, type a new name for the profile.

3. Click OK to apply changes and close the window.

To delete the profile, perform the following actions:

1. Select the desired profile from the list, and click Delete (   ).

2. In the window that appears, click OK.

4. In the Bridging Profiles window, click OK to apply changes and close the window.

4.11 Text Messages

The Text Messaging feature provides the ability to send and receive text messages in SmartPTT Dispatcher. You can also use this

feature to create templates for frequently sent messages.

The character limit for a text message is 500 characters, including spaces and punctuation marks.

Important

To send text messages, an operator must have the Send text messages right.

For information on user roles in SmartPTT Dispatcher, see Operators.

Important

The Text Messaging feature is unavailable if desktop client authentication on SmartPTT Radioserver is enabled and the profile

assigned to the client prohibits sending and receiving text messages. For details, see “Profiles” in SmartPTT Installation and

Configuration Guide.

NOTE

The Text Messaging feature is unavailable to SmartPTT Mobile users.

Actions with Messages

In SmartPTT Dispatcher, you can perform the following actions with text messages:

• Send text messages to radios and talkgroups. For details, see Sending Messages from the Send Message Window and Sending

Messages from the Call Window.

• Receive messages from radios.

• Send and receive messages from other dispatchers. For details, see Sending Messages to Dispatchers.

• Create templates for frequently sent messages. For details, see Managing Message Templates.

When a message from a radio is received, a new entry with information about the message appears in the Event Log and Call Window. In

the Call Windows settings, you can also configure the Call Window to appear automatically after receiving a message from a radio. For

details, see Configuring Call Windows.
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When a message from another dispatcher is received, the Dispatchers window appears. For details, see Accepting Calls from Other

Dispatchers.

You can set an audio notification to inform you of a new incoming message. For details, see “Rules” in SmartPTT Installation and

Configuration Guide.

Message Sending

In SmartPTT Dispatcher, you can send text messages to radios and talkgroups in one of the following ways:

• From the Send Message window.

This window provides full functionality of the SmartPTT Dispatcher Text Messaging feature. For details, see Sending Messages

from the Send Message Window and Managing Message Templates.

• From the radio or talkgroup Call Window.

The Call Window is usually used for sending quick messages. For details, see Sending Messages from the Call Window.

• From the TMS element in the Custom Console.

The TMS element can be used for sending quick messages and message templates without editing them. For details, see Sending

Messages from Custom Console.

• Automatically after the rule triggers, if the Message Sending feature was configured on the Initiator Alerts tab. For details,

see Rules and Lone Worker Mode.

NOTE

In the rule settings window, on the Other tab, you can configure the e-mail and SMS sending for any type of rule. For details,

see Configuring Other Services.

• Using deferred actions.

The Deferred Actions feature provides the ability to send text messages to offline radios. When a radio appears in the network, it

will receive the message. For details, see Creating Deferred Messages.

Message Status

You can track the status of your messages in the Status column of the Event Log and in the log field of the Call Window.

The message can have the following statuses:

Status Description

Message delivered The message was successfully delivered to the target radio.

Message not delivered The message was not delivered due to issues with the radio

connection to the radio system

Message accepted A message from a radio or another dispatcher was received.

Message sent The message was successfully sent to the talkgroup.

Message was not sent The message was not sent to the talkgroup due to issues with the

SmartPTT Dispatcher connection to SmartPTT Radioserver.
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SmartPTT Dispatcher does not display the talkgroup radios that received the message. To check the message delivery status for a

specific radio, you can resend the message to the desired radio individually.

NOTE

The delivery status may be affected by radio equipment settings. For information on your system configuration, contact your system

administrator.
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4.11.1 Sending Messages from the Send Message Window

Follow the procedure to send a text message to a radio or a talkgroup from the Send Message window.

Prerequisites: 

• Ensure the operator has the Send text messages right. For details, see Operators.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows sending

and receiving text messages. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows sending

and receiving text messages. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. Open the Send Message window in one of the following ways:

To open it from the Radio Fleet panel, to the right of the desired radio, talkgroup, or category name,

click the Actions (   ) button, and then click Send Message ( 

 ).

To open it from the Radios panel or the Custom Console

panel,

click the Actions (   ) button on the desired radio or

talkgroup element, and then click Send Message (   ).

To open it for a radio from the Maps panel, on the map or on the Radios tab of the Radios panel, right-click

the desired radio, and then click Send Message (   ).

To open it for a category from the Maps panel, on the expandable Radios panel, on the Categories tab, right-

click the desired category, and then click Send Message (   ).

To open it from the Call Window of a radio or a talkgroup, in the Call Window, click Message (   ).

For information on Call Windows, see Call Windows.

2. Depending on the message that you want to send, perform one of the following actions:

To type a new text message, in the text field, type your message, and then click Send.

To use a message template,

perform the following actions:

1. From the Template list, select the name of the

desired template.

The text of the message appears in the text field

below.

2. (Optional) In the text field, edit the text of the

message.

3. Click Send.

 The information on the sent message appears in the log field of the Call Window and in the Event Log.

NOTE

If you send the message to a talkgroup or a category on the Radio Fleet panel, the information on its delivery is displayed for each

radio and talkgroup individually.
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Postrequisites: 

For information on working with message templates, see Managing Message Templates.

4.11.2 Sending Messages from the Call Window

Follow the procedure to send a quick message from the Call Window of a radio or a talkgroup.

Prerequisites: 

• Ensure the operator has the Send text messages right. For details, see Operators.

• Ensure that the Call Window of the desired radio or talkgroup is open. For details, see Call Windows.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows sending

and receiving text messages. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

Send the message in one of the following ways:

To type a new message and send it from the Call Window, at the bottom of the Call Window, in the text field, type your

message, and then click Send (   ).

To type a new message or use a message template and

send it from the Send Message window,

perform the following actions:

1. Click Message (   ) to the right of the text field.

2. In the Send Message window, type the message in the text

field or use a message template, and then click Send.

For information on sending messages from the Send

Message window, see Sending Messages from the Send

Message Window.

 The information on the sent message appears in the log field of the Call Window and in the Event Log.

4.11.3 Managing Message Templates

Follow the procedure to configure message templates for frequently sent messages.

Prerequisites: 

• Ensure an operator has the Send text messages right. For details, see Operators.

• Ensure that the text messaging is activated in SmartPTT Radioserver Configurator. For details, see “Activating Text Message

Sending and Receiving” in SmartPTT Installation and Configuration Guide.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows sending

and receiving text messages. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. Open the Send Message window.

2. Depending on what you are going to do with the template, perform one of the following actions:

To create a new template,

perform the following actions:

1. In the text field, type your message, and then click Save Template.



353

SmartPTT Dispatcher Operation Text Messages

2. In the Message Template Name window, in the text field, type the

template name.

NOTE

If you leave the field empty, the template gets the New Template name

that you can change later.

To edit an existing template,

perform the following actions:

1. From the Template list, select the name of the desired template.

2. In the text field below, edit the template message.

3. Click Save Template.

To delete an existing template,

perform the following actions:

1. From the Template list, select the name of the desired template.

The text of the message appears in the text field below.

2. Click Delete Template.

3. In the Delete Template window, click OK.

4.12 Job Tickets

The Job Tickets feature provides the ability to send job tickets to radios and track implementation of the assigned tasks. When a radio

receives a job ticket, the radio user can change the radio status, for example reject this job ticket or mark that the task implementation

started. Job tickets can be send both to individual radios and to talkgroups.

NOTE

The Job Tickets feature is not available in Capacity Max systems.

NOTE

The Job Tickets feature is not available to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

Only radios with a display can receive job tickets. The radios that do not support the Job Tickets functionality but have a display receive

job tickets as messages, for example, <JTS> Job Ticket №1 Create weekly report.

To check whether a radio supports this functionality, contact your system administrator.

Job Tickets Panel

The Job Tickets panel provides the ability to manage assignments and track their implementation.

You can open the Job Tickets panel by clicking Tools → Job Tickets on the menu bar.
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The Job Tickets panel is divided into the following areas:

• Filters.

The Filters area provides the ability to filter job tickets in the Job Tickets Table. You can filter job tickets by their names,

assignees, statuses, date and time when job tickets were created or updated.

For information on filtering job tickets, see Filtering Job Tickets.

• Management area.

The Management area contains the Job Tickets Table and controls for managing job tickets. The Management area provides the

ability to create job tickets, assign them to radios, edit and delete them, as well as update statuses, and track tickets

implementation.

For information on job tickets management, see Managing Job Tickets.

• Status Change Log.

In the Status Change Log area, a table is located that displays the status assigned to the job ticket by an assignee, as well as date

and time of its update.

Job Tickets Table

By default, in the Management area, the Job Tickets Table contains all job tickets sent by this dispatch console. You can use it to see

the name and description of a ticket, its assignee, status, delivery update, as well as creation, expiration, and its status update dates. For

information on the table see below:

• The Job ticket column contains the ticket name and its number that was assigned by the automatic numbering feature if it was

enabled.

• The Description column provides the job ticket description.

• The Assigned column contains the radio or talkgroup to which the job ticket was sent.
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• The Status column indicates the implementation status of the job ticket set by the assignee. When the assigned radio changes the

job ticket status, the status in the Job Tickets Table changes accordingly. If the job ticket is assigned to a talkgroup, the status in

the table shows the latest status update and the name of the radio that updated it. All status updates performed by participants of

the talkgroup are available in the Status Change Log area.

• The Created column contains date and time when the job ticket was created.

• The Expires column contains date and time when the job ticket becomes invalid. The expiration time is calculated automatically

and depends on the expiration period that was set during ticket creation.

• The Updated column contains date and time when the job ticket status was last updated by the assignee.

• The Delivery status column indicates if a job ticket was sent and received by the assignee.

When a job ticket is sent to a radio, no status is displayed if the assignee is transmitting and its receiving channel is busy. As soon as the

transmission finishes, the status changes to Delivered.

In the Job Tickets Table, the job tickets with the Delivered and Not Delivered statuses for radios, as well as Sent and Not Sent for

talkgroups are highlighted with fading dark orange color ( ⬛ ).

NOTE

When a job ticket is sent to a talkgroup, SmartPTT Dispatcher does not display radios that received the job ticket. To check the job

ticket delivery status for a specific radio, you can resend this ticket to the desired radio individually.

After the job ticket expiration period ends, the Ticket outdated status appears. However, the assignee can still update its status. The job

tickets with this delivery status are highlighted in the Job Tickets Table with pink color ( ⬛ ).

If the job ticket assignee is offline and the expiration period ends before the assignee appears online, the job ticket will not be sent. Until

the expiration period ends, assignees will receive job tickets as soon as they appear online.

NOTE

Expired job tickets are not hidden when the Show completed tickets check box is cleared.

You can sort the job tickets displayed in the table by columns and arrange the entries in ascending or descending order by clicking the

name of the desired column.

Actions with Job Tickets

An operator can perform the following actions with job tickets:

• Create new job tickets and send them to radios and talkgroups, as well as track the job ticket implementation status. For details,

see Managing Job Tickets.

• Set status color and audio signal when status is changed. For details, see Managing Job Ticket Statuses.

• Filter the list of job tickets. For details, see Filtering Job Tickets.

4.12.1 Filtering Job Tickets

Follow the procedure to filter the job tickets in the Job Tickets Table.

Prerequisites: 

Ensure that the Job Tickets panel is open.

Procedure: 

1. In the upper-left corner of the Job Tickets panel, click the Expand (   ) button to expand the Filters area.
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2. Set the desired filter parameters:

To filter job tickets by name, perform the following actions:

1. Select the Job ticket check box.

2. From the unlocked list on the right, select the desired job

ticket name.

To filter job tickets by the radio or talkgroup that is its

assignee,

perform the following actions:

1. Select the Assignee check box.

2. From the unlocked list on the right, select the desired

radio or talkgroup name.

To filter job tickets by status, perform the following actions:

1. Select the Status check box.

2. From the unlocked list on the right, select the desired job

ticket status.

To filter job tickets by creation date and time, perform the following actions:

1. Select the Created check box.

2. In the unlocked fields on the right, enter the start and end

points of the desired job ticket creation time range.

To filter job tickets by status update date and time, perform the following actions:

1. Select the Updated check box.

2. In the unlocked fields on the right, enter the start and end

points of the desired job ticket status update time range.

Example

If you set the start point at 01.04.2020 00:00:00 and the end point at 07.04.2020 23:59:59 in the Updated fields, only the job tickets

that were updated after 1 April 2020 and before 7 April 2020 will appear in the Job Tickets Table.

3. Click Apply (   ) to apply selected filters to the Job Tickets Table entries.
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Postrequisites: 

To clear the applied filters and display all entries in the Job Tickets Table, click Clear (   ).

4.12.2 Managing Job Tickets

Follow the procedure to add, resend, or delete a job ticket as well as update all job ticket statuses or view the status change log of an

individual job ticket.

Prerequisites: 

(Optional) In the window for managing job ticket statuses, configure additional job ticket parameters:

• Automatic numbering

• Sending notifications when a dispatcher deletes an uncompleted job ticket

• Default status

• For job ticket statuses, the color, sound signal, and status completion settings

For details, see Managing Job Ticket Statuses.

Procedure: 

1. On the menu bar, click Tools → Job Tickets.

The Job Tickets panel appears.

2. (Optional) To resend, delete, or view information about a job ticket with the completion status, select the Show completed tickets

check box.

3. In the Management area, perform one of the following actions:
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To add a new job ticket and send it to a single or

multiple radios or talkgroups,

click Add (   ).

The Job ticket window appears.

To edit a job ticket before resending, in the Job Tickets table, select the desired job ticket, and then

click Resend (   ).

The Job ticket window appears.

To delete a job ticket, perform the following actions:

1. In the Job Tickets table, select the desired job ticket, and

then click Delete ticket (   ).

2. In the Deleting ticket window, click OK.

The job ticket is deleted from the table.

3. Proceed to step 9.

To update job ticket statuses after a period of the

dispatch console inactivity,

perform the following actions:

1. Click Update statuses (   ).

2. (Optional) If no changes occurred during the inactivity

period, in the Information window, click OK.

3. Proceed to step 9.

To view information on status updates of a job ticket, perform the following actions:

1. In the Job Tickets table, select the desired job ticket.

In the Status Change Log table, all statuses of the selected

job ticket are displayed with the date and time of their

assignment.

2. Proceed to step 9.
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4. In the Job ticket window, in the Job ticket field, type the name of the job ticket.

5. In the Description field, type a short description of the job ticket.

6. In the Expiration period (hr) field, enter the amount of time in hours for which the job ticket will be valid.

NOTE

Assignees do not receive information about the job ticket validity period and cannot see if it has already expired. To ensure the job

ticket task is not performed after its expiration time, you can delete it from the Job Tickets Table (if the Send notification to radio

when uncompleted job ticket was deleted by dispatcher check box is selected in the window for managing job ticket statuses), send

another job ticket indicating the cancellation or specify the job ticket expiration period in the Description field before sending it.

7. Drag and drop the desired radios or talkgroups from the Radio Fleet panel to the Assignees area.

NOTE

If you want to remove an assignee, select the desired assignee in the Assignees area, and then press the Delete key. You can remove

several assignees simultaneously by selecting them using the Shift or Ctrl keys.

8. Click OK to send the job ticket.

The new job ticket entry appears in the Job Tickets table.

9. (Optional) If necessary, close the Job Tickets panel by clicking Close (   ).

NOTE

The panel cannot be closed if the layout is locked.

Postrequisites: 

Configure the desired parameters to filter the job tickets displayed in the Job Tickets table. For details, see Filtering Job Tickets.

4.13 Telephone Interconnect

In SmartPTT Dispatcher, operators can initiate calls to telephone subscribers and vice versa. Between operators and telephone

subscribers, voice is transmitted in the full-duplex mode.

NOTE

SmartPTT also supports server telephony. It provides the ability to connect radio users and telephone subscribers in the half-duplex

mode. To use this feature, you must configure the radioserver connection to the PBX.

For information on SmartPTT Radioserver configuration, see “SIP Telephony” in SmartPTT Installation and Configuration Guide.
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If you configure the radioserver connection to the PBX, you can use SmartPTT Dispatcher to initiate calls between radio users and

telephone subscribers. If you configure only SmartPTT Dispatcher settings, you will be able to connect only telephone subscribers and

SmartPTT Dispatcher. SmartPTT uses the Session Initiation Protocol (SIP) to establish connection with the desired telephone

subscribers.

Important

To access the Telephone Interconnect feature, you must install the corresponding license, and the operator must have the Make

telephone calls right.

For information on user roles in SmartPTT Dispatcher, see Operators.

For information on licenses, see Licenses.

NOTE

The SIP ports can be blocked by firewall software. Contact your system administrator to check if your firewall settings allow SIP.

SmartPTT Dispatcher Telephone Interconnect features

• Voice call from SmartPTT Dispatcher to a telephone subscriber

• Voice call from a telephone subscriber to SmartPTT Dispatcher

• Initiation of a voice call between a radio user and telephone subscriber

• Service sounds playback (sound alert for incoming call, sound alert for outgoing call)

• Configuration of call volume directly in SmartPTT Dispatcher

Telephony Glossary

VoIP gateway is a separate device or PBX module to connect SmartPTT Dispatcher to the telephone network.

Private Branch eXchange (PBX) is a telephone system within an enterprise that switches calls between users on local lines, while

enabling all users to share a certain number of external phone lines.

Public Switched Telephone Network (PSTN) is the wired phone system that is accessed using phones, PBX, and data transmission

equipment.

Interaction with Telephone Subscribers

The Telephone Interconnect feature provides dispatchers with the ability to call telephone subscribers and vice versa. In SmartPTT

Dispatcher, you can also create a list of telephone subscribers to make calls.

NOTE

To connect radio users with telephone subscribers, you must configure the radioserver connection to the PBX. The radioserver

configuration procedure does not depend on the type of connection configured in SmartPTT Dispatcher.

For information on SmartPTT Radioserver configuration, see “SIP Telephony” in SmartPTT Installation and Configuration Guide.

SmartPTT Dispatcher provides the following connection options:

• Call a telephone subscriber from SmartPTT Dispatcher. For details, see Initiating Calls to Telephone Subscribers.

• Initiate connection between radios or talkgroups and telephone subscribers using SmartPTT Dispatcher. For details, see

Connecting Radios with Telephone Subscribers.

• Call SmartPTT Dispatcher from a telephone subscriber. For details, see Accepting Calls from Telephone Subscribers.

• Initiate a conference call that provides the ability to connect telephone subscribers, radios, talkgroups and/or dispatchers. For

details, see Conference Calls.
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NOTE

To make the Make Conference Call (   ) button available on the SmartPTT Dispatcher menu bar, enable calls to telephone

subscribers in the telephony settings.

If connection is established between a telephone subscriber and a talkgroup, the dispatcher that initiated the call can participate in the

conversation. If the connection is private (between a telephone subscriber and a single radio), the dispatcher can only listen to the

conversation without taking part in it.

If SmartPTT Dispatcher establishes connection between a telephone subscriber and a radio or a talkgroup, only the call participants can

end the call. SmartPTT Dispatcher cannot affect it in any way after the call was initiated.

NOTE

A special tone on the radio indicates the end of the call. If the radio user initiates a new transmission before they hear the tone, the

transmission will be initiated incorrectly and may fail.

4.13.1 Adding and Editing Telephone Subscribers

Follow the procedure to add a new subscriber to the list of telephone subscribers in SmartPTT Dispatcher or edit an existing subscriber.

Prerequisites: 

• From PBX settings obtain numbers of the desired telephone subscribers.

• If you do not use SIP automatic addressing, from SmartPTT Radioserver Configurator obtain the following information:

• Radioserver call number. For details, see “Configuring Incoming Calls” in SmartPTT Installation and Configuration Guide.

• IP address and port number of the SIP server. For details, see “Configuring Outgoing Calls” in SmartPTT Installation and

Configuration Guide.

• If you want to use the automatic SIP addressing format, ensure that the VoIP gateway default settings are specified in the

Telephone Interconnect settings. For details, see Configuring General Telephone Interconnect Settings.

• If you want to use SIP account for connection to the telephone subscriber, ensure that the desired account is added to the

SIP Accounts list in SmartPTT Dispatcher. For details, seeManaging SIP Accounts.

• (Optional) Prepare the following files:

• Telephone subscriber's avatar.

• Audio file that will play in SmartPTT Dispatcher when receiving a call from this telephone subscriber.

Procedure: 

1. On the menu bar, click Settings (   ) → Telephone Interconnect → Telephone Subscribers.

The Telephone Subscribers window appears.
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2. Perform one of the desired actions:

To add a new telephone subscriber, in the top part of the window, click Add (   ).

To edit an existing telephone subscriber, perform the following actions:

1. Select the desired subscriber from the list.

2. In the top part of the window, click Edit (   ).

 The Telephone Subscriber window appears.
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3. In the Subscriber field, type the subscriber's name.

4. Select the desired SIP addressing format:

To use default gateway settings, perform the following actions:

1. In the SIP-Address area, select Automatic.

2. In the Number field, type the phone number of the telephone

subscriber.

To use the subscriber's full address, perform the following actions:

1. In the SIP-Address area, select Full Address.
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2. In the Outgoing field, type the subscriber's SIP address for

outgoing calls in the following format:

sip:<prefix><number>@<gateway>:<port>

3. In the Incoming field, type the subscriber's SIP address for

incoming calls in the following format:

sip:<prefix><number>@<gateway>:<port>

NOTE

A SIP address is composed from dial prefix for outgoing or

incoming calls, telephone subscriber phone number, VoIP gateway IP

address, and VoIP SIP port in the following format:

sip:<prefix><number>@<gateway>:<port>. All these parameters

except the telephone subscriber phone number can be configured as

default in the Telephone Interconnect window.

For information on the Telephone Interconnect window

configuration, see Telephone Interconnect Settings.

On the screenshot, you can see a SIP address for the 1111 phone

number where the dial prefix for outgoing calls is 12, the dial prefix

for incoming calls is not specified, VoIP gateway IP address is

82.000.14.46, and SIP port is 5060.

5. (Optional) Select the Enable SIP Account check box, and then, from the list on the right, select the desired SIP account.

6. Configure incoming call alert sound:

To restore default settings and use the standard system

sound,

next to Sound for Incoming Call Alert, click Use a system sound ( 

 ).

To use custom sound, perform the following actions:

1. Next to Sound for Incoming Call Alert, click Select a sound

file for an incoming call (   ).

2. In the window that appears, select the desired audio file.

7. Configure telephone subscriber's avatar:

To select an image for the subscriber's avatar, perform the following actions:

1. In the upper-left corner of the window, click Select.

2. In the window that appears, select the desired image.

To remove current subscriber avatar, in the upper-left corner of the window, click Delete Subscriber

Photo (   ).

8. In the Telephone Subscriber window, click OK.

Postrequisites: 

To delete an existing telephone subscriber, in the Telephone Subscribers window, click the name of the subscriber, and then click

Delete (   ).
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4.13.2 Initiating Calls to Telephone Subscribers

Follow the procedure to initiate a call to a telephone subscriber.

Prerequisites: 

Ensure the operator has the Make telephone calls right.

For information on the operator rights, see Operators.

Procedure: 

1. On the menu bar, click Telephone Subscribers (   ).

The Telephone Subscribers window appears.
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2. In the window that appears, call the desired telephone subscriber:

To call a subscriber added to the SmartPTT

Dispatcher list of telephone subscribers,

perform the following actions:

1. On the Telephone Subscribers tab, select the desired subscriber

from the list.

The name and the avatar of the selected subscriber appear in the

upper-right corner of the window.

2. In the lower-right corner of the window, click Connect.

To call a subscriber that is not added to the

SmartPTT Dispatcher list of telephone

subscribers,

perform the following actions:

1. On the Dial Pad tab, dial the desired subscriber's number.

The Add (   ) button appears in the right part of the window.

NOTE

If the VoIP gateway default settings are specified, you need to dial

only the subscriber's phone number. If default settings are not

specified, you need to dial the subscriber's full SIP address. A

SIP address is composed from dial prefix for outgoing or incoming

calls, telephone subscriber phone number, VoIP gateway IP address,

and VoIP SIP port in the following format:

sip:<prefix><number>@<gateway>:<port>

2. (Optional) Add the subscriber to SmartPTT Dispatcher by clicking

the Add (   ) button and specifying information on them in the

Telephone Subscriber window.

3. Click the Phone (   ) button to the right of the number field or

click the Connect button in the lower-right corner of the window.

 The Connect button changes to Disconnect, the name of the called subscriber appears in the Recent Calls list above the list of

telephone subscribers.

3. (Optional) On the Extension Dialing tab, dial the DTMF extension code to reach the desired subscriber.

NOTE

After dialing the subscriber's number, apart from a private call, you can initiate a conference call by clicking the Make Conference

Call (   ) button. For details, see Initiating Conference Calls from the Telephone Subscribers Window.

4. To finish the call, click Disconnect or wait until it finishes automatically after the subscriber hangs up.

4.13.3 Connecting Radios with Telephone Subscribers

Follow the procedure to establish connection between a radio or a talkgroup and a telephone subscriber.

Prerequisites: 

Ensure an operator has the Make telephone calls right.

For information on the operator rights, see Operators.

Procedure: 

1. Open the telephone subscriber selection window in one of the following ways:

To open the window from the Radio Fleet panel, click the desired radio or talkgroup Actions (   ) button, and then click

Call Telephone Subscriber (   ).
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To open the window from the Radios panel or the

Custom Console panel,

click the desired radio or talkgroup Actions (   ) button, and then click

Call Telephone Subscriber (   ).

To open the window from the map panel, on the map or on the expandable Radios panel, right-click the desired

radio, and then click Call Telephone Subscriber (   ).

To open the window from the radio or talkgroup

Call Window,

in the Call Window of the desired radio or talkgroup, click Call Telephone

Subscriber (   ).

For information on Call Windows, see Call Windows.

 The window with the name of the selected radio or talkgroup appears.

2. Connect the radio or talkgroup to the desired telephone subscriber:

To connect to a subscriber added to the

SmartPTT Dispatcher list of telephone

subscribers,

select the desired subscriber from the list of telephone subscribers, and

then click Connect, or double-click the desired subscriber name.

To connect to a subscriber that is not added to

the SmartPTT Dispatcher list of telephone

subscribers,

perform the following actions:

1. Click the Dial Pad (   ) button.

The Dial Pad window appears.
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2. Dial the desired subscriber's number, and then click the Phone ( 

 ) button.

NOTE

If the VoIP gateway default settings are specified, you need to dial only

the subscriber's phone number. If default settings are not specified,

you need to dial the subscriber's full SIP address. A SIP address is

composed from dial prefix for outgoing or incoming calls, telephone

subscriber phone number, VoIP gateway IP address, and VoIP SIP port

in the following format: sip:<prefix><number>@<gateway>:<port>

 The Call Telephone Subscriber window appears.

NOTE

The window will not appear if it is prohibited in the Call Window settings. For details, see Configuring Call Windows.

3. To close the Call Telephone Subscriber window, click Close (   ).

NOTE

Closing the window does not end the call. Only the call participants can end the call.
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4.13.4 Accepting Calls from Telephone Subscribers

Follow the procedure to accept an incoming call from a telephone subscriber.

Procedure: 

1. In the Incoming call window that appears when a telephone subscriber calls SmartPTT Dispatcher, click Accept.

 The Telephone Subscribers window appears. The call starts.

2. To end the call, click Disconnect or wait until the call ends automatically after the subscriber hangs up.

The Disconnect button changes to Connect.

3. (Optional) If the calling telephone subscriber is not added to the SmartPTT Dispatcher list of telephone subscribers, you can add

them by performing the following actions:

a. In the right part of the window, under the number of the calling subscriber, click Add (   ).

The Telephone Subscriber window appears.
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b. Select the desired SIP addressing format:

To use default gateway settings, perform the following actions:

1. In the SIP-Address area, select Automatic.

2. In the Number field, type the subscriber's phone number.

To use the subscriber's full address, perform the following actions:

1. In the SIP-Address area, select Full Address.

2. In the Outgoing field, type the subscriber's SIP address for

outgoing calls in the following format:

sip:<prefix><number>@<gateway>:<port>.

3. In the Incoming field, type the subscriber's SIP address for

incoming calls in the following format:

sip:<prefix><number>@<gateway>:<port>.

c. (Optional) In the upper-left corner of the window, click Select, and then, in the window that appears, select an image for the

subscriber's avatar.

The selected avatar appears above the Select button.

d. (Optional) Select the Enable SIP Account check box, and then, from the list on the right, select the desired SIP account.

e. (Optional) Click Select a sound file for an incoming call (   ), and then, in the window that appears, select an audio file with

the desired incoming call alert sound.

f. At the bottom of the window, click OK.

Postrequisites: 

• To remove the subscriber avatar, click Delete Subscriber Photo (   ).

• To restore the standard system sound, click Use a system sound (   ).

• To edit parameters of telephone subscribers or delete telephone subscribers, see Adding and Editing Telephone Subscribers.



371

SmartPTT Dispatcher Operation Conference Calls

4.14 Conference Calls

SmartPTT Dispatcher provides the ability to organize conference calls. This functionality connects radio system objects in a single call.

All participants of a conference call can hear and speak to each other, but cannot see who participates. Only the dispatcher that initiated

a conference call can see, add, and remove participants from it.

Important

Conference calls are available to operators with the Make conference calls right.

For information on user roles in SmartPTT Dispatcher, see Operators.

The following radio objects can participate in conference calls:

• Radios

• Talkgroups

• Dispatchers

• Telephone subscribers

NOTE

Connection to telephone subscribers through a conference call requires the Telephone Interconnect Service license.

The conference call initiates automatically when you add a participant to the Participants field in the Conference Calls window.

Conference calls have the following connection statuses:

• The Ringing status indicates that the invitation request has been sent, and SmartPTT Dispatcher is waiting for connection to be

established.

• The Call status indicates that connection has been successfully established and the conference call is in progress.

A special tone indicates the end of the call on the radio. If the radio initiates a new transmission before hearing the tone, the

transmission will be initiated incorrectly and can fail.

NOTE

The conference call ends automatically when the Conference call idle session timeout period set in SmartPTT Radioserver

Configurator expires. For details, see “Configuring Phone Calls” in SmartPTT Installation and Configuration Guide.

Ways of Initiating Conference Calls

In SmartPTT Dispatcher, you can organize a conference call in one of the following ways:

• By selecting the desired participants from the Conference Calls window. For details, see Initiating Conference Calls from the

Conference Calls Window.

NOTE

To unlock the Make Conference Call (   ) button in the SmartPTT Dispatcher menu bar, you need to configure Telephone

Interconnect settings. For details, see Telephone Interconnect.

• By inviting a specific participant to the conference call using the following SmartPTT Dispatcher elements:

• SmartPTT Dispatcher panels. For details, see Initiating Conference Calls from Dispatcher Panels.

• The Dispatchers window. For details, see Initiating Conference Calls from the Dispatchers Window.

• The Telephone Subscribers window. For details, see Initiating Conference Calls from the Telephone Subscribers Window.
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4.14.1 Initiating Conference Calls from the Conference Calls Window

Follow the procedure to initiate a conference call using the Make Conference Call (   ) button.

Prerequisites: 

• Ensure that the desired radio or dispatcher is online.

• Ensure the operator has the Make conference calls right. For details, see Operators.

Procedure: 

1. On the menu bar, click Make Conference Call (   ).

The Conference Calls window appears.

2. In the window that appears, send a conference call request to the desired participant:

To send a call request to a radio, talkgroup,

dispatcher, or telephone subscriber registered in

SmartPTT Dispatcher,

in the left part of the Conference Calls window, expand the desired group,

and then double-click or drag the desired conference participant to the

Participants area in the upper-right corner of the window.

The selected radio object appears in the Participants area in the right part

of the window.

To send a call request to a telephone subscriber

not registered in SmartPTT Dispatcher,

perform the following actions:

1. In the left part of the Conference Calls window, click Dial Pad.

The dial pad appears.
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2. On the dial pad, dial the desired subscriber's number, and then

click the Call (   ) button.

NOTE

If the VoIP gateway default settings are specified in SmartPTT

Radioserver Configurator, you must only dial the subscriber's phone

number. If default settings are not specified, you need to dial the

subscriber's full address.

The selected radio object appears in the Participants area in the right

part of the window.

To send call requests to more participants to the

conference call,

repeat the steps above.

To remove a participant from the current

conference call,

click End Conference Call (   ) next to the name of the desired

participant in the Participants area.

The selected participant disappears from the Participants area in the

right part of the window.

To end the conference call for all participants, click Stop.

Postrequisites: 

• To mute the conference call sound and turn off your microphone, click Mute (   ).

• To turn off your microphone and keep listening to the conference participants, click Turn off microphone (   ).

4.14.2 Initiating Conference Calls from Dispatcher Panels

Follow the procedure to initiate a conference call by sending an invitation request to a radio, or talkgroup.

Prerequisites: 

• Ensure that the desired radio is online.

• Ensure the operator has the Make conference calls right. For details, see Operators.

Procedure: 

Initiate a conference call in one of the following ways:

To send a call request to a radio, or talkgroup

from the Radio Fleet panel,

click the Actions (   ) button on the desired radio object, and then click

Make Conference Call (   ).

The Conference Calls window with information on the initiated conference

call appears.

To send a call request to a radio from the Radios

panel,

click the Actions (   ) button on the desired radio object element, and

then click Make Conference Call (   ).

The Conference Calls window with information on the initiated conference

call appears.

To send a call request to a radio from the map

panel,

on the map, right-click the desired radio object, and then click

Make Conference Call (   ).

The Conference Calls window with information on the initiated conference

call appears.
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To send a call request to a radio, or talkgroup

from the Call Window,

in the Call Window of the desired radio object, click Make Conference

Call (   ).

The Conference Calls window with information on the initiated conference

call appears.

For information on Call Windows, see see Call Windows.

To remove a participant from the current

conference call,

click End Conference Call (   ) next to the name of the desired

participant in the Participants area.

The selected participant disappears from the Participants area in the right

part of the window.

To end the conference call for all participants, click Stop.

Postrequisites: 

• For information on adding participants from the Conference Calls window, see Initiating Conference Calls from the Conference

Calls Window.

• To mute the conference call sound and turn off your microphone, click Mute (   ).

• To turn off your microphone and keep listening to the conference participants, click Turn off microphone (   ).

4.14.3 Initiating Conference Calls from the Telephone Subscribers Window

Follow the procedure to initiate a conference call by sending an invitation request to a telephone subscriber.

Prerequisites: 

• Ensure that the desired telephone subscriber is online.

• Ensure that the required conference calls parameters are configured in the Telephone Interconnect settings.

• Ensure you have a license that permits access to Telephone Interconnect settings. For details, see Licenses.

• Ensure the operator has the Make conference calls right. For details, see Operators.

Procedure: 

1. On the menu bar, click Telephone Subscribers (   ).

The Telephone Subscribers window appears.
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• In the window that appears, initiate a conference call in one of the following ways:

To send a call request to a telephone subscriber registered

in SmartPTT Dispatcher,

on the Telephone Subscribers tab, from the list of telephone

subscribers, select the desired subscriber, and then click Make

Conference Call (   ) in the lower-right corner of the window.

The Conference Calls window with information on the initiated

conference call appears.

To send a call request to a telephone subscriber not

registered in SmartPTT Dispatcher,

on the Dial Pad tab, dial the desired subscriber's number, and

then click Make Conference Call (   ) in the lower-right corner

of the window.

The Conference Calls window with information on the initiated

conference call appears.

NOTE

If the VoIP gateway default settings are specified, you only

need to dial the subscriber's phone number. If default

settings are not specified, you need to dial the subscriber's

full address.

To remove a participant from the current conference call,

click End Conference Call (   ) next to the name of the desired

participant in the Participants area.

The selected participant disappears from the Participants area

in the right part of the window.

To end the conference call for all participants, click Stop.

Postrequisites: 

• For information on adding participants from the Conference Calls window, see Initiating Conference Calls from the Conference

Calls Window.

• For information on adding participants from SmartPTT Dispatcher panels, see Initiating Conference Calls from Dispatcher Panels.
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• To mute the conference call sound and turn off your microphone, click Mute (   ).

• To turn off your microphone and keep listening to the conference participants, click Turn off microphone (   ).

4.14.4 Initiating Conference Calls from the Dispatchers Window

Follow the procedure to initiate a conference call by sending an invitation request to a dispatcher from the Dispatchers window.

Prerequisites: 

• Ensure that the desired dispatcher is added to SmartPTT Dispatcher and online.

• Ensure the operator has the Make conference calls right. For details, see Operators.

Procedure: 

1. On the menu bar, click Dispatchers (   ).

The Dispatchers window appears.

2. In the windows that appears, organize a conference call:

To send a call request to a dispatcher registered in

SmartPTT Dispatcher,

from the list of dispatchers, select the desired dispatcher, and

then click Make Conference Call (   ) in the lower-right corner

of the window.

The Conference Calls window with information on the initiated

conference call appears.

NOTE

If during the conference call the Dispatchers window is open,

closing it will remove the dispatcher from the conference-

call automatically.
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To remove a participant from the current conference call,

click End Conference Call (   ) next to the name of the desired

participant in the Participants area.

The selected participant disappears from the Participants area

in the right part of the window.

To end the conference call for all participants, click Stop.

Postrequisites: 

• For information on adding participants from the Conference Calls window, see Initiating Conference Calls from the Conference

Calls Window.

• For information on adding participants from SmartPTT Dispatcher panels, see Initiating Conference Calls from Dispatcher Panels.

• For information on adding participants from the Telephone Subscribers window, see Initiating Conference Calls from the

Telephone Subscribers Window.

• To mute the conference call sound and turn off your microphone, click Mute (   ).

• To turn off your microphone and keep listening to the conference participants, click Turn off microphone (   ).

4.15 Dispatchers

SmartPTT Dispatcher provides the ability to communicate with other operators of the SmartPTT system. To communicate with other

dispatchers, the system provides the following ways:

• Initiate and receive voice calls

• Make conference calls. For details, see Initiating Conference Calls from the Dispatchers Window.

• Exchange text messages

Important

To communicate with other dispatchers, the operator must have the Connect with external dispatchers right. If the operator does not

have this permission, the Dispatchers (   ) button will be disabled in the SmartPTT Dispatcher menu bar. If no dispatchers are added

to SmartPTT Dispatcher, this button will also be disabled.

For information on user roles in SmartPTT Dispatcher, see Operators.

Communication with Other Dispatchers

To initiate communication with other dispatchers, you must configure the Dispatchers List. For details, see Dispatcher List

Configuration.

You can initiate a voice call, conference call, or send a text message to another dispatcher by clicking the Dispatchers (   ) button on

the SmartPTT Dispatcher menu bar.

To the right of the dispatcher name, you can see one of the following statuses:

• The Offline status indicates that the dispatcher is unavailable (SmartPTT Dispatcher has not been started or this dispatcher has no

corresponding permission to communicate with other dispatchers).

• The Online status indicates that the dispatcher is available for communication.

If another dispatcher is available for communication, you can initiate a voice call, add them to a conference call, or send a text

message.

• The Ringing status indicates that voice communication with the dispatcher is establishing.
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• The Call status indicates that communication is established.

Actions with Other Dispatchers

In SmartPTT Dispatcher, you can communicate with other dispatchers in the following ways:

• By initiating voice calls. For details, see Initiating Voice Calls to Dispatchers.

• By accepting voice calls. For details, see Accepting Calls from Other Dispatchers.

• By sending text messages. For details, see Sending Messages to Dispatchers.

4.15.1 Initiating Voice Calls to Dispatchers

Follow the procedure to initiate a voice call to another dispatcher.

Prerequisites: 

• Ensure the Dispatchers (   ) button on the SmartPTT Dispatcher menu bar is available. If not, ensure the operator has the

Connect with external dispatchers right or at least one dispatcher is added. For details, see Operators.

• Ensure the desired dispatcher is online.

Procedure: 

1. On the menu bar, click the Dispatchers (   ) button.

The Dispatchers window appears.

2. In the window that appears, from the list of dispatchers on the left, select the desired dispatcher.
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3. Click the Connect button.

The Connect button changes to Disconnect. The Online status changes to Ringing.

4. Wait until the dispatcher accepts the call.

After the dispatcher accepts the call, and the status changes to Call, speak into your microphone.

5. Click Disconnect to end the call.

The Disconnect button changes to Connect.

4.15.2 Sending Messages to Dispatchers

Follow the procedure to send a text message to another dispatcher.

Prerequisites: 

• Ensure the Dispatchers (   ) button on the SmartPTT Dispatcher menu bar is available. If not, ensure the operator has the

Connect with external dispatchers right or at least one dispatcher is added. For details, see Operators.

• Ensure the desired dispatcher is online.

Procedure: 

1. On the menu bar, click the Dispatchers (   ) button.

The Dispatchers window appears.

2. In the window that appears, from the list of dispatchers on the left, select the desired dispatcher.

3. In the text field on the right, type the message, and then press Enter or click the Send (   ) button.

The sent message appears in the chat field above the text field.

Postrequisites: 

You can view the sent message details in the Event Log. For details, see SmartPTT Dispatcher Event Log.
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4.15.3 Accepting Calls from Other Dispatchers

Follow the procedure to accept an incoming call from another dispatcher.

Procedure: 

1. In the Incoming call window that appears in SmartPTT Dispatcher, click the Accept button.

 The Dispatchers window appears. The call starts.
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2. Click Disconnect to end the call.

The Disconnect button changes to Connect.

3. (Optional) If the incoming call is initiated by a dispatcher that is not added to SmartPTT Dispatcher, you can add a new dispatcher

to the list by performing the following actions:

a. Under the dispatcher IP address, click the Add (   ) button.

The Dispatcher window appears.

b. In the window that appears, in the Name field, type the dispatcher name.

c. (Optional) To select the avatar for the dispatcher, in the left part of the window, click Select.

d. (Optional) To select a tone for incoming dispatcher calls, click Browse (   ).

e. Click OK to save the changes and close the window.

The dispatcher IP address changes to the dispatcher name.

4.16 Monitoring

The Monitoring feature available in SmartPTT Dispatcher provides the operator with the ability to monitor the SmartPTT system events

and resources performance and download this information as reports.

Before you start working with the Monitoring feature, you must activate it in SmartPTT Radioserver Configurator and configure the

monitoring database connection, otherwise, it will be unavailable in SmartPTT Dispatcher.

For information on activating monitoring and configuring its database connection, see the “Configuring Monitoring Database

Connection“ section in SmartPTT Installation and Configuration Guide.

Important

To display monitoring in SmartPTT Dispatcher, the corresponding license is required.

For information on licenses, see Licenses.

The Monitoring submenu is available from the Tools menu on the SmartPTT Dispatcher menu bar.

Monitoring functionality in SmartPTT provides the following features:

• Air Monitoring provides a real-time graphical representation of the voice and data transmitted over the air.

• Topology provides a real-time graphical representation of the radio system configuration and the connection status of its

elements.

• Diagnostics provides a real-time information on the current state and alarms on MOTOTRBO repeaters.
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• Monitoring Event Log provides a real-time information on the current state and alarms on the radio system devices, such as

repeaters, routers, and UPS.

Important

Monitoring feature is unavailable if desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned to the

client prohibits monitoring. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

NOTE

Monitoring is not available for SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

Air Monitoring

The Air Monitoring feature provides the ability to monitor current system operations using graphical representation of data and voice

received from MOTOTRBO repeaters. Data and voice packets transmitted on the logical channel are displayed on the Air Monitoring

panel as colored vertical bars. The height of the bar corresponds to the signal strength level, and the color corresponds to the type of

the event according to the legend. Based on the height of the bar, the signal level can vary from low to high. The levels corresponding to

the RSSI ranges in decibels are displayed on the right side of each diagram.

The following types of events can be represented in the air monitoring diagram: call, telephone call, ARS, GPS, TMS, telemetry, indoor

and system. In addition, the panel has an Air Monitoring Table that provides detailed information on each event in the network.

You can open the Air Monitoring panel by clicking Tools → Monitoring → Air Monitoring on the SmartPTT Dispatcher menu bar.

The Air Monitoring panel contains the list of networks that were active at the moment when the panel was opened. If a network becomes

inactive, it disappears from the list.

Important

Air monitoring is not available in the Capacity Max and Connect Plus systems.

In SmartPTT Dispatcher, you can control the display of monitoring data on the Air Monitoring panel.

For information on configuring the display of events on the air monitoring diagram, see Configuring Air Monitoring.

Topology

Topology represents a schematic diagram of active networks connected to SmartPTT Radioserver.

You can open the Topology panel by clicking Tools → Monitoring → Topology on the SmartPTT Dispatcher menu bar.

A topology diagram can be built in two ways:

• Using the data specified during network configuration. For details, see “Network Monitoring” in SmartPTT Installation and

Configuration Guide.

• Automatically, based on the information received from the available network repeaters. In this case, the diagram will not display

supplemental network devices (power supplies, routers, etc.).

Important

A topology diagram is not available in Capacity Max.

Important

To correctly display repeaters of a backhaul chain on the Topology panel, you must first update topology in SmartPTT Radioserver

Configurator. For details, see “Updating Topology” in SmartPTT Installation and Configuration Guide.

The Topology panel contains a list of conventions (legend) used in the network topology diagram with an explanation of their meaning.

Network objects on the Topology diagram are displayed depending on their type and condition, as well as the links between them.

Topology objects on the diagram can be placed vertically or horizontally.
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Using the context menu, you can open the Server Control and Repeater Control windows to control remotely such topology elements as

SmartPTT Radioserver and hardware repeaters connected to SmartPTT Radioserver by right-clicking the desired object and selecting the

appropriate action in the context menu. For details, see Radioserver Remote Control and Repeater Remote Control.

Using the context menu, you can open the information window of any topology element, except networks, application peers, and

locations by right-clicking the desired object and selecting the appropriate action in the context menu. This window provides the ability to

view statistics and parameters of the desired object. When an alarm occurs on a device (except for routers and UPS), the Alarms area

appears in the device information window, containing information about the cause and time of the alarm.

For information on the device information window and topology schematic diagram, see the SmartPTT Dispatcher embedded help.

Diagnostics

The Diagnostics feature provides a list of devices to which SmartPTT Radioserver is connected and detailed information about their

current status.

Important

Diagnostics is not available in Capacity Max.

You can open the Diagnostics panel by clicking Tools → Monitoring → Diagnostics on the SmartPTT Dispatcher menu bar.

The Diagnostics panel consists of the Diagnostics Table that contains information about all devices connected to SmartPTT

Radioserver and the area that provides the following information:

• Information on current alarms on a device.

Each alarm has its own color indicator of the alarm severity. Depending on the type of alarm, the indicator can be red (critical

alarm), yellow (non-critical alarm), or blue (noises on a device).

• Technical information about the device state. It is displayed only for some types of devices.

• Information on various parameters related to the reception or transmission of data.

• Various information on the selected device.

• Alarms that are monitored for the selected device.

For information on the table, see the SmartPTT Dispatcher embedded help.

Monitoring Event Log

The Monitoring Event Log provides information on the state of device connection to SmartPTT Radioserver.

Important

The Monitoring Event Log is not available in Capacity Max.

NOTE

Do not confuse Monitoring Event Log with the SmartPTT Dispatcher or SmartPTT Radioserver Event Log. Monitoring Event Log

monitors alarms on the radio system devices, such as repeaters, routers, or UPS. The SmartPTT Dispatcher Event Log provides

information on all events registered in the SmartPTT Dispatcher database. The radioserver Event Log panel provides information on

events from all dispatch systems connected to the radioserver. For details, see Event Log and Notification Panels.

You can open the Event Log panel by clicking Tools → Monitoring → Event Log on the SmartPTT Dispatcher menu bar.

The Event Log panel contains the Monitoring Event Log Table. It displays information about events on the current moment or for a

specified period.

For information on the table, see the SmartPTT Dispatcher embedded help.

For information on configuring the display of the Monitoring Event Log, see Configuring Monitoring Event Log Display.
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Monitoring Reports

In SmartPTT Dispatcher, you can create reports on the SmartPTT Dispatcher and SmartPTT Radioserver operation, including the

monitoring reports.

The Monitoring submenu is available from the Reports menu on the SmartPTT Dispatcher menu bar.

Important

The menu is available to operators with the Build reports right.

For information on user roles in SmartPTT Dispatcher, see Operators.

To access the monitoring reports, monitoring must also be activated in SmartPTT Radioserver Configurator and the monitoring license

must be installed.

Monitoring reports are unavailable if desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned to the

client prohibits creating the monitoring reports. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

In SmartPTT Dispatcher, you can create the following monitoring reports:

• The Air Monitoring report based on the Air Monitoring panel data. For details, see Creating Air Monitoring Report.

• The Event Log report based on the Monitoring Event Log data. For details, see Creating Monitoring Event Log Report.

• The System Usage report providing information on the radio network channel load, radio network uptime, radio network

downtime, etc. For details, see Creating System Usage Report.

For information on the monitoring reports, see also Monitoring Reports.

4.16.1 Configuring Air Monitoring

Follow the procedure to configure air monitoring display.

Prerequisites: 

• Ensure you have the corresponding license. For details, see Licenses.

• Ensure the Monitoring feature is activated in SmartPTT Radioserver Configurator. For details, see “Configuring Monitoring

Database Connection” in SmartPTT Installation and Configuration Guide.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows using

the air monitoring. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Tools → Monitoring → Air Monitoring.

The Air Monitoring panel appears.
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2. Select the check box next to the name of the desired network.

3. Configure air monitoring diagrams:

To display events from different slots or networks in one

block,

select the Show Summary check box.

To display events from different slots or networks in

separated blocks,

select the Show Details check box.

To display all blocks simultaneously, select both Show Summary and Show Details check boxes.

4.16.2 Radioserver Remote Control

Follow the procedure to control the SmartPTT Radioserver computer remotely.

Prerequisites: 

• Add and configure the desired radioserver. For details, see Managing Radioservers.

• Configure the radioserver IPMI settings. For details, see Configuring IPMI Settings.

• Ensure you have the corresponding license. For details, see Licenses.

• Ensure the Monitoring feature is activated in SmartPTT Radioserver Configurator. For details, see “Configuring Monitoring

Database Connection” in SmartPTT Installation and Configuration Guide.
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• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows using

the Monitoring feature. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

• Ensure that the Topology panel is open.

Procedure: 

1. On the Topology panel, right-click the desired radioserver element and select Control.

The Server Control window appears.

NOTE

If the Information window appears instead of the Server Control window, reconfigure IPMI.

2. In the Server Control window, perform one or more of the following actions:

To update the power status, click Refresh.

Important

If the power status is detected as N/A Unknown, check that IPMI settings are

correct.

To turn on the radioserver computer, in the Power management (hardware) area, click Turn on.

To reboot the radioserver computer, in the Power management (hardware) area, click Reset.

WARNING

Rebooting the computer can cause irreversible damage and/or data loss.

To turn off the radioserver computer, perform one of the following actions:

• In the Power management (OS) area, click Turn off.

• In the Power management (hardware) area, click Turn off.

WARNING

Turning off the computer can cause irreversible damage and/or data loss.

NOTE

If the radioserver computer is blocked, you can turn it off only in the Power

management (hardware) area.

3. Click Close (   ).
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4.16.3 Repeater Remote Control

Follow the procedure to remotely control a hardware repeater connected to SmartPTT Radioserver.

Prerequisites: 

• Ensure that the Topology panel is open.

• Ensure that the status of connection to the desired repeater is displayed in green or yellow in the network topology diagram.

• Ensure you have the corresponding license. For details, see Licenses.

• Ensure the Monitoring feature is activated in SmartPTT Radioserver Configurator. For details, see “Configuring Monitoring

Database Connection” in SmartPTT Installation and Configuration Guide.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows using

the Monitoring feature. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the Topology panel, right-click the desired repeater element and select Control.

The Repeater Control window appears.

NOTE

If the Warning window with the No connection message appears instead of the Repeater Control window, check connection to the

repeater.

If the Warning window with the Application peer control is not supported message appears instead of the Repeater Control window, it

means that you are trying to control a virtual repeater. You cannot operate virtual repeaters remotely.

2. In the Repeater Control window, perform one of the following actions:

To restart a repeater, click Restart.

To configure a repeater, perform the following actions:

1. Perform one or several of the following actions:

a. From the Current Channel list, select the desired duplex channel

used for the reception and transmission of data.

NOTE

If the Current Channel list contains no items, ensure that you are not

trying to control a Connect Plus Master Peer. You cannot operate

Connect Plus Master Peers remotely.
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b. From the Power, Tx list, select the desired transmitter power

mode of a repeater, bands for which are specified in the

repeater configuration file.

c. From the State list, select the activity or inactivity mode of the

repeater receiver and transmitter.

d. (Optional) If the Block list is available in the window, select the

desired repeater path mode from it.

2. Click Apply.

3. Wait until the Waiting for response status changes.

View the operation status:

If the The operation completed successfully

status is displayed,

perform one of the following actions:

• If the repeater is restarted, perform step 5.

• If you selected an analog channel instead of a digital channel from

the Current Channel list in step 2, perform step 4.

• If other configuration changes are applied, perform step 5.

If the Timeout was exceeded status is

displayed,

perform the following actions:

1. Check connection to the repeater.

2. Repeat step 2.

If the The operation completed with errors

status is displayed,

perform the following actions:

1. Check connection to the repeater and SmartPTT Radioserver.

2. Repeat step 2.

4. (Optional) If you selected an analog channel instead of a digital channel from the Current Channel list in step 2, perform the

following actions:

a. Click Close (   ).

b. Reopen the Repeater Control window by right-clicking the desired repeater element and selecting Control.

c. From the Block list, select the desired repeater path mode.

d. Click Apply.

e. Repeat step 3.

5. Click Close (   ).

4.16.4 Configuring Monitoring Event Log Display

Follow the procedure to configure monitoring event log display.

Prerequisites: 

• Ensure you have the corresponding license. For details, see Licenses.

• Ensure the Monitoring feature is activated in SmartPTT Radioserver Configurator. For details, see “Configuring Monitoring

Database Connection” in SmartPTT Installation and Configuration Guide.
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• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows using

the air monitoring. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Tools → Monitoring → Event Log.

The Event Log panel appears.

2. Configure event displaying:

To display events in the monitoring log at the current

moment,

select the Show Current Events parameter.

To display events in the monitoring log for a specified

period,

perform the following actions:

1. Select the Show Logged Events parameter.

2. In the calendar next to the parameter select the desired

period.

3. Set SmartPTT Radioserver for displaying of events:

To display connected devices on the desired radioserver, from the Radioserver list select the desired radioserver.

To display connected devices on all radioservers, from the Radioserver list select All radioservers.

4. Click the Apply button.

4.17 Reports

The Reports feature provides access to a range of tools for creating reports on the SmartPTT Dispatcher and SmartPTT Radioserver

operation for the desired period.

Tools for creating reports are available in the Reports menu. You can create reports based on information stored in the database. You

can configure parameters according to which data is exported from the database to a report. A generated report appears in a separate

preview window that provides access to the following actions:

• Save as a separate file of the PRNX format (a file for preview)

• Set page parameters and print
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• Export to a separate file in many common formats

• Send to an email address

For information on examples of created reports, see Exporting Reports.

Important

The Reports menu is available to the operators with the Reports right.

For information on user roles in SmartPTT Dispatcher, see Operators.

SmartPTT Dispatcher provides ability to generate:

• SmartPTT Dispatcher or SmartPTT Radioserver Event Log reports

• Radio activity reports (viewing the number of all calls and group calls)

• Location reports for all radios or specific radios

• Radio movement, categories, and authorized radio users reports

• Online and offline radio reports

• Monitoring reports

• Lone Worker reports (viewing events of radios in the Lone Worker mode)

• Indoor tracking reports for selected radios or authorized radio users

NOTE

The monitoring reports, the Lone Workers, and Indoor Tracking reports are unavailable for SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

Event Log Report

The Report Wizard functionality provides the ability to create reports based on information stored in the SmartPTT Dispatcher or

SmartPTT Radioserver Event Log.

You can create the report based on the Event Log by clicking Reports → Report Wizard on the menu bar.

Important

If the SmartPTT Radioserver Event Log is not activated in SmartPTT Radioserver Configurator or SmartPTT Radioserver is not

running, SmartPTT Radioserver will not be displayed as a data source.

For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and Configuration Guide.

Important

If desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned to the client prohibits requesting data

from the radioserver, you will not receive radioserver data to create a report. For details, see “Profiles” in SmartPTT Installation and

Configuration Guide.

To generate this report, you can configure the following parameters:

• Data source. You can select a SmartPTT Dispatcher or SmartPTT Radioserver database.

• Data that will be included in the report.

• Parameters to group or sort the report data.

• Parameters to filter report data.

• Report file name and directory on the computer.

For information on creating reports with the wizard, see Creating Event Log Report.
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Radio Activity Report

The Radio Activity report contains information on the number of All Call and group calls grouped by hours, minutes or days.

You can create the Radio Activity Report report by clicking Reports → Radio Activity Report on the menu bar.

To generate a Radio Activity report, you can configure the following parameters:

• Start and end dates of events that will be displayed in the report.

• Data source. You can select a SmartPTT Dispatcher or SmartPTT Radioserver database.

• Radio network channel, control station, or trunked radio system to create a report.

• Parameters to group the report data (by days, hours, or minutes).

Important

If the SmartPTT Radioserver Event Log is not activated in SmartPTT Radioserver Configurator or SmartPTT Radioserver is not

running, SmartPTT Radioserver will not be displayed as a data source.

For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and Configuration Guide.

Important

If desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned to the client prohibits requesting data

from the radioserver, you will not receive radioserver data to create a report. For details, see “Profiles” in SmartPTT Installation and

Configuration Guide.

For information on Radio Activity Report creating, see Creating Radio Activity Report.

Text Chat History Report

The Text Chat History report contains SmartPTT Mobile application text messages, and also events related to dynamic group creation,

deletion, and editing.

You can create the Text Chat History report by clicking Reports → Text Chat History on the menu bar.

To generate a Text Chat History report, you can configure the following parameters:

• Radioserver data base that will be used to create a report

• Chat type that will be included in the report

• Parties of the private chat

• Start and end dates of the events that will be displayed in the report

• UTC time format

• Filtering messages with a specified text or type

• Report file format

Important

If the SmartPTT Radioserver Event Log is not activated in SmartPTT Radioserver Configurator or SmartPTT Radioserver is not

running, SmartPTT Radioserver will not be displayed as a data source.

For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and Configuration Guide.

Important

If desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned to the client prohibits requesting data

from the radioserver, you will not receive radioserver data to create a report. For details, see “Profiles” in SmartPTT Installation and

Configuration Guide.

For information on Text Chat History creating, see Exporting Reports.
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Radio Location Report

The Radio Location report contains information on the radio coordinates for a certain period.

You can create the Radio Location report by clicking Reports → Radio Locations on the menu bar.

Important

To create a report, you must have the license that supports GPS. For details, see Licenses.

To generate a Radio Location report, you can configure the following parameters:

• Data source. You can select a SmartPTT Dispatcher or SmartPTT Radioserver database.

• Radios that will be included in the report.

• Users that will be included in the report.

• Parameters to group the report data (by radios or users).

• Radio address based on the received GPS coordinates.

• UTC time format.

• RSSI signal level in decibels.

• Route that will be included in the report.

• Displaying only key route points in the report.

Important

If the SmartPTT Radioserver Event Log is not activated in SmartPTT Radioserver Configurator or SmartPTT Radioserver is not

running, SmartPTT Radioserver will not be displayed as a data source.

For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and Configuration Guide.

Important

If desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned to the client prohibits requesting data

from the radioserver, you will not receive radioserver data to create a report. For details, see “Profiles” in SmartPTT Installation and

Configuration Guide.

NOTE

You can set the radio address in the report only if the address data provider is configured in the positioning system settings. If you do

not specify the address data provider when configuring the report, the Find on Map link will appear in the Address column of the

created report. The link opens Google Maps or OpenStreetMap service. By clicking this link, you can see the location of the radio on

the map.

For information on Radio Location report creating, see Creating Radio Location Report.

Radio Movement Report

The Radio Movement report contains information on the radio movement based on the received GPS coordinates.

You can create the Radio Movement report by clicking Reports → Radio Movement on the menu bar.

Important

To create a report, you must have the license that supports GPS. For details, see Licenses.

To generate a Radio Movement report, you can configure the following parameters:

• Start and end dates of events that will be displayed in the report.

• Data source. You can select a SmartPTT Dispatcher or SmartPTT Radioserver database.
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• Radios, radio categories, or radio users whose movement data will be displayed in the report.

• Time duration to determine a radio stop.

• Use of points of interest coordinates to generate a report.

• Maximum deviation of a radio from a point of interest.

Important

If the SmartPTT Radioserver Event Log is not activated in SmartPTT Radioserver Configurator or SmartPTT Radioserver is not

running, SmartPTT Radioserver will not be displayed as a data source.

For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and Configuration Guide.

Important

If desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned to the client prohibits requesting data

from the radioserver, you will not receive radioserver data to create a report. For details, see “Profiles” in SmartPTT Installation and

Configuration Guide.

For information on Radio Movement report creating, see Creating Radio Movement Report.

Online Radios Report

The Online Radios report provides the ability to export the list of radios that are currently in the network. The report displays both

registered and unregistered radios. You can also include information about offline radios in the current report.

You can create the Online Radios report by clicking Reports → Online Radios on the menu bar.

You can generate a report using data from:

• All online radios

• Desired radio

• Specific range of radios

• Offline radios

For information on Online Radios report creating, see Creating Online Radios Report.

Monitoring Reports

Monitoring data reports provide the ability to:

• View radio system calls information

• View information on events and alarms registered on the radio system devices

• View information on the system load

You can create the Monitoring reports by clicking Reports → Monitoring on the menu bar.

For information on monitoring reports creating, see Monitoring Reports.

Lone Workers Report

The Lone Workers report provides information about registration, calls, sending messages, and other events for radios in the Lone

Worker mode.

You can create the Lone Workers report by clicking Reports → Lone Workers on the menu bar.

To generate a Lone Workers report, you can configure the following parameters:

• Start and end dates of events that will be displayed in the report.
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• Radios that will be included in the report.

• Parameters by which the report data can be sorted.

For information on Lone Workers report creating, see Creating Lone Workers Report.

Indoor Tracking Reports

The Indoor Tracking report contains information on the movement of indoor radios and users based on the data received from special

beacons.

You can create the Indoor Tracking report by clicking Reports → Indoor Tracking on the menu bar.

Important

For report creating, the Indoor Tracking license is required. For details, see Licenses.

To generate an Indoor Tracking report, you can configure the following parameters:

• Start and end dates of events that will be displayed in the report.

• Data source. You can select a SmartPTT Dispatcher or SmartPTT Radioserver database.

• Beacons that will be included in the report.

• Radios that will be included in the report.

• Users that will be included in the report.

• Parameters to group the report data.

For information on Indoor Tracking report creating, see Creating Indoor Tracking Report.

4.17.1 Creating Event Log Report

Follow the procedure to create a report based on the SmartPTT Dispatcher or SmartPTT Radioserver Event Log information.

Prerequisites: 

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator, otherwise it will be

unavailable for creating a report. For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and

Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running, otherwise it will be unavailable for creating a report.

• Ensure the operator has the Build reports right. For details, see Operators.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows

requesting data from the radioserver. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Report Wizard.

The Select data source window appears.

2. In the window that appears, select the data source for a report:
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To select the SmartPTT Dispatcher database as the data

source,

perform the following actions:

1. From the Data source list, select Dispatcher.

2. Click Next.

To select the SmartPTT Radioserver database as the data

source,

perform the following actions:

1. From the Data source list, select the desired SmartPTT

Radioserver name.

2. Click Next.

3. In the Select data for the report window, select the data to display in the report:
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To display specific data in a report, perform the following actions:

1. Select the check box next to the desired parameter name.

2. Click Next.

To prevent specific data from displaying in a report, perform the following actions:

1. Clear the check box next to the desired parameter name.

2. Click Next.

NOTE

The number of parameters available for displaying in the report depends on the selected data source.

4. (Optional) In the Group and sort report data window, from the Group by list, select the desired parameter by which the report data

will be grouped.

NOTE

If the grouping is not specified, the report will be created with the grouping of data set in the Report Wizard by default.

5. (Optional) From the Sort by list, select the desired parameter by which the report data will be sorted.

NOTE

If the sorting is not specified, the report will be created with the sorting of data set in the Report Wizard by default.
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6. Click Next.

7. In the Filter conditions window, specify the data filtering conditions:

a. Next to the desired parameter, select the Active check box to apply filtering.
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b. From the Condition list, select the required condition to filter the desired parameter: Equal to, Not Equal to, Between.

c. From the Value list, select the value by which the desired parameter will be filtered.

d. Click Next.

8. In the Create and save report window, specify the path to the report file on the computer:

a. Click the Browse (   ) button.

b. In the Specify File Name window, specify the path to save a report on the computer.

c. In the corresponding field, specify the name of a report.

d. From the corresponding list, select the desired format to save a report.

For information on report exporting, see Report Actions.

9. Click Finish to create a report.

4.17.2 Creating Radio Activity Report

Follow the procedure to create a report based on radio activity data.

Prerequisites: 

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator, otherwise it will be

unavailable for creating a report. For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and

Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running, otherwise it will be unavailable for creating a report.

• Ensure the operator has the Build reports right. For details, see Operators.
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• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows

requesting data from the radioserver. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Radio Activity Report.

The Radio Activity Report window appears.

2. In the window that appears, in the Period field, enter the desired dates and time of events to create a report on the radio activity

for the specified period.

3. From the Source list, select the data source for the report:

To select the SmartPTT Dispatcher database as the data

source,

select the Dispatcher value.

To select the SmartPTT Radioserver database as the data

source,

select the value with the desired SmartPTT Radioserver

name.

4. From the Channel list, select the channel for the report:

To display data for the specific channel in the report, select a value with the name of the desired channel.

To display data for all channels in the report, select the All value.

5. In the Group by list, specify data grouping in the report:

To group data in the report by days, select the Days value.

To group data in the report by hours, select the Hours value.

To group data in the report by 30 minutes, select the 30 minutes value.

To group data in the report by 10 minutes, select the 10 minutes value.

To group data in the report by minutes, select the Minutes value.

6. Click OK to create a report.

Postrequisites: 

Select a format to export the report.

For information on report exporting, see Report Actions.
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4.17.3 Creating Text Chat History Report

Follow the procedure to create the text chat history report.

Prerequisites: 

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator, otherwise it will be

unavailable for creating a report. For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and

Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running, otherwise it will be unavailable for creating a report.

• Ensure the operator has the Build reports right. For details, see Operators.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows

requesting data from the radioserver. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

4.17.4 Creating Radio Location Report

Follow the procedure to create a report displaying radio coordinates data.

Prerequisites: 

• Ensure you have the license supporting GPS. For details, see Licenses.

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator, otherwise it will be

unavailable for creating a report. For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and

Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running, otherwise it will be unavailable for creating a report.

• Ensure the operator has the Build reports right. For details, see Operators.

• Ensure the operator has the Request radio location right. For details, see Operators.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows

requesting data from the radioserver. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Radio Locations.

The Radio Locations window appears.
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2. In the window that appears, in the Period field, enter the desired dates and time of events to create a report displaying radio

coordinates for the specified period.

3. From the Source list, select the data source for the report:

To select the SmartPTT Dispatcher database as the data

source,

select the Dispatcher value.

To select the SmartPTT Radioserver database as the data

source,

select the value with the desired SmartPTT Radioserver

name.

4. Specify which coordinates will be displayed in the report:

To display coordinates for radios in the report, perform the following actions:

1. Select Radio.

2. From the list below, select the desired radio or the All

radios value.

3. (Optional) If the grouping by radios is required, select the

Group by radios check box.

To display coordinates for registered users in the report, perform the following actions:

1. Select User.

2. From the list below, select the desired user or the All

users value.

3. (Optional) If the grouping by users is required, select the

Group by users check box.

5. (Optional) Configure displaying additional information in the report:
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To display time in the Coordinated Universal Time

standard (UTC+00:00) in the report,

select the UTC Time check box.

To display the RSSI signal level in decibels in the report, select the RSSI check box.

To display the radio address in the report, select the Address check box.

NOTE

The Address check box is not displayed in the Radio Locations

window, if the Address data provider check box is not

selected in the positioning systems settings.

To select the route, on which basis the report will be

created,

perform the following actions:

1. Select the Route check box.

2. From the unlocked list on the right, select the desired

route.

3. (Optional) If displaying only the coordinates of key route

points is required, select the Only Key Points check box.

6. Click OK to create a report.

Postrequisites: 

Select a format to export the report.

For information on report exporting, see Report Actions.

4.17.5 Creating Radio Movement Report

Follow the procedure to create a report based on radio movement data.

Prerequisites: 

• Ensure you have the license supporting GPS. For details, see Licenses.

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator, otherwise it will be

unavailable for creating a report. For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and

Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running, otherwise it will be unavailable for creating a report.

• Ensure the operator has the Build reports right. For details, see Operators.

• Ensure the operator has the Request radio location right. For details, see Operators.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows

requesting data from the radioserver. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Radio Movement.

The Radio Movement window appears.
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2. In the window that appears, in the Period field, enter the desired dates and time of events to create the report displaying radio

movement for the specified period.

3. From the Source list, select the data source for the report:

To select the SmartPTT Dispatcher database as the data

source,

select the Dispatcher value.

To select the SmartPTT Radioserver database as the data

source,

select the value with the desired SmartPTT Radioserver

name.

4. Specify which movement information will be displayed in the report:

To display information about the radios movement in the

report,

perform the following actions:

1. Select the Select radios element.

2. From the list next to the element, select the desired

radios.

To display information about the radio categories

movement in the report,

perform the following actions:

1. Select the Select categories element.

2. From the list next to the element, select the desired radio

categories.

To display information about the registered users

movement in the report,

perform the following actions:

1. Select the Select users element.

2. From the list next to the element, select the desired users.
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5. To specify the time after which a radio will be considered as stopped, enter the desired value in the Minimum stop time interval

(min) field.

6. (Optional) Configure displaying points of interest in the report:

To include points of interest in the report, select the Enable points of interest check box.

To set the acceptable distance of the radio deviation from

the point of interest,

perform the following actions:

1. Select the Enable points of interest check box.

2. Enter the desired value in the unblocked Radius (m) field.

7. Click OK to create a report.

Postrequisites: 

Select a format to export the report.

For information on report exporting, see Report Actions.

4.17.6 Creating Online Radios Report

Follow the procedure to create a report providing information about the radios that are currently online/offline.

Prerequisites: 

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator, otherwise it will be

unavailable for creating a report. For details, see “Configuring Event Log Database Connection” in SmartPTT Installation and

Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running, otherwise it will be unavailable for creating a report.

• Ensure the operator has the Build reports right. For details, see Operators.

• If desktop client authentication on SmartPTT Radioserver is enabled, ensure that the profile assigned to the client allows

requesting data from the radioserver. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Online Radios.

The Online Radios window appears.

2. In the window that appears, in the Select Radio IDs area, specify the desired radios for which the report will be created:

To create a report for all radios, select the All option.

To create a report for several radios, perform the following actions:
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1. Select the Radio ID range option.

2. Enter the start and end ID of the radio range in the fields.

To create a report for the specific radio, perform the following actions:

1. Select the Radio ID range option.

2. Enter the desired radio ID in the first field of the range.

To include data on offline radios in the report, select the Include offline subscribers check box.

3. Click OK to create a report.

Postrequisites: 

Select a format to export the report.

For information on report exporting, see Report Actions.

4.17.7 Monitoring Reports

Monitoring reports provide the following abilities:

• Display information received from MOTOTRBO repeaters, including information about voice calls.

For details, see Creating Air Monitoring Report.

• Display information on events and alarms registered on the radio system devices, such as repeaters, routers, and UPS.

For details, see Creating Monitoring Event Log Report.

• Display information on the system load, uptime, downtime, and other related radio system parameters.

For details, see Creating System Usage Report.

Important

The reporting functionality is available only if you have the corresponding license and the Monitoring feature is activated in SmartPTT

Radioserver Configurator.

For information on configuring monitoring, see “Configuring Monitoring Database Connection“ in SmartPTT Installation and

Configuration Guide.

For information on licenses, see Licenses.

Important

If desktop client authentication on SmartPTT radioserver is enabled and the profile assigned to the client prohibits using the

Monitoring feature, you will not be able to create monitoring reports. For details, see “Profiles” in SmartPTT Installation and

Configuration Guide.

NOTE

These reports are not available for SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

4.17.7.1 Creating Air Monitoring Report

Follow the procedure to create the air monitoring report.

Prerequisites: 

• Ensure you have the monitoring license. For details, see Licenses.

• Ensure the monitoring feature is activated in SmartPTT Radioserver Configurator. For details, see “Configuring Monitoring

Database Connection” in SmartPTT Installation and Configuration Guide.
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• Ensure that the desired SmartPTT Radioserver is running.

• Ensure the operator has the Build reports right. For details, see Operators.

• If desktop client authentication on SmartPTT radioserver is enabled, ensure that the profile assigned to the client allows using

monitoring feature. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Monitoring → Air Monitoring.

The Air Monitoring window appears.

2. In the window that appears, in the Period field, enter the desired dates and time of events to create the air monitoring report for

the specified period.

3. From the Radioserver list, select the desired SmartPTT Radioserver.

4. From the System list, select the network to create a report:

To create a report for the specific network, select the desired network.

To create a report for all networks, select the All value.

5. From the Radio list, select the radio to create a report:

To build a report for the specific radio, select the desired radio.

To create a report for all radios, select the All value.

6. (Optional) Configure additional parameters to create a report:

To display time in the Coordinated Universal Time

standard (UTC+00:00) in the report,

select the UTC Time check box.

To sort data in the report, perform the following actions:

1. Select the Sort by check box.

2. Select one of the parameters to sort data in the report:

System, Repeater, Slot, Event type, From, To, Duration

(ms), RSSI (dBm).
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7. Click OK to create a report.

Postrequisites: 

Select a format to export the report.

For information on report exporting, see Report Actions.

4.17.7.2 Creating Event Log Report

Follow the procedure to create a report based on data stored in the monitoring Event Log.

Prerequisites: 

• Ensure you have the monitoring license. For details, see Licenses.

• Ensure the monitoring feature is activated in SmartPTT Radioserver Configurator. For details, see “Configuring Monitoring

Database Connection” in SmartPTT Installation and Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running.

• Ensure the operator has the Build reports right. For details, see Operators.

• If desktop client authentication on SmartPTT radioserver is enabled, ensure that the profile assigned to the client allows using

monitoring feature. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Monitoring → Event Log.

The Event Log window appears.

2. In the window that appears, in the Period field, enter the desired dates and time of events to create the monitoring log report for

the specified period.

3. From the Radioserver list, select the desired SmartPTT Radioserver to create a report:

To create a report for the specific radioserver, select the desired radioserver.

To create a report for all radioservers, select the All radioservers value.

4. Click OK to create a report.

Postrequisites: 

Select a format to export the report.

For information on report exporting, see Report Actions.
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4.17.7.3 Creating System Usage Report

Follow the procedure to create a report providing information on system usage.

Prerequisites: 

• Ensure you have the monitoring license. For details, see Licenses.

• Ensure the monitoring feature is activated in SmartPTT Radioserver Configurator. For details, see “Configuring Monitoring

Database Connection” in SmartPTT Installation and Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running.

• Ensure the operator has the Build reports right. For details, see Operators.

• If desktop client authentication on SmartPTT radioserver is enabled, ensure that the profile assigned to the client allows using

monitoring feature. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Monitoring → System Usage.

The System Usage window appears.

2. In the window that appears, in the Period field, enter the desired dates and time of events to create the system usage report for the

specified period.

3. From the Radioserver list, select the desired SmartPTT Radioserver to create a report.

4. From the System list, select the desired radiosystem for which a report will be created.

5. Click OK to create a report.

Postrequisites: 

Select a format to export the report.

For information on report exporting, see Report Actions.

4.17.8 Creating Lone Workers Report

Follow the procedure to create a report providing information about events for radios in the Lone Worker mode.

Prerequisites: 

Ensure the operator has the Build reports right. For details, see Operators.

Procedure: 

1. On the menu bar, click Reports → Lone Workers.

The Lone Workers window appears.
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2. In the window that appears, in the Period field, enter the desired dates and time of events to create a report for the specified

period.

3. From the Radio list, select the radio for the report:

To create a report for the specific radio, select the name of the desired radio.

To create a report for all radios, select the All value.

4. (Optional) From the Sort By list, select the desired parameter by which the report data will be sorted:

a. Select the Sort By check box.

b. From the Sort by list, select the desired parameter by which the report data will be sorted: Direction, Event Type, Date/Time,

Additional information, Operator, Radioserver, Channel, Radio, Talkgroup, Status, Duration, Destination. 

5. Click OK to create the report.

Postrequisites: 

Select a format to export the report.

For information on report exporting, see Report Actions.

4.17.9 Creating Indoor Tracking Report

Follow the procedure to create a report on the movement of indoor radios based on data received from radio beacons.

Prerequisites: 

• Ensure you have the Indoor Tracking license. For details, see Licenses.

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator. For details, see “Configuring

Event Log Database Connection” in SmartPTT Installation and Configuration Guide.

• Ensure that indoor tracking is configured in SmartPTT Radioserver Configurator and SmartPTT Dispatcher.

• Ensure that the desired SmartPTT Radioserver is running.

• Ensure the operator has the Build reports right. For details, see Operators.

Procedure: 

1. On the menu bar, click Reports → Indoor Tracking.

The Indoor Tracking window appears.
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2. In the window that appears, in the Period field, enter the desired dates and time of events to create a report for the specified

period.

3. From the Radioserver list, select SmartPTT Radioserver for creating the report:

To create a report for the specific SmartPTT Radioserver, select SmartPTT Radioserver with the desired name.

To create a report for all radioservers, select the All radioservers value.

4. From the Beacon list, select the beacon for creating the report:

To create a report for the specific beacon, select a beacon with the desired name.

To create a report for all beacons, select the All beacons value.

5. Specify which data will be displayed in the report:

To display data for radios in the report, perform the following actions:

1. Select Radio.

2. From the list below, select the desired radio or the All

radios value.

To display data for registered users in the report, perform the following actions:

1. Select User.

2. From the list below, select the desired user or the All

users value.

6. (Optional) Specify data grouping in the report:

a. Select the Group by check box.

b. Select the desired value:

To group data in the report by beacons, from the unblocked list on the right, select the Beacons value.

To group data in the report by users, from the unblocked list on the right, select the Users value.
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7. Click OK to create a report.

Postrequisites: 

Select a format to export the report.

For information on report exporting, see Report Actions.

4.17.10 Exporting Reports

Reports on the SmartPTT Dispatcher and SmartPTT Radioserver operation are created as separate files that can be saved on a computer

in the desired format, printed or sent to the desired email address. All these actions are performed in the Print Preview window, where

the created report is opened.

Reports on the SmartPTT Dispatcher and SmartPTT Radioserver operation are saved on the computer in the PRNX format.

If necessary, the created report can be exported in any of the following formats: PDF, HTML, MHT, RTF, XLS, XLSX, CSV, TXT, XPS. The

created reports can also be saved as image files in the following formats: BMP, EMF, WMF, GIF, JPEG, PNG, TIFF.

NOTE

Reports created by the Report Wizard on the basis of SmartPTT Dispatcher and SmartPTT Radioserver Event Logs are saved on a

computer as separate files in the following formats: HTML, MHT, XLS, XLSX, CSV, TXT.

Example of Event Log Report

The figure below shows the example of a report created with the Report Wizard.

Depending on the values you select when configuring the parameters of the Event Report, each generated report can consist of the

following elements:

• The default report name.

• The list of selected conditions and its values. You can see the following conditions: Direction, Event type, Date, Radioserver,

Channel, Talkgroup, Radio, User, Destination. Data is filtered according to the selected conditions and displayed in the report.

• The summary table filled with data of the following parameters: Direction, Event type, Date/Time, Additional information, Not read,

Operator, Radioserver, Channel, Radio, User, Source, Talkgroup, Destination, Status, Duration, Connection Type, Sound Record,

Lone Worker, Note.

For detailed information on each parameter, see the SmartPTT Dispatcher embedded help.

Example of Radio Activity Report

The figure below shows the example of a report based on radio activity data.
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Depending on the values you select when configuring the parameters of the Radio Activity Report, each generated report can consist of

the following elements:

• The default report name.

• The start and end dates of events that are displayed in the report.

• The summary table with the following data:

• Amount of Calls — number of calls for the specified period.

• Duration, hh:mm:ss — total duration of calls for each type.

• The summary table filled with detailed data for each period.

• Amount of Calls — number of calls for the period.

• Duration, hh:mm:ss — total duration of calls for each type.

• Period — time range of displayed data.
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• Visual data representation as a bar chart with a legend.

Example of Text Chat History Report

The figure below shows the example of a Text Chat History report in the HTML format.

The report shows the SmartPTT Mobile user chat history for a specific period. Depending on the values you select when configuring the

parameters of the Text Chat History report, each generated report can contain the following information:

• Name of the chat used to generate the report.

• Period used to generate the report.

NOTE

The period is displayed if you specify the period for which you want to display messages in the report.
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• Text that is present in all messages in the report.

NOTE

The text is displayed in the Containing text field if you enable search for messages with the specific text in the Text Chat History

window. For details, see Creating Text Chat History Report.

• Date and time when the event occurred or the user sent a text message.

• Name of the user that initiated the event or sent the message.

• Service message about creating, editing, deleting a text chat, and adding, deleting users from a text chat. The message text has a

blue background.

NOTE

Service messages are included in the report only if you select the Include service messages in the report check box in the Text Chat

History window. For details, see Creating Text Chat History Report.

• Text message sent by the user. The message background is white.

• Emergency message from the mobile client in the emergency state. The message background is red.

• Last message status registered at the moment the report was created.

• Contacts of the technical support.

• Time and date when the report file was created.

The name of the created report file has the following format: Chat_<Chat name>_<Period>, where:

• <Chat name> — depending on the chat type, it can have one of the following formats:

• <Group chat name> — name of the group chat.

• <Participant 1 name>&<Participant 2 name> — name of the private chat.

• <Period> — has the <mm-dd-yy_mm-dd-yy> format that indicates the beginning and end dates of the period. If you did not specify

the search period, then this parameter is hidden in the file name.

Example of Radio Location Report

The figure below shows the example of the report based on radio location data.
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Depending on the values you select when configuring the parameters of the Radio Location report, each generated report can consist of

the following elements:

• The default report name.

• The start and end dates of events that are displayed in the report.

• The summary table with the following data:

• Date — date and time when the radio coordinates are registered in the system.

• Radio/User — radio identifier or name of the radio user.

• Latitude — latitude value of the radio geographic location.

• Longitude — longitude value of the radio geographic location.

• Speed m/s — speed of radio movement.

• Precision (m) — precision value for the radio geographic location.
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• Address — mailing address of the radio location.

Example of Radio Movement Report

The figure below shows the example of the report based on radio movement data.

Depending on the values you select when configuring the parameters of the Radio Movement report, each generated report can consist of

the following elements:

• The default report name.

• The start and end dates of events that are displayed in the report.

• The summary table with the following data:

• Start time — date and time when the radio started moving.

• Stop time — date and time when the radio stopped moving.

• Moving time — total time of the radio movement.

• Distance, km — distance value distance that radio traveled during the specified time.

• Maximum speed, m/s — maximum speed of the radio.

• Location — address or the point of interest where the radio stayed without moving.

• Stop time interval — time during which a radio did not move.

• Idle time — time during which a radio is idle.
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Example of Online Radios Report

The figure below shows the example of the report based on online and offline radios data.

Depending on the values you select when configuring the parameters of the Online Radios report, each generated report can consist of

the following elements:

• The default report name. The name also contains the total number of online/offline radios.

• The summary table with the following data:

• Radio ID — unique identifier of the radio that is currently online/offline.

• Network Type — type of the network where the radio is registered.

• Offline since — date and time since the radio became offline.

• Name — radio name displayed in the network.

Example of Air Monitoring Report

The figure below shows the example of the report based on air monitoring data.
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Depending on the values you select when configuring the parameters of the Air Monitoring report, each generated report can consist of

the following elements:

• The default report name.

• The start and end dates of events that are displayed in the report.

• The additional display options such as System, Radio, UTC time.

• The summary table with the following data:

• Date — date and time when the event was registered in the system.

• System — radio system name.

• Site — site identifier (applied only for Linked Capacity Plus networks).

• Repeater — name of a repeater.

• Slot — number of a slot used to transmit data.

• Voice/Data — type of transmitted data.

• Event type — type of a transmitted event.

• From — unique identifier of the event initiator.

• To — unique identifier of the event receiver.

• Duration (ms) — duration of the event.

• RSSI (dBm) —  RSSI level in decibels.

Example of Monitoring Event Log Report

The figure below shows the example of the Monitoring Event Log report.
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Depending on the values you select when configuring the parameters of the Monitoring Event Log report, each generated report can

consist of the following elements:

• The default report name.

• The start and end dates of events that are displayed in the report.

• The name of the radioserver whose database was used as a data source to create the report.

• The summary table with the following data:

• Radioserver — name of the radioserver where the event was registered.

• Network — name of the network where the event was registered.

• Site —  site identifier (applied only for Linked Capacity Plus networks).

• Event time — date and time when the event happened.

• Device type — type of the device connected to the radioserver.

• Repeater — unique identifier of the repeater.

• Device Name — name of the device connected to the radioserver.

• Device ID — unique identifier of the device connected to the radioserver.

• Alarm Severity —  degree of alarm severity, such as Critical, Major, Minor.

• Description — additional information about the device state.

Example of System Usage Report

The figure below shows the example of the report based on the system usage data.
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Depending on the values you select when configuring the parameters of the System Usage report, each generated report can consist of

the following elements:

• The default report name.

• The start and end dates of events that are displayed in the report.

• The name of the radio network which the report was created for.

• The summary table filled with data on each site configured in the selected radio system. You can see the following parameters:

• Site — repeater identifier, site identifier, radioserver identifier in the selected radio network.

• Number of Channels — total number of channels on each site.

• Number of Radios —  total number of radios registered in this site.

• Online, h:mm:ss — total amount of time during which radios of this site are online.

• Offline, h:mm:ss — total amount of time during which radios of this site are offline.
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• The summary table filled with data on channel usage of each site in the selected radio network. You can see the following

parameters:

• Site — name of the site in the selected radio network.

• Number of Channels — total number of channels on each site.

• Duration, h:mm:ss, ms — amount of time used by each channel of the site.

•  The summary table filled with data on each radio. You can see the following parameters:

• # — sequence number of the radio in the list.

• Radio ID — unique identifier of the radio.

• Name — name of the radio.

• Sites — name of the site where this radio is registered.

Example of Lone Workers Report

The figure below shows the example of the report based on data of radios in the Lone Worker mode.

Depending on the values you select when configuring the parameters of the Lone Workers report, each generated report can consist of

the following elements:

• The default report name.

• The start and end dates of events that are displayed in the report.

• The name of the radio which the report was created for.

• The summary table filled with data on each event registered for this radio. You can see the following parameters:

• Direction — direction of the data transmission relative to the selected radio. You can see the following values:

• Incoming — the event was received by the radio.

• Outgoing — the event was initiated by the radio.

• Event type — type of the registered event.

• Date/Time —  date and time when the event was registered.

• Additional information — details about the registered event. For example, ID of the incoming initiator, an operator name, etc.

• Operator — displays the operator name. The account name of this operator was used to start the SmartPTT Dispatcher when

the event happened.

• Radioserver — name of the radioserver where the event was registered.
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• Channel — name of the channel where the event was registered.

• Radio — name or ID of the device where the event was registered.

• Talkgroup — name of the radio talk group.

• Status — status of the registered event.

• Duration — duration of the event.

• Destination — name or ID of the receiver of the registered event.

• Source — name or ID of the event initiator.

Example of Indoor Tracking Report

The figure below shows the example of the Indoor Tracking report. The report is based on data received from special beacons.

Depending on the values you select when configuring the parameters of the Indoor Tracking report, each generated report can consist of

the following elements:

• The default report name.

• The start and end dates of the events that are displayed in the report.

• The summary table showing information about indoor location of the radio at a specific time. You can see the following

parameters:

• Radioserver — IP address of the radioserver whose database was used as a data source when creating the report.

• Beacons — identifier of the beacon for which the report was generated.

• Radio/User —  identifier of the radio or name of the radio user.

• Data/Time — date and time when the radio was detected near the beacon.
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• Message — text notifying that the system received data on radio location.

4.17.10.1 Report Actions

Follow the procedure to perform the desired actions with the generated report in the Print Preview window.

Procedure: 

1. Create the desired report. For details, see Reports.

The Print Preview window appears.

NOTE

The Print Preview window appears when you create a report from the Reports menu, and if you do not use the Report Wizard to create

a report.

2. In the window that appears, perform the desired action with the report:

To zoom in/zoom out the report page, perform one of the following actions::

• From the Page Size list, select the desired page size in

percentage points.

• Click Zoom out (   )/Zoom in (   ).

To go to the next/previous report page,

click Next Page (   )/Previous Page (   ) respectively.

To go to the first/last report page,

click First Page (   )/Last Page (   ) respectively.

To go to a specific report page, in the lower-left corner, in the Page field, enter a page number, and

then press ENTER.

To open a report saved as a file in the PRNX format, perform the following actions:

1. Click Open (   ).

2. In the window that appears, select the desired file in the

PRNX format.
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3. Click Open.

To save the created report to the PRNX format, perform the following actions:

1. Click Save (   ).

2. In the window that appears, specify a folder and a file name

to save the file.

3. Click Save.

To choose a printer and print the report, perform the following actions:

1. Click Print (   ).

2. In the window that appears, select a print device.

3. Configure the desired printing options.

4. Click Print.

To print the report using default print device,

click Quick Print (   ).

The default print device will print the report.

To setup report page options, perform the following actions:

1. Click Page Setup (   ).

The Page Setup window appears.

2. In the window that appears, configure report page options.

3. Click OK.

To export the report, perform the following actions:

1. Click the arrow on the Export Document (   ) button.

2. From the menu, select the desired file format to export the

report.

3. In the window that appears, configure export options.

4. Click OK.

5. In the window that appears, specify a folder and name to

save the file.

6. Click Save.

To send the report using email, perform the following actions:

1. Click the arrow on the Send via e-mail (   ) button.

2. From the menu, select the desired file format to send the

report using email.

3. In the window that appears, configure export options.

4. Click OK.

5. In the window that appears, specify a folder and name to

save the file.
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6. Click Save. The default email client appears. The report file

will be automatically attached to the email.

7. Fill the desired fields and send the email.

4.18 Telemetry

The Telemetry service transmits and processes telemetry signals between SmartPTT Dispatcher and radios connected to sensors or

actuators using GPIO pins.

Important

Telemetry actions are available to the operators with the Send telemetry commands right.

For information on user roles in SmartPTT Dispatcher, see Operators.

NOTE

The Telemetry feature is available only to DMR radios.

SmartPTT Dispatcher provides the following features:

• Receive dry (volt-free) contacts data

• Notify if the signal was changed

• Send telecommands

Important

Telemetry features are unavailable if desktop client authentication on SmartPTT Radioserver is enabled and the profile assigned to

the client prohibits access to telemetry actions. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

You can send telecommands using a channel with normal traffic (for example, the dedicated channel of a single-site system). Radios

with corresponding firmware can send telecommands after pressing the programmed button using a dedicated telemetry data channel

that must be configured in the codeplug.

Configured actions can be assigned to a radio or talkgroup using the Telemetry (   ) element. Then they can be executed from the radio

or talkgroup Call Window.

NOTE

The telemetry actions can be assigned only to the radios that are registered in the system. If the radio is not registered, the Telemetry

feature will be unavailable.

NOTE

The telemetry actions are unavailable for All Calls. Only outgoing telemetry actions are available for talkgroups.

Telemetry events can trigger custom rules to initiate various actions. To use this feature, in the the Custom Rule Table select Telemetry

as the condition type.

For information on custom rule configuration, see Custom Rules.

You also can send configured telecommands and monitor the current status of GPIO pins on a Custom Console if you set the Incoming

Telemetry and Outgoing Telemetry tiles in the Console Configuration window. For details, see Custom Consoles.

For information on performing telemetry actions in SmartPTT Dispatcher, see the sections below.
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4.18.1 Executing Telemetry Actions from Radio Call Window

Follow the procedure to execute an outgoing telemetry action from the radio Call Window.

Prerequisites: 

• Assign the desired telemetry actions to the radio. For details, see Assigning Telemetry to Radios.

• Ensure the radioserver is online.

Procedure: 

1. To open the radio Call Window, perform one of the following actions:

To open the radio Call Window from the Radio Fleet panel, double-click the desired radio on the Radio Fleet panel.

To open the radio Call Window from the Radios panel or in

the Custom Console,

right-click the desired radio on the Radios panel or in the

Custom Console.

 For information on the radio Call Window, see Call Windows.

2. From the Outgoing Telemetry (   ) menu, select the desired telemetry action to execute.

Important

To execute telemetry actions, the radio contacts or VIO must be mapped to a physical GPIO line in the radio codeplug.

3. (Optional) To receive the current telemetry status, click Get Status of Telemetry Contact (   ).

The updated status will be displayed in the radio Call Window log.
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4.18.2 Executing Telemetry Actions from Talkgroup Call Window

Follow the procedure to execute an outgoing telemetry action from the talkgroup Call Window.

Prerequisites: 

• Assign the desired telemetry actions to the talkgroup. For details, see Assigning Telemetry to Talkgroups.

• Ensure the radioserver is online.

Procedure: 

1. On the Radio Fleet panel, double-click the desired talkgroup.

The talkgroup Call Window appears.

2. From the Outgoing Telemetry (   ) menu, select the desired telemetry action to execute. This action will be executed by the

radios that listen to this talkgroup.

Important

To execute telemetry actions, the radio contacts or VIO must be mapped to a physical GPIO line in the radio codeplug.



If you have a request or want to learn more about our solutions, please contact our sales managers via email sales@smartptt.com

Customer support is provided by SmartPTT Technical Support Center. You can contact a support engineer via email

support@smartptt.com or by submitting a request on the official support website support.smartptt.com

You can find the full SmartPTT Terms of Technical Support on the official website https://smartptt.com/smartptt-terms-of-technical-

support/

SmartPTT Technical Support Center does not consult on deployment and maintenance of Motorola Solutions products except on

settings related to SmartPTT connection and data communication.

For technical support on Motorola Solutions products, please contact an authorized Motorola Solutions representative in your region.

To share your feedback on the product, documentation, and services, email us at feedback@smartptt.com

Contact Us

Web: smartptt.com

Email: info@smartptt.com

Tel.: +1-786-362-5525

Mailbox: 290 Northwest 165th St, # P-800A, Miami, FL, 33169, USA
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